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Safety Instruction

Before using the product ...

For your safety and effective operation, please read the safety instructions thoroughly before using the product.
Safety Instructions should always be observed in order to prevent accident or risk with the safe and proper use
the product.

Instructions are divided into “Warning” and “Caution”, and the meaning of the terms is as follows.

&Warning This symbol indicates the possibility of serious injury or death if some applicable
instruction is violated

] This symbol indicates the possibility of severe or slight injury, and property
& Caution damages if some applicable instruction is violated

Moreover, even classified events under its & caution category may develop into serious accidents relying
on situations. Therefore we strongly advise users to observe all precautions properly just like warnings.

The marks displayed on the product and in the user’s manual have the following meanings.
& Be careful! Danger may be expected.

ABe careful! Electric shock may occur.

The user’s manual even after read shall be kept available and accessible to any user of the product.



Safety Instruction

Safety Instructions for design process

7

/™ 'Warning

1. Please install a protection circuit on the exterior of PLC so that the whole system may
operate safely regardless of failures from external power or PLC. Any abnormal output or
operation from PLC may cause serious problems to safety in whole system.

- Install protection units on the exterior of PLC like an interlock circuit that deals with opposite
operations such as emergency stop, protection circuit, and forward/reverse rotation or install an
interlock circuit that deals with high/low limit under its position controls.

- If any system error (watch-dog timer error, module installation error, etc.) is detected during
CPU operation in PLC, all output signals are designed to be turned off and stopped for safety.
However, there are cases when output signals remain active due to device failures in Relay and
TR which can’t be detected. Thus, you are recommended to install an addition circuit to monitor
the output status for those critical outputs which may cause significant problems.

2. Never overload more than rated current of output module nor allow to have a short circuit.
Over current for a long period time may cause a fire .

3. Never let the external power of the output circuit to be on earlier than PLC power, which may
cause accidents from abnormal output or operation.

4. Please install interlock circuits in the sequence program for safe operations in the system
when exchange data with PLC or modify operation modes using a computer or other
external equipments Read specific instructions thoroughly when conducting control operations
with PLC.




Safety Instruction

Safety Instructions for design process
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/™\ Caution

\

I/O signal or communication line shall be wired at least 100mm away from a high-voltage cable or
power line. Fail to follow this instruction may cause malfunctions from noise

Safety Instructions on installation process

7

/N Caution

1. Use PLC only in the environment specified in PLC manual or general standard of data
sheet. If not, electric shock, fire, abnormal operation of the product may be caused.

2. Before install or remove the module, be sure PLC power is off. If not, electric shock or
damage on the product may be caused.

3. Be sure that every module is securely attached after adding a module or an extension

connector. If the product is installed loosely or incorrectly, abnormal operation, error or dropping
may be caused. In addition, contact failures under poor cable installation will be causing
malfunctions as well.

4. Be sure that screws get tighten securely under vibrating environments. Fail to do so will

put the product under direct vibrations which will cause electric shock, fire and abnormal operation.
5. Do not come in contact with conducting parts in each module, which may cause electric
shock, malfunctions or abnormal operation.




Safety Instruction

Safety Instructions for wiring process
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/™ Warning

1. Prior to wiring works, make sure that every power is turned off. If not, electric shock or
damage on the product may be caused.

2. After wiring process is done, make sure that terminal covers are installed properly before
its use. Fail to install the cover may cause electric shocks.

/™ Caution

1. Check rated voltages and terminal arrangements in each product prior to its wiring
process. Applying incorrect voltages other than rated voltages and misarrangement among
terminals may cause fire or malfunctions.

2. Secure terminal screws tightly applying with specified torque. If the screws get loose, short
circuit, fire or abnormal operation may be caused. Securing screws too tightly will cause damages
to the module or malfunctions, short circuit, and dropping.

3. Be sure to earth to the ground using Class 3 wires for FG terminals which is exclusively
used for PLC. If the terminals not grounded correctly, abnormal operation or electric shock may
be caused.

4.  Don’t let any foreign materials such as wiring waste inside the module while wiring,
which may cause fire, damage on the product or abnormal operation.

5. Make sure that pressed terminals get tighten following the specified torque. External

connector type shall be pressed or soldered using proper equipments.




Safety Instruction

Safety Instructions for test-operation and maintenance

/" Warning

=

Don’t touch the terminal when powered. Electric shock or abnormal operation may occur.

Prior to cleaning or tightening the terminal screws, let all the external power off including
PLC power. If not, electric shock or abnormal operation may occur.

Don’t let the battery recharged, disassembled, heated, short or soldered. Heat, explosion or

ignition may cause injuries or fire.

& Caution

Do not make modifications or disassemble each module. Fire, electric shock or abnormal
operation may occur.

Prior to installing or disassembling the module, let all the external power off including PLC
power. If not, electric shock or abnormal operation may occur.

Keep any wireless equipment such as walkie-talkie or cell phones at least 30cm away from
PLC. If not, abnormal operation may be caused.

When making a modification on programs or using run to modify functions under PLC
operations, read and comprehend all contents in the manual fully. Mismanagement will cause
damages to products and accidents.

Avoid any physical impact to the battery and prevent it from dropping as well. Damages to
battery may cause leakage from its fluid. When battery was dropped or exposed under strong
impact, never reuse the battery again. Moreover skilled workers are needed when exchanging

batteries.




Safety Instruction

Safety Instructions for waste disposal
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/\ Caution

\

» Product or battery waste shall be processed as industrial waste. The waste may discharge

toxic materials or explode itself.
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Revision History

\ersion Date Remark Page
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V12 2005.09 XG-PD CH5.2
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H1.3.2
1. Adding models CH13
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-adding switch module (XGL-EH5T) CH76
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3. Adding error code table CH ]_1.
4. Adding CH 11 Compliance with EMC Specifications
. Fixing h
5. Fixing headquarter address Back cover-
H1.2.1
1. Modifying Overview SH 132
V1.6 2009.09 2. Adding CPU CH5. 3'
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1. How to enable link through flag added CH5.5.2
VL7 2011.05 2. Write_ NC, Send_NC” instruction added CH7.21
VL8 2013.10 1. Addlng_ Communication load specifications CH2.2.3
2. Changing Modbus server offset area CH8.3.1
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2. Adding info-U, iXP CH4
3. Adding XGR HS Link CH6.6~6.7
V19 2014.03 4. Adding XGT Dedicated Communication’s Header CH8.1.2
5. Adding XGT Dedicated Communication’s error Code CH8
6. Adding High Performance XGT CH9.2.3
7. Changing error code table CH104
V20 2014.11 XG5000 V4.0 Ul Update ;
V2.1 2016.10 XGL-EFMTB, XGL-EFMFB contents added -
V2.2 2017.06 Adding RAPIEnet protocol and Cnet protocol -
V2.21 2017.09 Error code update CH10.2.2
V2.30 2018.05 Adding OPC UA Server service CH12
V3.0 2020.02 Adding Smart extension service -




Revision History

Version Date Remark Page
1. Format and contents modification according to the change of ALL
company name(LSIS -> LS ELECTRIC)
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1. MRS IP assignment description added CH2.2,CH2.3
V3.2 2020.11 . L
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V3.5 2024.01 DNP3 Server Added CH7.6
1. Added input data clear function when high-speed link timeout CHE
V3.6 2024.06 occurs
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V3.61 2024.09 Error code update CH9.2.2
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V3.62 2024.11 CH7.4

- Not available if H\W version is V3.0 or higher




About User’s Manual

Thank you for purchasing PLC of LS ELECTRIC Co., Ltd.

Before use, make sure to carefully read and understand the User’s Manual about the functions, performances, installation and
programming of the product you purchased in order for correct use and importantly, let the end user and maintenance

administrator to be provided with the User’s Manual.

The User's Manual describes the product. If necessary, you may refer to the following description and order accordingly. In

addition, you may connect our website (http:/iww.Is-electric.com/) and download the information as a PDF file.

Relevant User’s Manuals

(for XGl, XGR)

Title Description
XG5000 User's Manual XG5000 sgflwarg user manyal dESCI’IbII"Ig online functlon such as
programming, print, monitoring, debugging by using XGK, XGB
(for XGK, XGB)
CPU
XG5000 User's Manual XG5000 software user manual describing online function such

as programming, print, monitoring, debugging by using XGl,
XGR CPU

XGK/XGB Instructions & Programming
User’s Manual

User’s manual for programming to explain how to use
instructions that are used PLC system with XGK, XGB CPU.

XGI/XGR Instructions & Programming
User’s Manual

User’s manual for programming to explain how to use
instructions that are used PLC system with XGI, XGR CPU.

XGK CPU User’s Manual

XGK-CPUU/CPUH/CPUA/CPUS/CPUE/CPUSN/CPUHN/
CPUUN user manual describing about XGK CPU module,
power module, base, 10 module, specification of extension cable
and system configuration, EMC standard

XGI CPU User’s Manual

XGI-CPUU/D,CPUU,CPUH,CPUS,CPUE,CPUUN user manual
describing about XGI CPU module, power module, base, IO
module, specification of extension cable and system
configuration, EMC standard

XGR redundant series User’s
Manual

XGR- CPUH/F, CPUHIT user manual describing about XGR
CPU module, power module, extension drive, base, IO module,
specification of extension cable and system configuration, EMC
standard

Communication device User’s Manual

User’s manual for programming to explain how to use Extension
driver, Smart I/O extention, Smart I/O block
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Chapter 1 Overview

Chapter 1 Overview

1.1 Guide to use this manual

This user's manual provides information on the performance specifications and operation methods of each product required

to use the Ethernet (FEnet) module and switch module.

Classificat
. Item Contents
ion
: This chapter describes the structure of this manual, product features, and features
Chapter 1 | Overview . .
provided by version.
Chaoter 2 Product It describes the general specifications, performance specifications and cable
P specifications specifications for PLC. Also, it describes part names and functions.
. . Installation method, setting sequence for operation, cable wiring precautions, trial
Installation and trial _ . : . . ;
Chapter 3 operation operation (module registration, basic setting, download upload, link enable, system
P diagnosis). This section explains how to remove and replace the module.
Chaoter 4 Smart  extension | Function overview, Smart extension service operation, Smart extension setting,
P service Smart extension diagnosis function, Smart extension system.
Describes the function overview, high speed link service operation, high speed link
Chapter 5 | HS Link Service setting, high speed link information, XGR redundancy program method and
Ethernet system configuration.
Function overview, P2P service operation, P2P service setting, user frame
. definition overview, operation, setting, E-mail service, P2P parameter download
Chapter 6 | P2P service . . P g . P
and diagnosis, XGR redundancy program method are described.
Please refer to Chapter 5 for system configuration.
Function overview, XGT server operation, Modbus server overview, Modbus server
operation, EtherNet / IP service operation, EtherNet / IP service setting, EtherNet /
Chapter 7 | Server service IP service diagnosis, EtherNet / IP system configuration, OPC UA function and OPC
UA server setting.
Please refer to Chapter 5 for system configuration.
- . This chapter describes remote communication control and system configuration
Chapter 8 | Additional service ) p 4 g
using switch module.
_ LED error check, module error check using XG5000, problem-specific
Chapter 9 | Troubleshooting . . g P P
troubleshooting, and communication error code.

h r Descri he requirements for mplian with EM ndar nd th
Chapte EMC Standard esgbeste eque.ets.o compliance t. _Cstadads and the
10 requirements for compliance with the Low Voltage Directive.

. This section describes the XGT CPU memory device list, term descriptions, flag list,
Appendix | - L . . .
communication relay (L) list, ASCII code table, and dimensions.
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Chapter 1 Overview

1.2 Characteristics

Ethernet is a 'technical standard' established by the IEEE, which enables easy network construction and high-speed, high-
capacity data collection through CSMA / CD communication. Ethernet module is a module for data transmission between
upper system such as PC device or PLC using electric / optical media. The Ethernet module supports TCP / IP and UDP / IP
protocols and has the following characteristics.

1.2.1 Ethernet module

Easy module change using module change switch of CPU and module change wizard of XG5000.
Up to 24 Ethernet modules can be installed regardless of the main base and the extension base.(XGR CPU only
supports main base)
Media support based on the IEEE802.3 standard.
Check parameter and service setting, module and network status using communication configuration tool (XG5000).
Dynamic Host Configuration Protocol (DHCP) support for dynamically setting IP addresses.
Provide access table to secure communication with host PC (HMI).
Smart extension service for easy configuration and high speed data communication between our products.
High speed link support for high speed data communication between our products.
Possible to set high speed link block to transfer data between modules(Maximum transmission 32 blocks x 200
words, maximum reception 128 blocks x 200 words, maximum transmission and reception 128 blocks x 200 words).
When using extension mode, RAPIEnet V2 high speed link supports a maximum of 256 blocks x 700 words for
transmission, a maximum of 256 blocks x 700 words for reception, and a maximum of 256 blocks x 700 words for
transmission and reception.
Communication with up to 16 modules is available in addition to the high speed link.(Dedicated communication
server + P2P communication) (up to 32 modules in Ethernet V6.0 or higher).
The loader service through the Ethernet (XG5000) is supported: (Dedicated TCP/IP PORT: 2002).
Easy connection with 3rd party modules (system) using P2P communication and XG5000.
Support for dedicated protocols (XGT) and open protocols (EtherNet / IP, Modbus / TCP).
Simple client function for communication between our communication module and other company's modules
(Dedicated Communication, EtherNet / IP, Modbus / TCP, User frame definition client functions).
Provides various diagnostic functions and module and network status information.

- Status of communication module

- Communication service(Smart extension, high speed link,P2P,Dedicated protocol server) status

- The Auto Scan function that provides our module information connected to the network is provided.

- The PING function that allows you to check the existence of another module is provided.

- The type of packet and data average received by module are provided (Forecast the network load).

- The function to diagnose the communication module through the network is provided.
Provide email service(ASCII)
Provide One IP Solution function

Supported OS versions of each function are as follows.

1) FEnet OS V 6.0 or higher: Support XGT Cnet dedicated protocol, MODBUS RTU protocol, MODBUS ASCII
protocol ,RAPIEnet protocol.

2) FEnet OS V 8.0 or higher: Supported Smart extension service and EtherNet / IP protocol.

3) XGR CPU OS V2.4 or higher: One IP Solution function supported
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1.2.2  Switch module

A switch module is a hub module that has a switching function for interfacing between XGT series Ethernet modules. Mounting
XGT base module to connect PLC-to-PLC or system-to-system by Ethernet communication.

1-3

(1) Can be mounted on XGK / 1/ R base module (XGL-EH5T)

It can be mounted on XGT base without external power, and its compact size makes it easy to install in small spaces.
(2) Supported 1Gbps communication (XOL-ES4T, XOL-ES4H)

100M / 1Gbps communication can be selected. It also supports electric and optical mixing modules.

(3) Supported Ring configuration (XOL-ES4T, XOL-ES4H)
Ring 1 is available between Portl and Port2, Ring?2 is available between Port3 and Port4.
(4) Reliability of Industrial Device Standards

Compared to commercial switches, it guarantees environmental and noise reliability.
(5) Built-in crossover function (provides convenience in cable work)

Direct cables between routers and switch or between PC and switches, cross cables between routers and routers or
switch and switches. Auto Crossover is a device that provides auto-detecting function and can be connected between
same devices by direct cable.

(6) High speed link operation guarantee

Broadcast Storm, that is, the switch keeps broadcasting traffic and releases the function that causes network down,

so the high speed link packet operates normally.
(7) Provide CHS (chassis) GROUND on RJ-45 connectors.
Transmission error rate is improved when using shielded cables (STP) on RJ-45 connectors.
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1.2.3

This chapter describes the product configuration of the XGT Ethernet module.

124

Product name

(1) The XGT model does not support AUI (LOBASE-5).
(2) Twisted pair cable unit (category 5E or higher) uses 100Mbps switch and can be mixed with existing 10Mbps
(category 3 or less), but the In this case network speed is limited to 10Mbps.

Please be careful when installing the system
(3) XGL-EH5T can be used as a switch by mounting on XGT base module. It can be used by simply installing it
without a program and has a speed of up to 100Mbps.
The XGL-EFMT / XGL-EFMF module is discontinued and can be replaced by XGL-EFMTB / XGL-EFMFB.

Type Content Note
XGL-EFMT 10BASE-T/100BASE-TX Category-5E or higher(STP)
XGL-EFMF 100BASE-FX Fiber Optic(SC)
XGL-EFMTB 100BASE-TX/1000BASE-T Category-5E or higher(STP)
XGK/ XG|/ XGR XGL-EEMHB 100BASE-TX/1000BASE-T Category-5E or higher(STP)
Common 100BASE-FX/1000BASE-X Fiber Optic(LC/SFP)
XGL-EFMFB 100BASE-FX/1000BASE-X Fiber Optic(LC/SFP)
XOL-ESAT, 100BASE-TX/1000BASE-T Category-5E or higher(STP)
XOL-ES4H 100BASE-FX/1000BASE-X Fiber Optic(LC/SFP)
XGL-EH5T 10/100BASE-TX Category-5E or higher(STP)

Function Items by Version

The function items provided by each version are as follows.

Model name
XGL-EFMT
XGL-EFMTB XGL-EFMTB | XGL-EFMF
XGL-EFMFB XGL-EFMFB | (V5.0 or less) Function
XGL-EFMHB (V6.0 or XGL-EFMTB
(V8.0 or higher) higher) XGL-EFMFB
(v6.0 orless)
Supported Supported Supported High speed link service, P2P service (XGT Enet, Modbus
TCP), Server service, Remote service.
Supported Supported Unavailable XGT Cnet client, Modbus RTU/ASCII client, RAPIEnNet client
Supported Unavailable Unavailable EtherNet/IP service
Smart extension service
Unavailable Unavailable Unavailable OPC UA server service(Only version 7.x  support)
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(1) HS Link Service

The high speed link is the communication method between the XGT PLC and XGB PLC communication modules
and data is transmitted and received periodically according to the high speed link parameter setting. The high speed
link service transmits a frame to the subnet broadcast using the UDP protocol. Devices in the same subnet receive
broadcast frame at the same time, and if the relevant frame is registered in the reception list, the data it will processed.

(2) P2P service

The P2P service is the client function in the following client/server model. This function requests the server for
reading/writing data. When the starting condition of each block is On, this function creates a request frame with the
protocol specified as the relevant channel, receives and processes the response.

The parameter consists of up to 64 P2P blocks.

(3) Server service

Dedicated communication (server) service is a protocol of Ethernet module that can read and write information and
data of PLC from PC and peripheral devices. Ethernet operates as a server in a communication network and
responds to memory read or write requests from an external device or PC using the XGT protocol or Modbus TCP
protocol. TCP port 2004 and UDP port 2005 are used for XGT dedicated driver of Ethernet module, and Modbus
TCP driver uses TCP 502. The dedicated service means the server function in the following client/server model. The
client connects to the server and read and write data according to the set protocol. The server performs the functions
of (2) reception detection and (3) response transmission.

@ Request @ Indication

A\ 4

Client Server
@ Confirmation ® Response

A

(4) Remote service

Remote service function is a function that can control programming, downloading user programs, debugging program
and monitoring etc. in the network system where PLC is connected to each other by Ethernet without using XG5000
direct connection with communication module.

(5) EtherNet / IP service

EtherNet/ IP is a protocol that puts Common Industrial Protocol (CIP: Common Industrial Protocol such as DeviceNet,
ControlNet, CompoNet, etc.) to the upper layer to the open protocol Ethernet. EtherNet/IP therefore enables
DeviceNet, ControlNet, and CompoNet product developers, system integrators and users to apply the same objects
and profiles to ensure interoperability between multi-vendor and sub-network devices. In addition, it provides two
Ethernet ports, and has built-in switch functions necessary for the existing star method, and is a module for data
transmission between PLCs or between PLCs and EtherNet/IP supported 10 modules.
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(6) OPC UA server service

OPC Unified Architecture (IEC 62541) is an interoperability standard for secure and reliable information exchange,
making it suitable for industrial applications. Based on client-server model, it is a communication protocol applicable
from sensor level to cloud and has the following features.

Multi / cross platform support

Unlike OPC Classic, which was dependent on the Windows operating system, it can be operated on an embedded
device without being limited to one operating system or programming language.

- Strong security

Supports authentication and authorization through signing, encryption and data integrity, and uses X.509 certificates
for authentication.

- Service Oriented Architecture

(7) Smart extension service

Smart extension service is a service between Ethernet (B type) module and communication device (expansion driver,
Smart |/ O extension, Smart |/ O block) product. It is a service that can control and monitor multiple connected PLCs
with simple setting. Among EtherNet / IP functions, scanner functions are integrated in the Smart expansion service.

(8) RAPIEnNet service

Based on Ethernet communication, it communicates between XGT series PLCs and provides two Ethernet ports
capable of line (daisy chain) and ring configuration. It provides a flexible network configuration method compared to
the existing STAR type PLC-to-PLC communication module. The RAPIEnet module is divided into two electric ports
(100BASE-TX /1000BASE-T), two optical ports (LOOBASE-FX/1000BASE-X) and mixed (1L00BASE-TX/1000BASE-
T, 100BASE-FX//1000BASE-X) according to the media type. This service is for data transmission.

(9) Ethernet switch

It uses CSMA / CD to control communication, establishes an easy network, and enables high-speed, high-capacity
data collection.

(10) RAPIEnet switch(MRS)

MRS(Multi-port RAPIEnet Switch) is based on Ethernet and can be configured in a ring / line topology and enables
high speed and high capacity data collection. It acts as a switch to connect between its our RAPIEnet network
modules.

(1) Interoperability is a feature that enables seamless communication between information system devices and
services of the same or different types, and provides the ability to accurately perform information exchange or a
series of processes.

(1) The applicable products by product category are shown in the table below.

Product category Product Note
Extension driver XGL-DBDT, XGL-DBDF, XGL-DBDH
Smart /O expansion XEL-BSSRT, XEL-BSSRF, XEL-BSSRH
Smart I/O block GEL-TR4C1/TR4C, GEL-DT4C1/DT4C, GEL-D24C,
GEL-RY2C, GEL-AV8C, GEL-AC8C, GEL-DVA4C,
GEL-DC4C
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1.2.5 Number of units that can be installed for each CPU

Up to 24 Ethernet modules can be mounted regardless of the main base or extension base. For maximum performance of
the communication module, mount it on the main base where possible. The table below shows the types of services available
for each CPU.

XGK XGl XGR
Classification | w | v < | T |2 | 5| 2|5 | Y %) 5 =) % = % "\I" %
cla|a|la|alz|2|2|85|a|2|2|2]|2]| 3 S 5
o|lojo |0 |C|S5|ol S (@) O () % 35 a = %
HS Link . )
. 12 units 6 units
Service
P2P service 8 units 6 units
Server . )
. 24 units 6 units
service

(1) In XGR system, Ethernet is available only for the main base.
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1.3 Software for using the product

Describes programming tools and other CPU software for using the Ethernet module. For use, please refer to the following
and apply it to the system.

1.3.1 Software checklist
(1) Ethernet module
Programming
Classification Service/Driver adding XGK CPU XGI CPU XGR CPU tools
(XG5000)
XGK-CPUE: XGI-CPUE:
XGL-EFMT ) V2.0 or higher | V3.30 or higher . .
XGL-EFMF XGK-CPUSN: | XGI- CPUUN; | V1-3orhigher V2.4 or higher
V1.00 or higher | V1.10 or higher
XGL-EFMTB XGK-CPUE : XGI-CPUE:
XGL-EFMFB | V4.55 or higher | V4.57 or higher . .
(V50  or XGK-CPUSN: | XGI- CPUUN: | V272 orhigher | V3.71 or higher
higher) V1.05 or higher | V1.12 or higher
1.P2P Service
Driver
- XGT Cnet client
XGL-EFMTB | mggga: g?ﬁ”cﬁgi?t XGK-CPUE: | XGI-CPUE:
XGL-EFMFB ; V4.57 or higher | V4.08 or higher . .
(V6.0 or -ZRI,QA\AP;)IIEEﬁ;:IF:?QEOCOI XGK-CPUSN: XGl- CPUUN: V2.72 or higher | V3.71 or higher
higher) - RAPIEnet v1 V1.21 or higher | V1.31 or higher
3. High speed link station type
- RAPIEnet
4. Smart server function
XGK-CPUE : XGI-CPUE:
XGL-EFMTB : :
i . V4.57 or higher | V4.08 or higher . .
zi/G7LO)EFMFB 1, OPC UA server function XGK-CPUSN- XGIl- CPUUN: V2.73 or higher | V4.25 or higher
' V1.21 or higher | V1.31 or higher
1. Smart extension service XGK-CPUE : XGI-CPUE:
' . V4.57 or higher | V4.08 or higher | Unavailable .
2. EtherNet / IP service XGK-CPUSN: XGl- CPUUN: V4.30 or higher
V1.21 or higher | V1.31 or higher
XGL-EFMTB | 3. RAPIEnet protocol XGK-CPUE : XGI-CPUE:
XGL-EFMFB - RAPIEnet v2 V4.57 or higher | V4.08 or higher . .
XGL-EFMHB | 4. P2P source portsetting | XGK-CPUSN: | XGI- CPUUN: | Y272 orhigher | V4.30 or higher
(v8.0 or | function V1.21 or higher | V1.31 or higher
higher) 3. Command XGK-CPUE : | XGI-CPUE:
- SNDUDATA V4.70 or higher | V4.11 or higher
- RCVUDATA ' 9N ' 9NeT 1 v2.81 or higher | V4.30 or higher
XGK-CPUSN: | XGI- CPUUN:
- SEND_UDATA V1.40 or higher | V1.50 or higher
- RCV_UDATA : 9 : 9
XGL-EFMTB | 1. User port change function ) .
XGL-EFMFB | 2. RAPIEnet Auto scan cflgfoljlﬁf Her \);flogzg:: her
XGL-EFMHB | save/compare function y 9 ) ' 9 ) V2.72 or higher | V4.50 or higher
XGK-CPUSN: | XGI- CPUUN:
(v8.1 or | 3. RAPIEnet+ Auto Scan . .
X . V1.21 or higher | V1.31 or higher
higher) function
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2. Command
- MSETIP ) )
- MNETINFO XGK-CPUSN: | XGI- CPUUN: 1y o ilable | v4.50 or higher
-M SET IP V1.40 or higher | V1.50 or higher
-M_NET_INFO
L g speedinkreoone | Joore XS
XGL-EFMTB | timeout setting function y 9 ) y 9 - | V2.72 or higher | V4.51 or higher
4 XGK-CPUSN: | XGI- CPUUN:
XGL-EFMFB | 2. SNTP function ) :
XGL-EEMHB V1.21 or higher | V1.31 or higher
(v8.3 or | 3. Command i . i .
higher) - MGETLED XGK Cplf].sﬁ' XGl CPth;I]' Unavailable V4.51 or higher
-M GET LED V1.50 or higher | V1.61 or higher
égtgim;g XGK-CPUE : XGI-CPUE:

i 1. 100Mbps auto-negotiation | V4.57 or higher | V4.08 or higher . .
é%"fFMHEr speed limit function XGK-CPUSN: | XGI- CPUUN: | Y272 0rhigher | V4.52 or higher
higﬁer) V1.21 or higher | V1.31 or higher

1. Expand the number of high
igtgﬁm;g speed link blocks (Only XGI- CPUUN:

i supported by XGI-CPUZ) i V2.00 or higher | .
zi/GBI}EFMHEr 2. Smart expansion EB XGI- CPUZT: V4.73 or higher
hi Her) number expansion (63 -> V1.50 or higher

9 127)
XGL-EFMTB XGI-CPUE:
XGL-EEMEB V4.30 or h|ghfer
XGL-EFMHB | 1. DNP3 Server - XGl- CPUUN: V4.76 or higher
(V8.8 or V2.00 or higher
hi Her) XGI- CPUZT:
9 V1.50 or higher
XGL-EFMTB | 1. Input data clear function
XGL-EFMFB | when high-speed link timeout
XGL-EFMHB | occurs - - - V4.78 or higher
(V9.0 or | 2. RAPIEnet Generic Slave
higher) Function
XGL-EFMTB
XGL-EFMFB | 1. XGR Smart extension
XGL-EFMHB | service (Supports only - - V3.10 or higher | V4.78 or higher
(V9.1 or | EtherNet/IP message service)
higher)

1) In the table above, XGK-CPUE includes both XGK-CPUE/S/A/H/U.

2) In the table above, XGI-CPUE includes both XGI-CPUE/S/SP/H/U/UD.
3) In the table above, XGI-CPUSN includes both XGK-CPUSN/HN/UN.
4) In the table above, XGI-CPUZ7 includes both XGI-CPUZ3/5/7.

(2) Switch
Classification Service/Driver XGK CPU XGI CPU XGR CPU Programming
adding tools (XG5000)
XOL-ESAT (V1.x) RAPIEnet v1 - - - - Not
XOL-ESAT RAPIEnet v2 programmable
(V2.0 or higher) - Some of the
RAPIEnet v2 diagnostics
XOL-ES4H available
XGL-EH5T Ethernet - - - -
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(1) The above program can be downloaded and used from the current website If you cannot use the Internet, visit
the nearest distributor and use the installation CD-ROM.
Website address: http://www.ls-electric.com/

(2) XG5000 can be programmed with RS-232C port and USB of CPU module. Refer to XGK CPU Module or XGl
CPU Module User's Manual for wiring type.

(3) Some functions may not work normally if a version other than stated above is used. Please check compatibility.

1.3.2 Checking the product information

(1) Checking the version

Check the version of the module before using the Ethernet module.

Check the module information by double clicking the Ethernet module on [XG5000] -[Online] ->[Communication
module setting and diagnosis] - [System Diagnosis].

Communication Module Information

? X

Displays the general information of communication module,

List Contents
bodule kind ®GL-EFMTE
Baze Mumber 1
Slat Murnber 1l
Station Mo 1
DHCP ruzed
IP Address 192.168.1.10
MALC Address QOEOST1 0271 04
Module Statuz Syztern OK
System parameter information Mot exist
GROUP Statuz #aT group
Speed/Full Duplex EE::'ID EH¥8
Option board ype FEnet electric module
Hardware Error Mormal
Hardware Version Wer, 2.00
05 ver Wer, 8.00
Dedicated Service Enable

Close

(2) Check the version via the case label on the product.

For each communication module, product information of the module is attached to the outer case. After detaching

a module without a connection with a PC, a label is attached to the back of the module and the model name and
version information are indicated.


http://www.ls-electric.com/
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Chapter 2 Product specifications

2.1 General specifications

The general specifications of the XGT series are as follows.

No Item Specifications Rg!ateq
specifications
1 Operating ambient 0~ 55 °C
temperature
2 Storage 25 ~+70°C
temperature
3 Ambient humidity 5 ~ 95%RH (Non-condensing)
4 Storage humidity 5 ~ 95%RH (Non-condensing)
In case of occasional vibration -
Frequency Acceleration Amplitude Times
5<f< 8.4 Hz - 3.5mm
4<f<150 Hz 8 ms(1 -
5 | Vibration resistance 8 S0 9 .8 alt G). - X, Y z . IEC 61131-2
In case of continuous vibration Each direction
Frequency Acceleration Amplitude 10 times
5<f< 8.4 Hz - 1.75mm
8.4<f<150 Hz 4.9m/s2 (0.5G) -
ePeak impact acceleration: 147 ms" (15G)
6 Shock resistance eDuration ; 11 ms, IEC 61131-2
ePulse waveform: Half-sine (3 times for each direction of X, Y and Z)
Square wave Test standard of
impulse noise AC:+1,500V,DC : 900V LS ELECTRIC
Electrostatic . IEC 61131-2
discharge 4.0kV (Contact discharge) IEC 61000-4-2
. . Radiated
7 Noise resistance . IEC 61131-2,
elegtromagnetlc 80 ~ 1000 MHz, 10V/m IEC 61000-4-3
field noise
e P Digital/Analog | ,
Fast transient Classification ower igital ng og_ nput/Output IEC 61131-2
Iburst noise module Communication Interface IEC 61000-4-4
Voltage 2kV 1kVv
8 operating Free from corrosive gases and excessive dust
atmosphere
9 Operating altitude Up to 2,000m
10 Pollution degree Less than equal to 2
11 Cooling method Air cooling

(2) IEC (International Electrotechnical Commission): An international nongovernmental organization which promotes
international cooperation in the standardization in the fields of electricity and electronics, publishes international
standards and operates relevant conformity assessment systems.
(2) Pollution degree: An index indicating pollution degree of the operating environment which decides insulation
performance of the devices. For instance, Pollution degree 2 indicates the state generally that only non-conductive
pollution occurs. However, temporary conduction occurs in this state due to dew formation.

2-1
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2.2 Performance specifications

Please refer to the table below when configuring the system.

Specifications
11 Driver S Port number Note
on method
Up to 128 blocks
FEnet UDP/IP 2006 200 words per block
Up to 128 blocks, 200 words per
HS Link Service block
RAPIEnet - - Up to 256 blocks, 700 words
when using high speed link block
expansion
. TCP/IP 2004
XGT Enet client UDP/IP 2005
. TCP/IP 2004
XGT Cnet client UDP/IP 2005 Up to 8 P2P parameters
Modbus _ TCP/IP 502 Up to 32 channels per parameter
P2P service TCP/RTU/ASCII client Up to 64 blocks per parameter
RAPIEnet client - - setting
Specified by | Up to 1400 Byte per blocks
— TCPAP the user
User frame definition Specified b
Class UDP/IP P y
ificati the user
on E-mail - - Up to 128 address
Smart extension RAPIEnet v2, ; .
service ) EtherNet/IP Max. 64 station
o Adapter: Up to 64 tag
Explicit message Maximum number of
server, UDP/IP 2222 connections: 64
EtherNetIP | Adapter (IO data) (/O data) | (/O data + Explicit)
Service
Explicit message TCP_/ ”,3 248|.1$
client, (Explicit) (Explicit) Up to 64 channels
Scanner
Server service |y~ oo TCP/IP 2004 Up to 64 channels
(Dedicated UDP/IP 2005 Up to 1400 bvtes
communication) | Modbus Server TCP/IP 502 P y
4840(default)
OPC UA server | - TCP/IP Specified by | Maximum client 10 modules
the user
Remote service | Server UDP/IP 2007/2008

(1) In case of server service (dedicated communication), Ethernet OS version less than V6.0 supports up to 16
channels.
(2) In case of P2P service, Ethernet OS version supports up to 16 channels under V6.0.
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2.2.1

Ethernet module
Item XGL-EFMT [ XGL-EFMTB | XGL-EFMF | XGL-EFMFB XGL-EFMHB
Transmission Electric:
speed(Mbps) 10/100 10/100/1000 100 100/1000 19/100/1000
Optical :100/1000
Transmission method Baseband
Maximum distance 100m 2km Electric:100m
Trans between nodes (Node-Switch) (Multi-mode) Optical: 2km
fer Minimum distance Recommend 1m or higher Electrical:
Speci between nodes note1) ) Recommend 1m
) pe_C' or higher note1)
ficatio ) Electrical: Category 5E or higher STP(Shielded Twisted-pair) cable
ns Send media . . .
Optical: Multi mode(MMF)/Single mode(SMF) cable
Maximum protocol size 1,500 Byte
Communication CSMA/CD
network access method
Frame error check CRC32
method
Max. load EFMT/EFMF: 1,200pps
EFMTB/EFMFB/EFMHB(Ethernet):10,000pps,RAPIEnet: 40,000pps
RAPIEnNet used: line, ring(Use MRS when using other topologies)
RAPIEnet not used
Topology . .
- Line, tree, star (use switch)
- DLR(Ring node) "ot2)
Diagnosis function Station number / IP collision detection function, diagnosis using XG5000
IP setting method XG5000, DHCP

Station number setting range

Station number setting value set by XG5000 (0 to 220)

External connecting terminal

RJ45, SFP : PADT connection, data communication

Data processing unit Byte(8bit)
RAPIEnet Service Specifications Max readinite datasize | 1,400 byte™=
Max No. of connected 64 station (However, MRS is not included in the number
stations per network of connected stations, and is limited to 12.)
Data processing unit Byte(8bit)
Non-periodic tag: 1400 Bytes
Mex readhwrite data size PeriodicN°®4): 1,400 Bytes
EtherNet/IP Service specifications Available communication | Connection type(Periodic ) message: class1
type Non connection type(Non-periodic ) message: tag, Object
Maximum number of Connection-type (periodic)+ Non connection type(Non-
connections periodic ):64
Data processing unit Word(16bit), bit
Modbus / TCP service Max read data size 125 Word(2,000 Bits)
specifications Max write data size 123 Word(1,968 Bits)
Maximum number of 64
connections
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Basic

Speci

ficatio
ns

Current | 100Mbp 410 560 630 750 670
consumptlo S

n(mA) 1Gbps - 900 - 740 830

Weight(g) 105 146 120 130 120

*Note 1) When using a cable shorter than 1m, the signal to noise ratio (SNR) is lowered due to the effect of reflected waves, so link
down or packet loss may occur.

*Note 2) DLR (Ring node) only works with XGL-EFMTB/EFMFB/EFMHB V8.60 or higher.

*Note 3) It is the size when connecting with communication device.

*Note 4) The | / O refresh size can only be accessed by an Originator that supports Large Forward Open (0x5B) if it is
greater than or equal to 512 bytes including the header. The input header size consists of a 2-byte PDU sequence number,
the output header size includes a 2-byte PDU sequence number and 4 bytes of Run-Idle information. Run-Idle information

4 bytes are determined according to the setting value of EDS.

(1) Baud rate can be set as shown above when RAPIEnet is set to Disable. However, when setting RAPIEnet v1 in
driver setting, only 100M is supported for electrical and optical ports, and setting 100/1000 for electrical and optical

ports when setting to RAPIEnet v2.

2.2.2  Switch module
ltem RAPIEnet Ethernet
XOL-ESA4T, XOL-ES4H XGL-EH5T
100Mbps/1Gbps
. 100Mbps(1,2 port) ;
Transmission 100Mbps/1Gbps (1,2port,electric) 10/100Mbps
speed (3,4port) 100Mbps/1Gbps
Tran P (3,4port,optical)
sfer XOL-ESA4T: 100BASE-TX, 2 port,
Port type and
Spe 100BASE-TX/1000BASE-T 2 port
cific ””m;fsr of XOL-ES4H:100BASE-TX/1000BASE-T 2 port, 10/100BASE-TX, 5 port
atio P 100BASE-FX/1000BASE-X 2port
ns | Transmission 100m 100m/2km 100m
distance
Diagnosis , . .
function LED display LED display LED display
IP allocation 192.168.1.xx (xx: 100 + station number switch 1~99) -
Basi Power . _ 5V(supply from base
c supply(DC) 24V(Input range: 20.4~28.8V) module)
Spe Current
cific | consumption(m 300 300 550
atio A)
ns Weight(g) 200 280 90
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2.2.3

Power specification

(1) Switch module(XOL-ES4T/ XOL-ES4H)

Item Specifications
Input power DC 24V(Input range: 20.4~28.8V)
input current 0.3A (+24VDC)
Power display RUN LED ON at power input

1. Use UL approved power supply
Use a power supply that meets Class 2 or that meets the Limited voltage limited circuit (LVLC) requirement.

2.2.4

Load specifications

Communication load is divided into the load by media interrupt received per second from Ethernet media and the
transmission load transmitted by CPU module to Ethernet module. If the load due to the media interrupt guaranteed by the
Ethernet module and the transmission load are exceeded, it may not operate normally.

(1) Communication load due to media interrupt

1) The amount of packets generated per second due to the load on the data frames delivered to the media is
measured.

2) The maximum load of the Ethernet module delivered to the media (based on server operation) is up to
10,000 packages / sec.

3) Checking method: XG5000 -> [Online]-> Communication module setting and diagnosis]-> [System
Diagnosis] After clicking Ethernet module, you can check packet rate per second in [Media Information].

Media Information *

Standard Information
Base No.: II' Slot No.: II'

Detailed information:

Section Broad Muli Uni UDFP ARP(EARF) Throw out
Total packets o] 0 1] 1] i} 1]
Mo. of Packets per second 0 0 0 0 0 0

Read Refresh

4) If the maximum load is exceeded, an error in the operation of the Ethernet module, such as a
communication error, a diagnostic service failure, or a remote connection failure occurs.

5) Even if the receive block is not set in HS link parameter, the load is increased because media interrupt
occurs.

6) When the maximum load is exceeded, change the communication cycle of the Ethernet module where high
speed link transmission is set.

ex) 20ms — 200ms
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(1) XGL-EFMT/EFMF : approximately 1,200 packet/sec, XGL-EFMTB/EFMFB/ EFMHB
approximately 10,000 packet/sec
(2) In B type Ethernet, 10,000 packets / sec is overloaded even when more than 1,100 packets are
received in 100ms based on instantaneous load.

(2) Transmission load of XGK / | / R system (load by the amount of data transferred by CPU module to
communication module)

1) The transmission load is determined by the communication module scan time, HS link service cycle and
P2P service setting of the CPU module.
2) Maximum number of HS link transmission blocks on Ethernet module: (HS link transmission cycle / CPU
maximum scan) x 8 blocks/2
The maximum HS link transmission / receive load is exceeded, change HS link transmission cycle or block
number.
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2.3 Structure and Characteristics

2.3.1 Names of Part and Function

(1) XGL-EFMT/XGL-EFMF

——
R
Emﬂ1nl|r? M-
"L
Tl (ol
g, e

s - P
<Name of each part>
No. Name Content

1 LED Display Please refer to the content below.

o It is a connector for electric cable for connecting Ethernet communication with external
2 Communication | 4o ice

Connector - — — -

3 It is a connector for optical fiber cable for Ethernet communication with external device.

<Names of LED and Function>

Names of
LED

contents of LED

Indication LED status

Functional description

Display module ON

Normal operation.

RUN .
operation status Off Do not normal operation.
Display High speed | ON High speed link service operates normally.
HS [ink service off ] ] ]
operation state. High speed link service does not operate normally.
Display P2P ON P2P service operates normally.
P2P  service operation ]
Off P2P service does not operate normally.
state
Display Smart ON Operating remote service with remote Ethernet communication device (including
PADT [extension service PC).

operation state. | Off

Remote service operation is disabled.
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Names of Indication LED status Functional description
LED contents of LED P
Display server ON Operating server service with remote Ethernet (including PC).
PC  [service operation
state Off Server service operation is disabled.
ERR Display module | ON Communication with the CPU module is not normal. The module is critical error.
failure state Off Normal operation.
ON Sending data.
Display send o . : -
TX P y Flickering | When sending stops repeatable during transmission.
operation status
Off Do not sending data
ON Receiving data.
Display receive L - . .
RX P y Flickering | When receiving stops repeatable during receive.
operation status
off Do not receiving data
Display ON The communication network is connected 100Mbps
PHY | communication
speed Off The communication network is connected 10Mbps
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(2) XGL-EFMTB/XGL-EFMFB/ XGL-EFMHB

<Name of each part>

O
XGL=-EFMTR,,

I
XGL-EEMED_

—
NGL-EFMHE

EFMHE

No. Name Content
1 LED Display Please refer to the table.
o Itis a connector for electric cable for connecting Ethernet communication with external
2 Communication | 4o ice
Connector - — — - -

3 It is a connector for optical fiber cable for Ethernet communication with external device.

ON: when data is transmit or receive.
RJ-45 ACT ) . . . . -

4 (Yellow) Flickering: Flashes when sending and stopping are repeated, during transmission.
Off: Do not sending or receiving data.
Shows link speed when link partner and link are connected (when Link LED is
on).

5 RJ-45LNK | Green ON: 1Gbps

(Orange & Green)| Orange ON: 100Mbps
- Off : 10Mbps (Link LED is on and RJ45 LNK LED is off)

<Names of LED and Function>

Names of Indication LED status Functional description
LED contents of LED P
RUN Display module | ON Normal operation.

operation status | Off Do not normal operation.

Display High ON High speed link service operates normaly.
HS  |speed link service ] ] .

operation state. Off High-speed link service is canceled.
P2P  [Display P2P ON P2P service operates normally.
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Names of Indication LED status Functional description
LED contents of LED P
service operation | Off

State

High-speed P2P service is canceled.

Display Smart ON Operating remote service with remote Ethernet communication device (including
PADT |extension service PC).
operation state. | Off Remote service operation is disabled.
ON The product is critical error due to a failure in communication with the CPU module
ERR  |P'sPlay module oran H / W failure.
failure state
Off Normal operation.
Display server ON Indicates that the remote Ethernet communication device (including PC) is in service
SVR [service operation by connecting to the server service.
state. Off There are no clients connected to the server service.
ON When the Relay option of the basic parameter is checked and the media speed of
Display relay Port 1 and Port 2 is the same, the data frame can be relayed.
RELAY | service Flickering | The relay option of the basic parameter is checked and the communication speed of
operation state. the two ports is different, so the frame cannot be relayed. (V6.0 or higher)
Off The frame cannot be relayed.
ON - There is no basic parameter.
- There is a basic parameter error.(Module type, Media type, IP setting error)
- There is RAPIEnNet slave parameter error.(V6.0 or higher)
- There is a station number conflict on the RAPIEnet network.(V6.0 or higher)
- Transceiver recognition fails when the media setting for SFP is Auto(V8.0 or
Display Check higher)
CHK | LED operation - This is the case with CPU version that does not support TAG. (V8.0 or higher)
state - In case of EtherNet / IP tag or smart expansion tag error. (V8.0 or higher)
* For detalils, please check the history of XGL-EFMxB.
Flickering | OS or parameters are being written to flash memory.
(v6.0or |- RAPIEnet network change over switching ring—>line
higher) If there is a lot of communication data and you discard the received data.
Off Normal operation.
ON - Station number conflict occurred When RAPIEnet was set. (V6.0 or higher)
- IP conflict or operating Flash Erase.
In case error occurs when using the smart extension service (V8.0 or
higher).
* For details, please check the history of XGL-EFMxB.
Flickering | Communication frame errors (CRC errors and other error handling). (Automatically
Display FAULT turned off after 30 ms On)
FAULT | LED operation - In case of Smart | / O drop out during Smart | / O control with RAPIEnet V1. (V6.0
state. or higher)
In case the slave with hot swap is dropped whilw operating smart expansion service
(V8.0 or higher).
* For details, please check the history of XGL-EFMxB.
Off Normal operation.
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Names of Indication LED status Functional descriotion
LED contents of LED P
ON Sending and receiving data.
Display ACT d d
ACT | LED operation |Flickering | When sending stops repeatable during transmission.
state. . .
Off Do not sending or receiving data.
Display LINK ON When the communication network is connected.
LINK | LED operation * Please refer to the RJ-45 LNK LED specification for LINK speed.
state Off When the communication network is not connected.

(1) Relay function is not supported at OMbps, so if Relay option is checked at 10Mbps, Relay LED will be off.
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(3) XGL-EH5T

<Name of each part>

CH3

CH4

CHS

No. Name Content
1 LED Display Please see below.
5 Communication | It is a connector for electric cable for connecting Ethernet communication with external
Connector device.

<Names of LED and Function>

Names of Indication LED status Functional descriotion
LED contents of LED P
Display module ON Displays the power On status of the module.
PWR
power status Off Displays the power off status of the module.
Display ON -
send/receive L
ACT ) Flickering | Port 1 data send/receive is in progress.
operation status by
port Off Port 1 data transmission / reception does not operation.
. ON Port 1 100Mbps communication is connected.
Display
LNK  |communication Flickering |-
speed status by port off Port 1 10Mbps communication is connected.
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(4) XOL-ESAT/ XOL-ES4H
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<Name of each part>

No. Name Content
1 LED Display Please see below.
2 Station number The station number of the product can be set from 0 to 99.
3 Communication It is a connector for electric cable for connecting Ethernet communication with external device.
4 Connector It is a connector for optical fiber cable for Ethernet communication with external device.
Hook for DIN Rail . .
5 . Hook for fixing the product when mounted on DIN rail.
fixation
6 Fixed hole Hole for fixing the product to the panel.
Power su ) . . .
7 pply This connector is for DC 24V power supply. +,-, PE 3 terminals in that order.
connector
8 ower switch This switch selects the power supply. Select the left side when supplying power to the power
P supply connector and the right side to the adapter terminal.
Terminal for the . . .
9 adapter Adapter power input terminal block Currently unused power switch must be used to the left.
. .. | 100M/ 1G selection switch when using optical connector. The speed is automatically adjusted
Optical communication . . - .
10 according to the optical connector communication speed of the connected external device.

speed selector switch

Therefore, no setting is necessary.

<Names of LED and Function>

Indicati tents of | LED stat . .
Names of LED naication contents 0 slals Functional description
LED
RUN Display module power ON Normal operation.
status Off This is not a normal operation.
1Ghbps Display ON | Ports 3 and 4 are communicating at 1 Gbps.
YOL-ESA communication speed Off .
(XOL-ESAT) | otus by port Ports 3 and 4 are communicating at 100Mbps.
1G(T) Display o ON | Ports 1 and 2 are communicating at 1 Gbps.
OLESAH communication speed off —
(XOL- ) lstatus by port Ports 1 and 2 are communicating at 100Mbps.
1G(F) Display ON |Ports 3 and 4 are communicating at 1 Gbps.
communication speed —
(XOL-ESAH) | s by port Off | Ports 3 and 4 are communicating at 100Mbps.
RINGL Network Topology ON Ports 1 and 2 are changed to the ring topology.
Display by Port Off  |Ports 1 and 2 are changed to the line topology.
RING2 Network Topology ON Ports 3 and 4 are changed to the ring topology.
Display by Port Off | Ports 3and 4 are changed to the line topology.
ERR D|Sp|ay module failure ON H/MW is critical error.
state Off Normal operation.
Display Relay ON |Ports 1 and 2 operate when the data frame operates as a relay.
RELAY1 |operation status by — .
port Off This is the case when ports 1 and 2 are not acting as relay for data frame.
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Indication contents of | LED status

Names of LED LED Functional description
Display Relay ON | Ports 3 and 4 operate when the data frame operates as a relay.
RELAY2 |operation status by _. ]

port Off This is the case when ports 3 and 4 are not acting as relay for data frame.

ON This is when MRS has a station number or IP collision with another node.
Flickering |- This is the case of a station number collision between the nodes other than
FAULT Display FAULT LED MRS in the network.
operation state. - This is when the switching loop path is detected in the MRS.

Off The station number collision situation has been resolved and it is operating
normally.

(1) Relay is a function that connects data between ports. Relay between ports is possible, and RELAY1 and

RELAY?2 display relay status between 1,2 port and 3,4 port.
(2) MRS receives an IP linked to the set station number. Please be careful not to cause IP conflicts when configuring

the network.
- IP address assigned to MRS: 192.168.1.xx (xx: 100 + station number switch 1~99)
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2.4 Specification of cable

2.4.1 Twisted pair cable

Cables are classified into two types according to the following standards.
Shield or not: 3 categories (UTP, FTP, STP), frequency band used: 7 categories (Cat.1~7)

(1) Cable type (Shield)

Classification

Detail

Usage

UTP(or U.UTP)

Unshielded high speed signal cable

Up to 200MHz

Sound + information (data)+ Low-end video signal

FTP(or S.UTP)

Cable where only the cable core is shielded

Max. 100MHz

Electromagnetic interfere (EMI) and electrical stabilization are

considered.

Sound + information (data) + low grade video signal

STP(or S.STP)

Double shielded cable,Pair individual
shielding and cable core are shielded

Up to 500MHz

Sound + information (data)+ video signal, Replacement of 75Q

coaxial cable

UTP : Unshielded Twisted Paired Copper Cable
FTP : (Overall) Foiled Twisted Paired Copper Cable
STP : (Overall) Shielded(and Shielded Individually Pair)Twisted Paired Copper Cable
PLC Ethernet communication cable is recommended to use S.STP cable.

If the S.STP cable cannot be used due to the field conditions, a module error may occur due to
communication error and noise.

(2) Cable categories

Aprliee Transmission
Classification | frequency speed(M/Ghbps) Shield or not Usage
(MHz) P P
Category 5 100 10/100M  |Unshielded 100m ~ 100BASE-TX s
supported
Category 5e 100 100M/1G  |Unshielded 1000BASE-Tsupported
Category 6 250 1G Unshielded /Shielded 1000BASE-T supported
Category 6a 500 10G Shielded 10G BASE-Tsupported
Category 7 600 10G Shielded 10G BASE-Tsupported



http://www.ktword.co.kr/abbr_view.php?nav=&m_temp1=2028&id=453
http://www.ktword.co.kr/abbr_view.php?nav=&m_temp1=2028&id=453
http://www.ktword.co.kr/abbr_view.php?nav=&m_temp1=2028&id=453
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1000

Category 7a

10G Shielded

10G BASE-Tsupported

(3) Example of category 5 twist pair wire (UTP) (CTP-LANS)

Item Unit Value
Conductor resistance Q/km 93.5
(Max.)
Insulation MQ-km 2500
resistance(Min.)
Withstand voltage V/minute AC 500
Characteristic Q(1~100MHz) 100 + 15
impedance
10MHz 6.5
Attenuation dgﬁgsosm 16MHz 8.2
20MHz 9.3
10MHz 47
e | AT [ aown: v
20MHz 42
2.4.2 Optical Fiber Cable
Item Value
Cable type MME: Twin strands of Multi-mode fiber/SMF: Single-mode fiber
Connector XGL-EFMF: SC type connector
XGL-EFMFB/EFMHB: LC type connector

(1) The connection cable of the communication module differs according to the system configuration and
environment, so please consult with a specialist.
(2) The characteristics of the optical cable are that when the fingerprint or contaminants are caught on
the end of the cable, attenuation may occur and the communication may be interrupted.



http://www.ktword.co.kr/abbr_view.php?nav=&m_temp1=2028&id=453
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2.5How to connect communication between our products

Ethernet module displays communication connection method with own communication module when master and slave

operate.
2.5.1

Master communication
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Slave communication

2.5.2
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Chapter 3 Product Installation and trial operation

3.1 Product Installation

3.1.1 Preparation for operating

(1) Ethernet module system configuration

1) Check the basic elements necessary for the system configuration and select a proper communication module.

2) Select a cable for the communication module.

3) When installing the Communication module, make sure that there is no foreign substance in the base connector
to be mounted, and check that the connector pin of this module is not damaged.

4) Ethernet module can be mounted on the main base and expansion base, but it is recommended to use it on
the main base. However, in case of XGR system, it can be installed only on the main base.

5) When installing the module, insert the raised part of the lower part of the module into the base groove without
connecting the communication cable, and apply enough force until the upper part is completely locked with the
base locking device. If it is not locked, there may be abnormality in the interface with the CPU module.

6) Cables used for communication module should be installed referring to the standard.

7) Ethernet switches and cables required for communication with the Ethernet module should be selected as
standard products.

(2) Switch module system configuration

1) When installing the switch module, make sure that there is no foreign substance in the base connector to be
mounted, and check that the connector pin of this module is not damaged.

2) XGL-EH5T module is powered from the base module. Therefore, the switch module is not recognized by the
CPU and can be installed in either the expansion or the main base slot.

3) When installing the module, insert the raised part of the lower part of the module into the base groove without
connecting the communication cable, and enough force until the upper part is completely locked with the base
locking device. If the lock is not locked, the module may be detached from the base module.

4) The XOL-ES4T / ES4H Switch module should be fixed to the panel and supplied with a 24 VDC connector.
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3.1.2 Setting sequence for operation

Describes the order of installation and operation of the product. When the installation of the product is completed, please
install and set up the system in the following order.

1) Mount Ethernet module on base module.

2) Connect the cable of Ethernet module with other communication module.

3) Power on the system where Ethernet module has installed.

4) Setting basic parameter in XG5000.

5) Reset the module after downloading the basic parameters.

6) After resetting the module, Check if RUN and CHK LEDs are normal.

7) If Ethernet module and CPU module are confirmed as normal operation, check [System Diagnostics] = [PLC
Information] using XG5000.

8) To check the network connection, check if the response is received from the PC to the network using PING, or
if the network is not connected to the PC, select the Ethernet module on the monitor in
[Online]>[Communication module setting and Diagnostics]>[System Diagnostics] of the XG5000 and then click
the mouse. Check the response using the right-click Ping Test item.

9) Set up and download communication services.

10) Allow Service Enable.

11) Write a program in xG5000 and download it to CPU module to start operation.

(1) If the station number and IP address of the Ethernet module are set, be sure to Reset the module. Initial
station number and IP address (including frame) keep the value read from communication module at initialization.
Parameter changes during communication are not applied during operation.
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3.2 Installation

3.2.1

Ethernet module

UTP 5 Cable

Network

L
Hub/Switch

?

~ PLC

8Pin RJ-45 Plug

Maximum segment length for electric media is 100 m Cables are classified into two types according to the following standards.

Between Switch and
Pin No. Signal Ethernet module Cross cable
Straight cable
1 TD+ 1—1 1—3
2 TD- 2—2 2—6
3 RD+ 3—3 3—1
4 TRD2+ 4—4 4—7
5 TRD2- 5—5 5—8
6 RD- 6—6 6—2
7 TRD3+ 7—7 7T—4
8 TRD3- 8—8 8 —5

(1) Straight cable
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(2) Cross cable

f e, = : a 1. White/Orange 1. White/Orange  wm : o T . |

. ] 2. Orange 2. Orange i 3
MM M B3 \\hite/Green 3. White/Green [Tl Wk
# 4. Blue 4. Blue _
e e S M 5 \Nite/BlUe 5. White/Blue — Cwm e
EEE———— . Green 6. Green g
- 7. White/Brown 7. White/Brown  femm oWk
_-_1— 8 Brown 8 Brown

(1) Twisted pair cable is manufactured by twisting wires of pins 1 - 2, 3- 6, 4 - 5 and 7- 8 to reduce interference
between pairs.
(2) Hub power should be separated from PLC power so that there is no noise effect.
(3) For cable terminal processing and production, please consult with a professional manufacturer for
production and installation.
(4) When using STP cables, the shielded drain wire of the cable must be in electrical contact with the RJ45
shields on both sides.
(5) The optical cable is susceptible to impact, pressure, folding, pulling, etc.
If the cable contact surface connected to the connector is contaminated, communication failure may occur or
communication may not be possible. Therefore If you are installing outdoors, you need additional cable
protection measures appropriate for your installation environment.
(6) Module connector type of XGL-EFMF (SC type) and XGL-EFMFB (LC type) are different.

In case of mixed use, use SC-LC converter to connect.

(3) Precautions for installing the cable

1) For reliable 100Mbps signal transmission, use a cable that meets category 5 or higher characteristics.
2) Be careful not to exceed excessively the tensile strength of the cable while wiring.

3) When removing the cover, peel off the cover only for the length you want to wire and make sure that the

insulation is not damaged.

4) The cable connector should be slightly loosened. If you connect too strongly, the characteristics of Category -

5 may be deteriorated.
5) Maintain proper distance between EMI sources and cables when installing cables.

Condition Minimum separation distance
2.0KVA or less 2.5 KVA 5.0KVA or higher

Unshleld_ed power I|r_1e_or electrical equipment are 127mm 305mm 610mm
open or in close proximity to non-metallic pipes
_Ifthe unshlelded_ power I|n_e or the electric equipment 64mm 152mm 305mm
is close to a buried metallic pipe
If the power line in the buried metallic pipe (or
equivalent shielded metallic pipe) is close to a buried - 76mm 152mm
metallic pipe
Transformer, electric motor and fluorescent light 1,016mm , 305mm
(1) When the voltage is 480V and the power rating is 5KVA or more, additional calculation is required.
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3.2.2 Installing and Removing the Switch Module

The XOL-ES4T / ES4H is equipped with a standard DIN rail (35 mm rail width) hook and can be installed on the DIN rail.
When installing on DIN rail

(» The can be installed directly on the panel using screw mounting holes.

@ The can be installed directly on the panel using screw mounting holes.
* The DIN rail stopper must be installed on both sides of the module to secure the module.

In case of installing at panel

@ The can be installed directly on the panel using screw mounting holes.
@ When installing the product directly to the panel, use M3 type fixing screws.

Screw fixing hole

3-5
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Precautions for Ethernet Switch Module(XGL-EH5T) Installation
Switch modules can be used to connect between Ethernet modules using 10 / 100BASE-TX. Therefore, as shown
in the figure below, the configuration for network system configuration between modules and between PLC

systems and PCs can be connected.

LSE ecrric | 3-6
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3.3 Test operation

After connecting the communication cable, turn on the power and check the LED for normal operation. If it is normal, download
the program to the PLC and execute the program.

3.3.1 Precautions for System Configuration

IP addresses, including Ethernet modules, must not overlap each other. If duplicate address is connected, it does not work
due to communication error. In addition, the high speed link station number must be different to use the high speed link
service. Use a cable of the specified standard for the communication cable. Unspecified cables can cause serious
communication problems. The communication cable should be checked for disconnection or short circuiting before installation.
Securely connect the communication cable connector. Incomplete cable connection may cause communication error.

When connecting communication cables over long distances, route the cables at a sufficient distance from the power line or
inductive noise. If the cable is bent at a right angle or is excessively deformed, it may cause cable breakage and damage to
the connector in the communication module. If the LED does not work normally, refer to ‘Chapter 9 Troubleshooting' in this
manual to check the cause of the problem and if the problem still occurs, please contact the customer service center.

3.3.2 Check items before trial operation

This section describes the items to check before trial operation.

(1) Communication module mounted on PLC

Verification Content
Software installation and check - Installing XG50007?
Communication cable connection - Is communication cable connection and tap in good condition?
(if the cable is connected) - Is module LED and cable properly connected?
. Is the communication module mounted on the main base
Module mounting
module correctly?
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(2) Sequence of trial operation

The following shows the procedure from the completion of installation on the PLC to the trial run.

Start

Power ON:
1) Check the input power wiring.
2) Check the communication cable connection.
3) Turn on the power.
4) Check the power LED on the power module.
5) Check the LED status on the CPU module.
-> |If abnormal, refer to the troubleshooting in each PLC user's manual.
6) Check if the LED status of the communication module is normal.
If abnormal, refer to Chapter 9 Troubleshooting.
After setting communication parameter, download setting file.

v
Programming: Programming in XG5000 and write to CPU module.
v
Check program:
Check the operation of the communication module according to the program.
v
Modify program:
Correct any abnormality in the sequence program.
v
Saving program:
1) Save program file.
2) Print circuit diagrams and programs.
End
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3.3.3 The method to remove and replace the module.

If you want to replace or remove the module due to hardware error or system change, follow the procedure below.

(1) Order of exchanging communication module

1) Turn off the power module of the base where the communication module is installed.
2) Disconnect the network cable.
3) Operate the module according to the setting procedure in Section 3.3.2.

(2) Communication module exchange using the module change switch of the CPU.
Refer to “6.10 Changing Module during Operation” of CPU Module User's Manual.
(3) Communication module exchange using x5000 module change wizard

Refer to “10.23 Module Change Wizard” of XG5000 user's manual.

(1) When replacing the Ethernet module, reset the external device (MMI or PC). The timeout of the Ethernet
module may result in an unrequested connection from the external device or a loss of communication.
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3.4 Precautions when Connecting to a Network

If a node that supports the RAPIEnet protocol and a node that does not support the RAPIEnet protocol are connected on the

same network, refer to the information below.

3.4.1 Use ring network

When using a ring network, the node that supports the RAPIEnet protocol selects the ring manager for ring control. At this
time, because Relay option is disabled, nodes that do not support RAPIEnet protocol connected to Ring Manager cannot
communicate with other nodes except Ring Manager. (Relay operation is not performed even if Relay option of Ring Manager

is Enable.)

Ring Manager
Node #3(S.N:80) #2 support

RAPIEnet support

Ring Manager #1  Node #1(S.N:99)
suppor t RAPIEnet support

Node #2
RAP|Enet Not support

Node #5
RAP|Enet Not

T

Node #4(S.N.:70) I
RAPEnet squgit_m a

Node #6(S.N.:60) I
RAPIEN

RAPIEnet Unsupported Communication
Node Node #1 Node #2 Node #3 Node #4 Node #5 Node #6
Node #2 Possible - Possible Impossible | Impossible | Impossible
Node #5 Possible Impossible Possible Possible - Possible

selected.)

(3) Ring Manager # 1 and # 2 do not Relay.

When configuring a ring network, the standards for selecting a ring manager are as follows. (See picture above)

(1) The node with the highest station number among the RAPIEnet support nodes is selected as Ring Manager # 1.
(2) Among the neighbouring RAPIEnet supporting nodes of the node selected as Ring Manager # 1, the node with the
highest station number is selected as Ring Manager # 2. (# 3, the highest station number among nodes # 3 and # 6, is
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3.4.2 Use line network

When using a line type network, both last nodes among the nodes that support the RAPIEnet protocol are selected as the
Line Manager. At this time, if you connect nodes that do not support the RAPIEnet protocol to the outside of the line managers,
the nodes that can communicate with the nodes are determined by the relay option of the line manager.

line Manager #1

Node #3

Node #1 Node #2 RAPIEnet support

RAPIEnet Not support RAP[I;ne}_ suppor t I
T T -
i I ; l | I : I
o ! B o [] | -

line Manager #2

H
~ ]
L

Node #5 Node #4
RAP_I_Eth_ suppor t RAPIEnet Not support
g l ' 2 } — l H
Ml 0 | el |
RAPIEnet icati
Node #2 Relay Communication
Unsupported .
Node option Node #1 Node #2 Node #3 Node #4 Node #5
Enable - Possible Possible Possible Possible
Node #1 - - - - -
Disable - Possible Impossible | Impossible | Impossible
Enable Possible Possible Possible - Possible
Node #4 - - - - :
Disable Impossible Possible Possible - Possible

3-11 | LSELecTric
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3.5XG5000 Program

XG5000 is a program tool for Ethernet communication network control and management. It provides configuration and
management functions related to communication module such as communication parameter, communication service
parameter and module and network diagnosis.

The functions related to Ethernet module of XG5000 can be classified as follows.
1) Standard settings
2) Communication service (high speed link, dedicated service, P2P) parameter settings
3) Module and network diagnostic services

The parameters and files set by the user can be written (downloaded) and read (uploaded) to the Ethernet communication
module via the CPU module. The downloaded communication parameters are saved in the CPU and can be used without
resetting even if the new communication module is replaced in the slot initially set.

1. Parameters stored in CPU: communication module basic parameters, P2P parameters, high-speed link
parameters
2. Parameters stored in the Ethernet module: smart expansion parameters, EIP/OPC UA tag, certificate

-> |n case of item 2, a download is required when replacing the Ethernet module.

This chapter focuses on the settings required when using the Ethernet module.

3.5.1 CPU type setting

To connect with PLC by XG5000, CPU type should be set first. On the XG5000,select [Project] >[New Project] to create a
new project. In the New Project window, enter the name of the project as shown below, and select the CPU series and CPU

type.

New Project ? *

Project
Project name: |FEnet| |
Cancel
File directory: D:\PADT Project\PLC\FEnet
PLC
CPU Series: ¥GI - Product Mame...
CPU type: XGI-CPUUN

PLC Name: LSPLC

Program

Programming

Format: ¥G| Programming

Program name: MewProgram
Program I

Language:

Project description:
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Press “OK” button to display the screen below.

Do 3 Drabecle Yew Qe Montse Dy Tok ecow e 1
DRdEe / /4 B8 7MAIFYV Lo X RGURT FARPAE
S pm B NTBENEFGE | LIy

&anm;mﬂe.mamwmmasa%s YEY D DEDD EA veYLNE &8 B 0% D EEN s

4 % @0 Erors) || )0 Wamingi) | (0 Messagets

3.5.2 Communication module registration

This section describes the communication settings for the Ethernet module to operate.

(1) Selection and execution of communication module

For standard setting of communication module, base, slot location of communication module should be registered
in Undefined Network of XG5000 project tree list.

1) Offline registration

To register communication module without accessing XGT CPU module, use [Communication Module
Settings] window. When registering Ethernet module in base 0 and slot 0, set as follows in the project window.
In the Project window, select [Undefined Network], click the right mouse button and select [Add
item]—[Communication module].

€ FEnet - XG5000
Project Edit Find/Replace View Online Monitor Debug Tools Window Help

JER g~ L= o RRUI ?Egééf ¥ X ReTRBIiC@QE O H
;._;b.b D © | & [m o G Gl [y # o (8] 5 [ = @
&Hﬁiﬁﬁi’%ﬁ%?%&ﬁiﬁ%%%Fiéﬁ‘%?ﬂi Weew = Ellllu[

owsrgromtroom - I

A

L

1*’-7‘

ey

B G

® 'R "4

4 ff=FEnet =

4 Metwark Configuration
Undefined Metwarl

[ Motion Conrol Modul Add Item 3 Network
%3, System Yarlable =
I LSPLC(XGI-CPUU Copy Crl-C Com:numcatlc.m Module
? Global/Direct Variz g- pacte il P2P Communication
Wy Parameter High-speed Link Cemmunication
[[1| Basic Paramete e B2z Delete User Frame
IE| /0 Parameter Refresh Size 5 A EET
Local Ethernet N — — ] ST
atch Application Of Sma ension Variables
4-[5] 5can Program Add Slave
- [ p MewProgram Properties
User Function/Fu roperties Views Connection
b lear Nata Tuna | [ E— B

3-13 | LSE ecrric
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Click the [Add Module] button on the bottom left of the [Select Module] window.

Select Module x
PLC Type:
LSPLC
Communication Module:
Humbe: ~ BASE 5lot Module Network in use
Add Module | | Delete Module

In the [Communication Module Settings] window, specify Type, Base and Slot.

Communication Module Setting an... X
Type: | XGL-EFMTIE) -
Base: 00 -

Slot: i) -
| oK | | Cancel |

The screen where Ethernet module is registered in Slot 0 of BASE 0 is as follows.

Project - 0 x

R
4 s FEnet =
a Metwork Configuration
4 [:ff] Undefined Metwark
& LSPLC [BOSO XGL-EFMT(BITAG)]
[E| Motian Contral Madule
L Systern Variable
4-[ff] LSPLCCXGI-CPUUN)-Offline
2% Global/Direct Variables
4|y Parameter
\[3| Basic Parameter
[EE| /0 Parameter
Local Ethernet Pararmeter
4[] 5can Program
- p MewProgram
User Function/Function Block
e |lser Data Type
» Library

2) On line registration

If communication module is connected to the installed XGT CPU module, all communication modules installed
in XGT can be searched automatically and registered in the project window as follows. However, online

registration is possible only when the PLC mode is 'Stop'.

a) Select [Online] = [System Diagnostics] - [I/O information] .
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0n|\ne|Monitor Debug Tools Window Help

| Disconnect
A& Connection Settings...
Current Status

Change Mode
Read...

€ write..
Compare To PLC...
Set Flash Memory...

Control Redundancy

EtherCAT Slave

Communication Module Setting and Diagnosis
Reset/Clear

System Diagnostics

Forced I/0...

Skip 1/0...

Fault Mask...

Medule Changing Wizard...

Change Base Wizard...

-

Start Online Editing Cirl+Q
B Write Modified Program Crl+W
X End Online Editing Ctrl+U
Open Online Editing Pregram...

Online Force Edit...

-

G

PLC Info...
PLC History...

PLC Error/Warning..

1/0 Information...
Save PLC History

b) Press the "I/O Sync" button at the bottom left of the [I / O Information] window.

LS-'ELEC TRIC

110 information ? x
Base module information  Slot I/O information

Slot M odule

0 HGL-EFMTIE]

1

2

3

4

5

5

7

g

g

10

11
["] Show Existing Base Only

1/0 sync || Details | | oK || Cancel
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c) Check the contents of the message window and click “Yes” if there is no problem.

XG5000

Cverwrite /O parameters of the PLC with modules installed
in the PLC

Detailed module parameters will be reset as the default if
module type mismatch.

Continue?

OFU SN}

d) The screen where Ethernet module is automatic registered in slot 00 of base 00 is as follows.

Project * 0 x

® Ve G
+ s FEnet «
a Metwark Configuration
4 [:ff]Undefined Metwark
B, LSPLC [BOS0 XGL-EFMT(EXNTAG)]
Motion Control Module
£, Systemn Variable
4[] LSPLC{XGI-CPUUN)-STOP
2% Global/Direct Variables
4|y Parameter
(1| Basic Parameter
[EEE| /O Pararneter
Local Ethernet Parameter
4-[&]5can Program
- p MewProgram
User Function/Function Block
gUser Data Type
= Library

LS'ELECTR”C
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3.5.3 Basic settings

This is a screen for setting communication system parameters for Ethernet module to connect to network. It provides basic
information such as IP address, Subnet Mask, Gateway address, Receive Time Out Setting, No. of Dedicated Connections,
Host Table Settings and Sets EIP Server. Therefore, in order to perform Ethernet communication, it is necessary to download
after setting the parameters in the Standard settings of the module. XGI / XGK and XGR Standard Settings screens are
different.

(1) In case of CPU of XGK / XGl series

If you double-click Ethernet module under Undefined Network registered in project window, the following screen is
created.

Standard Settings - FEnet X

Basic Security Time Synchronization Sets EIP Target Advanced

TCP/IP Settings

saonno: (B ]

Media: Portl: |AUTO
Port2: | AUTO

IP Address: 192 . 168 1 . 2
Subnet Mask: 255 . 255 255 . 0
Gateway: 192 . 168
DMS Server: 0 - ] ]

DHCP Relay OPC UA
No. of Dedicated 3 (1-186)

Connections:

Receive Time Out Settings
Client: 60 ®xls x10ms

Server: 135 ®x1s x10ms

Driver Setting
Server Mode: XGT server
Wodbus Settings

RAPIERet Settings: Disable

The items in the Standard Settings window are as follows.
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1) TCP/IP setting(XGK/I CPU series)

Classification

Content

Station No

Station number used for high speed link and RAPIEnet communication between

Ethernet modules.

- Modules on the same network should not have duplicate station numbers.

- The station number range of the high speed link communication is 0 ~ 63.

- The station number range of the RAPIEnet communication (including Smart

Extension) is 0 ~ 220.

* Precautions for V6.0 and later

- When RAPIEnet is enabled, it is set as RAPIEnet's station number.

- When using Modbus RTU / ASCIl and XGT Cnet server service, it is set as
station number.

Media

Select the communication media you want to use.

>AUTO (electric): Automatically sets the media settings of the currently
installed module.

>10M HALF: 10Mbps Half Duplex Electric
>10M FULL: 10Mbps Full Duplex Electric
>100M HALF: 100Mbps Half Duplex Electric
>100M FULL: 10Mbps Full Duplex Electric
>100M FX/HALF 100Mbps Half Duplex optical
>100M FX/FULL: 100Mbps Full Duplex optical
>1G FULL: 1Gbps Full Duplex Electric
>1G FX/FULL: 1Gbps Full Duplex optical

IP address

Set the IP address of the Ethernet module.

Subnet mask

This is the value for classifying whether the destination station is in the same
network with its own station or not.

Set the gateway module address (router address) for sending and receiving data

Gateway through a station or a public network that uses a different network from your own
station.
DNS server Specifies the domain name server.
DHCP DHCP (Dynamic Host Configuration Protocol) is used when you want to use
dynamic IP (use when connecting ADSL line) without using Fixed IP.
Relay Used to send data frames received on the port to the other port.
OPC UA Enable / Disable the OPC UA server function.(Only V7.x version is supported)

No. of Dedicated
Connections

The maximum number of TCP-dedicated services that can be connected at the
same time.

- V6.0 or less version: Available range is 1~ 16 and default is 3.

- V6.0 or higher version: The number of server connections that can be connected
simultaneously is 64, and is not affected by the number of dedicated connections
in the basic parameters.

2) Reception timeout

time setting

Classification

Content

Client

If a response message is not received within the client Receive Time Out period set
by the requesting server during P2P client communication, it assumes a problem
with the server system and terminates the connected P2P client service.

- V6.0 or less version: Not Available

- V6.0 or higher 2 sec~255 sec setting available. (If the client driver type is
RAPIEnet, 4 seconds are applied.

Server

If there is no request for the set time from the client while the server service is
connected to the PC or HMI, the server operation is finished assuming that a
problem has occurred with the client system.
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1) Driver setting

Content
XGT server: When operating as a server(TCP Port:2004, UDP Port:2005)
- V6.0 or less: It supports XGT Enet dedicated communication server.
- V6.0 or higher: Supports XGT Enet dedicated communication server / XGT
Cnet dedicated communication server.
Modbus server: Modbus server settings(TCP Port:502)
- v6.0 or less: Supports Modbus TCP server
- v6.0 or higher: Supports Modbus TCP / RTU/ASCII server
Smart server: The XGT server and the Modbus server are supported at the same
time. (V6.0 or higher)
Select the protocol driver when RAPIEnet is used.
- Disable: RAPIEnet is not used.
- RAPIEnet v1: Available from V6.0 or higher
- RAPIEnet v2(Default): Available from V8.0 or higher

Classification

Server mode

RAPIEnet setting

(2) In case of XGR CPU

Indicates the default parameters set in the XGR CPU In the case of XGR, the Standard Settings varies depending
on whether the One IP Solution function is used or not.

Standard Settings - FEnet x

Basic  Security Time Synchronization  Adwvanced

OME IP Sclution(Station Mumber and P on standby are Master+1);

TCP/IP Settings

A-side | B-side
Station Mo.: 0
Media: Portl: | aUTO
Port2: | AUTC
IP Address: 192 . 168 . 2
Subnet Mask: 255 . 255 . 255 . O
Gateway: 192 . 168 .
DNS Server: o . 0 ]
DHCP Copy A -> B Copy A <=-B
Relay OPC UA
No. of D_edicated 3 (1-16)
Connections:
Receive Time Out Settings
Client: 60 ®xls x10ms
Server: 15 ® xls ®x10ms

Driver Setting

Server Mode:

RAPIEnet Settings:

XGT server

Disable

i
re




Chapter 3 Product Installation and Test Operation

1) ONE IP Solution

If ONE IP Solution is used, when master switching occurs due to error, communication disconnection, etc.,
the IP address of the FEnet module mounted on the master base and the FEnet module mounted on the
standby base are exchanged. To do this, an individual module reset is performed after the master switch.

If you check ONE IP Solution, ONE IP Solution is activated and only one IP is registered.
When using ONE IP Solution, only an even number can be entered. The configured IP address becomes the
Ethernet module IP address of the master base.

The Standby base Ethernet module IP address becomes Master base Ethernet module IP address + 1.

2) TCP/IP setting(XGR CPU series)

After setting one of A-side or B-side, use copy button or set station number and IP independently.

Classification

Content

Station No

Station number used for high speed link and RAPIEnet communication between
Ethernet modules.

- Modules on the same network should not have duplicate station numbers.

- The station number range of the high speed link communication is 0 ~ 63.

- The station number range of the RAPIEnet communication (including Smart
Extension) is 0 ~ 220.

* Precautions for V6.0 or higher

- When RAPIEnet is enabled, it is set as RAPIEnet's station number.

- When using Modbus RTU / ASCII and XGT Chnet client, it is set as station number.

Media

Select the communication media you want to use.

>AUTO (electric): Automatically sets the media settings of the currently installed
module.

>10M HALF: 10Mbps Half Duplex Electric
>10M FULL: 10Mbps Full Duplex Electric
>100M HALF: 100Mbps Half Duplex Electric
>100M FULL: 10Mbps Full Duplex Electric
>100M FX/HALF 100Mbps Half Duplex optical
>100M FX/FULL: 100Mbps Full Duplex optical
>1G FULL: 1Gbps Full Duplex Electric
>1G FX/FULL: 1Gbps Full Duplex optical

IP address

Set the IP address of the Ethernet module.

Subnet mask

This is the value for classifying whether the destination station is in the same network
with its own station or not.

Set the gateway module address (router address) for sending and receiving data

Gateway through a station or a public network that uses a different network from your own
station.
DNS server Specifies the domain name server.
DHCP DHCP (Dynamic Host Configuration Protocol) is used when you want to use

dynamic IP (use when connecting ADSL line) without using Fixed IP.

Copy A -> B, Copy B -

It is activated when One IP Solution is not checked. After setting Standard Settings
parameters of A side or B side, click A-> B Copy or B-> A to copy the set parameters

> A to the other side.
Relay Used to send data frames received on the port to the other port.
OPC UA Enable / Disable the OPC UA server function.(Only V7.x version is supported)

No. of Dedicated
Connections

The maximum number of TCP-dedicated services that can be connected at the same
time.

- V6.0 or less version: Available range is 1~ 16 and default is 3.

- V6.0 or higher version: The number of server connections that can be connected
simultaneously is 64, and is not affected by the number of dedicated connections in
the basic parameters.
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3) Reception timeout time setting

Classification Content

Client If a response message is not received within the client Receive Time Out period set by
the requesting server during P2P client communication, it assumes a problem with the
server system and terminates the connected P2P client service.
- V6.0 or less version: Not Available
- V6.0 or higher: 2 sec~255 sec setting available (If the client driver type is RAPIEnet, 4
seconds are applied).

Server If there is no request for the set time from the client while the server service is connected
to the PC or HMI, the server operation is finished assuming that a problem has occurred
with the client system.

4) Driver setting

Classification Content

XGT server: When operating as a server(TCP Port:2004, UDP Port:2005)

- V6.0 or less: It supports XGT Enet dedicated communication server.

- V6.0 or higher: Supports XGT Enet dedicated communication server / XGT Cnet
dedicated communication server

Modbus server: Modbus server settings(TCP Port:502)

- v6.0 or less: Supports Modbus TCP server

- v6.0 or higher: Supports Modbus TCP / RTU/ASCII server

Smart server: Simultaneous supports XGT server and Modbus server (V6.0 or higher).

Server mode

Select the protocol driver when RAPIEnNet is used.

- Disable: RAPIEnet is not used.

- RAPIEnet v1: Available from V6.0 or higher

- RAPIEnet v2(Default): Available from V8.0 or higher

RAPIEnet
setting

1. In the media setting, all items except “AUTO” are Force mode. The link setting may be wrong when connecting
between AUTO set device and Force mode set device, so XGL-EFMxB (V8.1 or higher) and XOL-ES4x (V2.1 or
higher) products do not support the above link setting. In order to use it in force mode, the link partner must be set
to the same force mode and the connecting cable must use a cross cable.

& Media setting example

Case Device A Media setting Device B Media setting Result

1 AUTO AUTO Link up available

2 AUTO a Force mode Link up Unavailable
3 a Force mode a Force mode Link up available

4 a Force mode B Force mode Link up Unavailable

2. For XOL-ES4x products, the media setting is always “AUTO”




Chapter 3 Product Installation and Test Operation

(1) In case of DHCP setting, download the parameter and connect to PLC and check the IP address in
[Online]> [Communication module setting]=>[System diagnosis]=>[Communication module information].
In addition, you can check the default setting displayed when you double-click the communication module
displayed in the project tree after opening from the PLC.

(2) For a dynamic IP address, if the power is off, the existing IP address may not exist.

(3) When making remote connection to the module with DHCP setting If the power of the remote side is turned
on again as in (2), check the IP address for the remote station again.

(4) Refer to the table below for the PORT information for IP allocation using DHCP by OS version of XGL-

EFMXxB.
OS Version XGL-EFMTB XGL-EFMFB XGL-EFMHB
8.30 or less PORT 1 PORT 1 PORT 2
8.30 or higher PORT 1.2 PORT 1.2 PORT 1.2

1. If you are not using RAPIEnet, please set RAPIEnet to Disable
2. When setting RAPIEnet, check the protocol driver that can be supported by OS version and set it.
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3.5.4  Security setting

Classification Setting Set or not
Case -
availability

There are no restrictions on the devices accessed by the
module.

Basic Security Time Synchronization  Sets EIP Target  Advanced

1 Enable host table No Setting
Enable host table
[ IP Address |
T
Only the devices with the IP address registered in the host
. table is allowed.
Enable host table Setting :
Standard Settings - FEnet X
2 Basic Security Time Synchronization Sets EIP Target Advanced

v Enable host table
Extended Settings

[ IP Address |
T T92.168.1.100

Extended parameter No Setting

Set access permission and access denial with parameters of
MacAddress, IP Address, and TCP/UDP Port Number.
Individual, range, and Wildcard settings are possible.

X

- Standard Settings - FEnet
Enable host table Setting
Basic Security Time Synchrenization Sets EIP Target Advanced
] Enable host table
3 v Extended Settings
Type | OReraton | Grt (individuall ond (continuous)
| 1] 192.168.1.3 192168110
| 2] IPAddiess Block 192.168.1.50
3
. 4 2000 9000
Extended parameter Setting (5] Porhunber | Erable oo
&
| 7] 11:22:33:44:55:66
| B| MAC addiess Block 11:22:32:4455:77 11:22:33:44:55:93
9

User custom port: This is a function to change the server port. By default, the XG5000 port is assigned 2002, the XGT server
(TCP) is assigned 2004, and the XGT server (UDP) is assigned 2005, but you can change this value to the number you want.

Standard Settings - FEnet x

Basic Settings Host Table Settings SNTP Setting  Sets EIP Server Advanced

Specify a dedicated protoccl user port

[XG5000 V4.5x U]
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] User custom port

Continuous Setting

Port Humber Additional Port

=GE000 Port[TCP) 2000
#aT Server Port[TCP] 3000 2
#ET Server Port{UDP) 3100 3

Extend Server]l Port[TCP]
Eutend Server? Port[TCF)
Extended Serverd Part [UDP)
Eutended Serverd Port (UDF)

[XG5000 Vv4.61 or higher Ul]

The number of channels allocated on a user port is different for each OS version, see the table below.

OS version of FEnet | Compatible | User port number | Number of channels Number of channels
module XG5000 versions | setting (Default port number) (User port number)
- Setting the number of

Do not support user | dedicated connections | _
V6.0 or less port setting function and server mode in basic
parameters
- Do not support user | XGT server: 64 )
V6.0~ V8.0 port setting function Modbus server: 64
When not setting user | XGT server: 64 )
V4.50-V4.60 port number Modbus server: 64
Vv8.10 ~ Vv8.20 QU=VA. :
When setting user .
g Modbus server: 64 XGT server: 64
port number
When not setting user | XGT server: 64 )
VA.50-V4.60 port number Modbus server: 64
Vv8.30 ~Vv8.55 .50~V4. - }
When setting user | XGT server: 56 XGT server: 8
port number Modbus server: 64
When not setting user | XGT server: 64 )
ort number Modbus server: 64
V8.60 or highernoted) | V4.61 or above P - :
When setting user | XGT server: 32 XGT server: 32 note)
port number Modbus server: 64

Note 1) If the FEnet module OS version is V8.60 or higher, the user port function has changed and is not compatible with
lower versions. Please use XG5000 V4.61 or higher version.

Note 2) When setting [Number of additional ports], N consecutive humbers starting from the port number set can be used
as user ports. The number of channels for each additional port is allocated by dividing 32 into N+1.

Example) When setting port number 3000 and number of additional ports to 3:

User-defined ports 3000~3003, number of channels for each port: 32/(3+1) = 8 channels
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3.5.5 Time synchronization Setting

This is the SNTP (Simple Network Time Protocol) protocol setting screen that synchronizes time with the server by requesting
time information from an NTP (Network Time Protocol) server.

Standard Settings - FEnet x
Basic Security Time Synchrenization Sets EIP Target Advanced

] Enable NTP Time Synchronization

] Behavior when initializing MNTP

NTR IP Address Port Number
Server 4 192.168.1.150 123

2 192.168.1.160 123
Synchronization 30min
Cycle:

Time Zone Setting: (UTC+09:00) Seoul

Classification Content
Enable SNTP Time ENABLE : Enable SNTP operation
Synchronization DISABLE : Disabled SNTP operation
Behavior when ENABLE: Operates immediately when power is applied.
initializing SNTP DISABLE: Operates after synchronization cycle time after power is applied.
NTP server Register NTP server to request time information.
Synchronization cycle | Set the frequency to request time information.
TIME ZONE Setting Set the standard time.

(1) When SNTP is activated, the module receives the time received from the NTP server and updates it with

the CPU time information.
(2) When SNTP is activated after installing multiple Ethernet modules, each Ethernet module individually
transmits the time received from the NTP server to the CPU.
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3.5.6 EIP Target Setting

This is a screen to input local tag and data count when using EtherNet / IP target.

Classification Content
Local tag Set the tag to use as EIP target among the_ regist'ered Igcal tags.
- It can be set as target tag of 'Device / Variable' in addition to local tag.
The number of data When you enter a local tag, the data count of the selected tag is displayed.

3.5.7 Advanced Settings

Media: This function limits the maximum connection speed to 100Mbps when media in Basic Settings is set to
AUTO.

Media

Limit auto negotiation speed to 100Mbps
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3.5.8 Download/Upload

Standard Settings parameters created using XG5000 can be written (download) or parameters can be read (uploaded).

(1) Writing (download)

1) Connect with the CPU of the system equipped with the Ethernet module via [Online] >

& FEnet - XG5000
% Project Edit

R M
4 5 FEnet +
4 Metwarl: Configuration
4 [;[[] Undefined Metwarl
B LSPLC [BOSO XGL-EFt
Motion Contral Module
&3, System Variable
4-[Jf] LSPLC{XGI-CPUUN)-Offlii
2%, Global/Direct Yariables
4-Lyjy Parameater
|(3| Basic Parameter
e8| /0 Parameter
Local Ethernet Paramete
4-[{3] 5can Program
- | p MewPragram
User Function/Function Blg
= User Data Type
s Library

2) Select [Online] = [Write].

€ FEnet - XG5000
% Project Edit
e &

EH pED BB
{ £sc FY T4 SFi coh 572 cs5 aH a e
Project

‘e H
y FEnet =
4 Metwaork Configuration
4-[:Jf) Undefined Metwork
B LSPLC [B0S0 XGL-EFM
Motion Control Module
£, Systemn Variable
4 [[[] LEPLC{XGI-CPUUN)}-STO
2% Global/Direct Variables
4Ly Parameter
\[3| Basic Parameter
| /0 Parameter
Local Ethernet Paramete
4-[5] Scan Program
- | p MewProgram
Iser Function/Function Blo
=o User Data Type
® Library

3) After selecting the network parameter to download and pressing “OK” button, writing is completed and PLC

reset is executed.
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Find/Replace View | Online

& g D& Connect

A% Connection Settings...

Find/Replace View | Online | Monitor
/| Disconnect
/@ Connection Settings...

Monitor Debug Tools Window Help

Current Status

Safety Lock

 Signature

Change Mode

Set Flash Memory...

Contrel Redundancy

EtherCAT Slave

Communication Module Setting and Diagnosis

Reset/Clear
System Diagnostics

Forced 1/0...

Skip 1/0...

Debug Tools Window Help

Current Status

 Lock

S
Safety Signature

Change Mode
Read...

[ Write..

Compare To PLC...
Set Flash Memory...

Control Redundancy

EtherCAT Slave

Communication Module Setting and Diagnosis
Reset/Clear

Systern Diagnostics

Forced I/0...
Skip 1/0...

»

3
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Write to PLC

nhibit Program Upload

~[:5ets link enable with parameters

B LSPLC
- PLC Configuration

\/r& Parameter
\/El Basic Parameter
\/ I/0 parameter
\/ Special module parameter
- [ZI[E Local Ethernet Parameter
\/ Program

- iil Auto variable retain value

e[ Metwaork Parameter

T Basic
\/ [Reset]FEnet [basel, slotl]
(I EIP tag
[ EIP Target
~[Z1B] High-speed Link
JED p2rER)

Cancel

Setting...

Clear PLC...

1) XG5000 can be connected to RS-232C port or USB port of CPU module. Refer to the wiring diagram of the

relevant CPU module for the available cable types.
2) When downloading the communication parameters to the CPU module, if the link of the related service is
allowed, the parameter is automatically changed after the download is completed. If the link of the related
service is not allowed, the parameter is not applied until the link is allowed.
3) When writing after changing basic setting in V6.0 or higher version, the CPU module must be reset after writing

to apply the changed contents to communication module.
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(2) Reading(Upload)

1) Connect to the CPU module of the system equipped with the Ethernet module and select [Online] - [Read].

& FEnet - XG5000
Project Edit Find/Replace View | Online | Monitor Debug Tools Window Help
EN=Reg = | 4@ | { [ Disconnect i
EgE > ED | @R /@ Connection Settings...

| Current Status 3
iie H A FHEHSER TR

Project I

i M

4 £Ix FEnet Change Mode ’
4 Network Caonfiguration Read..

4[] Undefined Metwork - .
B LSPLC [BOST XGL-EFM HE Wiite.

Maotion Confrol Module Compare To PLC..
&5 System Yariable Set Flash Memory...
4[] LSPLC{XGI-CPUUN)-STO
? Global/Direct Variables Control Redundancy
4Ly Parameter
(1] Basic Parameter EtherCAT Slave 3
[ 1/0 Parameter Communication Medule Setting and Diagnosis v
Lacal Ethernet Paramete Reset/Clear 5
4-[&] 5can Program
3

| p MewProgram System Diagnostics

User Function/Function Blg
b User Data Type Forced I/0...
» Library Skip 1/0..

2) After connecting, select [Online]> [Read] and the following screen will appear.

Read From PLC

Inhibit Program Upload

Sets link enable with parameters

- JgF LsPLC - ok
""" |:| PLC Configuration
r‘lh Parameter Cancel
Basic Parameter :
1/0 parameter SHITL -
Special module parameter
Local Ethernet Parameter
Program
ﬁ Auto variable retain value
[ |9, Data memary
""" E:, Metwork Parameter
- I Basic

=
*

Enet [base0, slot0]:
n smart Extension Service

High-speed Link
Bl High-speed Link 01
|| High-speed Link 02
|| High-speed Link 03
B High-speed Link 04
| High-speed Link 05
| High-speed Link 06
Bi| High-speed Link 07
|| High-speed Link 08
|| High-speed Link 09 -

3) Click the “OK” button to complete reading. If reading is completed and clicks the parameter to check, the data
read from CPU module can be checked on XG5000 screen.
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3.5.9 Link enable

In order to send / receive high speed link and P2P data downloaded to XG5000, link permission to start communication
operation is required. By allowing link enable, communication module initiates sending / receiving service. Each parameter
can be individually assigned an action. If the link is enabled even when the CPU module is stopped, communication will

continue.

(1) Link Enable on XG5000

1) Click [Online]->[Communication Module Setting and Diagnosis]->[Enables Services] and the following screen

will appear.

B Fenet - XG5000
i Project Edit Find/Replace  View
D eE &8

H D> R

iw [ aF HBE APF NE INE =
mHEH NSNS HE N

roject

iR &
4 7% FEnet
4 Metwork Configuration
4[] Undefined Metwork
£ LSPLC [BOS0 XGL-EFM
Mation Contral Madule
£, System Varlable
4[] LEPLC{XGI-CPUUN)-STO
%, Global/Direct Variables
a ﬁParameler
[[)] Basic Parameter
[ED| /0 Parameter
Local Ethernet Paramete
4[] 5can Program
©-[ 1y NewProgram
User Function/Function Bld
== User Data Type
s Library

Online | Moniter Debug Tools Window Help
¢’ Disconnect K& 4@ 384 2]
% Connection Settings. F N 0

Current Status

Lock

Signature

Change Mode
Read...

o write
Compare To PLC
Set Flash Memory...

Contrel Redundancy

EtherCAT Slave
Communication Medule Setting and Diagnosis ¢# Enable Link/Services...
Reset/Clear

System Diagnostics

0S Upload/Dewnload...
EIP Tag Manager

Forced 1/0.
Skip /0.
Fault Mask.

[ system Diagnosis

2) Set service enable for each parameter.

I

Enable Link/Services

""D High-speed Link 8
High-speed Link 9

| High-speed Link 12

D P2p(EIR 1
[ JEY p2pEIR) 2
~-[IED p2p(EIR) 3
~-[16ED pzrEIR) 4
~[1ED P2p(EIR S
[ 16D p2rEIR 6
~[1ED p2piEIR) 7
~[1ED p2riEIR) &

nication semvice status!
High-speed Link
High-speed Link 1
High-speed Link 2
High-speed Link 3
High-speed Link 4
High-speed Link 5
High-speed Link &
High-speed Link 7

High-speed Link 10
High-speed Link 11

P2P(EIF)

-

3) When the link enable write is executed, the following message appears to indicate that the link enable was

successful.
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(2) Link enable through a flag

3-31

XG5000

o Setting communications completed.

1) Here is how to enable link via flag. The following version is required to use link enable using flag.

ltem Version
XG5000 V3.61 or higher
XGR CPU V1.91 or higher
XGI CPU V3.4 or higher
XGK CPU V3.7 or higher
XGL-EFMTB V5.0 or higher

2) List of flags related to link enable

-XGK CPU module

Flag Data type | Device Contents
_HS1 ENABLE_STATE | BIT F09600 | Current enable/disable status of high speed link NO. 1
_HS2 _ENABLE_STATE | BIT F09601 | Current enable/disable status of high speed link NO. 2
_HS3_ENABLE_STATE | BIT F09602 | Current enable/disable status of high speed link NO. 3
_HS4 ENABLE_STATE | BIT F09603 | Current enable/disable status of high speed link NO. 4
_HS5 ENABLE_STATE | BIT F09604 | Current enable/disable status of high speed link NO. 5
_HS6_ENABLE_STATE | BIT F09605 | Current enable/disable status of high speed link NO. 6
_HS7 _ENABLE_STATE | BIT F09606 | Current enable/disable status of high speed link NO. 7
_HS8 ENABLE_STATE | BIT F09607 | Current enable/disable status of high speed link NO. 8
_HS9 ENABLE_STATE | BIT F09608 | Current enable/disable status of high speed link NO. 9
_HS10_ENABLE_STATE | BIT F09609 i:(l;rrent enable/disable status of high speed link NO.
_HS11_ENABLE STATE | BIT FO9G0A (ltrrrent enable/disable status of high speed link NO.
_HS12 ENABLE STATE | BIT F0960B f:rrent enable/disable status of high speed link NO.
_HS1 REQ BIT F10300 | Request enable/disable for high speed link No. 1
_HS2 REQ BIT F10301 | Request enable/disable for high speed link No. 2
_HS3 REQ BIT F10302 | Request enable/disable for high speed link No. 3
_HS4 REQ BIT F10303 | Request enable/disable for high speed link No. 4
_HS5 REQ BIT F10304 | Request enable/disable for high speed link No. 5
_HS6_REQ BIT F10305 | Request enable/disable for high speed link No. 6
_HS7_REQ BIT F10306 | Request enable/disable for high speed link No. 7
_HS8 REQ BIT F10307 | Request enable/disable for high speed link No. 8
_HS9 REQ BIT F10308 | Request enable/disable for high speed link No. 9
_HS10 REQ BIT F10309 | Request enable/disable for high speed link No. 10
_HS11 REQ BIT F1030A | Request enable/disable for high speed link No. 11
_HS12 REQ BIT F1030B | Request enable/disable for high speed link No. 12
_HS1 REQ _NUM BIT F10310 | Setenable/disable for high speed link No. 1
~HS2 REQ _NUM BIT F10311 | Set enable/disable for high speed link No. 2
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Flag Data type | Device Contents
~HS3 REQ _NUM BIT F10312 | Set enable/disable for high speed link No. 3
_HS4 REQ_NUM BIT F10313 | Set enable/disable for high speed link No. 4
_HS5 REQ _NUM BIT F10314 | Set enable/disable for high speed link No. 5
_HS6_REQ_NUM BIT F10315 | Set enable/disable for high speed link No. 6
_HS7 REQ_NUM BIT F10316 | Set enable/disable for high speed link No. 7
~HS8 REQ _NUM BIT F10317 | Set enable/disable for high speed link No. 8
~HS9 REQ _NUM BIT F10318 | Set enable/disable for high speed link No. 9
_HS10 REQ_NUM BIT F10319 | Set enable/disable for high speed link No. 10
_HS11 REQ _NUM BIT F1031A | Set enable/disable for high speed link No. 11
_HS12 REQ _NUM BIT F1031B | Set enable/disable for high speed link No. 12
_P2P1_ENABLE_STATE | BIT F09620 | P2P1 enable/disable current status
_P2P2_ENABLE_STATE | BIT F09621 | P2P2 enable/disable current status
_P2P3_ENABLE_STATE | BIT F09622 | P2P3 enable/disable current status
_P2P4 ENABLE_STATE | BIT F09623 | P2P4 enable/disable current status
_P2P5 ENABLE_STATE | BIT F09624 | P2P5 enable/disable current status
_P2P6_ENABLE_STATE | BIT F09625 | P2P6 enable/disable current status
_P2P7_ENABLE_STATE | BIT F09626 | P2P7 enable/disable current status
_P2P8_ENABLE_STATE | BIT F09627 | P2P8 enable/disable current status
_P2P1_REQ BIT F10320 | Request enable/disable for P2P No. 1
_P2P2 REQ BIT F10321 | Request enable/disable for P2P No. 2
_P2P3 REQ BIT F10322 | Request enable/disable for P2P No. 3
_P2P4 REQ BIT F10323 | Request enable/disable for P2P No. 4
_P2P5_REQ BIT F10324 | Request enable/disable for P2P No. 5
_P2P6_REQ BIT F10325 | Request enable/disable for P2P No. 6
_P2P7_REQ BIT F10326 | Request enable/disable for P2P No. 7
_P2P8 REQ BIT F10327 | Request enable/disable for P2P No. 8
_P2P1 REQ_NUM BIT F10330 | Set enable/disable for P2P No. 1
_P2P2 REQ_NUM BIT F10331 | Set enable/disable for P2P No. 2
_P2P3_REQ_NUM BIT F10332 | Set enable/disable for P2P No. 3
_P2P4 REQ_NUM BIT F10333 | Set enable/disable for P2P No. 4
_P2P5_REQ_NUM BIT F10334 | Set enable/disable for P2P No. 5
_P2P6_REQ_NUM BIT F10335 | Set enable/disable for P2P No. 6
_P2P7 REQ_NUM BIT F10336 | Set enable/disable for P2P No. 7
_P2P8 REQ_NUM BIT F10337 | Set enable/disable for P2P No. 8

-XG| CPU module

Flag Data type Device Contents
_HS ENABLE_STATE | ARRAY[0..11] OF BOOL %FX15840 | HS enable/disable current status
_HS_REQ ARRAYI[0..11] OF BOOL | %FX16480 | HS enable/disable request
_HS REQ_NUM ARRAY[0..11] OF BOOL Y%EX16496 ?sét;rég"ninable/disable for high
_P2P_ENABLE_STATE | ARRAY[0..7] OF BOOL %FX15872 | P2P enable/disable current status
_P2P_REQ ARRAY[0..7] OF BOOL %FX16512 | P2P enable/disable request
_P2P_REQ_NUM ARRAY][0..7] OF BOOL %FX16528 | Setting P2P enable/disable
-XGR CPU module

Flag Data type Device Contents
_HS ENABLE_STATE | ARRAY[0..11] OF BOOL %FX19040 | HS enable/disable current status

HS REQ ARRAY[0..11] OF BOOL %FX31520 | HS enable/disable request
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_HS REQ_NUM ARRAY[0..11] OF BOOL %FX31536 | Setting enable/disable for high
speed link
_P2P_ENABLE_STATE | ARRAYJ0..7] OF BOOL %FX19072 | P2P enable/disable current status
_P2P_REQ ARRAY[0..7] OF BOOL %FX31552 | P2P enable/disable request
P2P REQ NUM ARRAYJ0..7] OF BOOL %FX31568 | Setting P2P enable/disable

» Link enable method
- Set flag on in set enable/disable for high speed link/P2P - Set flag on in request enable/disable for high
speed link/P2P
» Disable enable method
- Set flag off in set enable/disable for high speed link/P2P - Set flag on in request enable/disable for high
speed link/P2P
» The enable / disable status flag of HS link / P2P can be used to monitor the enable / disable status of the HS
link.
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3.6 System diagnosis

The system diagnosis function indicates the overall service status and information communication module. It shows detailed
online status such as link type, link information and O /S information so that users can diagnose and debug data send/ receive
relationship of current communication module.

3.6.1 Diagnostics

When select [Online]->[Communication Module Setting and Diagnosis]->[System Diagnosis],the following screen will be
displayed.

& Fenet - XG5000

£ project Edit Find/Replace View m‘ Monitor Debug Tools Window Help

DEBRES| S5 E 15 Dsoned kB wass o ®E
‘el pED | R®|* /8 Connection Setfings.. L T m R0

Current Status 14 =
A=|E|C SO

s,

SR HHENBEL R

afety Lock

Project

== Signature

e AvEE S

4 s FEnet Change Mode 3
4 Network Configuration Read

4 [:[J] Undefined Metwark e
B LSPLC [BOSO XGL-EF! [ write

Mation Contral Module Compare To PLC
£ System Varlable Set Flash Memary
4-[[[] LSPLC{XGI-CPUUN)-5TO
2%, Global/Direct Variables Contral Redundancy
4[|y Parameter
(1] Basic Parameter EtherCAT Slave 4
[ /O Parameter Communication Module Setting and Diagnosis ¥ |7 Enable Link/Services.
Local Ethernet Paramet Reset/Clear o
4[] Scan Program 08 Upload/Download
3
[y Neme.gram ! System Diagnostics EIP Tag Manager
User Function/Function BI
k== User Data Type Sl Config. Upload (Dnet, Pnet)
"% Library skip 1/0.
Fault Mask... [F System Diagnosis
Module Changing Wizard...
% Start Online Editing Ctrl+Q
& \rite Modified Program Ctrl+w
X End Online Editing Ctrl+U
Open Online Editing Program.

Online Force Edit.

It displays the base information, slot information and CPU operation status of the installed module.

. renen - Ausw E————
Broject Edn Find/Replace Wiew Qnline Monitor Debug ook Window Help
D S S8 ES PRA NN % X | W EEGE H

etwark: Conflauration

= Undefined Netwark
L LSPLC [BOBO XGL-EFMTIBNTAGY]
M ol Module:

5 Scan From
& [ HewProgram
LUser Function/Function Block

& User Dits Typs
B Library

Aasdress Assignment (Flwed) Comment
Main Base(12 Siols)
Power Module(AC 100~240 ar DC24V Ingut)
High Performance CPU Moduledl/0: Maximum 6.144 Pointz)
Fast Ememet Modue, Elecical Master

Aost Recently Used

funcion Hame
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= !

3.6.2 Types of diagnostic functions

On the diagnosis screen, diagnose the status of each module with the pop-up menu. The main functions of each item are as

follows.
P Newsrogamprogam) " 1seic < [
an
xcclijxix.\' NGI_PUUN xGLEFMTB
; [~ | Detailed Medule Infermation...
- = j Status By Service...
m Media Information...
g m Autoscan...
. a System Log...
[~ | Ping Test
IC| RAPIEnet media information
‘ Wiew Communication Module Log
Save Communication Module Log
O Remote 05 downlead
Loopback Test
Systemn Synchronization...
Classification Content
Detailed Module It shows basic information, hardware and communication status of
Information communication module.
. Dedicated service, P2P service, High Speed Link service, Smart extension status
Status By Service ;
are displayed.

Media information Provides packet information of data sent and received through the media.
Ethernet It provides IP information of our module connected to the Ethernet network and
Autoscan activated.

RAPIENet . . L .

Autoscan Provides RAPIEnet module and configuration information connected RAPIEnet

(V6.0 or higher) network.

Ao I erNet P

scan Autoscan Provides module and configuration information connected to EtherNet / IP

(V8.0 or higher) network.
R:Li:)izzr Provides information on networks composed of RAPIEnet and EtherNet / IP

(V8.10 or higher) modules.

It is a function to check the system operation, Modbus Service, P2P Service log.

System Log Provides brief log information of communication module.
Ping Test This shows the port connection status of other station connected to the network.
RAPIEnet media
information Provide packet information for RAPIEnet.

(V6.0 or higher)
View Communication
Module Log
(V6.0 or higher)
Save Communication
Module Log
(V6.0 or higher)
Remote OS download With RAPIEnet enable, the OS of the remote module connected to the network is

Provides event / communication history information of the communication
module.

Compress and saves event / communication history information of the
communication module.

(V6.0 or higher) updated using the RAPIEnet protocol.
Loop-back test It is a function to check whether there is an abnormality in the port of the local
(V6.0 or higher) module, and performs loopback test for each port.

System synchronization | Synchronizes the current PLC status to system diagnostics.
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(1) Communication Module Information

Communication module information shows Standard information such as base information, HS link station no., IP
information and start status of media and communication service. This allows the user to check whether the
communication module is in normal state.

Communication Module Infermation 4 =

Displays the general information of communication module.

List Contents
Module kind HEL-EFMTE
Baze Mumber u]
Slat Mumber u]
Station Mo u]
DHCF Unuzed
IP Address 192.168.1.10
Mal sddress O0EDS1 0871 04
todule Status Supstem O
System parameter information Mot exist
GROUP Status HGT group
Spesd/Full Duplex Eg::'ln iﬂ¥g
Option board tppe FE net electric module
Hardware Error Mormal
Hardware Yersion Ver 2.00
05 wer Ver, 8.00
Dedicated Service Enakble

Close

(2) Status By Service

The service status of communication module is divided into Dedicated Service, P2P Service, High Speed Link
Service and Smart Extension and shows the detailed information of each communication service.

1) Dedicated service

Dedicated service shows communication status with MMI / HMI, the parent client. Displays the send/ receive
data and error with the client of the set IP address.

Status by service x
Dedicated Service  P2P Service  HS Link Service Smart Extension

Standard Information Communication Diagnostics:

Base No.: IP Address Received packets Send Packets Emorpackets no. of packets received/sec St

Slot Mo.:

ik

Dedicated Service Info.

Mo. of Connected 5t.:

:

Drriver type

Read Refresh
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2) P2P service

When P2P parameter is set and enabled, it indicates whether the service is normal or not. Real-time monitoring
is possible by specifying redo and continuous read through menu.
Status by service

Dedicated Service P2P Service  HS Link Service  Smart Extension
Standard Information

*
Service information
Base No.: lII Parameter existence: Block in services: lII
Slat No - II' Parameter task status: IDLE
Communication Diagnostics
Block number Channel number Connection Status  Packets persecond  Service count  Emor count Block status
Details:
Read Refresh
3) HS Link Service

Status by service

Monitoring by flag is performed for individual parameters of HS link parameter. HS link service information
displays individual information such as run link and link trouble.

Dedicated Service

P2P Service HS Link Service  Smart Extension
Standard Information

>
HS Link Service Information
Base MNo.: Send e
Slot Mo.: III Receive III (Run link: 0, Link trouble: 0)
Packets:
Communication Diagnostics:
Index  Station number Block number Block type Datasize Fead area  Save area  High-speed link state Mode HStm Er
£ >
Read Refresh
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4) Smart Extension

Monitoring by flag is performed for individual parameters of Smart Extension HS link parameter. HS link service
information displays individual information such as run link and link trouble.

Status by service X
Dedicated Service P2P Service HS Link Service Smart Extension

Standard Information Service Information

Base No-: |I| Service Status
Slot No.: |I| SCAN MAX: SCAN MIN: SCAN CURR:

| | EBNo. | Protocol | Station NoJIP | Service | EBStatus | Service Count | Error Count |EB Detach Coun|

Save File Clear Scan Clear Flag Read Refresh

Close

(3) Media information

Indicates packet information input to the media.

Media Information >

Standard Information
Base MNo.: III Slot Mo.: III

Detailed information:

Section Broad Muli Uni UDP ARP(EARP) Throw out
Total packets V] V] V] V] 0 V]
Mo, of Packets per second 0 0 0 0 0 0
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(4) Ping Test

Ping Test >
Standard Information Basic Settings Results
: IP Address: Mo. of
Base No.: D [ 152168 .250 . 110 | e
Mo. of No. of
Slot No. : l:l settings: clmessses
No. of
Time-gut: ms errors:
Message
Success: Reply received from 192, 168,250,110,
Success: Reply received from 192, 168,250,110,
Success: Reply received from 192, 168, 250, 110,
Close
(5) Auto scan
Indicates the link interface status of the network.
Autoscan *
Baze MNo.: SlotMo.: Link Type: Selected Module
‘U | |U | |FE"|Et | | Link Status Service Status Media Info

Bl 7 7 7 7 7 7
192.168.1.122 192.168.1.112 192.168.1.120 192.168.1.124 192.168.1.122 192.168.1.121 192.168.1.125

o]

182.168.1.126
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(6) RAPIEnet media information(Module version V6.0 or higher)

Indicates the link interface status of the network.

Media Information X
Service State Information
Transmigzion Reception I
HGET server 1] 1] il
High-speed Link 1] 1] 0
P2P(EIF) 0 a
Others i} i} 4
0
0
Media State Information{packet/sec)
Transmiggion Reception [
a a
Broat.:lcast 0 B Eroad T llni TA
P ulticast o 1] 0 — Ui R
Unicast 0 ] roa. n
L] L]
Group transmission 0 1] 0 Multi T Group T
0 OMuli B OGroup AX
0
Packet monitoring
Part Number Transmizsion Feception Felay packet Errar 3000
1 627 2635 13 i 2400
mTx oTx 2
2 37e 76 3 a 1800 BRT mRx 2
1200 ——— —  ®Relay] HRelay 2
00 OEmor 1 OEmar 2
Error details i}
Clear Flag Read Close
(7) RAPIENnet autoscan(Module version V6.0 or higher:)
Indicates the link interface status of the network.
Autoscan
Slave Diagnosis
Base Mo.: 0 Link Type: RAPIEnet Total No. of Stations: 9
Slot No.: T Topology: Ring Station No. collision: Empty Measure cable distance
A
Local: 0 XGL-DBDT: 26 XGL-DBODT: 20 HGL-DBODT: 25 XGL-DBODT: 24 XGL-DBODT: 23
FEIT FENT PEET 0 PENT 0 PEET 0 CENT
L s 1L , 1L, 1L s 1L 5 I
€ ra € ¥ € ¥ € ¥ € ¥
-
HGL-DBDH: 13 XGL-DBDH: 21 XGL-DBOT: 22
BT PEET WD
. s 1L s 1L s 11 Y
< e < ¥ < ¥
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(8) Saving and comparing RAPIEnet autoscans (V8.1 or higher)

This function compares the results of the previous RAPIEnet autoscan with the results of the current RAPIEnet
autoscan in RAPIEnet autoscan. Executing RAPIEnet autoscan in [Online] = [communication Module Setting and
Diagnosis] = [System diagnosis].

——————————————————————————————————————————————— 1 ___@ _CGolden_Image _ Save LQmpars_l
I
T

I;Base [o [ Link type [RAPEnet [RAPEnetNo. [4 | Station Collisio | Empty : Save Slave D I
| Siot {o { Topology [RING [Topology Setti | RING I [ l |
__________________________________ ' L __ _Compare _ _ _ _| Measure Cable Distance |
@ Main ring group information
(Ethernet - MRS) .
Local 3 0 XEL-BSSRH: 1 92
I I I
i | == bem | e > <
@ Network configuration
@ Device type compare >

(Node /cable status )
® Autocan Read and Retry

:[] Show user topology settings and compare resul'

F——-
0
n
&
o
n
o
<
i

1) Main ring group information

Monitors network information connected to the master module configured for smart expansion.

2) Golden image Save, Compare
Measure the cable distance of the auto-scanned network and compare the network configuration information.

- Save: Saves the connected network configuration information. Check the network change information by
running Compare using Save.

- Slave Diagnosis: Monitor the cable connection status and connection location of Smart I/ for.

- Compare: If you execute Compare, the difference between the network configuration saved with the Save
menu and the current network configuration information is compared and displayed in the network

configuration.
- Cable distance measurement: Measures the cable distance between networks in M.
Module Electric transceiver Optic transceiver Note
Ethernet Distance: Display m Distance(Not display): Fiber
Expansion driver Date :Display 2021-01-11 Optic
Smart I/O block Date :Display 2021-01-11
MRS Distance: Display - m Distance(Not display): Fiber | Not
Smart I/O | Date : Display 2021-01-11 or | Optic supported
expansion N/A Date : Display 2021-01-11 or
N/A
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3) Network configuration

Displays the network information executed by Auto Scan and the result of executing Golden image.

4) Device type compare

If you select Compare from the Save and Compare menu in Golden image, the saved information and network
change information are visually displayed. In addition, if you select to “display the user topology setting and
comparison result’, the difference between the topology set in the smart expansion and the current topology
is displayed.

5) Auto scan redo and continuous read

If continuous reading is selected from the menu to perform auto scan, auto scan is executed continuously.
And when you select Redo, the autoscan information that was re-run is displayed.

If you execute Save from the Golden image Save and Compare menu, the following screen is display.

| Base [o [ Link type | RAPEnet |RAPEnetNo. |4 | Station Collisio | Empty Save Slave Diagnosis
| Siot o | Topology | RNG | Topology Setti | RING |
Compare Measure Cable Distance
A
Local 3 0 XEL-BSSRH: 1 XOL-ES4T(H): 92

| Disconnect -I Add cable -

[] show user topology settings and compare results Read Retry Close

If you execute Compare from the Golden image Save and Compare menu, the following screen is display.
In other words, it indicates the cable disconnection between station 0 and XEL-BSSRH (station No.1)
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| Base [o | Link type [RAPEnet |RAPEnetNo. |4 | Station Collisio | Empty Save Slave Diagnosis
| Siot jo | Topology | LNE | Topology Setti | RING | |
Stop Measure Cable Distance
Local 3 0 XEL-BSSRH: 1 XOL-ES4T(H): 92
I I B
L« a3 e N e N
€ > € > € ¥
€ >
i
{
%
| Ada: -l Delete: -I Change: -
Show user topology settings and compare results Read Retry Close

If you execute Compare from the Golden image Save and Compare menu, the following screen is display.
In other words, it indicates that GEL-DT4C (station No. 4) has been added between local station No.3 and

station No.O.
Autoscan
[Base {o {Link type |RAPEnet RAPEnetNo. |5 { Station Collisio | Empty — Slave Diagnosis
[ siot o {Topology {RING [ Topology Setti | RING |
Stop Measure Cable Distance
~

Local: 3 GEL-DT4C(1): 4 0 XEL-BSSRH: 1 XOL-ES4T(H): 92

ﬁ ”m m 3

< N & P 5 & 3
< > < > < > < >
<

[Ada: I[oeiet=: W[ Change: [

Show user topology settings and compare results Read Retry Close
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“If you select to “display the user topology setting and comparison result”, the difference between the topology

set in the smart expansion and the current topology is displayed. In other words, it is set as a ring in the smart
expansion, but the current topology is connected by lines.

[Base o

| Link type [RAPEnet [RAPEnetNo. [S | station Coflisio | Empty — Siave Diagnosis
| Slot o | Topology | LINE | Topology Setti | RING | |
Compare Measure Cable Distance
~
Locat 3 GEL-DT4C(1): 4 0 XEL-BSSRH: 1 XOL-ES4T(H): 92
ENT e (W ETT
| L 1l
< € > < > € >
|
!
v
| Disconnect -I Add cable -
[ Show user topology settings and compare results Read Retry Close

Auto scan and the currently connected cable distance are schematically expressed in the network configuration.

[ Base jo | Link type [RAPEnet [RAPEnetNo. |5 | Station Coliisio | Empty Save Slave Diagnosis
[ siot Jo [Topology [RING [ Topology Setti | RING | [
Compare Measure Cable Distance
~
Local 3 GEL-DT4C(1): 4 0 XEL-BSSRH: 1 XOL-ES4T(H): 92
'mr B W BT B
[l 1L 4
€ — > € — > € v >
Fiber Optic
€ >
2021-01-26
v
| Disconnect -I Add cable -
[[] show user topology settings and compare results Read Retry Close
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(9) RAPIEnet+ Auto Scan function (V8.10 or higher)

Auto Scan function of RAPIEnet + is provided for link disconnect section detection of EtherNet / IP devices
connected to XOL-ES4x (MRS). The disconnect section detection is performed by comparing the current system
configuration (hereafter Live Image) based on the system configuration (hereinafter Golden Image) set by the user.
Therefore, in order to use this function, after configuring the system, click the “Save” button to save the Golden

Image first.

When autoscan of RAPIEnet + is executed in [Online] - [Communication module setting and diagnosis] = [System
Diagnosis], information about the IP device connected to the first MRS is displayed.
The figure below shows the Ul of the RAPIEnet + autoscan function.

| Base |o | Link type | RAPEnet | RAPEnetNo. |5

| Station Collisio | Empty e

Slave Diagnosis

| Slot o | Topology | RING | Topology Setti | RING

@ Main Ring group information

Local: 3 GEL-DT4C(1): 4 0

Compare Measure Cable Distance

@ Golden Image
Save/Compare A

XEL-BSSRH: 1 XOL-ES4T(H): 92

I"m
N |i & d L ¢
7 7 <

Fiber Optic

S
m ae hedts
& __Fiber Optic .
* 00 °

<

2021-01-26

® Network configuration

@ Device type compare
(Node /cable status )

| Disconnect -I Add cable ||

[:] Show user topology settings and compare results

W

® Autoscan Retry

Read Retry Close

If the system configuration is complete, click the “Save” button to save Golden Image. Golden Image is saved in the
communication master module and will be used in the future comparison function. Click the “Retry” button to check the
current system configuration. If you click the “Compare” button, you will see the changes compared to Golden Image.
There are two changes: a) adding / removing node, b) cable connection / remove.

If node No.0 is added between station No.3 and station No.1, the node added in green is displayed as shown below.
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B Y RAPIEnet+ Autosca — n
Base 0 Link type RAPEnet+ RAPEnetNo. {4 Save
Slot 0 Topology RING Station Collisio | Empty
Stop
~
W
< >
Add: Delete: Change:
Connect cab Disconnect Retry Close

In the above state, if the cable between the node no.0 and station No.1 is removed, the disconnection section is
displayed in red as shown below.

Base 0 Link type RAPEnet+ RAPEnetNo. |4 Save
Slot 0 Topology LINE Station Collisio | Empty

Stop

< >

Add: Delete: Change: |
Connect cab Disconnect Reftry Close
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If the node cable of station No.0 and station No.1 is connected again, the connected section is indicated by a blue
line as follows.

| Base 0 Link type RAPEnet+ RAPEnetNo. |4 Save
[ siot 0 Topology RING Station Collisio | Empty
Stop
~
3
0
ﬂ
L4
< >
Add: | Deicte: | chanoe: a
Connect cab Disconnect | Retry Close

In the above state, if the node No. 0 is removed (module detachment etc.), the removed module is displayed in red,
and the cable disconnection section due to the module is displayed in red.

[Base 0 { Link type RAPEnet+  [RAPEnetNo. |4 Save
| Siot 0 { Topology RING | Station Collisio | Empty
Stop
~
3
0
g I
v
< >
[Ada: B[ Deicte: L | EreE
| Connect cab Disconnect | Retry T
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(10)View Communication Module Log(Modul

e version V6.0 or higher)

It indicates the event and communication history of communication module.

Module Log

Event History  Communication Log

Standard Information

Log Range Save File

Base Mo.: Previous Log First Log Read All
Delete Log
Slot Mo.: II' MextLog Recent Log
Mo Date Time Description 2
a 2020-02-06 10:55:28,398  Smart Expansion-AC FAIL occurred (EB Mo.: 24, Power: 0, Count: 6238)
1 2020-02-06 10:55:28,398 Smart Expansion-AC FAIL occurred (EB Mo.: 21, Power: 0, Count: 6235)
2 2020-02-06 10:55:28.436 Smart Expansion-Power OFF
3 2020-02-06 10:55:28.437 Smart Expansion-Power OFF
4 2020-02-06 10:55:28.438 Smart Expansion-Power OFF
5 2020-02-06 10:55:28.438 Smart Expansion-Power OFF
a 2020-02-06 10:55:28.438  Smart Expansion-Power OFF
7 2020-02-06 10:55:28.438  Smart Expansion-Power OFF
] 2020-02-06 10:55:28.438 Smart Expansion-Power OFF
9 2020-02-06 10:55:28.438 Smart Expansion-Power OFF
10 2020-02-06 10:55:28,596  Smart extension-reserved code(0x8087) (EB Mo.: 13, Count: 49845)
11 2020-02-06 10:55:28,596  Smart extension-reserved code(0x8087) (EB Mo.: 20, Count: 49545) e
- e e - [ . e e o . 5
Frame Data Details:
Close

(11) Remote OS download(Module version V6.0 or higher)

Update OS of remote communication module.

05 Download *
Local module information
Base Mo.: 0
Slot MNo.: 0
05 version:  Ver .01
Another module: Checked module ~
Remote Selection: (@) Slave (O Master
List of connected remote m0/8
Sele| Statil 05 ver Slave type
| | 13 Wer 1.01 #GL-CBCOH
| | 20 Wer 1.01 #GL-CBOT
| | 21 Wer 1.01 #GL-CBCOH
| | 22 Wer 1.01 =GL-DBOT
| | 23 Wer 1.01 =GL-DBOT
| | 24 Wer 1.01 =GL-DBOT
| | 25 Wer 1.01 =GL-DBOT
| | 2 Wer 1.01 =GL-DBOT

LS'ELECTR"C
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(12) Loopback test(Module version V6.0 or higher)

The loopback test of the local Ethernet module is used to test the hardware for abnormalities.

Loopback Test
Standard Information Basic Settings Results
Bseto: [0 | seaport:  [poma v sofattenpts: [ |
Slot Mo.: l:l Loopback Test: INTERMNAL MAC ~ # of successes: l:l
Message
Cancel

1) Reset communication module after remote OS download If you do not reset, the communication module will not

operate normally.
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Chapter 4 Smart Extenstion service

4.1 Overview

Smart extension service is a service between Ethernet (FEnet) module V8.0 or higher and Communication device, that is,
Expansion driver, Smart 1/0 expansion (XEL-BSSRT / BSSRF / BSSRH), Smart | / O block. It is a service that can be
used like one system by adding several PLCs with simple setting.

In the case of XGL-EFMx (B) V8.0, EtherNet / IP function is newly added, and client function of EtherNet / IP function is
integrated in Smart expansion service.

The function of the Smart Extension Service is as follows.

(1) Communication Device control function

1) Communication devices that support Smart extension Service are as follows.
- Extension driver: XGL-DBDT / DBDF / DBDH
- Smart I/O expansion: XEL-BSSRT / BSSRF / BSSRH
- Smart I/O block: GEL-TR4C1 / DT4C1/D24C/RY2C / AV8C / AC8C / DV4C / DCAC/ TRAC / DT4C
- Inverter Option B/D: CE-S7TM1
2) Protocols for communication between Ethernet modules and Communication devices are RAPIEnet v2 and
EtherNet / IP.
Smart extension service using RAPIEnet protocol is not supported when RAPIEnet setting of Ethernet (FEnet)
module is set to RAPIEnet v1.
3) Functions such as setting and controlling a PLC equipped with a communication device.
- Station number setting of Communication device is available to set remotely from Ethernet module (client) only if
station number switch of communication device is '00".
For details on setting station No. of communication device, refer to the communication device manual.
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4.2 Smart extension service setting

Smart Extension service can be easily set by selecting parameters for each item in XG5000. The setting procedure and
the function of each item are as follows.

4.2.1 Standard settings

Smart Extension service operates according to the Standard Settings of Ethernet (FEnet). The following describes the
Ethernet standard settings parameter for Smart Expansion service.

(1) Station No

Standard Settings - FEnet *
Basic Settings  Host Table Settings  Sets EIP Server
TCP/IP Settings
saono: B ]
Media: Port1: |AUTO w
Port2: |AUTO
IP address: [ 192 68 . 1 2|
Subnet Mask: [ 285 . 28 255 0]
Gateway: | 1592 168 . 1 1 |
DNS Server: [0 . 0o . 0 1]
[JDHCP [JRelay [JoPC UA
No. of Dedicated (1-18)
Connections:
Receive Time Out Settings
Client: seci2-255)
Server: sec(2 - 255)
Driver Setting
Server Mode: XGT server ~
RAPIEnet Settings: | RAPIEnet v2 ~
Canc

In the Smart extension service, the station number is used as the station number of Ethernet (master) when using
RAPIEnet protocol communication with the Communication device.

(2) RAPIEnet setting

The operation varies depending on the RAPIEnet setting in the driver setting item of the Standard Settings.
EtherNet / IP protocol can be used regardless of RAPIEnet setting.

RAPIEnet setting

Smart extension service operation

Disable

RAPIEnet protocol is not used.
- If set to Disable, RAPIEnet protocol cannot be used to connect communication devices
in Smart extension service, and only Ethernet / IP protocol can be used.

RAPIEnet v1

RAPIEnet v1 is used. (Same as the existing LSIS RAPIEnet.)
- If set to RAPIEnet v1, RAPIEnet protocol cannot be used to connect communication
devices in Smart extension service, and only Ethernet / IP protocol can be used.

RAPIEnet v2

RAPIEnet v2 (IEC Standard) is used.
- When set to RAPIEnet v2, RAPIEnet and Ethernet / IP protocols can be used for
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connection of Communication devices in Smart extension service.
- If RAPIEnet protocol is used in Smart Extension service, ring configuration and High
Speed communication between own networks are possible.

4.2.2 Smart extension service

(1) Click the [Project] tab on the left project window and select by right clicking on the communication module item on
the tree.

Project * 0 x NewPLC x

w HF XGK-CPUUN_TEST*
v@ Metwork Configuration

" v ) Undefined Network

[ % System Variable By
v i) NewPLCIXGK-CPUUN)-STO

- - Add Item L4 Smart Extension
29 Variable/Comment
v--@ Parameter Copy Ctri=C Network
Basic Parameter B Paste Ctrl=V Communication Module
E /O Parameter X Delete Delete P2P Communication
= E Local Ethernet Param . High-speed Link Communication
v-- Scan Program = Properties...
- . Use e
AN B c ation Modute et o ) R User Frame
: NewBLC ommunication Module Setting and Diagnosis Add a Group
Add Slave
Views Connection

(2) If you want to use the Smart Extension Wizard to set up the Smart extension service, select "Next" in the
[Overview] window of the Smart extension Wizard.

Overview x

Setting for starting Smart extension service
For using Smart extension service, it is necessary to set the extension base and device memory setting
for input / output refresh.

[4] Overview

[2] Detailed setting
[3] PLC area settings.

< Ba

(3) If you select “Next” in the [Overview] window of the Smart Extenstion Wizard, the [Details] window appears. Smart
extension service setting such as communication device adding and setting and PLC area setting can be performed.
However, | / O parameter setting must be made after setting communication device.
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Details

Mo, of Communication Devices:

EIE

(1~63) Autoscan

EBMNo.| Module type

Module Name

Station [ |P address Protocol

Apply

-

Maodular XGL-DBDT

1:192.168.1.101 {RAPIEnet

Maodular KGL-DBDT

192.168.1.102 :RAFIEnet

Maodular XGL-DBDT

192.168.1.103 | RAPIEnet

FNERINNY

Maodular KGL-DBDT

oSN IC I N ]

192.168.1.104 :RAPIEnet

AR

< Back

Cancel

(4) If you do not want to add the Smart Extension service without using the Smart extension wizard, simply select
“Cancel’ in the [Overview] window of the Smart extension wizard to register the Smart extension service.
(5) After setting each item in [Details] or performing “Autoscan”, select the following. In order to proceed with “Auto
Scan’, it must be in [Online]>[Connect].

- For the module type, refer to the Communication Device User's Manual.

ltem Contents
No. of | Set the number of Communication devices to be added to the Smart extension service.
Communication
Devices
Add connected Communication devices and specify connection information
Auto scan automatically.
- Only available online.
EB No. Specify the Extension Base (EB) nhumber of the communication device to add.
Specifies the module type of the Communication device to be added.
Module type

Module Name

Specifies the module name of the Communication device to be added.
- For the module Name, refer to the Communication Device User's Manual.

Specifies the station number of the Communication device to be added.

information.

Station No - The station number range is 0 ~ 220.
- Setting station number method, refer to the Communication device User's Manual.
Specifies the IP Assigns the Communication device to be added. For the IP setting,
IP Address S g )
refer to the Communication device User's Manual.
Specifies the connecting protocol of the communication device to be added.
Available protocol information according to RAPIEnet setting of master and
Communication device is as follow
RAPIEnet settings for | Communication device | Available protocol
Ethernet(Master) RAPIEnet settings
Disable EtherNet/IP
Disable
Protocol RAPIEnet v2 EtherNet/IP
Disable EtherNet/IP
RAPIEnet v1
RAPIEnet v2 EtherNet/IP
Disable EtherNet/IP
RAPIEnet v2
RAPIEnet v2 RAPIEnet
EtherNet/IP
Apply Check the application box of the communication device that will store the connection
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(6) In [PLC area setting] window, memory setting for 'Input / Output Variable' and 'Enables EB/Slot Diagnostic
variable' is available. The address and size are automatically changed according to the communication device
added in the advanced detailed settings. (However, the memory area setting counts Smart extension service as the
highest priority. An area that overlaps with the memory area used by other services may occur.) When setting are
finished, select 'Finish'.

PLC area setting X

Input/Output Variables

Set the device memory for input [ output refresh according
to the slot information of the set EB.

Address: 1000 The memoary address and size are calculated in words.
{Atleast 1536 words required)

Area:

IIO
<

Size: 1336

Enables EB/Slot Diagniostic variables

Diagnostic
Sets device memory for diagnostic variables.
you select Provide EB | Slot diagnostic variable, you can
Address: 2535 monitor the status information of EB and slot of Smart
Expansion.

. 100 The memory address and size are calculated in words.
Size: fAtleast 54 words reauired

Area:

I D
<

< Back Cancel

Item Contents

Area Set the memory area of the master to map the input / output variables of
the communication device.

- Select between P/ M /D (XGK) and I / Q / M / W (XGI) areas.

Address | Set the memory start address of the master to map the input / output
variables of the communication device.

Input/Output Variables | Size Set the memory area'’s size of the master to map the input / output
variables of the communication device.

-The Extension driver (XGL-DBDx) requires 384 words per unit.

- The Smart I/O expansion (XGL-BSSRXx) requires 256 words per unit.

- The Smart I/O block (Digital) requires 4 words per unit.

- The Smart I/O block (Analog) requires 32 words per unit.

Enables EB/Slot | Enable /Disable the use of EB/Slot Diagnostic variables.
Diagnostic variables (System diagnostic variables are always provided regardless of the setting.)
Area Set the memory area of the master to map the diagnostic variables of the

communication device.

- Select between P/ M /D (XGK) and I/ Q / M / W (XGI) areas.

Address | Set the memory start address of the master to map the Diagnostic

variables of the Communication device.

Size Set the memory area'’s size of the master to map the Diagnostic variables

of the communication device.

- The basic diagnostic variable of Smart extension service requires 22
words.

- 8 words per 1 unit of communication device are required.

Diagnostic variables




Chapter 4 Smart Extension service

(7) To add a communication device, right-click [Smart Extension] and select [Add Item] - [Add Communication
Device] or double-click New under Smart Extension in the project window.

Project » 0 x MewPLC x
v HE XGK-CPUUN_TEST*
+ & Metwork Configuration
v . Undefined Network
v g2 NewPLC [BOSD XGL-EFMT(E)(TAG)]
v D Srart Exte
: Add Item 4

LT New
..'g System Variable

: Changes Station No/IP
w i) NewPLCXGK-CPUU

24 Variable/Commer K Delete Delete
v"@ Parame.ter @ Properties... L |
Basic Parameter
@ 1/0 Parameter I]

Project

~ B KGK-CPUUN_TEST *
v &F Network Configuration
v -] Undefined Network

~ 0 Smart Extension
i Mew
----- % System Variable
v £ NewPLC(XGK-CPUUN)-STOP
; ' Variable/Comment
v [# Parameter

-8 1/0 Parameter
- Local Ethernet Parameter
w Scan Program

----- MNewProgram

v a8 MewPLC [BOSO XGL-EFMT(B)(TAG)]

Adds Communication Device

Auto Scanning

* 0 x

(8) You can add the communication device of the Smart Extension Service by specifying the connection information
on the Connection tab of the Add Communication Device window and selecting 'OK'.

Adds Communication Device

Basic Parameter Connect

B . 0-e

Protocol Type: RAPIEnet i

IP: 192 168 . 1 .1

Module Type: ¥EL-DEDT e
Image: XGL_DBDx bmp

EDS

AGL-DBDT:Verl.1

*

Cancel
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Item

Content

EB No.

Specify the Extension Base (EB) number of the Communication device to add.

Protocol type

Specifies the connecting protocol of the communication device to be added.
Available protocol information according to RAPIEnet setting of master and
Communication device is as follow

RAPIEnet settings for | Communication device | Available protocol
Ethernet(Master) RAPIEnet settings

Disable EtherNet/IP
Disable

RAPIEnet v2 EtherNet/IP

Disable EtherNet/IP
RAPIENnet v1

RAPIEnet v2 EtherNet/IP

Disable EtherNet/IP
RAPIEnet v2

RAPIEnet
RAPIEnetv2 EtherNet/IP

Specifies the station number of the Communication device to be added.

Station No - The station number range of the Communication device is 0 ~ 220.
- Setting method, refer to the Communication Device User's Manual.
P Specifies the IP Assigns the Communication device to be added.
- Setting method, refer to the Communication Device User's Manual.
Module type Specifies the module type of the communica_tion_ device _to be added.
- For the module Type, refer to the Communication Device User's Manual.
Select the image of the communication device.
image - Use the desired photo file as the image of the communication device.
- This image is only used in the 'Configure Communication Device Connection’ function.
Select the EDS information of the communication device.
EDS . o : . . o .
information - EDS information is automatically assigned when adding a communication device and

cannot be modified.
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4.2.3 Smart Extension master setting

In the Smart expansion master setting, the master setting, PLC area setting and Communication device operation setting
can be performed. When a Communication device is added using the Smart Expansion Window or Autoscan, the start
address and size of the input / output variables and diagnostic variables in the PLC area settings are automatically set up

for the added Communication device.

However, check that there is no overlapping memory area with other services other than the Smart Extension service.

(1) Double-click [Smart Extension] added in the project window with the left mouse button.

Project

w EF KGK-CPUUN_TEST *
V@ Metwerk Configuration

v ) Undefined Metwork
~ gl NewPLC [BOSO XGL-EFMT(B)(TAG)]

v @ Smart Extension

{3 EBO1 - XGL-DEDT
{7 EBOZ - XGL-DBDF
.. EBO3 - XGL-DEDH

. EBO4 - XGL-DEOT

.. % System Variable

+ i) NewPLC(XGK-CPUUN)-STOP
Ea Variable/Comment

v [ Parameter

Basic Parameter

g 170 Parameter

[H Local Ethernet Parameter
can Program

MewProgram

-

1 x

(2) Select “Master Setting” in the Smart Extension Tree to enter the master setting and PLC area setting items.

P newProgramiProgam)  »”  LsPLC [Bos0 smart Extension] x| R

Smart Extension

i Master Setting

Communication Device Settings
.- Allocate Input/Output Variables
L Allocate Diagnestic Variables
Connection Wiew

L. EIP Cycle/Details

Master Setting

Mame:

MasterName00

Module:

XGL-EFMT(B)

Image: FEnet_XGLbmp l:l

Control Period:

Topology:

Comment:

PLC Area [WORD]

Enables EB/Slot Diagnastic Variables

@Ring

3 ms

O Line

‘Watchdog Timer: 50 ms

{Min: 50 ms)

EB Alert Settings...

Fix the allocation of I/O module’s input/output variable(64 contacts)

[] Allocate extend device's memory per slot

[]9:MX0 => 3:MWO.0 Displayed In Format
[]%IW0.0.0 => %IW0 Displayed In Format

[] Standby Communication Par...

Address Start device Size
InputOutput %MW1000 500
Diagnostic %BMW1500 100

{* Sets start address and its size for the variables used for Smart Extension *}
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device

Item Contents
Name Set the name of the Smart Expansion master module.
EB No. Set the EB number of the Smart Expansion master module.
(Default: 0 Cannot be modified)
Module type Sgt the type of the Smfalrt Expansion master module.
(Displays the communication module type.)
image Set the image of the Smart Expansion master module.
Master Set the Control Frequency of the Smart Expansion master module.
. . - The Control Frequency means the communication cycle between
Setting Control Period . -
the expansion master (Ethernet) module and the communication
device (Expansion driver, Smart | / O expansion, Smart | / O block).
Set the time that frame of communication device should be received
Watchdog timer according to Control Frequency. If the frame of communication device is
not received in the Control Frequency, communication error occurs.
Topology Sets the topology information to be compared in RAPIEnet autoscan.
Description Make comments related to the Smart Expansion Master.
Set the items that activate the extension EB waming.
- Extension EB configuration error
- Dropping error during extension EB operation
EB Alert Settings - Extension EB refresh response timeout
- Receiving extension EB CRC error frame
- Module installation error in EB during extension EB operation
- Fuse error in module installed in extension EB
Enables EB/Slot Check “Enable EB / Slot Diagnostic variables” when using EB / Slot
Diagnostic variables | diagnostic variables.
Fixed allocation of I / | The number of Smart | / O block type contact points and the number of |
O module / O module contacts added to the Smart | / O extension type is fixed to
input/output 64 points, or it is provided with a function to allocate the number of
variables(64 points) | mounted | / O modules gradually. (At least 32 points)
PLC area Memory aIIocatiQn by | It provides the function of aIIoca'Fing the memory of thg Smart1/ O plock
setting slot of expansion type and the Smart | / O expansion type as a base unit or a slot unit.

Display % MX0 =>%
MWO0.0

When it is created as an XGI/R project, it provides the function of
displaying the BOOL type in WORD form in the input / output variable
allocation window and the diagnosis variable allocation window of the
Smart | / O expansion type.

%IWO0.0.0 => %IW0
Displayed in Format

When created as an XGI/R project, it provides the function to change |,
Q direct variable expressions for the extended base.

Standby
Communication
participation

When created as an XGR project, configure whether the standby
module participates in communication.

Input/Output
Variables

Setting the input / output variable of the Communication device.
(The size of the variable is the starting address plus the size.)

Diagnostic variables

Set Smart Expansion diagnostic variables.
(The size of the variable is the starting address plus the size.)

In case of Control Frequency, set more than 3 times of CPU scan cycle.
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(3) Address assignment to input / output modules

Address assignment to input / output modules has a function that can be individually set. For modules with inputs and

outputs, each can be set by specifying it in the form of 'input address / output address'.
It is available only when 'Memory allocation by slot of expansion device' is selected.

[When set to default]

Format: Decimal - [Variable Settingl ’ Synchronize
EB No. Station No/IP Slot number Variable name Type Device Monitor value Comment &
= XGF-AV8A (AD Voltage Inp
1 |EBO1 1 Slot00 Type(8 Channels))
2 _0000_EB01_0000_ERR BOOL %MX16000 Analog Input Module: Error
3 _0000_EBO1_0000_RDY BOOL %MX16015 Analog Input Module; Read
4 _0000_EBO1_0000_CHO_ACT BOOL %MX16016 Analog Input Module; CHO .
5 _0000_EBO1_0000_CH1_ACT BOOL %MX16017 Analog Input Module; CH1.
6 _0000_EBO1_0000_CH2_ACT BOOL %MX16018 Analog Input Module: CH2.
7 _0000_EBO1_0000_CH3_ACT BOOL %MX16019 Analog Input Module: CH3.
8 _0000_EBO1_0000_CH4_ACT BOOL %MX16020 Analog Input Module: CH4 .
[When input is set to% MW1000 and output is set to% MW2000]
Format: Decimal - ’ Variable Setting } ’ Synchronize I
Station No/IP Slot number Variable name Type Device Monitor value Comment "N
= = XGF-AVBA (AID Voltage Input
1 1 Slot00 %MW1000 Type(d Channels))
2 _0000_EB01_0000_ERR BOOL %MX16000 Analog Input Module: Error Flag
3 _0000_EBO01_0000_RDY BOOL %MX16015 Analog Input Module: Ready Flag
4 _0000_EB01_0000_CHO_ACT BOOL %MX16016 Analog Input Module: CHO Activatio
5 _0000_EBO1_0000_CH1_ACT BOOL %MX16017 Analog Input Module: CH1 Activatio
6 _0000_EB01_0000_CH2_ACT BOOL %MX16018 Analog Input Module: CH2 Activatio
7 _0000_EBO01_0000_CH3_ACT BOOL %MX16019 Analog Input Module: CH3 Activatio
8 _0000_EB01_0000_CH4_ACT BOOL %M} 16020 Analog Input Module: CH4 Activatio
n nANN CONn4 ANAN AR ANT [=Tatall LAV A RNDA Analan lnnid Madolas CUE Actoatin

(4) Select "Communication Device Settings" from the Smart extension tree to set the Communication
operation setting.

Y S m s o I

Srart Extensicn - cation Device Setti
. ommunication Device Settings
Master Setting <

-iCommunication Device Settings; Sets All I/O parameters Standard Input Filter: | 3 T ms

-- Allocate Input/Output Variables
Allocate Diagnostic Variables
-- Connection View

Settings Setting Detailed description
Run CPU-=Continue - Set Continue output when stopped
output when stopped Unset: Clear output when stopped
- EIP Cycle/Details Keep output when a CPU
or communication device r
SITOr 0CCUrS

Set Keep output
Unset: Clear output

Set: Continue running when breakdown occt
resolved return to normal operation

Unset: Error when breakdown

Use redundant power [~ :Sets when use redundant power

Keep input when a
communication device
ITor 0CCUrs

Exchange EB or modules o
while running(hot swap)

- SetKeepinput
Unset Clear input

4 4

* Supports all EB hot swap, module hot swap supports only Extension driver device

** Supports Extension driver device only

stELE CTRIC

device
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Chapter 4 Smart Extension service

ltem

Contents

Sets all I/O parameters

Set all | / O parameters of the PLC equipped with the
Communication device. Detailed setting is as follows.

Standard input filter

Set standard input filter value of input module installed in

Communication device. If you change the value, the filter

value of the input modules installed in the Communication
device is changed to the set value.

Hold output when
converting run-> stop.

When the CPU mode is changed from run to stop, this is the
setting for the output of the output module installed in the
Communication device in Smart Extension.

- setting: Hold output

- Non-setting:Clear output

Hold output when CPU
or Communication
device error occurs

Communication

When an error occurs in the CPU or Communication device,
it is the setting for the output of the output module installed
in the Communication device in the Smart extension.

- Setting: Hold output when an error occurs

- Non-setting: Clear output when an error occurs

Device Settings

EB or module swap
during operation (hot
swap)

Setting to allow the exchange of EB (PLC with
communication device) or module mounted in EB during
operation.

- Setting: Continue operation when a fault occurs and
normal operation when a fault is restored

- Non-setting: Change to error mode when a fault occurs

Use redundant power

Check if the redundant power base is used for the PLC
equipped with the communication device. If you use this
option, check various logs of power redundancy base and
get LED information according to the operation.

- Setting: Use redundant power base

- Non-setting: Use single power base

Maintain input when a
communication device
error occurs

This is a setting for maintaining input data values in smart
expansion when an error occurs in a communication device.
- Settings: Maintain input data when an error occurs

- Not set: Clear input data when an error occurs

(5) Sets all I/O parameters

Select [Sets all I/O parameters] of Communication device operation setting during master setting.

Communication Device Settings

E Sets all 1/O parameters i

Standard Input Filter | 3 ~ ms

Select the module to which the parameter will be applied in batch, set the parameter and select 'Apply

4-11




Chapter 4 Smart Extension service

Apply All >

XGI-A12A (AC 110V Input, 16 Contact

XGOQ-RY1A (Relay Output, 8 Contacts. Module: XGQ-RY 14
¥GQ-RY 1D (Built-in diagnostics, Relay (
XGQ-552A (Triac Output, 16 Contacts
¥GO-TRIC (Transistor Output, 8 Conte Channel | Emergene i ipoh
XGQ-TR4A/E (Transistor OutpUt, 32 Ce Channel 00 [00-07) Clear
¥GQ-TR8A/B (Transistor Output, 64 Cx|

oy =]

Check the location (Smart Extension EB, BASE, SLOT) of the module to apply in batch and select 'OK’

It is not applicable to each module individually, but the setting values are applied to all modules at once.)
Check apply all >

Press the [OK] button to change all the parameters of the module below.

PLC/name Module Location
EBOO BOO, S00
EBO1 B00, 500

o |[Coma ]

Use with caution because the set values of the same module in the Smart Expansion System are set to be
the same.

(6) Select [Smart Extension] in the Project window and double-click to select [Allocate Input/Output Variables] in the
Smart Extension tree. This function can be used like the same PLC system by mapping input / output device of PLC

system equipped with Communication device to device memory of CPU module equipped with Ethernet (FEnet)
module



Chapter 4 Smart Extension service

~ HP KGK-CPUUN_TEST*
v & Network Configuration
v i Undefined Network
v % NewPLC [BOSD XGL-EFMT(B)(TAG)]
« @ Smart Extension
- EBO1 - XGL-DEDT
- EBO2 - XGL-DBDF
P EBO3 - XGL-DBDH
..{fD EBO4 - XGL-DBDT
& System Variable
v -ff) NewPLC(XGK-CPUUN)-STOP
P4 Variable/Comment
~ [#% Parameter
Basic Parameter
& 1/0 Parameter

-Srart Extension

... Master Setting

Comrmunication Device Settings
Allocate Input/Output Variables
Allocate diagnostic variables
Connection View

- EIP Cycle/Details

----- H Local Ethernet Parameter
~ [&] Scan Program
.fF] NewProgram

(7) In the [Allocate Input/Output Variables] window, check the input / output devices of the PLCs equipped with each
Communication device. At this time, select “Register Variable” to register the device as a variable.

W emsmagan 5 e s s seerors |

Srnart Extension
. Master Setting Format: Hexadecimal ~
- Communication Device Settings - - -
- [Allocate Input/Output EB No. Station No/IP Slot number Variable name Type Device Monitor value Comment
1 |EBO1 =01 Slat00 =]
i Allocate diagnestic variables
H _0000_EBO1_RQ00 LWORD %ML250 Output address 00 ~ 63
i Connection Yiew =
: 3 _0000_EB01_RQO0P0OD BOOL %6MX16000 Output address 00
i EIP Cycle/Details —
4 _0000_EBO1_RQO0POA BOOL %MX16001 Output address 01
5 _0000_EB01_RQOOPO2 BOOL SeMX16002 Output address 02
B _0000_EB01_RQOOPO3 BOOL SMX16003 Output address 03
7 _0000_EB01_RQO0P04 BOOL S6MX16004 Output address 04
8 _0000_EB01_RQOOPOS BOOL SMX16005 Output address 05
9 _0000_EB01_RQO0OFP06 BOOL S6MX16006 Output address 06
10 _0000_EB01_RQOOPO7 BOOL SMX16007 Qutput address 07

(8) If you double-click [Variable / Comment] in the [Project] window, you can see that the Smart Extension input /
output variable is registered as the CPU variable of the master.

Project « 3 x NewProgram ]' NewPLC [BOS0 Smart Extension] % ]' MewPLC [BOS0 EBO1 - XGL-DBDT] /r/ Variable/Comment x
v EF KGK-CPUUMN_TEST* 5 . 1
v@ Metwork Configuration ﬂ\‘iﬂ\faﬂdﬂe lﬂ‘.liewDeuce EMFM l
v A Undefined Network Variable Type Device Used | HMI Comment
v éi'-b MewPLC [BOSD XGL-EFMT(B)(TAG)] 1 _0000_EBD1_DO:BIT DO01000.0 r [T Analog Output Module: CHO Error
v D Smart Extension 2 _0000_EBO1_0O0:BIT 00010001 r [T | Analog OQutput Module: CH1 Error
L New 3 _0000_EBO1_00:BIT DO01000.2 r [T | Analog Output Module: CH2 Error
£ EBO1 - XGL-DBDT 4 _0000_EBO1_00:BIT D001000.3 r [T Analog Qutput Module: CH3 Error
{1 EBO2 - XGL-DEDF 5 _0000_EBO1_00:BIT Do01000.4 r [ | Analog Output Module: CH4 Error
£ EBO3 - XGL-DBDH 6 _0000_EBO1_00:BIT D001000.5 r [ | Analog Output Module: CHS Error
.7 EBOM - XGL-DBOT 7 _0000_EBOD1_00:BIT DO01000.6 r [~ Analog Output Module: CHB Error
..... %. System Variable 2 _D000_EBO1_0O:BIT DOo01000.7 r [T | Analog Output Madule: CH7 Error
v -l NewPLCIXGK-CPUUN)-Offline 9 _0000_EBD1_DO:BIT DO01000.F r [T Analog Output Module: Ready Flag
%3 Variable/Comment 10 _D000_EBO1_0O:BIT Doo1001.0 r [T | Analog Output Module: CHO Activation Status
v [ Parameter 11 _0000_EBO1_00:BIT DO01001.1 r [~ Analog Output Module: CH1 Activation Status
Basic Parameter 12 _0000_EBO1_0O:BIT Doo01001.2 r [~ | Analog Output Module: CH2 Activation Status
E /0 Parameter 13 _0000_EBO1_00:BIT Do01001.3 r [T | Analog Output Module: CH3 Activation Status
[ Local Ethernet Parameter 14 _0000_EBD1_DO:BIT DO01007 .4 r [~ Analog Output Module: CH4 Activation Status
v Scan Program 15 _0000_EBO1_00:iBIT DO01001.5 r [~ Analog Output Module: CH5 Activation Status
“..[#] MNewProgram 16 _0000_EBO1_DO:BIT DO01001.6 r [~ | Analog Output Module: CHB Activation Status
17 _0000_EBO1_00:BIT Doo1001.7 r [T | Analog Output Module: CH7 Activation Status
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Chapter 4 Smart Extension service

The variable name rules for input / output variables are as follows

(1) /O Module
_BBSS_EBXX_RQxxPyy: Base number on which the master module is mounted
_BBSS_EBXX_RQxxPyy: Slot number on which the master module is mounted
_BBSS_EBXX_RQxxPyy: EB number of the Communication device
_BBSS_EBXX_RQxxPyy: Input / Output division(RQ:Output / RI: Input)
_BBSS_EBXX_RQxxPyy: Slot number of the module mounted on the Communication device
_BBSS_EBXX_RQxxPyy: Contact No.

(2) Special module
_BBSS_EBXX_bbss_CHO_ACT: Base number on which the master module is mounted
_BBSS_EBXX_bbss_CHO_ACT: Slot number on which the master module is mounted
_BBSS_EBXX_bbss_CHO_ACT: EB number of the Communication device
_BBSS _EBXX_bbss CHO_ACT: Base number of the module mounted on the Communication device
_BBSS _EBXX_bbss CHO_ACT: Slot number of the module mounted on the Communication device
_BBSS EBXX bhss CHO ACT: Variable type

(9) Select [Smart Extension] in the [Project] window and double-click to display [Allocate diagnostic variables] in the

Smart Extension tree.

v-@ XGK-CPUUN_TEST* -Smart Extension T
v &5 Network Configuration i
v -] Undefined Network
v 59?, MNewPLC [BOSD XGL-EFMT(B)(TAG)]

i Master Setting

Communication Device Settings
Allocate Input/Qutput Variables
Allocate diagnostic variables
Connection View

- XGL-DBOT - EIP Cycle/Details
- XGL-DBDF

- XGL-DEDH
- XGL-DEDT

----- & System Variable

v ) NewPLC(XGK-CPUUN)-Offline
----- 9 Variable/Comment
v@ Parameter

Basic Parameter

[ 1/0 Parameter

E Local Ethernet Parameter

w -[&] Scan Program

----- NewPrograrm
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(10) Diagnostic variables are as follows

Classification

Item

Type and Size

Contents

Number of Smart Expansion Network
Status changes
1) When using RAPIEnet V2 and changing

_BBSS_STATUS_CHG_CNT 1Word(2Byte) the network topology, count increases.

2) When changing error status or warning
status by smart extension EB, count
increases

Smart  Expansion Maximum Scan
time(100 4s)

_BBSS_SCAN_MAX 1Word(2Byte) (If all the protocol types of EB participating
in the service are EtherNet/IP, the value
of'_BBSS_SCAN_MAX'is not valid.)
Smart Expansion Minimum Scan
time(100 4s)

_BBSS_SCAN_MIN 1Word(2Byte) (If all the protocol types of EB participating
in the service are EtherNet/IP, the value
of'_BBSS_SCAN_MIN'is not valid.)

Smart Expansion Current Scan
time(100 4s)

_BBSS_SCAN_CUR 1Word(2Byte) (If all the protocol types of EB participating
in the service are EtherNet/IP, the value
of_ BBSS_SCAN_CUR'is not valid.)

~BBSS SYSTEM ER 1Bit Smart Extension overall EB error

_BBSS_SYSTEM_WAR 1Bit Smart Extension part EB error

_BBSS_EB_DEER 1Bit EB detached while operating Smart
Extension

~BBSS EB BASE INFO ER 1Bit Smart Extension base information error

BBSS 10 _TYER 1Bit Smart Extension I/O Type error
) BBSS 10 DEER 1Bit Smart Extension I/O detached error

System diag ~BBSS FUSE_ER 1Bit Smart Extension 1/O Fuse error
Smart Extension I/O refresh time out

_BBSS_REF_TIME_OUT 1Bit (For V9.10 and above, On when it occurs
twice in a row)

. Smart Extension EB CRC Error Frame

_BBSS_EB_CRC_ER 1Bit Receive

BBSS TAG_ER 1Bit Smart Extension tag inconsistency error
~_BBSS EB CFG ER 1Bit Smart Extension EB configuration error
. EB detached warning while operating

—BBSS_EB_DETACH_WAR 1Bit Smart Extension operation(Hot swap On)

_BBSS_IO_DETACH_WAR 1Bit 10 detgched warping while operating Smart
Extension operation(Hot swap On)

. FUSE warning while operating Smart

_BBSS_FUSE_WAR 1Bit Extension operation(Hot swap On)

BBSS EIP_BLOCK_SVC _ER 1Bit All EtherNet/IP block services are error
BBSS EIP_BLOCK_SVC WAR 1Bit Some of EtherNet/IP blocks is(are) error
BBSS STANDBY_COMM_EN 1Bit Standby Communication Participation
_BBSS_SATATUS_CHG_CNT_CLR | 1Bit Smart Expansion Network Status change
number initialization
. Smart Extension refresh time out
_BBSS_REF_TIME_OUT_CLR 1Bit initialization
BBSS EB CRC ER CLR 1Bit Sma_rt I_E)_(t_en_siop EB CRC Error Frame
- - - - - receive initialization
. Smart  Extension  scan information
_BBSS_SCAN_CLEAR 1Bit initialization
. Smart Extension flag information
_BBSS_ FLAG_CLEAR 1Bit initialization
BBSS EB ER Bit Array(0~64) Error Status by Smart Extension EB
BBSS EB_WAR Bit Array(0~64) Warning Status by Smart Extension EB
BBSS EBXX_CFG_ER 1Bit EB configuration error
EB Diagnostic ~_BBSS EBXX DEER 1B?t Detached while operaping EB
Diagnostic | variables of BBSS EBXX_ REF TIME_OUT 1B!t EB re_fresh response timeout
variables EB status BBSS EBXX P1 CRC_ER 1Bit Receive CRC error frame at EB port 1
’ BBSS EBXX P2 CRC_ER 1Bit Receive CRC error frame at EB port 2
_BBSS EBXX BASE INFO _ER 1Bit EB Base information error
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BBSS EBXX IO TYER 1Bit EB /O type error
_BBSS EBXX IO _DEER 1Bit EB I/O detached error
_BBSS _EBXX FUSE _ER 1Bit EB Fuse error
_BBSS_EBXX_SYY_IO_TYER 1Bit Module I/O type error
_ _ _BBSS_EBXX_SYY_IO_DEER 1Bit Module I/O detached error
Diagnostic BBSS EBXX SYY FUSE ER 1Bit Module Fuse error
variables . Communication service New Data Ready
by slot _BBSS_EBXX_SYY_SVC_NDR 1Bit (EtherNet / IP block service only)
. Communication Service error
_BBSS_EBXX_SYY_SVC_ER 1Bit (EtherNet / IP block service only)

The variable name rules for diagnostic variables are as follows

(1) System diagnostic variables
_BBSS_STATUS_CHG_CNT: Base number on which the master module is mounted
_BBSS_STATUS_CHG_CNT: Slot number on which the master module is mounted
_BBSS_STATUS_CHG_CNT: variable type

(2) EB Diagnostic variables
_BBSS_EBXX_CFG_ER: Base number on which the master module is mounted
_BBSS_EBXX_CFG_ER: Slot number on which the master module is mounted
_BBSS_EBXX_CFG_ER: EB number of the Communication device
_BBSS_EBXX_CFG_ER: variable type

(3) Slot Diagnostic variables
_BBSS_EBXX_SYY_IO_TYER: Base number on which the master module is mounted
_BBSS _EBXX_SYY_IO_TYER: Slot number on which the master module is mounted
_BBSS_EBXX_SYY_IO_TYER: EB number of the Communication device
_BBSS_EBXX_SYY_IO_TYER: Slot number of the module mounted on the Communication device
_BBSS_EBXX_SYY_IO_TYER: variable type

When _BBSS_EBXX_P1 CRC_ER is set, it means CRC error frame is received in the corresponding EB port. Check the
communication cable, noise in the communication environment, and cable connection.

(11) Select [Smart Extension] in the [Project] window and double-click to select [Connection View] in the Smart
Extension tree. Smart Extension service provides Connection View function to check the configuration of
connected Communication device. “Connection View” 'function allows to check the name, protocol, station number,
IP and communication status of the currently connected Communication device and EIP module.

w B HGK-CPUUM TEST*

v EF Metwork Configuration
~ ) Undefined Metwork

v -0 NewPLC [BOSO XGL-EFMT(B)(TAG)]
art Extension

- Smart Extension

Master Setting
- Communication Device Settings
- Allocate Input/Cutput Variables
- Allocate diagnostic variables

- XGL-DBDT
- XGL-DBDF
- XGL-DBDH
- XGL-DBOT

% System Variable
~ f] NewPLC(XGK-CPUUN)-Offline

Parameter

Basic Parameter

T 1/0 Parameter

T Local Ethernet Parameter
Scan Program

..[H MewProgram
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Smart Extension
.- Master Setting

i Communication Device Settings MasterName00
i Allocate Input/Output Variables EBOO XGL_'EFMT(_B}
E--A\In(ate diagnestic variables Station No.: 0

H . IP address: 192.168.1.2
i-- Connection View

" EIP Cycle/Details
. SlaveMame01
= XGL-DBDT
EB01 Ium Protocol: RAPIEnet

Station number: 1

SlaveMName02

i XGL-DBDF
EEIUE lum Protocol: RAPIEnet

Station number: 2

SlaveMame03

i XGL-DBDH
an lﬂm Protocol: RAPIEnet

Station number: 3

SlaveMame04

i XGL-DBDT
EE'M Iﬂm Protocol: RAPIEnsat

Station number: 4

(12) Select [Smart Extension] in the [Project] window and double-click to select [EIP Cycle/Details] in the Smart
Extension tree. In the EIP Cycle/Details, check the list of EIP clients currently configured. (EIP server list is not
available.)

v HF XGK-CPUUN_TEST*
v % Network Configuration
v i Undefined Network
v g NewPLC [BOSD XGL-EFMT(E) (TAG)]
v M Smart Extension
LS Mew
7 EBOT - XGL-DBOT
T EBO2 - XGL-DEDF
T EBO3 - XGL-DEDH
... EBO4 - XGL-DEDT

(13) Check the list and detailed settings of the EIP client in the EIP Cycle/Details window.

|-Smart Extension

L. Master Setting
~Communication Device Settings
-Allocate Input/Qutput Variables
-Allocate diagnostic variables

Connection View
IP Cycle/Details]

Smart Extension
- Master Setting ‘
Communication Device Settings
- Allocate Input/Output Variables
Allocate diagnostic variables
- Connection View

Transmission |

pedins] Timeout ‘ Data Type Local tag

todule kind | Operation mode. | 140 type: ‘ Cannection type | Function | Parameter contents ‘ Canditional flag
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(14) RAPIEnet autoscan topology change display function(V8.0 or higher)

This function displays the changed information on the screen when the topology information set by the user and the
installed topology information are different in RAPIEnet Auto Scan.

To set the topology information, you can set it in [Undefined Network]> [Smart Extension]> [Master Settings]> [Topology
Configuration] in the project window.
Project » 0 x
v &5 PLCTP2PO2*
v 2 Network Configuration
. v Undefined Network
v ﬁ, MewPLC [BO51 XGL-EFMTIBITAG)]

e & System Variable

v ()l NewPLC(XGK-CPUE)-STOP
E e ST T T P S L

-Smart BExtension

: - Master Settin
i~ Master Setting d

i Communication Device Settings Mame: | MasterMName00

i Allocate Input/Output Variables

. . . EE Mo.: 0

i Allocate diagnostic variables

Connection View Module: XGEL-EFMT(E) L

i EIP Cyclef/Details
Image: FEnet_XGL.bmp
Control Frequency: 3| ms Watchdog Timer: ms
Topology Configura (@) Ring ) Line {Min: 50 ms)

Comment:

Executing RAPIEnet autoscan in [Online]> Communication module setting and Diagnosis] and diagnosis> [System
diagnosis].

SEP-xxxx

O -

NGL-
XGK-CPUE XGO-TR2x * ppyrp ¥GI1-D21A XGQ-TR2x XGH-DTAA

Detailed Module Information...
Status By Sermvice...

Media Information...

Autoscan...
System Log...
Ping Test

RAFIEnet media information

Ethernet Autoscan
RAPIEnet Autoscan
EtherMet/IP Autoscan

RAPIEnet+ Autoscan

If setting topology information and the installed topology information is different, a red line indicates that the topology has

been changed as shown below.

Topology Configura (®) Ring

(CiLine

LSE ecrric | 4-18
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® ] RAPIEnet+ Autoscan

[Base {o { Link type | RAPERet+ {RAPERetno. |3

| Siot LK) | Topology { RING I Station Colisio | Empty

<

| Add: Delete: Change:
| connect cab Disconnect Load

The opposite case is indicated by a blue line.

® " RAPIEnet+ Autoscan

Base o Link type RAPIEnet+ RAPERet No. 4

Siot 1 Topology RING Station Collisic ] Empty

£

Add: Delete: Change:
Connect cab Disconnect
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424

Communication device setting

Set up the Communication device remotely. However, remote setting of station number and IP address is impossible

except for special cases.

(The station number and IP address of the communication device can be remotely set using the 'Station No./IP Change’
function only when the station number switch of the Communication device is’ 00’.) Setting method, refer to the
Communication Device User's Manual.

(1) In the project window, select the [Smart Extension]-> Extension driver and double-click it.

Project * B x
~ HE {GK-CPUUN_TEST*
v #E Network Configuration
w i) Undefined Network
v g% NewPLC [BOSO XGL-EFMT(B)(TAG)]
v P Smart Extension

- XGL-DBDT
- XGL-DBDF
: - XGL-DBDH
(D EBD4 - XGL-DEDT
B System Variable
~ i) NewPLC(XGK-CPUUN)-STOP
Ej Variable/Comment
v [ Parameter
| Basic Parameter
& 170 Parameter
[H Local Ethemet Parameter
v {8 Scan Program
{37 NewProgram

(2) In [Basic Parameter] of the [Sets Communication Devices] tree, Set the name and operation setting of

Communication device

i Connect

=J- Sets Communication Device

- Basic Parameter

: - 1/0 Parameters

2. Communication device Informat

.. Smart extension variables

Marne: |SlaveNameD1

Comrmunication Device Settings

Enables Master Cormunication Device

Settings Setting
Run CPU-=Continue r
output when stopped
Keep output when an
eITOr OCCUrS

Detailed description
Set Continue output when stopped
Unset Clear output when stopped

Keep output when an error occurs

Set Continue running when breakdown occt
resolved return to normal operation
Unset: Error when breakdown

Sets when use redundant power

while running(hot swap)

r
Exchange EB or modules

" r

i

Use redundant power

< >

* Supports all EB hot swap, module hot swap supports only expansion driver device
** Supports expansion driver device only

converting run-> stop.

Iltem Contents
Name Set the nhame of the Communication Device.
Set the Communication | Check this if you want to automatically reflect the master set values as the
device operation of the | Communication device operation set values.
master

When the CPU mode is changed from run to stop, this is the setting for the output
Hold output when | of the output module installed in the Communication device in Smart Extension.

- Setting: Hold output when switching from run to stop
- Non-setting: Clear output when switching from run to stop

Hold output when CPU or
communication device
error occurs.

When an error occurs in the CPU or Communication device, it is the setting for
the output of the output module installed in the Communication device in the
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Smart extension.

- Setting: Hold output when an error occurs

- Non-setting: Clear output when an error occurs

Setting to allow the exchange of EB (PLC with communication device) or module
mounted in EB during operation.

- Setting: Continue operation when a fault occurs and normal operation when a
fault is restored

- Non-setting: Change to error mode when a fault occurs

Check if the dual power base is used for the PLC equipped with the
communication device. If you use this option, check various logs of power

Use dual power base redundancy base and get LED information according to the operation.

- Setting: Use dual power base

- Non-setting: Use single power base

EB or module swap during
operation (hot swap)

(3)In [I / O Parameter] of [Communication device setting] tree, | / O parameter setting of PLC equipped with
communication device can be set. When a communication device is added using auto scan, parameter information
of the I / O module installed in the PLC is automatically set.

HGT

RUN
RING
RELAY [
CHR
FAULT

ERR
LINK1

hd
=7 Base 00: Default Apply Current Consumption
-y Slot 00 : XGF-DVEA (D; _ _
- & Slot 01 : XGF-AD4S (Isq Slot Madule Camment Input Filter Emergency Output |nput info. Output Infarmation
1 & Slot 02 : XGO-TRAAE 1] AGF-DVWEA D44 Voltage Output Type(8 Chan - -
= Slot 03: Default 1 HGF-AD45 (Isolated-type analog Input Type(4 -
= Slot 04 Default 2 HGO-TR4A/E (Transistor Output, 32 Contacts - Drafault
= Slot 05 Default El
o Slot 06 : Default 4
-z Slot 07 : Default 5
ez Slot 02 : Default g
e Slot09: Default 7
= Slot 10: Default g
= Slot 11: Default =
1
Item Contents
Module Select the module mounted on the communication device.
Description write a comment
- Select the comment cell you want to last with the left mouse button and create it.
- The comment is not stored in the communication module.
Input filter Select an input filter value. (Input module/input and output module)
Emergency output | Emergency output can be set. (Output module/input and output module)
Input The Communication device does not support the function of checking input
information/Output | information/ output information.
information

(4) In [Connect] of the [Sets Communication Devices] tree, check the connection information with the Communication
device.

Please refer to 4.3.2 Smart Expansion Service for setting items.
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W e e o seowon -

E| S:ets Communication Device EE Mo.:
i .. Basic Parameter

|/ Parameters Protacal Type!  |RapiEnet ~

= Communication device Informat Station Mo :

(-
(0=

-]

. Smart extension variables IP: 192 168 . 1 .M
Module Type: XGL-DBDT
Irmage: XGL_DBDx bmp
EDS XGL-DBDT:Verl.1 |

(5) In [Smart extension variables] of [Sets Communication Device] tree, check the module variable set in [I / O

Parameters].

W e 7 e e o ecomn > I

= Sets Communication Device

‘... Basic Parameter Slot ariable name Type Options Comment
170 Parameters 1 g B

&- Communication device Informat 2_ _00_CHO_ERR BIT UB0.0 Analog Output Module: CHO Error
3 _00_CH1_ERR (BIT UB0.1 Analog Output Module: CH1 Error
4_ _00_CH2Z_ERR BIT UB0.2 Analog Output Module: CHZ Error
5_ _00_CH3_ERR BIT UB0.3 Analog Output Module: CH3 Error
6 | _00_CH4_ERR BIT UB0.4 Analog Output Module: CH4 Error
7| _00_CHS_ERR | BIT UB0.5 Analog Qutput Module: CHS Error
B_ _0D0_CHE_ERR BIT UB0.6 Analog Output Module: CHE Error
El _0D0_CHY_ERR BIT UB0.7 Analog Output Module: CHY Error
10 | 00 _RDY BIT UB17 Enaiog Output ioduie: Ready Fiag
T _0D0_CHO_ACT BIT UB2.0 Analog Output Module: CHO Activation Status
F _0D0_CH1_ACT BIT UB2.1 Analog Output Module: CH1 Activation Status
13 | _00_CHZ_ACT (BIT uB2.2 Analog Output Module: CH2 Activation Status
T _D0_CH3_ACT BIT UB2.3 Analog Output Module: CH3 Activation Status
? _0D0_CH4_ACT BIT UBz2.4 Analog Output Module: CH4 Activation Status
16 | _D0_CH5_ACT BIT uUB2.5 Analog Output Module: CHS Activation Status
17 | _00_CHE_ACT BIT UBZ2.6 Analog Output Module: CHE Activation Status
? _D0_CHY_ACT BIT UB2.7 Analog Output Module: CH7 Activation Status
19 | _0D0_CHO_QUTE BIT UB4.0 Analog Output Module: CHO Output Enable
20 | _00_CH1_OUTE BIT UB4.1 Analog Output Module: CH1 Output Enable
? _00_CHz_OUTE BIT UB4.2 Analog Output Module: CHZ Output Enable
? _0D0_CH3_OUTE BIT UB4.3 Analog Output Module: CH3 Output Enable
123 | _00_CH4_OUTE BIT UB4.4 Analog Output Module: CH4 Output Enable
124 | _00_CH5_OUTE BIT UB4.5 Analog Output Module: CH5 Output Enable
? _D0_CHE_OUTE BIT UB4.6 Analog Output Module: CHE Output Enable
26 | _D0_CHY_OQUTE BIT UB4.7 Analog Output Module: CHT Output Enable

not supported.

- /O Module

_RQxxPyy: contact No.

- Special module

bbss CHO ACT: Variable type

_RQxxPyy: Input / Output division(RQ:Output / RI: Input)
_RQxxPyy: Slot number of the module mounted on the Communication device

(2) In case of PLC system equipped with Communication device, base extension using extension cable is

(2) The Expansion driver can be mounted in the CPU module slot of the main base. If it is installed in the
expansion base slot, it will not be recognized and it will not operate.
(3) Smart extension variable name rules by module are as follows.

_bbss_CHO_ACT: Base number of the module mounted on the Communication device
_bbss_CHO_ACT: Slot number of the module mounted on the Communication device
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4.2.5 Smart Extension service setting Download
When the setting of the Smart Extension service is downloaded to the CPU module, the Communication device operates
according to the setting value. (Downloading Smart Extension Service settings is only possible while online.)

(1) Select [Online] = [Write].

& XGK-CPUUN_TEST - XG5000

PROJECT EDIT FIND/REPLACE VIEW | OMLINE | MONITOR DEBUG TOOLS WINDOW HE

B LE Ak AR ANE

Project

v.@ XGK-CPUUN_TEST* Change Mode 4
v@ MNetwork Configuration 2 Read..
v i Undefined Network S wite
: v a8y MewPLC [BOSO XGL-EFMT(
- T Smart Extension Compare with PLC...
Mew Set Flash Memaory...

{7 EBO1 - XGL-DEDT
T EBOZ - XGL-DEDF
T EBO3 - XGL-DEDH EtherCAT Slave 4

_ () EBO4 - XGL-DBOT Communication Module Setting and Diagnosis L4

Control Redundancy

(2) After that, the Ethernet (master) module and Communication device are immediately reflected the Smart
expansion service setting value without the module reset. After that, the Ethernet (master) module and

Communication device are immediately reflected the Smart expansion service setting value without the module
reset.

When the module is exchanged using the Module Changing Wizard, the Smart expansion service parameter is not
set automatically. Therefore, download the following items again with [Online]->[Write] of XG5000.

Write to PLC ? *

[ tnhibit Program Upload
[ sets link enable with parameters

1P PLC Configuration

...|:| Comment Cancel
D@ Parameter -

; Basic Parameter =eting...

E 1/0 parameter

] DE, Spedal module parameter
il Local Ethernet Parameter
H "'|:| Program
D@‘ MNetwork Parameter
""" |:| Basic Settings

5| [Reset]FEnet [based, slotd]
[|@F Smart Extension Service
[ EtP tag

Clear PLC...

..... 15 High-speed Link
..... |:| PZP(EIF)

(1) In case of slaves using EtherNet / IP protocol, EB dropout may occur when downloading 'Smart
expansion' item setting. If EB or module change (hot swap) option is disabled during operation, slave
module may not work due to EB dropout. At this time, in order to restore the service, refer to 4.3.6
Enabling Smart extension service to perform Smart extension service. (Disable — Enable)
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4.2.6 Smart Extension Enable Services

Enable the service to use the Smart Extension service. Also, if you want to stop only the Smart extension service while the
PLC service is running, disabling the Smart Extension service will only stop the Smart Extension service. (Setting the
Smart Extension Service enable is only possible while online.)

(1) Select [Online]> [Communication module setting and Diagnosis]—> [Enable Services].
& XGK-CPUUN_TEST - XG5000

;i PROJECT EDIT FIND/REPLACE VIEW | ONLINE | MOMNITOR DEBUG TOOLS WINDOW HELP

IDEAEHS © &% B (8 vsomned AW e o

1% ®E@E @ ¢ G (B Connedion settings.. WE & o 1 0k
SR AR A AR N — | =% Sk AF A Safety Lod o
Grc H E i E s s gy eled EEHE DD
Project Safety Signature
~ B XGK-CPUUN_TEST* Change Mode »
v @ Network(;uﬂf\guration 2 Read..
v i Undefined Network = e

v g% NewPLC [BOSO XGL-EFMT(
v M@ Smart Extension e
Set Flash Memory...
- XGL-DBOT
- KGL-DBDF
- XGL-DEDH EtherCAT Slave L3

Control Redundancy

% i) EB04 - XGL-DBDT Communication Module Setting and Diagnosis 3 G‘ Enables Services
System Variable
Reset/Clear 4 p
w i) NewPLC(XGK-CPUUN)-STOP R 0S Upload/Download. .
E} Variable/Comment LS EDDENEIE EIP Tag Manager
hd @ Parameter ™ Forced 1/O...

Config. Upload [Dine et)
Basic Parameter onfig. Upload [Dnet, Pnet|

[ \/O Parameter

EI = N YN | B ——

Skip 1/0...
Fault Mask... System Diagnosis

(2) In the [Enable Service] window, check the Smart extension item and select OK to enable the Smart extension
service. In addition, uncheck the Smart Extension item and select OK to disable the Smart Extension service.

Enable Services 7 X
B &
[ 1Bl High-speed Link 1 a

[ 1] High-speed Link 2
= "DE High-speed Link 3
[ 1Bl High-speed Link 4
1 High-speed Link 5
= "DE High-speed Link &
= "DE High-speed Link 7
[ High-speed Link 8
= "DE High-speed Link §
= "DE High-speed Link 10
[ High-speed Link 11

DE High-speed Link 12
=-0E prER)
-] rrEP) 1

8 rrEr) 2
- E] prEF) 3
-[1[E PPEP) 4
- rrEP) 5
[ rrEP) &
- PPEP) 7
-] p2r(Er) 8
=-[E Smart Extension

(- [E] FEnet [baseD, slot0]
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4.3 Hot Swapping function

Functions that mask errors in case of module failure and control the system with replaced modules include Fault Mask
and 10 skip. This feature is only supported by the Smart Extension Service and is not supported by other services. In a
system equipped with a CPU, it is not set in the Smart Extension service but in the Error Operation Settings of the Basic
Parameter Setting window of the CPU.

Ethernet(FEnet) based Smart Extension system

Flags Updated When module detached

e 0001_IO_DEER : IO detachment error flag of Smart extension
system with Ethernet installed in slot 1 of base 0

* 0001_EBO2_IO_DEER : IO detachment error flag by EB in
Smart extension system

* 0001_EBO02_S06 10 _DEER : 10 detachment error flag Slot 6 of

Smart Extension system

4.3.1 Hot Swap Operation
Operation Hot Swap Enable Hot Swap Disable
Module Provided by Unavailable
change
Module Master hold previous mode Master hold previous mode,
detach Extension base where an error occurs is

operated in error mode

Perform control by referring to the flag that is Output operation can be specified in case of
updated by the user when module detached digital output module error
Perform control by referring to the flag that is

updated by the user when adding and deleting

EB
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4.3.2 Hot Swap Operation setting

The hot swap setting is set by the Smart Extension service.
(1) Double-click [Project] = [Smart Extension] window.

~ HE XGK-CPUUN_TEST*
v EE Network Configuration
v - Undefined Network
v g% NewPLC [BOS0 XGL-EFMT(B)(TAG)]
« (@ Smart Extension
LAY New
{3 EBOT - XGL-DBDT
7 EBO2 - XGL-DBDF
-7 EBO3 - XGL-DBDH
L..{f EBO4 - ¥GL-DEDT

(2) Click [Smart Extension] - [Communication Device Settings] to display the screen on the right.

Checking "Exchange EB or modules while running (hot swap)" in the setting item performs hot swap operation.

W e e o rersor >

- Smart Extension
. Master Setting
- Communication Device Settings

Communication Device Settings

Sets all I/ parameters Standard Input Filter |3 ~ | ms

- Allocate Input/Output Variables

Allocate diagnostic variables Settings Setting Detailed description
ciagn Run CPU-=Continue r Set: Continue output when stopped
Connection \‘r'?““ output when stopped Unset: Clear output when stopped
-~ EIP Cycle/Details Keep output when an - Keep output when an error occurs
errar occurs
Exchange EB or modules Set: Continue running when breakdown occl
X . v resolved return to normal operation
CLBOE I ELER, Unset: Error when breakdown
Use redundant power r Sets when use redundant power
< >

* Supports all EB hot swap, module hot swap supports only expansion driver device

** Supports expansion driver device only

(3) To set by Communication device, select EB of Communication device and cancel “Enables Master
Communication Device” in Basic Parameter item and set as below.

W 7 e e I

- 5ets Communication Device

Basic Parameter
/O Parameters

i Connect

Smart extension variables

= Communication device Informat

Mame: |SIaveNameD1

Communication Device Settings

[JEnables Master Communication Device

Settings Setting Detailed description
Run CPU-=Continue r Set. Continue output when stopped
output when stopped Unset: Clear output when stopped
AEED LTI e e r Keep output when an error occurs
EITOr 0CCurs
Exchange EB or modules Set: Continue running when breakdown occL
X . v resolved return to normal operation
R TS S, Unset: Error when breakdown
Use redundant power r Sets when use redundant power
< >

* Supports all EB hot swap, module hot swap supports only expansion driver device

** Supports expansion driver device only
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sion service

4.3.3

Diagnostic Variable Operation According to Exchange EB or modules while running (hot swap) Option

Some of the Allocate diagnostic variables depend on the setting of the Exchange EB or modules while running (hot swap)
option. The operation of Diagnostic Variables according to the option setting is as follows.

(1) System diag operation

System diag name

Hot Swap Settings in EB

Diagnostic Variable Operation with Hot Swap setting

_BBSS_SYSTEM_ER

Hot swap settings are

mixed(Enable/ Disable)

Hold “Off”

Hot swap settings are all Enabled

Hold “Off”

Hot swap settings are all Disabled

“ON” when EB detachment or EB | / O detachment
occurs

_BBSS_SYSTEM_WAR

Hot swap settings are

mixed(Enable/ Disable)

"On" if an EB detachment or EB | / O module
detachment occurs in an EB with hot-swap setting
disabled.

Hot swap settings are all Enabled

Hold “Off”

Hot swap settings are all Disabled

Hold “Off”

_BBSS_EB_DEER

Hot swap settings are
mixed(Enable/ Disable)

"ON" if an EB detachment occurs in an EB with hot-
swap setting disabled.

Hot swap settings are all Enabled

Hold “Off”

Hot swap settings are all Disabled

"On" if an EB detachment occurs

_BBSS_IO_DEER

Hot swap settings are
mixed(Enable/ Disable)

"On" if an 1/O module detachment occurs in an EB
with hot-swap setting disabled.

Hot swap settings are all Enabled

Hold “Off”

Hot swap settings are all Disabled

"On" if an I/O module detachment occurs

_BBSS_EB_DETACH_WAR

Hot swap settings are
mixed(Enable/ Disable)

"ON" if an EB detachment occurs in an EB with hot-
swap setting enabled.

Hot swap settings are all Enabled

"ON" if an EB detachment occurs in an EB with hot-
swap setting enabled.

Hot swap settings are all Disabled

Hold “Off”

_BBSS_|O0_DETACH_WAR

Hot swap settings are
mixed(Enable/ Disable)

"On" if an 1/0 module detachment occurs in an EB
with hot-swap setting enabled.

Hot swap settings are all Enabled

"On" if an 1/0 module detachment occurs in an EB
with hot-swap setting enabled.

Hot swap settings are all Disabled

Hold “Off”

_BBSS_FUSE_WAR

Hot swap settings are

mixed(Enable/ Disable)

"ON" if an FUSE error occurs in an EB with hot-swap
setting enabled.

Hot swap settings are all Enabled

"ON" if an FUSE error occurs in an EB with hot-swap
setting enabled.

Hot swap settings are all Disabled

Hold “Off”

_BBSS_EB_ER

Hot swap settings are
mixed(Enable/ Disable)

"On" if an EB detachment or EB | / O module
detachment occurs in an EB with hot-swap setting
disabled.

Hot swap settings are all Enabled

Hold “Off”

Hot swap settings are all Disabled

“ON” when EB detachment or EB | / O detachment
occurs

* BBSS: Displays the BASE and SLOT positions with the master module
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(2) EB diag operation

EB diag nhame

Hot Swap Settings in EB

Diagnostic Variable Operation with Hot Swap
setting

_BBSS_EBXX_IO_DEER

Hot swap settings are Enable

Hold “Off”

Hot swap settings are Disable

"On" if an I/O module detachment of EB occurs

_BBSS_EBXX_FUSE_ER

Hot swap settings are Enable

Hold “Off”

Hot swap settings are Disable

"On" if FUSE error occurs in the I/O module of
EB

_BBSS: Displays the BASE and SLOT positions with the master module
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4.3.4 Operation by Hot Swap Setting

The system below is an example of a mix of hot-swap Setting

.
Smar t {&1
extention - Ll

master
EBO1 EBO4

Hot swap Hot swap
enable disable
EBO2 I EBO3

Hot swap Hot swap
enable disable

(1) Module detached from base with hot swap enable
1) Operation

EBO1 to EB04 base operates normally when slot 1 module of EBO1 with hot swap enabled is detached.
The detached module operates according to the emergency output setting.

Smar t - 1 [7] —
extension %uj
master = =

EBO1

2) System diag
All System diag are turned Off.

System diag Monitoring value
SYSTEM_ER OFF
SYATEM_WAR OFF
EB_DEER OFF
IO_DEER OFF
EB_ER_00 OFF
EB_ER_01 OFF
EB_ER_02 OFF
EB_ER_03 OFF
EB_ER_04 OFF
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3) EB Diagnostic variables

The diagnostic variable is turned On because the 10 module of EB 01 is detached.

EBO1(Hot swap:Enable) EBO2(Hot swap:Enable) EBO3(Hot swap: Disable) | EBO4(Hot swap: Disable)
Diagnostic | Monitoring | Diagnostic | Monitoring | Diagnostic | Monitoring | Diagnostic | Monitoring
variables value variables value variables value variables value
EBO1_DEE OFF EBO2_DEE OFF EBO3_DEE OFE EB0O4_DEE OFF

R R R R

EBO1_IO_ EB02_IO_ EBO3_I10_ EBO4_I10_

DEER OFF DEER OFF DEER OFF DEER OFF
EBO1_S01 EBO2_Sxx_ EBO3_Sxx_ EBO4_Sxx_

_IO_DEER ON IO_DEER OFF IO_DEER OFF I0_DEER OFF

(2) Module detached from base with hot swap enable
1) Operation

EBO3 / EBO4 error and EBO1 / EBO2 operate normally when slot 1 module of EBO3 with hot swap disabled is
detached. Each module mounted on EB0O3 / EB04 shall be output according to the setting of “Keep output when an
error occurs”.

Smar t - || 4]
extension L‘ 0 I
master = | LIS

2) System diag
System warning, 10 detachment and EB_ER_03/ 04 are On.

System diag Monitoring
value

SYSTEM_ER OFF
SYATEM_WAR ON
EB_DEER OFF
IO_DEER ON
EB_ER_00 OFF
EB_ER_01 OFF
EB_ER_02 OFF
EB_ER_03 ON
EB_ER_04 ON
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(1) If EBO1 ~ EBO4 is set to disable, SYSTEM_ER, IO_DEER and EB_ERO1 ~ EB04 are On when the

module is detached from EB03, and Smart extension operation stops.

3) EB Diagnostic variables

The diagnostic variable is turned On because the IO module of EB 03 is detached.

EBO1(Hot swap:Enable) EBO2(Hot swap:Enable) EBO3(Hot swap: Disable) | EBO4(Hot swap: Disable)
Diagnostic | Monitoring | Diagnostic | Monitoring | Diagnostic | Monitoring | Diagnostic | Monitoring
variables value variables value variables value variables value
EBO1_DEE OFF EB02_DEE OFF EB03_DEE OFF EB04_DEE OFF

R R R R

EBO1_IO_ EB02_1O_ EB03_I1O_ EB04_10_

DEER OFF DEER OFF DEER OFF DEER OFF
EBO1_Sxx_ EB02_Sxx_ EB03_S01 EB04_Sxx_

IO_DEER OFF IO_DEER OFF _|O_DEER ON I0_DEER OFF

(3) EB detached with hot swap enable

4-31

1) Operation

EBO2 to EBO4 operates normally when EBO1 with hot swap enabled is detached. When detachment of EBO1 is
released, it operates normally.

Smar t -
extension
master =

2) System diag

—_— l

All System diag are turned Off.

System diag Monitoring
value
SYSTEM_ER OFF
SYATEM_WAR OFF
EB_DEER OFF
IO_DEER OFF
EB_ER_00 OFF
I LS’ELECTPEC

B4

EBO3
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EB_ER 01 OFF
EB_ER 02 OFF
EB_ER 03 OFF
EB_ER_04 OFF

3) EB Diagnostic variables

If EB 01 is dropped, EBO1_DEER variable is ON.

EBO1(Hot swap:Enable) EBO02(Hot swap:Enable) EBO3(Hot swap: Disable) | EBO4(Hot swap: Disable)
Diagnostic | Monitoring | Diagnostic | Monitoring | Diagnostic | Monitoring | Diagnostic | Monitoring
variables value variables value variables value variables value
EBO1_DEE ON EB02_DEE OFF EB03_DEE OFF EB04_DEE OFF

R R R R

EBO1_IO_ EB02_10_ EB03_10_ EB04_10_

DEER OFF DEER OFF DEER OFF DEER OFF
EBO1_S01 EBO2_Sxx_ EBO3_Sxx_ EBO4_Sxx_

_IO_DEER OFF I0_DEER OFF I0_DEER OFF I0_DEER OFF

(4) EB detached with hot swap disabled

1) Operation

EBO3 / EBO4 error and EBO1 / EBO2 operate normally when EBO3 with hot swap disabled is detached. Each
module mounted on EB03 / EB04 shall be output according to the setting of “Keep output when an error occurs”.

Smar t = 14|
extension
master

W
EBO1

2) System diag

System warning, EB detachment and EB_ER_03/ 04 are ON.

System diag Monitoring
value

SYSTEM_ER OFF
SYATEM_WAR ON
EB_DEER ON
IO_DEER OFF
EB_ER_00 OFF
EB_ER_01 OFF
EB_ER_02 OFF

LS'ELECTR"C |
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4-33

EB_ER 03

ON

EB_ER 04

ON

If EBO1 ~ EBO4 is set to disable, SYSTEM_ER, EB_DEER and EB_ERO01 ~ EB04 are ON when EBO3 is

detached and Smart extension operation stops.

3) EB Diagnostic variables

IO module detachment diagnostic variables of EB 03 turns ON.

EBO1(Hot swap:Enable) EBO2(Hot swap:Enable) EBO3(Hot swap: Disable) | EBO4(Hot swap: Disable)
Diagnostic | Monitoring | Diagnostic | Monitoring | Diagnostic | Monitoring | Diagnostic | Monitoring
variables value variables value variables value variables value
EBOL_DEE | | EBO2 DEE | | EBO3_DEE | | EBO4_DEE | |

R R R R

EBO1_IO_ EB02_IO_ EBO03_IO_ EBO4_IO_

DEER OFF DEER OFF DEER OFF DEER OFF
EBO1_Sxx_ EB02_Sxx_ EB03_S01 EB04_Sxx_

IO_DEER OFF IO_DEER OFF _|O_DEER ON IO_DEER OFF




Chapter 4 Smart Extension service

4.3.5 Operation and Return Condition of Communication Device According to Hot Swap Setting

(1) Hot Swap with EBO1 to EB06 Systems

EB No. Device Hot swap setting

EB 01 Extension driver Disable

EB 02 Extension driver Enable

EB 03 Smart /O expansion Disable

EB 04 Smart /0O expansion Enable

EB 05 Smart I/0O block Disable

EB 06 Smart I/O block Enable

(2) Communication Device Operation

Normal operation: O ,

Emergency output: ® ,Emergency output besides fault module: [

Cond Error condition Error operation Full service return condition
ition EBO1 | EBO2 | EBO3 | EBO4 | EBOS | EBO6 |
Module
1 failure O o ® o ® o 1. Fz?lult module measure 2. Master reset or
mounted on service Disable -> Enable
EBO1
EBO1 1. Reconnect EB
2 detachment © © © © © © 2. Master reset or service Disable -> Enable
Module
failure .
3 O O @) O O @) 1. Automatic return on fault module measure
mounted on
EBO2
EBO2
4 0 O ® @) O O O 1.Auto return on EB reconnect
detachment
Module
failure [JNote 1. Fault module measure 2. EB Reset
® O O ® O
S mounted on 1 3. Master reset or service Disable -> Enable
EBO3
EBO3 1. Reconnect EB
® O ® O ® O
6 detachment 2. Master reset or service Disable -> Enable
Module
7 failure o o o ® o o 1. Fault module measure 2. Auto return
mounted on when relevnat EB reset
EBO4
8 EBO4 O O @) ® O @) 1. Auto return on EB reconnect
detachment
EBO5 1. Reconnect EB
9 detachment © © © © © © 2. Master reset or service Disable -> Enable
10 EBO6 O O O O O ® 1. Auto return on EB reconnect
detachment

Master Reset or Service Disable-> enable is required for the system to operate normally when an EB that is not hot

swapped fails.
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(1) When hot swap of each country operated by Smart extension service is set to Enable and the media is
set to Auto, each station automatically operates by adjusting the communication speed. If there is
only 100M of station number, the system communicates with 100M.

(2) When hot swap of each country operated by Smart extension service is set to Disable and the media
is set to Auto, each station automatically operates by adjusting the communication speed However, if
100M and 1G media are mixed, EB will be detached when connecting to media with different speeds.
In this case, Smart extension service can be operated after setting communication media setting of
each station from Auto to 100M.

(3) Smart | / O expansion does not support hot swap function of expansion module.
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4.4 Smart Extension service operation

(1) Program using Smart Extension Wizard

XGP-AC23 XGK-CPUE

XGL-EFMTB

XGQ-RY2A

XGI-D22A

XGQ-TR2A

XGP-AC23 XGL-DBDT

XGQ-TR2A

XGQ-RY2A

XGI-D21A

XGQ-TR2A

XGH-DT4A

» Program to turn on the output contact point connected to the expansion stage 1 using the Smart expansion

service
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Program procedures

Seq .
Settin .
uen 9 Setting method
process
ce
1) [Project]>Open [New Project] and enter the project name, CPU series, CPU type,
programming type, and program name.
New Project ? X
Erperimer |5martExnensmn| e ]
R R
CPU Series XGK ~ | Product Name...
CPU type: XGK-CPUSM ~
Create P <
1 new Programname:  |NewProgram
project rogramtnguge: [
Project description:
1) Select [Undefined Network]>[Add item]> [Communication module].
2) In the [Select Module] window, click “Add module”.
Select Module =
PLC type:
NewPLC v
Communication Module:
Numher; BASE Slot Module Metwork in use
Undefined
2 Network
Add Add Module... Delete module _DK Cancel
1) Setting the Type, Base and Slot. After that, select the “OK” button to complete the
setting.
Communication Module Settings =
Type: XGL-EFMT(B)
Base: [an] i
Slat: oo e
Cancel
Double-click the communication module in the [Project] window.
~ EEF FEnet ™
~ EE Metwork Configuration
|~ P Undefined Network
L 5% MewPLC [BOSD XGL-EFMT(B}[TAG)]
% System Variable
3 Stan_dard ~ i) NewPLC(XGK-CPUUN)-Offline
SettlngS .23 Variable/Comment
~ [ Parameter
i Easic Parameter
EF /O Pararmeter
i { TE Local Ethernet Parameter
~ Scan Program
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Seq

Setting

uen Setting method
process
ce
Enter TCP / IP Settings, Receive time out Settings, and Driver settings on the [Basic
Settings] tab.
Standard Settings - FEnet x
Basic Seftings Host Table Settings ~ Sets EIP Server
TCP/IP Settings
Station No.: o]
Media: Port1: |AUTO ~
Port2: |AUTO
P address [ 1e2 168 1 2|
Subnet Mask [ 285 255 285 . O
Gateway: [ 1m2 168 1 1]
DNS Server [ e 0 0 1]
[CoHcP [ Relay [Joprc ua
Mo of Dedcaied (1-16)
Receive Time Out Settings
Ciient sec(2-255)
Server sec(2 - 255)
Driver Setting
Server Mode: KGT server ~
Modbus Settings
3 Standard RAPIEnet Seftings: | RAPIEnet v2 -
settings

Cancel

Click [Online]>[Write] and select and download the master module of the network
parameter. Downloaded parameters are applied after reset.

Writeto PLC

] inhibit Program Upload
[ sets link enable with parameters

6 NewpLC

i PLC Configuration
Comment

@ Parameter

Basic Parameter
1/0 parameter

Program
twork Parameter
Basic Settings

EIP tag
(163 1P Server
& High-speed Link
PIP(EIF)

@, Spedial module parameter
Local Ethernet Parameter

T

Cancel

Setting. ..

Clear

[Reset]FEnet [based, slotd]

X

PLC...

Adding
Smart
Extension
service

Click [Project]>[Add item]—>[Smart Extension].

Project
v BB XGK-CPUUN_TEST*

v &8 Network Configuration
v i Undefined Network
‘ gy NewPLC [BOSD XGL-EFr TR A

- % System Variable

v ) NewPLC(XGK-CPUUN)-STO
- 9 Variable/Comment

v [ Parameter

Basic Parameter Ez”
@ 1/0 Parameter

v 0 X

Open
Add ltem
Copy
Paste
¥ Delete

-] Local Ethemet Parame

v (2] Scan Program

JANGTEA

wfE NewPLC

= Properties...

Ctrl+C
Ctrl+v

Delete

Communication Module Setting and Diagnosis 4

Smart Extension

Network
Communication Module
P2P Communication

High-speed Link Communication

Add a Group

Add Slave

Views Connection
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Seq

Settin .
uen 9 Setting method
process
ce
1) Select “Autoscan” on the [Overview]>[Details] window to automatically register the
connected network.
(PLC system should be connected in [Online]>[Connect] before Autoscan.)
2) Set input / output variables and diagnostic variables as initial values in the [PLC Area
Setting] window. Then proceed to Section 7.
Details X PLC area setting X
No. of Communication Devices: 415 (1~63) Autoscan Input/Output Variables
Area: D v Set the device memory for input [ output refresh according
EBNo.| Moduletype | Module Name |Slation | |Paddress | Protocol | Apply to the slot infarmation of the st EB.
TWoduar  XGL-DEDT 1 1021681101 RAPEnel  [@ adeess: oo atfomi s wecEed e
; 2 Wodul XGL-DBDT 2 1821881102 RAPIEnet | )
Addmg 3 Mzdﬂ XGL-DBOT 3192 168.1.103 RAP\E:Zt ; S
Smart 4 Wodular XGL-DBDT 4 1921881104 RAPIENet |
4 EXte ns |O n :;:t;l:::ﬁfs\at Diagnostic variables
SerVICE Area: D v Sets device memory for diagnostic variables.
ynu_sa\aﬂcf Pr‘:v;]i“de Esufs\nht d\agannBsﬁt ;arliath\ef,synu Ean
Address: __2536 monitor the s S INformauon o and slot o Smar
) E#:;mw address and size are calculated in words.
Size: 100 fatieast S4wards renired)
<Back Cancel < Back Cancel
3) If select “Cancel” on the [Overview]>[Details] window ,start from section 5 below.
1) Double-click [Smart Extension] and click the [Master Setting] menu.
Project * 1 x NewPLC [BOS0 Smart Extension]
v J8F XGK-CPUUN_TEST* o i
v@ Metwork Configuration I
v Undefined Network on Device Settings
v 5??‘ NewPLC [BOSD XGL'EFMT(B)UAG)] Allocate Input/Cutput Variables
vﬂ Smart Extension llocate diagnostic variables
onnection View
- XGL-DBOT EIP Cycle/Details
- XGL-DEDF
- XGL-DBDH
- XGL-DBOT
2) Input Master Setting and PLC area in [Master Setting] and Communication Device
Settings in [Communication Device Settings].
5 Master MewProgram }/' NewPLC [BOS0 Smart Extension] x
H Smart Extension .
Settlng ;m; Seting Master Setting
_.. Communication Device Settings | Name: |""-35"‘3””=""”‘EUD ‘

Allocate Input/Qutput Variables

: o

. Allocate diagnostic variables BB No.:

;- Connection View Module: XGL-EFMT(B)

“ EIP Cycle/Details
Image: FEnet_XGL.bmp
Control Frequency: ms Watchdog timer: -m ms
comment:

PLC Area [WORD]
Enables EB/Slot Diagnostic variables
Fix the Smart I/0 module's inputfoutput variable(8 Byte)

Address Start device Size ~
Input/Output Vari : D0O01000 1536
Diagnostic D002536 100
v

(* Sets start address and its size for the variables used for Smart Extension *)
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Sequ | Setting Setting method
ence process

1) Click [Smart Extension]>[Add Item]-> [Add Communication Device].
Project - 3 X
~ EF XGK-CPUUN_TEST =
~ EE Metwork Configuration
~ D Undefined Network
~ -5 NewPLC [BOSO XGL-EFMT(E)(TAG)]
~ @ Srart Exte

; Add Item v Adds Communication Device ‘
25 Mew
% System Variable Changes Station No/IP S EEOE

~ . NewPLCXGK-CPUUY
{23 Variable/Comme(| % Delete Delete [

~ [ Parameter
Basic Param

[ 1/0 Parameter Il

Properties...

2) In the [Adds Communication Device] window, enter the contents of the [Basic
Parameter] and [Connect] tab.

Adds Cormmunication Device X
Basic Parameter Connect
SO —
Protocol Type: RAPIEnet i
L E— L
P 192168 . 1 .10
Module Type: XGL-DBDT v
Image: XGL_DBDx bmp
EDS XGL-DBDTVerl.1
Commun Cancel
6 ication
device

settin 3) Double-click [Smart Extension]>[EB01-XGL-DBDT] and click the [I / O Parameter]

9 | menu in the [BOSO EBO1] window.

Project

v EE XGK-CPUUN_TEST*
w HF Metwork Configuration
v Undefined Network
© ~v g% NewPLC [B0SD XGL-EFMT(B)(TAG)]

v ffﬂ Smart Extension

- ¥GL-DBDT
- XGL-DBDF
- ¥GL-DEDH
.. EBO4 - XGL-DEDT

4) Register | / O module installed in communication device in [I / O Parameter] and click
[ABQM button.

=) Sets Communication Deviee
o o ° ° ° ° ° o
o ° [ ° ° ° ° °
.

| L
& Com Infermat
|- Connect
. Smart extensio

Basic r
hd]

@D Base 00 Default Apply Current Consumption

Hodule Conment Input Fiter Emergency Output Input info. [i
0| ¥GFOVAA (D74 Votage Output Type(d Chan .

HGFADAS lsclated-ype anaiog input Type(d
G0 TRIA/ (Transistor Oulpul, 32 Corlacts

Defaull

LSE ecrric | 4-40




Chapter 4 Smart Extension service

4-41

Sequ

Setting

Setting method

ence Process
1) [Smart extension]->Open [Input / Output Variable Assignment] and click "Register
Variable".
Allocate It can be created by referring to the program after registering the variable
input/out RewrI s S o %
7 + &} XGK-CPUUN_TEST* Srmart Extension
p Ut v &} Network Configuration Master Setting Format: Hexadecimal v| | variable setting
- ~ ) Undefined Network - Communication Device Settings.
Var|ab|es 4% NewPLC [B0S0 XGL-EFMT(B)(TAG)] A \npuUDutputVanab\i ’:‘ EB No. | Station NoflP|_Slot number Variable name Type | Device | wonitorval Comment
@ Smart Edension Allocate diagnostic variables | [ =001 (511 Sloto =
275 New Connection View 2 _0000_EB01_00_CHO_ERR BIT D001000.0 Analog Output Module: CHO Eror
D EBO1 - XGL-DBDT EIP Cycle/Detsils _0000_EBO1_00_CH1_ERR | BIT D001000.1 Analog Output Module: CH1 Error
P EBO2 - XGL-DBDF _0000_EB01_00_CH2_ERR ' BIT D001000.2 Analog Output Module: CH2 Error
(9 EB03 - XGL-DBDH 6066 EB01 00 CH3 ERR TBIT T Bo010003 Analog Guiput iodule: CH3 Errar
D EBO4 - XGL-DBDT & _0000_EB01_00_CH4_ERR | BIT D001000.4 Analog Output Module: CH4 Error
1) Create NewProgeam of the scan program. At this time, output contact no.0 of slot 0
and slot 1 of Extension driver are displayed as” 0000 _EBO01_RQOOP00' and
' 0000 _EBO1 RQO1P0O0“ respectively.
program HOO0DD '%HHEEEB‘
8 - | _
ming i f 3
_0000_EBO1
_R0TPoo
3
In the [Online]>[Write] window ,Click ok.
Writeto PLC ? X
[ inhibit Program Upload
[ sets link enable with parameters
Configuration
12 comment Cancel
[0 Parameter :
L[] Basic Parameter Setting....
[ 1/0 parameter
Ol Epeaa\ module parameter DeaipIe
13 Local Ethernet Parameter
Program | LI Program
9 DOWﬂ|Oa [ |E® Network Parameter

d

I:_| Basic Settings
[ J[E] [Resef]FEnet [base, slot]
Smart Extension Service
; EIP tag
)] EIP server
[ High-speed Link
-[1[E] p2rEIP)

10

Set link
enable

[Online]>[Communication module setting and diagnosis]> Check Smart extension in
[Service Enable].

Enable Services ? x
ONLINE  MONTOR DEBUG TOOLS WINDOW  HELP =
| 8| Disconnect MMENL e s -[1E High-speed Link 1 -

[, High-speed Link 2
(1], High-speed Link 3
-[ 1L High-speed Link 4
-C1EL High-speed Link 5
[ High-speed Link 6
I, High-speed Link 7
- 1B, High-speed Link 8
-C1EL High-speed Link
-C1EL High-speed Link 10
[1E High-speed Link 11
1 High-speed Link 12

1Bl p2rER)

1B p2rEP) 1
& porEr) 2
CIE, PrEF) 3
» 1Bl p2rER) 4
-C1E p2pP(EIP) 5

1 @ Connection Settings...

BEE o0 o
& [ [E] £ A o o
1

Safety Lock

| Safety Signature

Change Mode 4
ﬁ Read..
% Write...
| ﬁ Compare with PLC...
Set Flash Memory...

Control Redundancy

EtherCAT Slave

Communication Module Setting and Diagnosis 3 G‘ Enables Services

-C1E PrEP) &

Reset/Cl » O, ppEr) 7
BT 05 Upload/Download... O prEr) s
System Diagnostics L4 EIP Tag Manager --E Smart Extension
@ -[/1[E] FEnet [basen, slotd]
Fi d 1/0...
GO Ly Config. Upload [Dnet, Pnet] _
Skip /0.

Fault Mask.., System Diagnosis
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4.5 Smart extension diagnosis function

Smart extension service is provided with diagnostic function. Check the service status of Smart extension service by using
service status, communication module history, diagnostic variables, Communication device connection configuration, EIP
cycle / detailed setting list.

451 Status by service (Smart extension)
(1) Select [Online]> [Communication module setting and Diagnosis] > [System diagnosis].

€ FEnet - xGs000
 PROJECT EDIT FIND/REPIACE VIEW | ONLINE | MONITOR DEBUG TOOLS WINDOW HELP

DBZEESE © &% M (& osona T35 T
EBE OOE @E oF g (S Connedionsettings.. LE & 11000 17 11
AUUEBELAELL o BEE @ DD
Project Safety Signature
V'Eﬁf FEnet ™ Change Mode 3

VE MNetwork Configuration £ Read..

i w P Undefined Network -

A Tite...

: gl MewPLC [BOSD XGL-EFMT

% System Variable Compare with PLC...

v -f) NewPLC(XGK-CPUUN)-STOP Set Flash Memory...

29 variable/Comment

Control Redundancy
~ [# Parameter

Basic Parameter EtherCAT Slave L4
@ 1/0 Parameter Communication Module Setting and Diagnosis » [# Enables Services
T Local Ethernet Parameter Reset/Clear »
Scan Program System Di . . 05 Upload/Download..
MewProgram R EIP Tag Manager
& Forced /0., Config. Upload (Dnet, Pet)
Skip /0.,
Fault Mask... @ System Diagnosis
Module Changing Wizard...
Base Changing Wizard...
@7 Start Online Editing Ctrl=Q
View High-speed Link  Vie & write Modified Program Ctrl=w
@ End Online Editing Ctrl=U

Function,

Open Online Editing Program...

(2) In the [System Diagnosis] window, right-click the "Ethernet module image area" and select the service-specific
status.

XGP-xxxx KGH - XGL-
: PUUH " ernre

Detailed Module Information...
Status By Service...

Media Information...
Autoscan...

System Log...

Ping Test

RAPIEnet media information

View Communication Module Log
Save Communication Module Log

Remote 05 download(R)

Loopback Test

System Synchronization...
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(3) Check the service status of the Smart extension by selecting the [Status by Service]>[Smart Extension] tab.

Status by service X
Dedicated Service P2P Service HS Link Service  Smart Extension
10210
Standard Information Service information
Base No lIl Service Status
Setho: [0 | SCAN MAX: SCAN MIN SCAN CURR:
EB No. Protocol Station No./IP Service EB Status Service Count | EB Detach Coun EB Flag
+ 01 RAPIEnet/IP 01 0 service : BASE_DEER 832251 0
| 02 RAPIEnet/IP 02 0 service : BASE_DEER 615667 0
03 RAPIEnet/IP 03 0 service : BASE_DEER 815721 0
| 04 RAPIEnet/IP 04 0 service : BASE_DEER 815721 0
]
]
]
]
Save the file Clear Scan Clear Flag Read Refresh
Item Contents
Base Number Displays the base humber on which the Ethernet module is mounted.

Slot No.

Displays the slot number on which the Ethernet module is mounted.

Service status

Displays the enabled status of the Smart extension service.
- Types of service status and descriptions are as follows.
Service status type Description

Enable Operating Smart Extension service.

Disable Stop Smart Extension service.
SCAN MAX Smart extension service displays the maximum scan cycle of the network.
SCAN MIN Smart extension service displays the minimum scan cycle of the network.
SCAN CURR Smart extension service displays the current scan cycle of the network.
EB No. Displays the EB number of the communication device.
Protocol Displays the protocol type used for connection with the communication device.

Station No/IP

Displays the station number / IP of the communication device.
- Displays the station number when the protocol type is RAPIEnet.
- Displays the IP address when the protocol type is EtherNet / IP.

Service Displays currently active services.
- 1/O service: Service provided by communication device with Smart Extension function
- Event service: EtherNet / IP Client Service

EB status Displays the current EB status.

Service status Description

IDLE The communication device (slave) to be controlled is not
connected in the network.

DETECTING Looking for communication device (slave).

STATE CFM The communication device has been checked.

PRM_DONE Parameter download has been completed to the

communication device.

IO_PRM_MISS_MATC
H

The parameter | / O list and the 1 / O list mounted on the
communication device are different.

WORKING

It is the status to update | / O data normally.

DETACH

The Communication device is detached during the
control.
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Service count Displays the service operation counts currently.

Error count Displays the count of errors that have occurred currently.

EB detachment count | Displays the EB detachment counts that have occurred currently.

EB flag Flag is displayed according to the type of error occurred when an error occurs in EB.
Slot No. (slot) Displays the slot number (EB).
Type(slot) Displays the module type installed in the slot (EB).
- For EtherNet / IP( EIP) clients, displays the service type.
Status(slot) Displays the service status of the slot (EB).

Block Status(slot) Display the status of that service block.

- This feature is only available for EIP clients.

Error code (Slot) The error code of the service is displayed.

- This feature is only available for EIP clients.

Service count(slot) The service count of the service is displayed.

- This feature is only available for EIP clients.

Error count(Slot) The error count of the service is displayed.

- This feature is only available for EIP clients.

Slot flag (slot) Flag is displayed according to the type of error occurred when an error occurs in slot.

File save Saves the current status of Smart extension service as a file.
Clear scan Initializes the scan information.

Initializes the SCAN MAX and SCAN MIN values.
Clear flag Initialize the EB flag and slot flag (slot).

- Error flag history is initialized.

Continuous reading

Smart extension service status is updated continuously.

452

View Communication Module Log

Check the event history and communication history of the Ethernet module by using the communication module history
view function of system diagnosis. In the event history, event history such as joining and dropping of communication
device nodes and mode switching history of communication module can be checked. In communication history,
communication error history such as response waiting time exceeded, CRC error history, etc. can be checked.

(1) Select [Online]-> [Communication module setting and Diagnosis] = [System diagnosis].

€ FEnet - XG5000

PROJECT EDIT FIND/REPLACE VIEW OMLINE | MONITOR DEBUG TOOLS WINDOW HELP

AF Ak ARE N —

Project

~ EF FEnet*
v & Network Configuration
| v . Undefined Network

g% NewPLC [BOSO XGL-EFMT( P

% System Variable

v i) NewPLCIXGK-CPUUN)-STOP

9 Variable/Comment
v -[# Parameter
Basic Parameter
E 1/0 Parameter

.TH| Local Ethernet Parameter

~ -[&] Scan Program
MNewProgram

: L =% % Ard
ZESC/ F3 F4 sF1 sF2 F5 F6 sF8 sF9 Fd F

D EEEHE =5 &2 E[% Disconnect
: :% @ @ O Ql g} I % (@ Connection Settings...

Safety Lock

Safety Signature

Change Mode
Read...

Write...

Compare with PLC...
Set Flash Memaory...

Control Redundancy

EtherCAT Slave
Communication Module Setting and Diagnosis
Reset/Clear

System Diagnostics

Forced I/O...

Skip /...

Fault Mask...

Module Changing Wizard...

Base Changing Wizard

LY
RFE 00000 0
BRE EEE RDD

»

4 E‘ Enables Services

05 Upload/Download...
EIP Tag Manager

Config. Upload [Dnet, Pnet)

System Diagnosis

(B Start Online Editing Ctrl=Q
ST View High-speed Link  View P2P % Jrite Modified Program Ctrl+W

(¥~ End Online Editing Ctri=U
EUnCHEnEE Open Online Editing Program

(2) In the [System Diagnosis] window, right-click the "Ethernet module image area"” and select the
Communication Module Log]

[View
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IBP—xxxx NGHK-
SEP-xxxx CPUUN

|

188
BASE/ST

(3) Check the event history by selecting [Event History] in the [View Communication Module Log] window.

SGL-
EFMTB

Detailed Module Information..,
Status By Service...

Media Information...

Autoscan...

System Log...

Ping Test

RAPIEnet media information
View Communication Module Log
Save Communication Module Log
Remote O5 download(R)
Loopback Test

System Synchronization...

1o

[«J[===

(Click the error history to display the details of the error and the corrective action.)

Module Log

EventHistory = Communication Log

Standard Information Log Range

Base Mo.: ‘ Previous Log | ‘ FirstLog | | Read All

Slot No.: | Mextlog || Recentlog |

No Date Time: Description ~

0 2020-02-07 11:01:49.721  System-Mode partidpated (Station No.: 23)

1 2020-02-07 11:01:49.816  System-Topology change line -> ring

2 2020-02-07 11:01:51.470  Smart extension-reserved code({0x8088) (EE Mo.: 13)

3 2020-02-07 11:01:51.470 Smart extension-reserved code(0x8088) (EB Mo.: 20)

4 2020-02-07 11:01:51.470  Smart extensionreserved code(0x8088) (EB Mo.: 21)

5 2020-02-07 11:01:51.470 Smart extension-reserved code{0x8088) (EB Mo.: 22)

3 2020-02-07 11:01:51.470  Smart extension-reserved code(0x8088) (EB Mo.: 23)

7 2020-02-07 11:01:51.470  Smart extension-reserved code({0x8088) (EE Mo.: 24)

8 2020-02-07 11:01:51.470 Smart extension-reserved code(0x8088) (EB Mo.: 25)

9 2020-02-07 11:01:54.835 Smart Expansion-AC FAIL occurred (EB No.: 13, Power: 0, Count: 374)

10 2020-02-07 11:01:54.836  Smart Expansion-AC FAIL occurred (EB No.: 26, Power: 0, Count: 378)

11 2020-02-07 11:01:54.837  Smart Expansion-AC FAIL occurred (EB No.: 22, Power: 0, Count: 375) o

i e e — e oo . —- e o - - - — 5
Frame Data Details:

(4) Check the communication error history by selecting [Communication history] at the top of [Module log] window.

(Click the error history to display the details of the error and the corrective action.)
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Module Log X
Event History Communication Log

Standard Information Log Range save File
Base Mo.: Previous Log First Log Read All

Delete Log
Slot Mo.: El Next Log Recent Log
Mo Date Description ~
1] 2020-02-07 Smart Expansion-Receive RAPIEnet auto scan results {(Module ID: 0x00007001, Mumber of moi
1 2020-02-07 Smart Expansion-Receive RAPIEnet auto scan results {(Module ID: 0x00007003, Mumber of mo
2 2020-02-07 Smart Expansion-Receive RAPIEnet auto scan results (Module ID: 0x00007003, Mumber of mo
3 2020-02-07 Smart Expansion-Receive RAPIEnet auto scan results (Module ID: 0x00007001, Mumber of mor
4 2020-02-07 Smart Expansion-Receive RAPIEnet auto scan results {(Module ID: 0x00007001, Mumber of mo
5 2020-02-07 Smart Expansion-Receive RAPIEnet auto scan results {(Module ID: 0x00007001, Mumber of mo
[ 2020-02-07 Smart Expansion-Receive RAPIEnet auto scan results (Module ID: 0x00007001, Mumber of mo
7 2020-02-07 Smart Expansion-Receive RAPIEnet auto scan results {(Module ID: 0x00007001, Mumber of moi
a8 2020-02-07 Smart Expansion - Response Wait Timeout (OBJECT ID: 20, EB Mo.: 22, LINK ID: 0x141601C0)
9 2020-02-07 Smart Expansion - Response Wait Timeout (OBJECT ID: 20, EB Mo.: 26, LINK ID: Ox141A013A]
10 2020-02-07 Smart Expansion - Response Wait Timeout (OBJECT ID: 20, EB Mo.: 24, LINK ID: Ox1413016F)
11 2020-02-07 Smart Expansion - Response Wait Timeout (OBJECT ID: 20, EB Mo.: 26, LINK ID: Ox141A015C] e
& e e - e P o,

Frame Data Details:
Close
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4.6 Smart extension system configuration

Smart extension service can be used in various system configurations. However, if 1Gbps and 100Mbps media are mixed

4.6.1 Typical Configuration

Ethernet module(Vv8.0)

Expansion
Smart 1I/O

Block-type Smart 1/O

I
RAFPPIEnet
Ethen'etlt/IP

Total number of slaves: 63
100Mbps/1Gbps

Ethernet
module(V8.0)

O W
- gL L ) )
Expansion driver( Expansion

Smart I/O

WAl
Smart I/O
S ]
RAPFPI<net

100Mbps/1Gbps

A
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in the system, it will operate at 100Mbps. In case of optical media, the transceiver should be mounted accordingly.

Ethernet module(V8.0)
1] -

Expansion
Smart I/O

Ll,zl

Block-type Smart 1/O

S
RrRAPIEnet
Ethen'et/IP

Total number of slaves: 63
100Mbps/1Gbps

Total number of slaves: 63

Expansion driver

Expansion
(XGL-DBDx)

Smart 1/0O

Smart 1I/0O
—————
RAPFr<net

100Mbps/1Gbps
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4.6.2 Ring/ Line configuration.

Mix RAPIEnet and Ethernet / IP communication for ring / line configuration.

Ethernet
mc_Jld_u le(V8.0)

= Total number of slaves: 63
_ I i
= NN

Expansion driver Expansion Expansion driver Expansion
Smart I/O (XGL-DBDXx) Smart I/O
Smart 1/O 1 o
—
- RAFRFPIEnet \ :
- | Etheni‘et/IP
g
100Mbps/1Gbps 100Mbps/1Gbps
-yt

The switch module (MRS) does not support ring type connection when EtherNet / IP protocol is used.

When using the EtherNet / IP protocol in the Smart extension service, general-purpose Ethernet switch can be used.
When using the RAPIEnet protocol, communication is not guaranteed when using the general-purpose switch.

When used as a Smart extension service with EtherNet / IP or RAPIEnet protocol, it operates at 100Mbps when 1Gbps
and 100Mbps are simultaneously connected in the same ring.
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4.6.3 Auto Speed Sync Operation

The Smart extension Master and Communication device modules provide an Auto Speed Sync function that automatically

matches the speed of the two communication ports when the media setting of both communication ports is AUTO. At this

time, the communication speed is synchronized to the lower of the communication speeds of the two ports.
When all the conditions below are met, Auto Speed Sync function is activated and the media setting information is

completed until the module is reset.

(1) The media setting on the electrical port is AUTO - Electrical / Mixed Module

(2) When the RAPIEnNet setting is RAPIEnet v2 or when the RAPIEnet setting is Disable but the Relay option is
Enable

(3) When receiving service data (data for refreshing slave | / O module data (refresh data)) not setting data such as
parameter data from other company or its master.

ex 1)When the link speed of the network is set to 100Mbps by the Auto Speed Sync function, if a node supporting
all 1G / 100M is added to the network, the node is connected at 100M speed and the relay function of the
neighboring node is also operated. Communication is possible

Adds node 5
Auto speed sync complete and relay support (100M) (100M/1G support)
100M 100M 100M 100M
Node 1 [«—» Node 2 [<—»{ Node 3 |[—m Node 4 [«—» Node 5

ex 2)When the link speed of the network is set to 100 Mbps by the Auto Speed Sync function, if a node that
supports only 1G is added to the network, communication is not possible because the communication link between
neighboring nodes is not established.

Holding 100M between nodes 1 ~ 4 and automate 4,5 communication
after completing auto speed sync

Adds node 5
(1G support)

100M 100M 100M 100M

Node 1 |[«— Node 2 |«— Node 3 |«— Node 4 |« Node 5

sS4 =9t

ex 3) If a network that supports only 100M is added to the network when the link speed of the network is set to 1
Gbps by the auto speed sync function, the link communicates at 100M, but the relay function of the neighbor node
does not work also, communication with other nodes except the previous one is not possible.

Holding 1G between nodes 1 ~ 4 and 100M communication between 4
and 5 after auto speed sync is completed, and relay function of
node 4 does not work

1G 1G 1G 100M
~—» Node 2 |—» Node 3 |«—» Node 4 [&—»

Adds node 5
(100M support)

Node 1 Node 5

Relay function
disabled
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(1) The optical module determines the link speed based on the Transceiver's 100M or 1G even when
the media is set to AUTO. However, in case of the mixing module, if 100M Transceiver is
connected to the optical port, if the electrical port is set to AUTO, the communication is connected
to 100M according to the optical port speed.
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Chapter 5 High Speed link Service

5.1 Overview

HS link is a communication method between XGT PLC communication modules and can send and receive data periodically
by setting HS link parameter. In XG5000, data can be send / received by setting send / receive data size, period, area and
storage area in parameter.

High speed link is a service to send and receive at the end of PLC program when parameter is set. Therefore, when the send
/ receive cycle is short, the communication module transmits every scan data, which decreases the efficiency due to the
increase of the traffic. The user can set the send / receive period from a minimum of 5 ms to a maximum of 10 seconds.
The default is 200 ms.

However, since HS link service uses subnet broadcast service, it may affect other communication modules using the same
network. Therefore, in order to maximize communication efficiency, the user can set the maximum send / receive size (400
bytes) that can be set per HS link block. This reduces the total number of blocks used and increases communication efficiency.
The high speed link function is as follows.

(1) High speed link block setting function

1) High-speed link service is up to 12 XGK /1 and 6 XGR.

2) Each HS link can be set to 32 blocks for sending and 128 blocks for receiving. If mixed, up to 128 blocks can
be set. Up to 200 words can be set for each block.

3) When using high speed link extension mode, RAPIEnet V2 high speed link supports a maximum of 256 blocks
X 700 words for transmission, a maximum of 256 blocks x 700 words for reception, and a maximum of 256
blocks x 700 words for transmission and reception.

(2) Send cycle setting function

User can set send / receive cycle for each module Send / receive cycle is set from 5ms to 10 seconds per module.
(3) Send and receive setting function

Set the send / receive area per data block according to the set | / O address.
(4) High speed link information provision function

It is easy to construct a reliable communication system by providing high speed link information with user keyword.
It indicates the high speed link points. The setting unit per high speed link block is word (16 points).

Classification Maximum send and | Maximum send points |Maximum block number| Maximum points per
receive points (Word) (Word) block (Word)
Basic mode 25600 6400 128ea (0-127) 200

Extension mode

(RAPIEnet V2) 179,200 179,200 256ea (0-255) 700

1) In Ethernet module version V5.0 or lower, the minimum send period setting unit of HS link service is 20ms..

2) FEnet Type: The maximum block number setting for receive is 32. By changing the receiving station number, up
to 128 blocks of data can be received.

3) RAPIEnet (Basic mode): The block number can be set from 0 to 63. But the maximum number of transmission
blocks is 32.

4) RAPIEnet (Extension mode): The block number can be set from 0 to 255. The maximum number of transmission
blocks is 256.




Chapter 5 High speed link service

5.2HS link send / receive data processing

How to use High Speed Link is explained as a setting example when Ethernet module of station“0” and station“1” sends and

receives data.

Station “0” sends 10 words of data in MO00O of block “0” and receives 10 words of data in M0O010 of block 1 of station “1”.
Station “1” receives 10 words of data from block 0 of station “0” to M0O030 and sends 10 words of data from M0020 of block

“1” of station “1”.

There are 32 block numbers from 0 to 31 for sending data and 128 from 0 to 127 for receiving in HS link parameter. When
sending data, set the Read area and Block nhumber to be read without specifying the destination station number.

“0” station
eStation type : local Block 0 —_—>
eMode : send / receive
Block 1 +—

eBlock No.: 0,1

eRead area: MO000O
eSave area: M0O010
eCommunication period
settings : 200ms

N

eSize: 10 words

“1” station

Block 0

Block 1

eStation type : local
eMode : send / receive
eBlock No.: 0,1

eRead area: M0020
eSave area: MO030
eCommunication period
settings : 200ms

Size: 10 words

High-speed link send / receive processing is performed at the end of scan time If the high-speed link period is faster than

scan, it is performed once at the end of scan.

Start scan End scan

Start scan

High speed link
Send / receive
cycle(5ms)

High speed link
Send / receive

Scan time(8ms) ¢
|
|
|
|
|
|

cycle(10ms) |

+
ﬂ

End scan
Start scan

%

-

-

End scan
Start scan

+
ﬂ

End scan

Start scan
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5.3 HS link setting

Select High Speed Link parameter and set the item. The setting order and function per item are as follows.

5.3.1 Standard settings

The following describes the Standard settings parameter needed high speed link service.

Standard Settings - FEnet X

Basic Security Time Synchronization Sets EIP Target Advanced

TCP/IP Settings

saonvo: @]
Media: Port1: |AUTO
Port2: | AUTO

IP Address: 192 . 188 . 1 . 2
Subnet Mask: 255 . 255 . 255 . 0
Gateway: 192 168
DNS Server: 0 0 0

DHCP Relay OPC UA
Mo. of Dedicated 3 (1-18)

Connections:

Receive Time Out Settings
Client 60 ®x1s x10ms

Server: 135 xS x10ms

Driver Setting
Server Mode: XGT server

RAPIEnet Settings: Disable

(1) Station No

In the high speed link service, the station number is used as the station number of Ethernet (master) when using
RAPIEnet protocol communication with the Communication device.

(2) RAPIEnNet setting

Service operation depends on the RAPIEnet settings in the driver settings of the Standard settings window.

RAPIEnet HS Link Service operation

setting

Disable Only Ethernet protocol is available.

RAPIEnet v1 Only RAPIEnet v1 protocol is available.

RAPIEnet v2 Only RAPIEnet EtherNet / IP protocols is available.
If RAPIEnet protocol is used, ring configuration and High Speed communication between
own networks are possible.

5-3
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5.3.2 HS Link Service

(1) Parameter setting method for high speed link

1) Click the Project tap on the left [Project] window and select by right clicking on the communication module item
on the tree.

e &
4 (s FEnet »
4- £ Metwork Configuration
4 Undefined Metwark
B LSPLC [BOSO XGL-EFMTIBNT
[ Moation Contral Module Ope
&, Systern Variable
EI LSPLC{XGK-CPUH)-Offline Add tem D
Bl Variable/Comment
- |jy Parameter
(3] Basic Pararneter
I,/O Parameter
4-[3] Scan Program
[ MewProgram

[

Copy Ctrl+C
Ctrl+V
Delete Communication Module

P2P Communication
High-speed Link Cemmunication

Communication Module Setting and Diagnosis 4 User Frame

Add Slave

2) Click the View High-speed Link tab on the left [Project] window and select by right clicking on the PLC item on
the tree.

D M
‘ FEnet*
[t LSPLC{XGK-CPUH)-stine

Upen

Add Item r PLC_

0
[ E] (=]
3

2
i
i
T
i

LSE . ecTric | 5-4
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5-5

(2) Communication module setting

Communication Module Setting and Diagnosis

Communication Module Setting and Diagnosis
Module type: | XGL-EFMTI(E]

Base Mo.:

5lot No.:

High-speed
link index:

™

Communication Period Settings

Period 200 msec
Output Data Settings In Case of Emergency

CPU error: Latch L

CPU stop: Latch 0

Input Data Set in an Emergency

Receive Area Data in
Receive Timeout:

Register Slave

®) Latch

Advanced

Clear

Clear

Clear

Cancel

Advanced *
Time Settings
Receive
10
Timeout(1~255): *oms
Use Extension Mode
Area Start Address Size
Flag fwea

Classification

Content

Module type

Register Ethernet module.

Base Number

Base number where Ethernet module is mounted.

Communication Siot No.

Slot number where Ethernet module is mounted.

module setting

number

High speed link

Set the high-speed link number from 1 to 12.

Communication

period settings Period type

It can be set from 5ms to 10sec in communication cycle.

- The send cycle is only for blocks set to send.

- The transmission period is equally applied to the entire
transmission block within one HS link parameter.

Receive Timeout

If it is not received within the set time, an error is processed.
(OS V8.3 or later)

When set, RAPIEnet V2 high-speed link supports a maximum
of 256 blocks x 700 words for transmission/reception/total
blocks. (OS V8.7 or later)

Advanced Use Extension
Mode
CPU error
Output data
settings in case of
emergency
CPU stop

Latch: It keeps and transmits the latest data received from the
CPU. Even if it is set to latch, it may appear to be cleared by
giving data to the CPU before the error. Clear: Clear Ignores the
data received from the CPU and sets HS link send data to O for
transmission. Even if the emergency output data setting of the
device area of the high speed link sending side is set to latch in
the CPU, the data set to 0 is transmitted when set to clear in the
emergency output data setting of XG5000 high speed link
setting.

Input Data Set in

an Emergency Timeout

Receive Area
Data in Receive

Latch: Retains the last received data when a reception timeout
occurs.

Clear: When a reception timeout occurs, the reception area is
cleared to “0”. (OS V9.0 or later)

Slave Registration™
(V6.0 or higher)

Select Smart I/O block to be registered in HS link.

* 1 is used when high speed linking with Smart | / O block of RAPIEnet v1 version after specifying RAPIEnet v1 in

Ethernet basic setting.
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(3) Screen after selecting communication module

B &

jex | Station lype

Diagnostic
Mode Station No. | Block number | Moduls Typs | Read [Transmit] Area Varcble name: | Variable name commert]  1e20 322 | 5aue Rocaive)Area Varable name | Varisbe neme comment] 5242 | irfamation

£ Network Configuration
[ Undefined Network

< B LSPLC [BOSO XGL-EFMT(B)(T.
High-speed Link 01

[ Mution Control Module

5 System Variable
4 EHLSPLC(XGK-CPUH)-Offline

B Variable/Comment
P ﬁp aaaaa ter

2 NewProgram

BBy Navigator Motion . HS Link .. P2P Win 15

Classification Content
FEnet Select for Ethernet high speed link communication.
RAPIEnet Select _for RAPIEnet high speed link commu_nication. _
The driver setting must be set to RAPIEnet in the Standard settings.
Station type RAPIEnet Select to control Smart I/O block with high speed link.
RAPIEnet RAPIEnet Smart I/O block can be set by loading slave in HS link parameter after
Remote " setting in slave configuration screen.
However, RAPIEnet vl must be enabled in Standard settings.
Send Send data.
Receive Receives data.
Mode Send/Receive'l It is automatically input when conne_cted to I / O mixed module slave of RAPIEnet
Smart I/O block. (Ethernet V6.0 or higher)
Send means the module station number of own station, and when receiving, it
means the module number of other station.
Station No If the station type is FEnet, the range is ‘0~63’, and if the station type is RAPIEnet,

the range is ‘0~220’.
‘Do not use duplicated station number because it is ' own station’ or unique
number that distinguishes communication module in the same network system.

Block number

Set the send / receive block.
* RAPIEnet Smart I/O block is automatically set to the same station number and
block number.

Memory area of own module. Available memory area.
1) XGK: P,M,K,F,T,C,U,ZL,N,D,R,ZR

Read area 2) XGI/XGR: M,1,Q,R,W
For the size and range of each memory area, refer to the XGT CPU memory
device list in the Appendix.
Variable The variable name of the device set in the read area is displayed.

Variable Comment

The variable comment of the device set in the read area is displayed.

Read area Word size

Set the data size to be sent in words.

This area is to receive and store data from the destination station.
1) XGK: P,M,K,F,T,C,U,Z,L,N,D,R,ZR

Save area 2) XGI/XGR: M,1,Q,R,W
For the size and range of each memory area, refer to the Synchronous start XGT
CPU memory device list in the Appendix.
Variable The variable name of the device set in the save area is displayed.

Variable Comment

The variable comment of the device set in the save area is displayed..

Save area Word size

Set the data size to be receive in words

Diagnostic information device

Displays the diagnostic information device when the use diagnostic area option of
the registered slave is enabled.

* 1 is used when high speed linking with Smart | / O block of RAPIEnet v1 version after specifying RAPIEnet v1 in

Ethernet basic setting.
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slaves are not supported.

speed link service is not supported.

(1) RAPIENet driver can be set in Ethernet (V6.0 or higher).
(2) RAPIEnet Remote is set automatically when connecting RAPIEnet Smart | / O block as slave.

(3) The send / receive mode is set when connecting RAPIEnet Smart | / O block.

(4) High-speed link service between Ethernet (master) and expansion driver / Smart | / O expansion /

Smart | / O block (slave) is available only in Smart | / O block RAPIEnet v1 version.

The rest of the

It is supported as a slave module (expansion driver / Smart | / O extension type / Smart | / O block
type) and smart extension service with Ethernet (V8.0 or higher) as RAPIEnet v2 driver, and high-

(4) Write high-speed link parameters
1) Select [Online]> [Write] on menu.

& XGK-CPUUMN_TEST - XG5000

DEads = ag =5
TS 0O G0 @SB

B [Lb Ak AR N — | L

Project

v EF KGK-CPUUN_TEST*
v@ MNetwork Configuration a2
v i Undefined Network =
: v a8y NewPLC [BOSO XGL-EFMT(

- XGL-DBDT
- XGL-DBDF
- XGL-DBDH
- XKGL-DBDT

Disconnect
Connection Settings...
Safety Lock

Safety Signature
Change Mode

Read...

Write...

Compare with PLC..,
Set Flash Memaory...

Control Redundancy

EtherCAT Slave

Communication Module Setting and Diagnosis

2) Check the relevant HS link in [Write] window and press OK button.

Write to PLC

[J1nhibit Program Upload
[ 5ets link enable with parameters

[ PLC Configuration
D Comment

D@ Parameter

'|:| Basic Parameter
E 1/0 parameter

; 18] Program
L[ 1EF Metwork Parameter
|:| Basic Settings

EIP tag

-[JJE] High-speed Link
-[JIE par(eIr)

D@, Spedal module parameter
1 Local Ethernet Parameter

4 [Reset]FEnet [based, slotd]
{3 smart Extension Service

? X

Cancel

Setting

Clear PLC...

i PROJECT EDIT FIND/REPLACE VIEW | ONLINE | MONITOR DEBUG TOOLS WINDOW HE

3
3
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(5) High-speed link parameters read

1) Select [Online]-> [read] on menu.

€ FEnet - XG5000
Y PROJECT EDIT FIND/REPLACE VIEW | ONLINE | MONITOR DEBUG TOOLS WINDOW HE
DEEgEE 5 &8 B ( &1 Disconnect
Connection Settings...
:m:% @@@ & G};%(@i onnection Settings

LR ARE N — | b % AF o
by T4 oEi 95 5 b B ata kg F o owlek

Project Safety Signature
v HF FEnet™ Change Mode 4
v 25 Metwork Configuration % Read
i v P Undefined Metwork = e
rite..

,,,,, % System Variable Compare with PLC...

v £ NewPLC(XGK-CPUUN)-STOP Set Flash Memory...
%3 Variable/Comment
v [#% Parameter

P Basic Parameter EtherCAT Slave 4
[ 170 Parameter Communication Module Setting and Diagnosis 4
E Local Ethernet Parameter Reset/Clear ¥
Scan Program
[ NewProgram

Control Redundancy

w
System Diagnostics 4

2) Check the relevant HS link in [read] window and press OK button.

Read From PLC 7 .t

Inhibit Program Upload

Sets link enable with parameters

] NewPLC N
""" 16 PLC Configuration
- Comment Cancel
718 Parameter
Basic Parameter
E 1/ parameter
ﬂ Special module parameter
@ Local Ethernet Parameter
- Program
[ J(¥] Data memory
""" [/Z® Metwork Parameter
. Basic Settings
FEnet [base0, slotd]
€D smart Extension Service
£ EIP Server
71 High-speed Link
[+ High-speed Link 01
E High-speed Link 02
H High-speed Link 03
H High-speed Link 04
E High-speed Link 05
E High-speed Link 0&
E High-speed Link 07
E High-speed Link 08
H High-speed Link 09
-1 High-speed Link 10 -

e

LSE ecrric | 5-8
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(6) Downloading parameter

1) Select [Online]> [Write] of XG5000 to open the screen below. Check the setting parameters and click the OK
button.

2) After downloading the Standard Settings parameters, the PLC power must be Off-> On or reset. If you do not
reset the communication module, the new communication parameter information will not be applied.

Write to PLC ? >

[ 1nhibit Program Upload
[ sets link enable with parameters

- PLC Configuration
- [ZIE] Comment Cancel

[ [} Parameter
Basic Parameter
1 1/0 parameter
: @, Special module parameter
o @ Local Ethernet Parameter
- [](&) Program
-~ [Z]EF Metwork Parameter
[ [E] Basic Settings
L [Reset]FEnet [basel, slotd]
EIP tag
[T EIP server
[ [E] High-speed Link
P2P(EIF)

Setting...

Clear PLC...
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5.3.3 Communication device configuration (Smart | / O block v1 version)

When using Smart | / O block RAPIEnet v1 driver, the following settings are possible.
Set RAPIEnet setting as below in standard settings.

Standard Settings - FEnet X
Basic Settings  Host Table Settings  Sets EIP Server

TCP/IP Settings

saonfo: [0 |

Media: Port1: |AUTO ~

Port2. |AUTO
IP address: [ e . 1 . 2 |
Subnet Mask: [ 255 . 255 . 255 . 0 |
Gateway: [ 12 . e . 1 . 1|
DNS Server: [0 0o . 0o . 1]
OoHcP [JRelay Clorc uA
No. of Dedicated (1-18)
Connections:

Receive Time Out Settings

Cliert: sec(2 - 255)

Server: sec(2 - 255)
Driver Setting
Server Mode: XGT server ~

Medbus Settings

RAPIEnet Settings: | RAPIEnet w1 ~

Cancel

Select the newly registered Ethernet (XGL-EFMx) module on the network configuration screen and right-click to select the
[Add Item]-> [Add Slave] menu. Alternatively, select [Project] > [Add Item] - [Add Slave] on the XG5000 menu to perform
the same function.

Project v b ox
~ BB FEnet*
w &% Network Configuration
« ) Undefined Network
v g% NewPLC [BOSD XGL-EFMT(B)(TAG)]
----- [ High-speed Link 01 Open
..... % Systemn Variable
v i) NewPLC(XGK-CPUH)-STOP

Add Item L4 Smart Extension

) Variable/Comment any ctr=C Netwark
Y @ ;raeme.te; B Paste Ctrl=V Communication Module

asic Parameter

. X Delete Delete P2P Communication

@ 170 Parameter

v Scan Program @ FrapEmess High-speed Link Communication
NewProgram User Frame
Communication Module Setting and Diagnosis 4

Add a Group

Add Slave

Views Connection

RIS View High-speed Link  View P2P

(1) Slave configuration window

RAPIEnet Smart I/0 block module is a slave module. To communicate with master module, parameter for each slave
must be set. The configuration window for the slave configuration is shown below.

LSeE ecrric | 5-10
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Project * R
v B FEnet*

~ & Network Configuration

¢ w i Undefined Network

| v g% NewPLC [BOSD XGL-EFMT(B)(TAG)]
: T High-speed Link 01
.48 Slave Configuration
% System Variable
+ (£ NewPLCXGK-CPUH)-STOP

E} Variable/Comment

~ [ Parameter

i [ Basic Parameter

. - /O Parameter

w Scan Program

. MewProgram

[AisIlall View High-speed Link  View P2P

Autoscan

Batch application of parameters

[ using the diagnostic area 62

[ using Heartbeat: 1000 (200~65500 63

1) Auto scan(Slave Registration)

This item is activated only when there is an online connection to the PLC. By clicking Auto Scan, you can add
Smart | O block that is not occupied by other master modules. Clicking Add Auto Scan Slave creates a list of
slaves that can be added from the network.

Autoscan
Slave Diagnosis
Base Mo.: 1] Link Type: RAPIEnet Total No. of Stations: 4 -
Slot Mo.: a Topology: Ring Station Mo. collision: Empty Measure cable distance
”~
Local: 0 GEL-ACBC: 1 GEL-AWEC: 2 GEL-DVAC: 4
N
. | L— 5 P 5 P 5
Name Meaning
Standard It means the network configuration information of master (local) number.
information Displays the base number and slot number.
Add Slave Itis a function to select the module to control among the Smart | / O block
modules existing in the network at the master station (Local).

Add Slave e
Select Slave
Stati
Sele| on sl b Master Master
ct | Num SYELYDE Station(1] Station(2)
ber
L] 1 GEL-&ACAC
L] 2 GEL-&VEC
Ll 4 GELLWAC

Select All Cancel

5-11 I Ls-—ELECTPIC
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1) If you click the Add Slave button, you can add only for Smart | / O block with no parameters. If the slave to
be selected in the slave add window is controlled by another master module, the slave cannot be selected.

2) Apply all parameters

This function is used when applying all the modules according to the module type. In the system consisting of
Smart |/ O block, parameters for each module can be applied collectively, reducing the parameter setting time.

B Apply All ®
Slave Selection: | GEL-ACBC ~
Product Name:  GEL-AC8C
Station:
Input Module
High-speed link transfer mode: Cydic i
High-speed link frequency(msec): 200 ~
Minimum tramsmission prohibition time (msec): 200
Data Transfer: (O Broadcast ® Uricast
Input Filter (msec): 3
Output Module
Emergency output mode: Latch
Apply(&) Close(C)
"7 Apply All X
Slave Selection: GEL-ACSC v
GEL-ACBC
Parameter CHOD CH1 CH2 CH3 CH4 CH5 CHE CHT7
[] Operation Channel Disable Disable Disable Disable Disable Disable Disable Disable
[] Input Range Setting 4~20mA 4~20mA 4~20mA 4~20mA 4~20mA 4~20mA 4~20mA 4~20mA
Output Data Type 0~16000 0~16000 0~16000 0~16000 0~16000 0~-16000 0~-16000 0-~-16000
[ Filter Status Setting Disable Disable Disable Disable Disable Disable Disable Disable
Filter Constant Value 1 1 1 1 1 1 1 1
[] Averaging Method Settin Disable Disable Disable Disable Disable Disable Disable Disable
[] Average Method Setting Count-Avr Count-Avr Count-Avr Count-Avr Count-Avr Count-Avr Count-Avr Count-Avr
Average Value 2 2 2 2 2 2 2 2
[] Hold Last Value Disable Disable Disable Dizable Dizsable Dizsable Dizsable Dizable
Apply(a) Close(C)
LSEectrec | 5-12
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The functions of each menu are as follows.

Name
Select Slave
Basic Parameter
Module Parameter

Meaning
It means the module to apply the parameter batch application function.
It means the basic parameter of module.

In case of module parameter, it is active only when analog input / output
module is selected.

Apply The set parameters are applied.

3) Using the diagnostic area

Using the diagnostic area function is to transmit diagnostic information provided from slave module to PLC

device area. Check using the diagnostic area and input the start address of PLC device where the diagnostic

information will be saved. The diagnosis area of 1 word per slave is automatically allocated to HS link block.
4) Using Heartbeat

It is a function to check if there is a network drop between the RAPIEnet Smart | / O block and master. It
checks the presence of the network by checking the heartbeat signal periodically every set time. The heartbeat
setting cycle is available from 200ms to 65500msec. If you check the use of diagnostic area, you can get the
information of each smart | / O block heartbeat error.

5) Master module number

This function is activated when Smart | / O block is used in XGR CPU. It means the station number of the

master of XGR CPU and the master module settled on standby Smart I/O block connects only the data of
XGR master side to the output.

(2) System catalog EDS information(slave registration)

It contains basic parameter information about Smart 1/0 block module and module parameter information. If you

double-click Smart 10 to use or drag-in to slave configuration window, parameter setting window of selected module
is created.

Slave Configuration - BOOS00

(3 XGL-EFMFB
= [ XGL-EFMHE
Autoscan [using the dagnostic area 62 o XOLEFMTE
[lusing Heartbeat: [0 as0sss00 5[ Generic
&[22 Generic Device
(i [23 Generic EtherNet/IP Module
=3 LS Industrial System Ca, Lid,
-2 AC Drive Device
[ 157 Ethernet 1P
- (3 5100 Ethernet IP
-3 LS Industrial Systems Co,, Ltd.
Slave Selection: GEL-ACEC ~

W7 Apply All

&£ Communications Adapter
-3 XGL-EIPT
I (T &3 LS Industrial Systems Co,Ltd.

(3 Communicat tions Adapter
Station:

- XEL-BSSB
©-[3 Device
5[ AC Drive Deviee
High-speed link transfer mode: Cycic g -0 CENT
(- (3 157 Ethemet IP
e -3 5100 Ethemet 1P
Mirimum transmission prokibition tne (msec): 200 =2 General Purpose Analog 170
- GEL-ACBC
= GEL-AVEC
Input Fiter (msec): 3 [ Verld
- GEL-DCAC
Output Module - GEL-DV4C
Emergency output mode: Latch & % E"GE'E“L‘PD”Z’:(” se Descrete /0
-3 GEL-DT4CT
- [ GEL-RV2C
Apply(A) Close(c) -3 GEL-TR4C1
=1 Generic Device
[ Generic EtherNet/IP Module
nrmmiinica tinns Adanter

R=Tx
System catalog | _

Input Module

High-speed ink frequency(mseq): 200

DataTransfer: O Broadeast @® Unicast

1) Basic parameter setting

Basic parameter means communication basic parameter setting for communication between Smart | / O block
module and master. Setting method is drag-in or double click slave module to configuration window from
catalog menu of slave configuration window. Basic parameters are divided into station number information

and setting items related to input module output module, and setting items are automatically activated
according to module type.
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BT Apply All b4

Slave Selection: | GEL-ACSC v
Basic Parameter [RRGEEEEEEEY

Product Name: ~ GEL-ACSC

Station:

Input Module

High-speed link transfer mode:
High-speed link frequency (msec): 0 -
Minimum transmission prohibition me (msec):
Data Transfer:

Input Fiter(msec):

Output Module

Emergency output mode: Latch

Cydic v

() Broadcast (®) Unicast

Apply(A) Close(c)

Name

Meaning

Product name

Displays the product name of the Smart | / O block module.

This menu is used to set Smart | / O station No. 0 ~ 63. It must match the station number of

Station No
the module on the network.
High-speed | Cyclic: It is used when the slave sends the input data to the master periodically.
link transfer | CoS: Used to send data only when the input status changes. If data changes are slow,
mode applying CoS can reduce the network load.
High-speed | Only applicable for slaves with inputs. Only active when the HS link send mode is Cyclic
link transfer | mode. The send cycle is as follows.
cycle
Y Setting range : 5~1000(default: 200)
This function is activated when the high speed link send mode of the slave is CoS. It means
Minimum the minimum interval for send mode in CoS.
send prohibit | Frequent data transfers on a periodic basis will affect the overall network load on the system.
time

Therefore, if the data of input module occurs frequently and aperiodically, the data is
transmitted only when the input value is changed at the set time interval.

Data Transfer
method

Broadcast: When you send data, not send the data to a specific receiver, but to all devices
connected to that network.
Unicast: This is the most commonly used one-to-one communication method.

Input filter

This function is activated only when the digital input module is used. The input filter function
is supported to prevent input of invalid values by external noise. Input the data as valid data
only when the data is kept above the input filter value set. Set the input filter value
considering the environment.

Setting range : 1~100(default: 3)

Emergency
Output Mode

This function is activated only when the output module type is used. If the network
configuration is disconnected during normal communication with the master module, the
existing output data can be set to latch and clear mode.

Latch: Maintain existing output data when physical communication with the master module
is disconnected.

Clear (default): Initializes the existing output data to 0 when physical communication with
the master module is disconnected.

The transmission cycle of the output module depends on the communication cycle setting
in [Communication module setting]
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() When the data of input module is changed in 2ms unit, it is the calculation method of network load
according to minimum send prohibition time.
1) When the minimum send prohibition time is set to 2 ms
— Packets per second (pps) = 1/ 0.002 = 500pps
— 5,000 pps with 10 modules of the same condition
2) When the minimum send prohibition time is set to 200ms
— Packets generated per second (pps) =1 /0.2 = 5pps
— 50pps with 10 modules of the same condition
(2) If the data change interval of input module is shorter than the minimum High Speed Link send period
(5ms), High Speed Link send mode is recommended as Cyclic mode for stable system operation.

2) Module parameter settings

Module parameter is a window to set basic information necessary to operate Smart | / O block special module
connected to network. For detailed parameters, refer to parameter setting of each product.

(3) High-speed link parameters setting

1) Click the Project tap on the left [Project] window and select “Hlgh-speed Link Communication” by right clicking
on the communication module item on the tree.

Project v I x
w EF FEnet*

v@ Metwork Configuration

w P Undefined Network

----- & System Variable Open
v fif) NewPLC(XGK-CPUK

n Add Item L3 Smart Extension

e %j Variable/Comme

~ [@ Parameter Copy Ctrl=C Network

Basic Parame| B2 paste Crl=V Communication Module
Iﬁ IO Paramete ¥ Delete Delete P2ZF Communication

H . High-speed Link Communication
MewProgram = Properties...

User Frame
Communication Module Setting and Diagnosis 4 Add a Group

Add Slave
Views Connection

Right-click on [High-speed Link 01] in the [Project Window]. When [Properties] — [Communication module
setting and Diagnosis] window is displayed, click [Register slave] and the [Apply RAPIEnet slave configuration]
window appears. Click after selecting the slave to apply.

2) HS link block setting(slave)
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Communication Module Settings > | Apply RAPIEnet slave configuration hat
Communication Module Settings Slave Configuration
Modkd . P— Station Mumber: 1, GEL-ACSC
odule type: X =2 il Station Mumber: 2, GEL-AVEC
Base Mo.: 00 B Station Mumber: 4, GEL-DV4C
Slat No.: 00
High-speed link |g1 i
index:
Communication period settings
Period type: 200 msec ~
Output data settings in case of emergency
CPU error: (O Latch (®) Clear
CPU stop: O Latch (®) Clear
Slave Registration oK Cancel Select All Apply Cancel

Even if it is necessary to change the slave list in the HS link block according to the network system change, click
Slave Registration to select the slave to be used and click Apply.

3) HS link block setting(slave)

If you double-click High-speed Link item on High-speed Link view tab, the following parameter registration
window is created.

Set the area to read and save.

Diagnostic
Index Station type fode Station numbeq Block number [ Module type | Read area| Varisble name  Varisble name camment| E\?;rdd‘:::; Save area| Variable name | Yariable name comment 3\?;:1::: information
device

0 | FARERE 5 Reccive 2 2 GELAVEC MOD10 8

Remote
1| PAPlEnet oy G 1 4 GELDVAC | MODOD 4

Remote
2
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(4) Downloading the high speed link parameter

After completing HS link parameter setting, select [Online] = [Write (Basic setting, HS link, P2P)] in XG5000 and
check the HS link and click OK button.

Write to PLC

[ trhibit Program Upload

[ sets link enable with parameters

2 newLe

1P PLC Configuration

~[ZIE] Comment Cancel
Setting...
g
& yo parameter Clear PLC...
@, Spedal module parameter

Program

EF Network Parameter

asic Settings

[Reset]FEnet [basel, slot]
EIP tag

6D P server

[ & High-speed Link

E High-speed Link 01

~[E PepER)

(5) High-speed link parameters enable

Select [Online] &> [Communication module setting and diagnosis] = [Enable services] in XG5000 and check the

corresponding high speed link and click the write button. When HS link is enabled, HS LED is turned on in the LED
display of the module to start HS link.

Enable Services

BB EF

=) DE Communication service status

=11 High-speed Link

([ High-speed Link 1

DE‘. High-speed Link 2
[ High-speed Link 3

- [ High-speed Link 4

- JE High-speed Link 5

DH High-speed Link &
DE High-speed Link 7

- [ High-speed Link 8

- J[E, High-speed Link 9

-~ High-speed Link 10
DE High-speed Link 11

-1 High-speed Link 12

- Por(Er)

~[ 1B pap(ETP) 1

CE par(Er) 2

OH prEP) 3

- prEr) 4

~[JE] Pp(erP) 5

-1 PrEP) &

D& rrEr) 7

~H PrEP) &

=[] Smart Extension -

Conce

5-17 I LSELECTPiC




Chapter 5 High speed link service

5.4HS Link operation

Standard settings

> To change the basic parameters (high speed link
1 |Use XGS%)O station no., Media, IP, etc.), the basic parameters
— - must be set, downloaded and reset.

Communication module settings = = . =

Module Type > Network ConfigurationAdd item on Undefined

2 ©® XGL-FEMXx(B) Network] — [Select communication module] and

3 | Base No.(0~7) select add module in 'Communication module
2 | SiotNo.(0-11) settings“window to set communication module.

v
Select High speed link

5 | HS link setting window

——y Click added communication module and select Add
item-> High speed link communication.

\Y
Communication module settings 1. Set according to the number of communication
6 | High speed link number 1| = modules used.
~12 (One high speed link is applied per communication
7 | Select Period type module.)
7 | Output data setup in case of
emergency
\
High speed link block setting 1. The self station number is automatically assigned
S (R‘;?'Ster list in sending and the other station number must be
ation type o .
8 ® FEnet/RAPIENet —> specified in receiving. 3 . .
Mode 2. 32 blocks can be specified Send / receive data is
o ®send / receive distinguished by station number and block number.
10 | Station number(0~63) 3. Set the station number. The station number is
11 | Block number(0 ~31) automatically set for sending.
12 | Read area / Save area 4. Set the block number.
13 | Size(1~ 200 word) 5. Set the area to read when sending and the save
. v . area when receiving.
Online (after connecting
local) Download HS link parameters to CPU from XG5000
Write —
14 @High speed link parameter
\Y4

Enable services setting
15 | High speed link 1 ~12
v

Enable enable services in XG5000 by setting high
speed link parameter set for high speed link
oneration.

J

1 to 15 contents are also set
for the destination station.

1) V5.0 or less: The period type of communication period setting can be set from 20ms to 10sec.
2) HS link number can be set from 1 ~ 12. The parameter should be set using one HS link number per
module to prevent collision of communication data.




Chapter 5 High speed link service

(1) HS Link Service Operation

XGP-AC23 XGK-CPUE| XGL-EFMFB| XGL-EFMFB | NGHD22A | XGO-TR2A
XGE-B044

XGP-ACP3 YGK-CPUE | ¥GL-EFMFR | GO-TR2A | XGHD22A | XGO-TR2A | ¥GH-OT4A | XGFDC4H
YGB-B06A

How to use High Speed Link is explained as a setting example when Ethernet module of station “0” and station “1” sends

and receives data.

“Station "0" transmits two words of M0O0O0O in block“0” and the data received from station "1" is stored in M0010. “Station "1"
receives M000O 2 words of station“0” stores them in M0010, and transmits 2 words of MO00OO data in block“1”

When sending, specify the area to be read and the sending block without specifying the destination station number.

eStation type: local
eMode: send / receive
eBlock No.: 0, 1
eBlock 0, send (Read
area): M0O000, M0001
eBlock 1, receive (Save
area)

: M0010, M0011
ePeriod type: 200ms
eSize: 2 words

“0” station

Block 0

Block 1

“1” station

Block 0

Block 1

eStation type: local
eMode: send / receive
eBlock No.: 0, 1

eBlock 0, receive (Save
area): M0010, M0011
eBlock 1, send (Read
area): M0O000, M0001
ePeriod type: 200ms
eSize: 2 words
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Program sequence: Connect to PLC system 1, 2 CPU and set in the following order. Set system 1 as station

number 0 and system 2 as station number 1.

Seq .
Settin .
uen 9 Setting method
process
ce
1) [Project]>Open [New Project] and enter the project name, CPU series, CPU type,
programming type, and program name.
Mew Project ? *
Project name: |5”‘5’tEXtE”5‘U” [ e ]
CPU Series XGK ~ | | Product Name...
CPU type: ¥GK-CPUH w
Create irﬂorir:tn:vming LD Programming ~
1 new Programname: | NewProgram
project n
Project description:
1) Select [Undefined Network]>[Add item]> [Communication module].
2) In the [Select Module] window, click “Add module”.
Select Module X
PLC type:
NewPLC ~
Communication Module:
Number, BASE Slot Module Network in use
Undefined
2 Network
Add Add Modle... | Delete module Cancel
1) Set Type, Base and Slot in Communication module settings. After that, select OK button
in [Communication module selection] and module setting is completed.
Communication Module Settings X
Type: XGL-EFMT(E) ~
Base: ily] ~
Slot: 00 ~
Cance
Double-click the communication module in the [Project] window.
Project + I x
v &% Smart Extension *
+ HB Network Configuration
| v Undefined Network
; oy ,5%, MNewPLC [BOSD XGL-EFMT(B)(TAG]]
3 Standard ----- & System Variable
H v .ffi)l NewPLC(XGK-CPUH)-Offline
Settlngs ----- 29 Variable/Comment
v@ Parameter
-.JE Basic Parameter
- IO Parameter
~ [&] 5can Program
\.fE] NewProgram
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5-21

Seq
uen
ce

Setting
process

Setting method

Standard
settings

Set TCP / IP Settings, Receive time out Settings, and Driver settings on the [Basic

Settings] tab.

1) Station No.0: set station number 0 and IP address

2) Station No.1: set station number 1 and IP address to a station number different from

station number 0.

Standard Settings - FEnet x Standard Settings - FEnet =
Basic Seftings | Host Table Settings  Sets EIP Server Basic Settings Host Table Seftings  Sets EIP Server
TCP/IF Settings TCP/IP Settings
Staton No.: b ] Station Mo
Media Partl: [AUTO ~ Media Fort1. [AUTO ~
Portz: [AUTO Pon2. [AUTO
IP address [ e 163 1 1 ] IP address [ o2 168 1 EN
Subret Mask: [ 255 255 . 255 . O Subriet Mask [=s5 255 . 255 o
Gateway [ e 168 1 1] Gateway [ o2 168 1 [
DNS Server: [ e 0 0 1] DNS Server [ e 0. o 1]
[ oHcP [ Relay Jorcua ] DHCP [ Relay [Jorcua
Mo. of Dedicated (1-16) Mo. of Dedicated (1-18)
Connections: Connections
Receive Time Out Settings Receive Time Out Settings
Client seci2 - 255) Client: seci2 - 255)
Server sec(2 - 255) Server: seci2 - 255)
Driver Setting Driver Setting
Server Mode XGT server ~ Server Mode: XGT server ~
Modbus Settings Modbus Seftings
RAPIEnet Settings: | RAFIEnet v2 ~ RAPIEnet Settings: | RAPIEnet v2 ~

HS  link

setting

Click [Project]>[Add item]->[High speed link communication].

v 3 ox

Project
~ EF Smart Extension *
~ B Network Configuration
i~ Undefined Network
... g% NewPLC [BOSD XGL-EFMTm e
. System Variable Open

~ - NewPLC(XGK-CPUH)-Offline P 5 .
24 Variable/Comment
~ -[# Parameter Copy ctri=C Metwork
[E] Basic Parameter B2 Paste Ctri=V Communication Module
1/0 Parameter ¥ Delete Delete P2P Communication
(2] ScanP
~ can Frogram = High-speed Link Communication
NewProgram Properties...
User Frame
Communication Module Setting and Diagnosis ~ » Add a Group
Add Slave
Views Connection

From the Communication module settings window, select the high speed link index,
communication period and output data settings in case of emergency, and then click the
[OK] button.

Communication Module Settings x

Communication Module Settings

Module type: XGL-EFMT(E)

Base No.: 0o

Slot Mo, : 00

High-speed link | g1 ~
index:

Communication period settings

Period type: 200 msec v

Output data settings in case of emergency

CPU error: Olatch ®) Clear
CPU stop: OiLatch (®) Clear
Slave Registration | I (¢].4 Cancel
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Seq .
Settin .
uen procesgs Setting method
ce
Projed - & < NewriC-rstncor < MM |
Smart Ext *
v ?é?‘\letwnerr:?:nﬁguratmn Index Station type Mode Station numben Block number | Module bpe Fead area
i v ) Undefined Metwork
; ~ 593, MewPLC [BOSD XGL-EFMT(B)(TAG)] 0
L./ High-speed Link 01 !
% System Variable 2
v ) NewPLC[XGK-CPUH)-Offline 3
%j Variable/Comment 4
v@ Parameter 5
- Basic Parameter 5
[ 10 Parameter 7
v Scan Program a
. & NewProgram q
4 HS link
setting Double-click HS link 01 in the [Project] window.
1)Block 0 send and block 1 receive of Station No. O(Block 1 send data of station No. 1)
' Read aiea Save area Disgnastic
Index Station type: Mads Station number | Block number | Module tpe Read arza Variable name | Variable name comment Word size Save area Wariable name| Y ariable name comment e e information
[i] FEnet 1. Send [i] [i] MO000 2 B
1 FEnet 2. Receive 1 1 Moo10 2
2
2)Block 0 receive(Block 0 send data of station No.0) and block 1 send of Station No. 1
Newpt..- s i o1 |
' Read s. Diagnostic
Indes | Station type Made Station number | Block number| Madule type Read area Variable name | Variable name comment vf:m::: Save aiea “aiiable name | Variable name comment vj;;i‘:: irformation
0 FEnet 1. Send 1 1 MO000 2 e
1 FEnet 2. Receive o o Moo10 2
2
1) Station No. 0 program: Sends M0000 (hFFFF and h0000 values changed every 500ms)
and M0001 value 2 word data to high speed link 01 as block 0, and outputs M0010 to
P0003 of M0010 and M0011 data received as block 1 of station number 1 to high speed
link 01.
_T15
. I ! MOY hFFFF Dooooo l_
_T15
i | Hew haooo Doooon [_
,HSWD,DSDTATE
] i | Hov 000000 MO0OD L
_OH
. | | HOV Kod1 0 POOO3 [_
g | Programm | 1) Station No. 1 program: Sends M0000 (hAAAA and h0000 values changed every
Ing 500ms) and M0001 value 2 word data to high speed link 01 as block 1, and outputs M0010

to PO001 of MO010 and M0011 data received as block 0 of station number 0 to high speed
link 01.

| AN e, |

T [ wov [ 0on0no L
D i

TS

y Hov hoo00 DO0000
1 | L

_HS1_STATE
il |
| How DO0000 wooon ||

e |

N
A [ nov Noo10 poo01 ||
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I

=3 Setting

Set link

Enable].
ONLINE | MONITOR DEBUG TOOLS WINDOW HELP
(£ Disconnect
| Connedtion Settings...

{ Safety Lock

| Safety Signature
Change Mode
Read...

=
B write...
a8

Compare with PLC...

(
Set Flash Memary...

Control Redundancy

enable EtherCAT Slave
Communication Module Setting and Diagnosis @ Enables senvices
e e 05 Upload/Download...
System Diagnostics
EIP Tag Manager

Forced 1/0...

@ rorce Config. Upload (Dnet, Pret)
Skip 1/0...
— System Diagnosis
Module Changing Wizard. .
Base Changing Wizard...

@ start Online Editing cr-Q

| &S write Modified Program Chrl=W

@ End Online Editing ctri-u
Open Online Editing Program...

LSELECTPFC

MR WL e
SIS S S|

uen process Setting method
ce
In the [Online]>[Write] window ,Click ok.
Write to PLC ? X
[[] tnhibit Program Upload
[ sets link enable with parameters
@ newpLC
PLC Configuration
Comment Cancel
@ Parameter Setting
Basic Parameter
6 P rogram 1JO parameter e
DOWnload . Special module parameter sarfLe
Program
Network Parameter
Basic Settings
[Reset]FEnet [basen, slot0]
EIP tag
EIP Server
T8l High-speed Link
[/ H High-spesd Link 01
P2P(EIP)
[Online]>[Communication module setting and diagnosis]->check link 1 in [Service

Enable Services

B A

E=-CE ?CUmmumcath service sta
- High-speed Link

[JE High-speed Link 1
- []{E High-speed Link 2
--["J[E High-speed Link 3
-1 High-speed Link 4

[JE High-speed Link 5
-] High-speed Link &
- ]{E High-speed Link 7
--[J[E High-speed Link 8
--[1[E High-speed Link 8

[ High-speed Link 10
- []{E] High-speed Link 11
~-[1T8 High-speed Link 12
=-CIE P2rEF)

[ PzrEP) 1

[ PzrEr) 2
-[1[E] pap(EP) 3
-1 PaPER) 4
-1 PIPER) 5§

[ rzrEP) 6
- []{E] pap(EIP) 7
1] pap(ErP) 8
=[] smart Extension

X
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5.5HS Link Information

551

High speed link flag

As HS link service exchanges data between two or more communication modules, it is necessary to check the reliability of
data read from the other station. User can check the service status by using HS link flag information for reliable communication.
In other words, according to the parameters set by the user, the high-speed link flag information is provided by synthesizing
the data received up to that point every time a high-speed link is operated. HS link flag information includes run-link

(_HSXRLINK), link-trouble (_ HSXLTRBL) for information of the whole communication network, and HSXSTATE, HSXTRX,
_HSxMOD, and _ HSXERR for communication status for 128 blocks. When write a program, use high speed link information

in the form of keywords and monitor the high speed link status using the high speed link flag information monitor function.
shows the function and definition of HS link information.

NEIIE] Operation Error High-speed |Block settin
Classification Run-Link [Link-Trouble | communicati P operation 119n-sp 9
mode link state status
on status mode
Type of|Complete Complete Individual Individual Individual Individual Individual
information information |information |information |information |information |information |information
Name of keyword _HSXSETBL
(X: High speed | HSXRLINK | HSxLTRBL |-1SXTRXIN] |_HSXMODIN] |_HSXERRIN]|L_HSXSTATE {50y 10
link No = 1~12) (n=0..127)  [(n=0..127) (n=0..127)  [[n](n=0..127) 127)
Data type Bit Bit Bit-Array Bit-Array Bit-Array Bit-Array Bit-Array
Monitoring Possible Possible Possible Possible Possible Possible Possible
Use of program Possible Possible Possible Possible Possible Possible Possible

If you select [Variable / Comment] in the project screen of XG5000, [View Flag] screen is displayed. It is displayed when the

flag type is “high speed link” in this screen.

V] view variale | D] view Device | view Flag \

Flag Type Select List

High speed link ~ (A all Parameter number: 1 Block index:

Variable Type Device IE:)F"U?A HMI Comment

1 _HS1_RLINK BIT L000000 [] [™ | Al stations are OK in HS link 1
2 _HS2_RLINK BIT L000500 r [ Al stations are OK in HS link 2
3 _HS3_RLINK BIT L001000 r [~ All stations are OK in HS link 3
4 _HS4_RLINK BIT LO01500 r [~ All stations are OK in HS link 4
5 _HS5_RLINK BIT LO02000 r [~ All stations are OK in HS link 5
6 _HS8B6_RLINK BIT L002500 [] [™ Al stations are OK in HS link 6
7 _HS7_RLINK BIT L003000 [] [~ Al stations are OK in HS link 7
3 _HS8_RLINK BIT L003500 r [ All stations are OK in HS link 8
9 _HS9_RLINK BIT LO04000 r [~ All stations are OK in HS link 9
10 _HS10_RLINK BIT LO04500 r [~ All stations are OK in HS link 10
1 _HS811_RLINK BIT L005000 [] [™ Al stations are OK in HS link 11
12 _HS12_RLINK BIT L005500 r [” | Al stations are OK in HS link 12

(1) Run-link (_HSXRLINK, x=High speed link No.(1~12))

This is the entire information that indicates whether the high speed link is normally executed with the set parameters.

If it is 'On’ once, it is 'On' when the following conditions are met.

1)
2)
3)
4)

time

When ‘On’ is set for Enable Link
When all parameter registration lists are set normally
When all the data corresponding to the parameter registration list are transmitted and received to the set cycle
When the status of all destination stations set for the parameter are in RUN status and there is no error at that

(2) Link-trouble(_ HSXLTRBL, x=High speed link No.(1~12)

5-24
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Total Information that indicates whether the High Speed Link is normal with the set parameters. It is Off when Run
Link is On and it is on Run Link is Off.

(3) Normal communication status(_ HSXTRX][0..127], x=High speed link No.(1~12))

(4)

®)

(6)

()

Up to 128 send / receive information as individual information representing the send / receive status of block link

parameter. If registered sending / receiving operation is done according to period time, corresponding bit is On and
if not, it is Off.

Operation mode(_ HSxMODE]0..127], x=High speed link No.(1~12))

This is the individual information that shows the block operation status of HS link parameter and shows 128 operation
mode information which is the maximum number of registered. If the station set for the Block item is in Run mode,
the relevant bit will become On. If it is in Stop/Pause/Debug mode, the relevant bit will become Off.

Error operation mode(_ HSXERR[0..127], x=High speed link No.(1~12))

Individual information indicating the operation status of each high-speed link parameter for each block. Up to 128
blocks of error information are displayed. When the user program cannot be executed, it indicates that the other
station PLC is operating normally when it is Off, and when it is On, the other station is in abnormal status.

High-speed link  state( HSXSTATEJ[0..127], x=High speed link No.(1~12))

As individual information that shows the operation status of each HS block parameter, it displays up to 128 HS link
states and displays the information for each item by block. That is, if the sending / receiving status of each list is
normal, the operation mode is Run, if there is no error, it is On and if it is not satisfied, the item is Off.

Block setting status( HSXSETBLOCK]O0..127], x=High speed link No.(1~12))
As individual information that shows the operation status of each HS block parameter, it displays up to 128 block

setting states and displays the information for each item by block. That is, if the sending / receiving status of each
block is normal, the operation mode is Run, if there is no error, it is On and if it is not satisfied, the item is Off.

(8) Receiving area clear setting status when reception timeout occurs (_ HSx_INPUT_CLR, x=High speed link No.(1~12))

5-25

Among the high speed link parameters, it is On when the “Input Data Set in an Emergency: Receive Area Data in
Receive Timeout” setting is Latch.
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5.5.2 HS Link Information Monitor

High speed link information can be checked by using variable /comment monitor or communication module setting after
connecting XG5000 online.

(1) Variable monitor

Variable monitor is a function to monitor only necessary items by using view flag monitor function of XG5000. Select
[Variable Monitoring Window] in [View] to display the following variable registration screen. Select the flag to register
by selecting the high speed link information flags one by one in the variable flag list list screen. At this time, since
_HSXSTATE [n], _HSXERR [n], _HSXxMOD [n], and _HSXTRX [n] are Array type flags, the user must select the array
number manually and the array number means the block number in the parameter.

(2) High speed link monitor in XG5000 diagnostic service

Select [Connet] - [Online] - [Communication module setting and Diagnosis] = [System Diagnosis] from XG5000.
P revrcpososmatedension] »” newric x [

XGP-xxXX XEL-
Iy g SGK-CPUH " ppyrp

l
]

hd
Systemn information Address Assignment (Yariable} Comment
- [l CPU: %GK-CPUH High Performance CPU Maduletl/0: Maxirmurm 6144 Points)
{5
{2 Slat 1t Empty slot [POO010 ~ POOOTF]
“-[Hz Slot 2: Empty slat [POO020 ~ PO0O0ZF]
[tls Slat 3: Empty slot [PO0030 ~ PO003F]
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(3) HS Link Service selection

Place the mouse cursor on XGL-EFMTB and right-click and click [Status by Service] to open the following screen.
Select HS link service.

Status by service

Dedicated Service P2P Service HS Link Service  Smart Extension
Standard Information

*
HS Link Service Information
Base Mo Send f—
Slot MNo.: Receive 5 (Run link: 1, Link trouble: 0)
Lo ] R [ ]
Communication Diagnostics:
Index  Station number  Block number Block type Data size FReadarea Save area  Highspeed link state Mode HE
00 02 02 Slave reception 08 MO010 Mormal Fun Mo
[l 04 04 Slave transmission 04 MOo00 Nomal Run  No
£ >
Close

5-27 |
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5.6 XGR Redundancy Program Method

This section explains how to use High Speed Link in XGR.

5.6.1

When configuring an XGR redundant network

When configuring a redundant network in XGR, you can freely set the A-side and B-side station numbers and IP addresses.
In other words, The same station number (IP address) or different station number (IP address) can be used. If you use other
station number, network operates separately.

XCR-ACF  XGR-ACF
XGR—CPUH X6L-EFHT XGL-EIMH . - iy g SGR—CPUH XGL-EFHT XGL-EINH

1) ) ) 0 [0][@] e
MASTER

. 0] »
g o et
* RUN

g . | @
| @

XGI-CPUU  XGO-RY2 XGL- FMT XGL- FHT XGQ-TR4 XGL- [MH XGL- THMH XGL-ES XGL-ESHF XC ~TR4 XGQ-TRZ ‘

@ 8@ ol m 0 (e

(1) When XGR sends - XGK (1) receives

1) Issue of sequence number

When sending from XGR, the highest 1 word must be issued in the ladder program as the sequence number
(SEQ_NO). The sequence number is incremented by 1 for each scan.

2) User data

The data sent by the user is set in the remaining part except the top 1 word. In XGR system, master
(communication module of Main base) and standby (communication module of Main base) always provide the
same service, so the receiver must decide which data to receive. In addition, if one cable is disconnected due
to a network failure, programming is required to receive data from the other side and not receive data from the
disconnected side. Based on the issued sequence number, the receiving side can receive and use the updated
data whenever the sequence number is updated.

3) Receive side input data setting

When the sequence number is updated as in the case above, the receive-side receives the updated data of
A-side or B-side as input data and updates the sequence number at that time. In general, since the standby
communication module is serviced 1 scan later than the master communication module, it always receives the
communication data sent from the master communication module as input data. Even if data is input from
standby after saving the master side sequence number, the data is ignored because it is the same sequence
number. In addition, if communication of one side becomes impossible due to network line failure, sequence
number is not updated and communication data is not received as input data, thus communication duplication
is possible.
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1 '

4) High speed link function block

In XGR and XGl, function block is used for receiving data processing. In XGK, there is no function block, so
you can use the program written in the below letter.

Send/ receive using sequence number is a basic data send / receive algorithm method. Depending on your
application service, you do not need to use it if you have a specific data pattern.

(2) When XGK(I) sends - XGR receives
1) Set data send and receive

The XGK (1) side to be transmitted should use two communication modules to service the same data with the
same setting. At this time, sequence number is not necessary and the receiving side receives communication
data coming into the master as input data. If STATE FLAG is turned off with STATE FLAG as a contact in the
condition of receiving input data in consideration of network failure, copy the standby data to the master by
SYNC command and receive the data.

Since the block setting is the same for A-side and B-side, if the station number of the sending side is different,
the receiving block should be Setting Value to twice the desired block.
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5.6.2 When configuring an XGR Single network

In case of a single net in XGR, A-Side and B-Side are grouped in the same network. So, station number and IP should be
set differently.

XGR-ACF  XGR-ACF ‘ ‘ XGR-ACF  XGR-ACF = — - o
‘ O - o NGR—CPUH XGL-EFNT XGL-EIMH it O NGR—CPUH XGL-EFMT XGL-EIMH

O "

(@@} WENS ORI [O)[0] & e

HASTER
o] CPU-A
* CPU-B
* RUN
SToP

1|

nn‘s a/l’ BR‘S‘%’/T

(1) When XGR sends - XGK (l) receives
1) Data send and receive

When sending, block setting is one station number to receive, so communication service is made same as
communication setting between XGK (I) and XGK (I). On the receiving side, if the data received from A (B) -
Side is the reference or STATE FLAG of the input block of the station is OFF, the data of B (A) -Side station
no. must be treated as input data.

(4) When XGK(l) sends - XGR receives
1) Data send and receive

When sending from XGK (I), set data to be sent equally to two communication modules connected to XGR
system. In XGR, the receiving side, data coming into the master is treated as input data. If STATE FLAG is
set at the contact point of input data and STATE FLAG of the master is turned off, input data of the
communication module of the standby main base must be imported to the master using the SYNC command.
This series of steps can be set up in the same way as the XGR receiving side when configuring redundant
network.
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5.7 XGR Redundant High Speed Link Setting Program

This section explains how to use High Speed Link in XGR.
5.7.1 When configuring an XGR redundant network
(1) When XGR sends - XGK (I) receives
1) Communication settings(XGR send-side)

Standard settings (When using the same high speed link station no. By applying One IP Solution)

Standard Settings - FEnet X
Basic Settings  Host Table Settings

OME IP Solution(Station Mumber and IP on standby are Master+1,

TCP/IP Settings

One IP
Station Mo.: l:l
Media: Portl: | AUTO -
Port2: | AUTO!
1P address: [[12 .18 . 1 . 2 |
Subnet Mask: | 255 . 255 . 255 .0 |
Gateway: [[192 .18 . 1 . 1 |
DNS Server: | o .o .0 .1 |
DHCP
Crelay orcua
Comectons: a-1
Receive Time Out Settings

Client: sec(2 - 255)
Server: sec(2 - 255)

Driver Setting

Server Mode: XGT server =
Modbus Settings
RAPIEnet Settings: | Disable e
Cancel

High speed link block setting (When the sequence number is set in block 0)

Index | Station type Mode Station rumber Block number|  Maodule type Read area Yariable name ‘ariable name comment E\f;g ‘:{::
0 FEret 1. Send A-side:l], B-side: 1] ZMwi 1
1 FEret 1. Send A-side:l], B-side: 1 w100 2

High speed link block setting (When setting sequence number (first 1 word) and data to be sent by user in

block 0)
. . . . Fead area
Index | Station type Maode Station rumber Block number| Module type Read area Yariable narme Variable name comment| 4, S
0 FEret 1. Send A-side:l], B-side:1 1] w100 3
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2) Ladder program(XGR send- side)
In the HS link block setting, increase the sequence number in the first block and set the send data to be sent

by the user in the second block.

Ly

_ON INC
—— ——EN ENOf

Lz

%BMWO N ouTE %MW

L3

Comment}! set the send data to be sent by the user

L5

_T200MS MOVE
F—EN  ENOF

LE

%IW31.00 4y QUTF %MWI00

Ly

3) Communication settings(XGK(l) receive-side)

Standard settings

Commemli.l' increase the sequence number for HS link send

Standard Settings - FEnet

TCR/IP Settings

Basic Settings  Host Table Settings

OME IP Solution{Station Mumber and IP on standby are Master+1

* Standard Settings - FEnet

TCP/IP Settings

Basic Settings  Host Table Settings

[~ ONE 1P Solution(Station Mumber and IP on standby are Master +1

Port1: | AUTO -
Port2; | AUTO
[ 192 . 168 1 12|
[ 255 . a5 . ess o |
[ 192 . 168 1 1]
[ o 0 0 1]
Corc ua

a-®

sec(2 - 255)
[15 ] secz-255)

XGT server

Modbus Settings

Disable

One IP One IP
Station Mo.: Station MNo.:
Media: Porti: AUTO ~ Media:

Port2: AUTO
IP address: [ 132 . 18 1 1| 1P address:
Subnet Mask: | 255 255 255 0 | Subnet Mask:
Gateway: [ 192 . 18 1 1] Gateway:
DNS Server: | 0 0 0 1 | DNS Server:

DHCP DHCP
[Crelay Copcua [Crelay

Conmectons: @9 Cometaone:
Receive Time Out Settings Receive Time Out Settings
Client: sec(2 - 255) Client:
Server: _ sec(2 - 255) Server:
Driver Setting Driver Setting
Server Mode: XGT server ~ Server Mode:
Modbus Settings
RAFIEnet Settings: | Digable - RAPIEnet Settings:
Cancel

LS'ELECTR’IC
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High speed link block setting (Communication module connected to XGR A-Side)

Index Station type Mode Station number | Block number | Module type | Read area| Yariable name | Yariable name comment Ev?;dd ‘ZE: Save area Wariable name | Yariable name comment| 3?::1‘?'::
i} FEnet 2. Receive 0 0 w0 1
1 FEnet 2 Receive 1} 1 ZMw/100 2
The sequence number and user data can be set in one block as shown below.
Index | Station bype Mode Station rumber | Block number [ Module lype | Read area| Variable name | Vanabls name comment ﬁ,?;[dd :::: Save area “ariable name | Variable name comment 33:52’;:
0 FEmet 2 Receive 1} 1} ZMw109 3
High speed link block setting (Communication module connected to XGR B-Side)
Index Station type Mode Station number | Block number | Module type | Read area| Yariable name | Yariable name comment, E:;dd ‘z‘r:: Save area “Wariable name | Yariable name comment 3\?;;?;:
0 FEnet 2. Receive 1] 1 Zhw20 1
1 FEnet 2. Receive 0 1 w20 2
The sequence number and user data can be set in one block as shown below.
Index | Station type Mode Station number | Block number | Module lype | Read area| Variable name | Variable name comment C\?;g ‘:ir:; Save aiea “Yariable name | Yaniable name comment 3\?;%2"::
0 FEnat 2. Receive 1} 1} #Mw119 3

4) ladder program(XGK(l) receive-side)

Input data setting using HS_FB function block.

INST

hsfb_on HS_FB
— —REQ DONf
E

_HS1_STA

TEODT  9MOD STATF
Total states | A
of HS link
1-block 001

_HS2_STA

TEODT  4moD
Total states | |
of HS link
2-block 001

m

%MWI0 {Rx
SRI_

RCV_Al  HRev
LAl

BMW20  Rx_
SRI_

RCV_Bl  1rcv
RCV_DATA Ry
DAT
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Classification

Contents

MOD A STATE FLAG for A-Side High Speed Link Input Block
MOD B STATE FLAG for B-Side High Speed Link Input Block
RX SRI A SEQ number of A-Side(Device setting (word) of HS link first input block)
RCV Al Receive data of A-Side(Variable Array)
RX SRI B SEQ number of B-Side(Device setting (word) of HS link first input block)
RCV B1 Receive data of B-Side(Variable Array)
RCV DATA Input data to be processed by user by judging SEQ number of A-Side, SEQ

number of B-Side and STATE

5) HS link receiving ladder program in XGK

In XGK, there is no function block, so you can use the program written in the below letter. Input the sequence
number of A-Side / B-Side input to RX_SRI_A / B and the device of data to be input to RCV_A1 / B1. The
MOV instruction has a size of 10 in the bottom item. Consider the size to be entered. For the remaining items,

refer to the function block used in XGR (I) of the same title.

nu

2 |/ wn=e
“ | _Hs1_#oD00
1 MOD_t
[ | ’
~ | _Hsz_soDon
0 MOD_E
2 |4 Compare SEQ-HD
N HS_4_NOR
0 < CUR_SER_NO  F_SRI_A -
| I SR R ]
N H5_B_HOR
el o CUR_SER_NO RX_SRI_B!
HS_4_NOR RAMBE_BIY
o | ! = CUR_SER_MO  HFFOD !
HS_B_NOR
—
HS_4_NOR  RANGE_EIY | MY CURSER_NO EUH_SER_NL
o1 [ [/ . - 0T
H5_B_NOR
iyt | oy RISRI_A  HS_Rv_a0]|

| MY RESRIB  HSRCYBO]
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{mia]

rJ

RANGE. B1Y IR
T 1 -
| A ROSRIA HOOFF HS_RCV_AD[|
| A RXSRIB  HOOFF  HS_RCV_BO[|
HS.A_HCR [Ca RS g EUR_HHX_NL
T 1 —
HS._B_NDR
_| l_
HSANR MDA [op oo EURESER_NL
LI LI 1 —
|
I | CHP CURMAXND  HS_RCY_AQ]]
6T CUR_SER_HD L
- CHP HS_RCY_B0
— | | ;
GTE P HSACY.AD EUR_SER_NL
| | FCY- iR}
AT
, | CHP CURMACND  Hs_RCv_Ad]
GTE HS_4_SEL
— | —
HSBHNOR MO | P HS_RCY_BO EURGSER_NL
[ 1 1 -
i
LT | o CURMAND HsRCv BO||
i} op  CURSERND g poy “DL
BIE P : HS.RCY.BO EUR_SER_NL
I | RV IR}
_GTE
I [ oW CURMACNO Hs Rcv BO||
_BTE HS_B_SEL
— | —
HSANR MDA TR EUR_EER_NL
T [ | L
i R e MR [ WOv  CURSERNO RY_SRIB|]
Ir’fl 11 [ L
HSBNDR  MODB WY RSB EUR_SER_NL
— | I | i I
HS‘.“};SEL HS‘lf;.NDR B F- 1O | WO¥  CURSERND RY_SRIA]
15T 140 10 L
M?Df HS',“-HSEL I RCV_Al  RCY_DATA 0|
e I RCY_BI  RCY_DATA ]
1T 1T L
I_DI [ wov oy oaTa  PODD4 ||
[ o MO201 PO00S ||
END
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(2) When XGK(l) sends - XGR receives
1) Communication settings(XGK(l) send- side)

Standard Settings - FEnet s Standard Settings - FEnet =
Basic Settings  Host Table Settings Basic Settings  Host Table Settings
OME IP Solution{Station Mumber and IP on standby are Master+1. OME IP Solution{Station Mumber and IP on standby are Master+1,
TCP/IP Settings TCP/IP Settings
One IP One IP
Media: Portl: | AUTO ~ Media: Portl: | AUTO ~
Port2: | ALTO Port2: | ALTO
1P address: [[12 188 . 1 . 1| IP address: [[192 . 188 . 1 . 12 |
Subnet Mask: | 255 . 255 255 0 | Subnet Mask: | 255 255 255 0 |
Gateway: | 192 168 . 1 . 1 | Gateway: | 192 168 1 1 |
DNS Server: [ o o .o .1 DNS Server: [0 o o .1 |
DHCP DHCP
[CJrelay Joprcua Crelay CJopcua
MNo. of Dedicated Mo. of Dedicated
Conmachons w19 Comnectons: -
Receive Time Out Settings Receive Time Out Settings
Client: sec(2 - 255) Client: sec(2 - 255)
Server: sec(2 - 255) Server: sec(? - 255)
Driver Setting Driver Setting
Server Mode: XGT server ~ Server Mode: XGT server ~
Modbus Settings Modbus Settings
RAPIEnet Settings: | Disable ~ RAPIEnet Settings: | Disable ~
Cancel Cancel
High speed link block setting (Communication module connected to XGR A-Side)
A Wariable
Index Station type Mode Station numben Block number | Module typel Read area Variable name \H’\?ag arEa
name comment ordl siz8
1} FEnet 1. 5end 11 1] Zhiw100 200
1 FEnet 1. Send I 1 HhwE00 200
High speed link block setting (Communication module connected to XGR B-Side)
. Wariable
Index Station type Mode Station numben Block number | Module typel Fead area Variable name E\?ag area
harne camment ord size
0 FE et 1. Send I a Fhwi100 200
1 FEnet 1. 5end 1 1 ZhwB00 200
2) ladder program(XGK(l) receive-side) : No ladder program required
Ls ELECTRIC
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3) Communication settings(XGR receive- side)

Standard settings

Standard Settings - FEnet > Standard Settings - FEnet Py
Basic Settings  Host Table Settings Basic Settings  Host Table Settings
ONE IP Solution{Station Mumber and IP on standby are Master +1; ONE IP Solution{Station Mumber and IP on standby are Master +1
TCP/IP Settings TCP/IP Settings
Cne IP One IP
Station No.: Station No.:
Media: Port1: | AUTO ~ Media: Portl: | AUTO ~
Port2: | AUTO Port2: | AUTO
IP address: [[152 . 188 1 1| IP address: [[1e2 168 .~ 1 11|
Subnet Mask: | 255 . 3255 255 0 | Subnet Mask: | 255 . 255 255 a |
Gateway: [[152 . 188 1 1] Gateway: [[1e2 o188 .~ 1 1]
DNS Server: | o . 0 o L | DNS Server: | o . o o 1 |
DHCP DHCP
[Jrelay [Jorcua Crelay Jorc ua
Mo. of Dedicated . Mo. of Dedicated .
Connections: 3 -1 Connections: 3 (1-18)
Receive Time Out Settings Receive Time Out Settings
Client: sec(2 - 255) Client: sec(2 - 255)
Server: sec(2 - 255) Server: sec(2 - 255)
Driver Setting Driver Setting
Server Mode: XGT server ~ Server Mode: XGT server =
lodbus Settings
RAPIEnet Settings: |Disable o RAPIEnet Settings: | Disable e
Cancel cancel
Block setting
. Wariable q Wariable
. B Module | Read | Variable Read area “Wariable Save area
Index Station type Mode Station humber | Block number name Save area name
type alea name comment Wiord size name commant Wiord size
0 FEnet 2. Receive 1 0 ZMw1 00 200
1 FEnet 2. Receive 1 1 ZWwAA00 200
2 FEnet 2. Receive 12 0 ZMw00 200
& FEnet 2. Receive 12 1 ZMWwWA00 200

4) Ladder program(XGR receive- side)

If the network is hormal, you can process data on the master side. However, if a network error occurs, you
should copy the data on the standby side to the master and process it as data using the SYNC command
using STATE FLAG. At this time, since receiving block of master and standby should be set, use STATE
FLAG for each block instead of link trouble ( HSx_LTRBL) to determine network failure.
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5.7.2  When configuring an XGR Single network

(1) When XGR sends - XGK () receives

1) communication setting(XGR send- side)

Standard Settings - FEnet = Standard Settings - FEnet =
Basic Settings  Host Table Settings Basic Settings  Host Table Settings
[ oME 1P Solution (Station Number and IP on standby are Master +1 [[] oME 1P Solution{Station Mumber and IF on standby are Master +17
TCR/IP Settings TCP/IP Settings
A-side B-side A-side B-side
Media: Portl: | ALTO ~ Media: Portl: | AUTO ~
Port2: | ALTO Port2: | ALUTO
IP address: [ 182 68 . 1 wo | IP address: [ 12 188 . 1 101 |
Subnet Mask: | 255 255 255 o | Subnet Mask: | 255 255 255 o |
Gateway: [ 1e2 w8 . 1 . 1 | Gateway: [ 1m2 w8 . 1 . 1 |
DMS Server: | o a a 1 | DMNS Server: | o o o 1 |
[JoHce Copy A ->B Copy A <-B CJoHce Copy & ->B Copy & <-B
[relay [Jorcua Crelay CJorcua
Mo. of Dedicated _ Mo, of Dedicated -
Connections: 3 (a-18) Connections: 3 (1-18)
Receive Time Out Settings Receive Time Out Settings
Client: sec(2 - 255) Client: sec(2 - 255)
Server: sec(2 - 255) Server: sec(2 - 255)
Driver Setting Driver Setting
Server Mode: XGT server ~ Server Mode: XGT server ~
Modbus Settings Modbus Settings
RAPIEnet Settings: Disable ~ RAPIEnet Settings: | Disable ~
Cancel Cancel
2) High-speed link parameters setting
. . . . Read area
Index Station type Mode Station number Block rumber | Module type Fead area ‘Wariable name Wariable name comment Yofterd] s
1] FEret 1. Send A-side:l], B-side: 1] ZMwi 1
1 FEret 1. Send A-side:l], B-side: 1 w100 2
3) Ladder program(XGR send- side)
Commentlﬁ increase the sequence number for HS link send
L7
_ON INC
EN  ENO[
L2
MWD N outk %MWD
L3
Comment]/ set the send data to be sent by the user
Ly
_T200MS MOVE
EN  ENO[
L&
%IW31.0.0 9N ouTh *%MW100
L7
LSEectric | 5-38
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4) Communication settings(XGK(l) receive- side)

High speed link parameter setting at receiving side including sequence number

Index Station type Made Station number | Black number | Module twpe | Read area| “ariable name | ¥ariable name comment \HI::rdd ;r:: Save area W ariable name | Yariable name comment| Sﬁgﬁji';:
0 FEret 2 Receive 1 1] Bl 1
1 FEret 2 Receive a 1 kw00 2
2 FEret 2 Receive 1 1} w20 1
3 FEret 2 Receive 1 1 ZWW20 2

5) Ladder program(XGK (l) receive- side)

5_39 | stELECTR‘iC

hs_fb

INSTH
HS_FB
—— }—————{REQ DONE
_HS1_STATE
ooo JM?P_ STAT
_HS1_STATE
o0z JMOD_
B
W10 {R¥_S
RI_A
RCY_al JRCV_
Al
sMwz0  {RX_S
RI_B
RCY_BI {RCY_
Bl
RCY_DATA {RCY_
DATA
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(2) When XGK(I) sends— XGR receives
1) Communication settings(XGK(l) send- side)

High-speed link parameters setting

Index Station type Mode Station numbern Block number | Madule tupe Read area Warniable name | Yariable name commant E\?;ﬂ 2{::
0 FEnet 1. Send 1 ] w0 200
1 FEnet 1. Send 1 1 M 1000 200
2) ladder program(XGK(l) send- side side) : No ladder program required
3) Communication settings(XGR receive- side)
4) Redundant receive high speed link parameter setting
Index Station type Mode Station number | Block number Mgiile Ha?:ad Vig?:ée :EI%EEZ F\E\?oa:jz[i:: Save area Vzg?nb;e :EI%EHEZ i\?;::las[i:ea
0 FEnet 2 Receive 1Al 0 Zhw0 200
1 FEnet 2 Receive 1Al 1 w1000 200
5) Ladder program(XGR receive- side)
] INSTS
_HSID_DSDTME SYHE
| /1 RED  DOWE}
h IN3T4
_HSID_DSITME SYHE
| /1 RED  DOMEL 1 JOIRC  STATE STAT
1 JOIRC STATE  STAT AMo0 -SHEIJS
IMDS00  qSRCS gMO0 {0ST3
| ¢ 2
$MOBO0  405T3 ] {0512
| 2 E
100 J0512
| E
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5.8 Ethernet System Configuration

Ethernet systems can connect to the Internet public network using the open protocol TCP / IP. Therefore, on-site PLC
system access is possible by using GLOFA VIEW (latest: InfoU, XP, iXP) of wide area monitoring system [1,2]. In addition, a
local monitoring system directly connected to the site network allows access to on-site PLC systems.

Wide—area Surveillance Wide-area Surveillance

System(1) System
[P: 191,100,105, 1 100 105 2
InfoU
Switch Router
S o -
PLC(1) PLC(2) PLC(3)
IP 192 168,91, 190 IP: 192,168,91,191 IP:_]92;168,91,192 Router

B=UE| Switch
(el
| - e

PLC(5) PLC(6)
[P: 192,168,91,194 P 192,168,91,195

T -

'Iﬂiﬁ 5

PLC(4)
IP: 192,168,91,193

4
l :

o

|
Hl o

=0 T =
F
Local Surveillance
Local Surveillance System iXP(2)
System iXP(1) IP: 192,168,91,197
[P: 192,168,91,196
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5.8.1 Configuration of Ethernet System Using Dedicated Network

The Ethernet system can be configured using a dedicated network that is not connected to the Internet. Shows an example
of an Ethernet system configuration using a dedicated network. PLC system connected to dedicated Ethernet network using
XGT Ethernet module can send or receive data using High Speed Link, P2P, dedicated service.

PLC(1) PLC(2) PLC(3)
IP: 192,168,91,190 [P: 192,168,91, 191 [P: 192,168,91,192

. —
-

2

III__J
SR e iXP(1) iXP(2)

InfoU IP: 192,168,91,194 IP: 192,168,91,195
IP: 192,168,91,193

Ethernet
Network

5.8.2 Mix of Dedicated Networks and Third-Party Ethernet Systems

Shows an example where a PLC system and a third-party PLC system are configured using a dedicated network Ethernet
system. Our Ethernet module allows for User frame definition Communication. Therefore, knowing the frame structure of
other company's PLC Ethernet module, it is possible to send / receive data to / from the company's PLC and other company's
PLC by using user defined communication.

~PLO(D) PLC(2) PLC(3)
IP: 192,168,91,190 IP: 192,168,91,191 IP: 192,168,91,192

—l - 3
?‘I

% Ethernet

Network

L

Other company's i Xp
InfoU product IP: 192,168,91,195
[P: 192,168,91,193 IP: 192,168,91,194
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5.8.3 Mix of public, dedicated and third party Ethernet systems

This shows a mixed Ethernet network system in which a PLC system and a third party PLC system are configured as one
system using the Internet, that is, a public network and a dedicated network. Wide area monitoring system [1,2] can access
remote Ethernet network using public network. The wide area monitoring system [1,2] accessing the remote Ethernet network
can access other companies and its own PLC system and send or receive the necessary data. In addition, a local monitoring
system directly connected to the site network allows access to on-site PLC systems.

Wide-Area Surveillance Wide—Area Surveil lance
System (1) System (2)

IP: 191,100,105, 1 : R 105,2
InfoU
Switch Router

SR s ﬂ ~
PLC(1) PLC(2) PLC(3) Router §

IP: 192,168,91,193  IP: 192,168,91,194 IP: 192,168,91,195 Switch
1T 1T
. 8 |-} -
e 5 Hil Tl
- LOCal—Area
Surveil lance System

iXP
192,168,91, 197

Other company PLC(4)

IP: 192,168,91,196 Ip:

5.8.4  System configuration using InfoU, PLC-to-PLC Dedicated Ethernet in XGR system

In XGR system, the Ethernet module can only be mounted on the main base and must be mounted on the same slot on both
bases of A/ B. The Ethernet module mounted on the base running as the master CPU performs normal send / receive service,
but the Ethernet module mounted on the base running as the standby CPU does not send / receive.

InfoU
[P: 192,168,91,195

Ethernet
network

InfoU
[P: 192,168,91,19%4

XGK/ |

A-Side B-Side IP: 192,168,91,193

IP: 192,168,91, 191 IP: 192,168,91,192
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5.8.5 System configuration using single network Ethernet in XGR system

InfoU
[P: 192,168,91,1%4

Ethernet
network

PP U PR p— X(}</|

A-Side B-Side [P: 192,168,91,193

IP: 192,168,91, 191 IP: 192,168,91,192

LSE . ecTric | 5-44
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Chapter 6 P2P service

6.10verview

6.1.1 Overview of P2P service

P2P service is the master operation of communication module. It is the function implemented by function, block
(command) by parameter setting. There are seven P2P commands available in the Ethernet module: Read, Write,
Write_NC, Send, Send_NC, Receive, and ESend.

For P2P service registration and editing, up to 8 P2P parameters can be set in XG5000. Each P2P parameter
consists of up to 64 P2P blocks.

(1) P2P parameter registration

- Up to eight P2P parameters can be set per CPU.
- Multiple P2P parameters can be set for the same communication module.
However, Enable only one of many P2P parameters for the same communication module.
- The each P2P parameter consists of P2P channel, P2P block, user frame definition and email.

(2) P2P editing

- Up to 64 P2P blocks that can be registered for each P2P parameter.
- A frame can be registered separately for each driver.

6.1.2 P2P parameter configuration

In order to use P2P service, user carry should set it for desired operation in P2P parameter window. P2P
parameter configuration consists of 4 pieces of information.
(1) P2P channel

- Set the logical channels (IP, PORT, dedicated driver) of the carry P2P service
- Configurable P2P Driver

1) User frame definition

2) XGT client

3) Modbus TCP client

4) Modbus RTU client( V6.0 or higher)
5) Modbus ASCII client( V6.0 or higher)
6) XGT Cnet client( V6.0 or higher)

7) RAPIEnet client (V6.0 or higher)

(2) P2P block

- Set 64 P2P blocks that operate independently
(3) User frame definition

- Register of a user frame definition
(4) E-mail

Register a frame for transmitting and receiving an- E-mail frame
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6.2 Type of P2P service

6.2.1 Type of P2P command

P2P used by the user for writing a program can be classified into seven commands.

The usage of commands varies according to the service method. Apply each command by referring to the

following table.

Classification Command Usage
Read Reads the specified area of the destination station
. Sends the area data of its own station to the destination
. Write .
XGT client station
Write NC Sends the area data of its own station to the destination
- station (No confirmation)
Send Sends the area data of its own station to the destination
station
User defined Sends the area data of its own station to the destination
Send NC . . .
frame - station (No confirmation)
. Receives and saves data transmitted from the destination
Receive :
station
Read Reads the specified area of the destination station
Writ Sends the area data of its own station to the destination
Modbus client rnie station
. Sends the area data of its own station to the destination
Write_NC . . .
- station (No confirmation)
E-mail ESend Transmits a message when an event occurs
Notes

1) Difference between Write (Send) and Write_ NC (Send_NC)

provide the corresponding optional function.
X The transmission data must be set not to exceed 3 KB for the simultaneous start condition.

If more than 3KB of data is used simultaneously, communication module error may occur.
2) In order to use Write_ NC, Send NC instruction, XG5000 and CPU O / S as below are required.

Classification Version
XG5000 V3.61 or higher
XGR CPU V1.91 or higher

can be enabled.

In general P2P communication, request data is sent to the start condition, and after receiving a
response, the request data is sent again to the next start condition. If you use Write_ NC (Send_NC)
command, data is sent in the next start condition without receiving a response. Therefore, 3) fast data
transmission is possible. Read (Receive) service that requires the other party's response does not

3) Multiple P2P parameters can be set for communication module. However, only one P2P parameter

6.2.2 Type of P2P service
(1) XGT Enet client/XGT Cnet client( V6.0 or higher)

The XGT client service is used for data send and receive of the between Ethernet. With the built-in self
protocol, the user sets communication by specifying only standard settings such as channel, data type
(BIT, BYTE, WORD, etc.) and memory area. Normal Port No. 2004 is used for TCP and Port No. 2005 is

used for UDP.

(2) User defined frame

For communication between Ethernet modules or other devices, this service allows users to define third -
party protocols in Ethernet modules. Communication protocols for Ethernet-based devices are defined

6-2



Chapter 6 P2P service

] '
differently by the manufacturer, which can be edited to suit the characteristics of each communication
module. The user frame definition has basic structure of HEAD, BODY and TAIL.
(3) Modbus TCP / Modbus RTU( V6.0 or higher)/Modbus ASCII( V6.0 or higher) Client

Ethernet module supports various Modbus protocol in addition to user frame definition protocol.
(4) RAPIEnNet client (V6.0 or higher)

in which If RAPIEnet is set in the standard settings, the RAPIEnet client service is available.
(5) E-mail

E-mail service is a service to notify the remote administrator of the status by using the system when a
problem occurs in the system. If the status of the CPU has changed or an event occurred during operation,
you can deliver the status information using the mail server.
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6.3 P2P service setting ‘

6.3.1 Ethernet (server) driver

(1) Driver setting

Ethernet (server) driver is XGT Ethernet built-in server protocol. The built-in protocol includes the XGT
server and the Modbus server. Ethernet (server) driver is used to read or write data of Ethernet module
from other station using Modbus or XGT protocol. MMI (HMI) is often used for the correspondent station.
Communication with an external device is possible only by setting parameters without the user writing a
communication program.

(2) Types of Ethernet (server) driver

The types of Ethernet driver that are supported are as follows.

Type

Description

P2P driver

XGT server

XGT dedicated protocol for LS
ELECTRIC

XGT client
XGT Cnet client

Modbus Server

Modicon's open protocol

Modbus TCP client
Modbus RTU client
Modbus ASCII client

Smart server

When using XGT dedicated
protocol Modbus protocol
simultaneously

XGT client

XGT Cnet client
Modbus TCP client
Modbus RTU client
Modbus ASCII client

RAPIEnet server

RAPIEnet protocol of LS

RAPIEnet client

ELECTRIC

(1) For 6.0 and below, the number of drivers is reduced by the number of available drivers by the
number of Ethernet channels set. Please note when using

(2) Ethernet (server) driver enables the 1:N communication. Therefore, connected data can be
taken to one port set by multiple client devices.

(3) V6.0 and higher, up to 64 clients can be connected to each server port.

6.3.2 P2P channel

The Ethernet P2P channel is used when the XGT FEnet should operate as the master using the built-in protocol
or carries out communication using the use defined protocol.

XGT PLC
Other company PLC

el

| I: : Il 1.Request connection I
)| : (TCP/IP)

| 3.Request data read/write

| o

—
e}

2 .Responsw connect ion
(TCP/IP)
4 Response data read/write



Chapter 6 P2P service
= '

(1) P2P channel setting

The Ethernet module can send and receive data in up to 16 channels. The channel consists of the IP
address and port number of the communication device. The number of channels that can be used in the
P2P is the total number of channels (16) subtracted by the number of dedicated connections in the basic
parameter. The number of P2P channel = 16 - The number of dedicated communication connections)
In V6.0 and above, the number of P2P channels of the module is 32 regardless of the number of dedicated
connections.

P2P can communicate with simple parameter setting for communication with device using XGT, MODBUS
TCP protocol for user's convenience. For communication with other devices, the user can define the frame
directly and communicate.

Also, the user can register a message and mail address in order to transmit or receive an email frame.
(ASCII support)

However, it is not necessary to set a channel for email communication.

When you select the P2P channel from the P2P Setting window, the P2P Channel Setting window will
be displayed as follows.

Channel Setting =
Chann|  Operation mode P2P Diriver TCRAUDP Client/Server Port Mumber| Partner IP address ~

u] e TCF Client 2004 192168.1.1

1 Iser frame definition 0.0.0.1

2 HGT client 0.0.0.1

3 Modbus TCF c:li,ant 000

2 Madbus RTU client GO

todbus ASCI client

5 %GT Cret clisnt 0.0.0.1

E RAPIEnet client 0.0.01

7 0.0.0.1

5] 0.0.0.1

9 0001

10 0.0.0.1

11 0.0.0.1

12 0.0.0.1

13 0.0.0.1

14 0.0.0.1

15 0001

16 0.0.0.1

17 0.0.0.1

18 0.0.0.1

19 il | e

Detailed Settings Cancel
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Classification

Content

User frame
definition

A protocol used to communicate with an external device. It
is a user frame definition protocol (frame definition).

XGT Enet client

This is the XGT dedicated protocol. (The frame is not
defined.)

XGT Cnet client

It is XGT Cnet client protocol Communicate with LS
ELECTRIC Cnet module connected to LTE modem.

P2pP Modbus TCP Defines the operation with the MODBUS TCP protocol of
driver Client Modicon.
Modbus ASCII Defines the operation with the MODBUS ASCII protocol of
client Modicon.
Modbus RTU Defines the operation with the MODBUS RTU protocol of
client Modicon.

RAPIEnet client

It is RAPIEnet client.
However, RAPIEnet must be enabled in Standard settings.

TCP/UDP

Choose between TCP and UDP. When the Modbus TCP is
selected, it will be fixed to TCP.

Client/Server

Act as client (master) among client and server.

Port number

Enter the port number of the destination station.
Specify a random port for user frame definition.

IP address of destination
station

Input IP address of destination station to communicate with
XGT Ethernet module module through designated channel.

Details

It is the function to specify the port number of the client

1) If XGT Ethernet is client, destination station's IP address must set server device address. If the
server is assigned an IP dynamically using DHCP, the IP address will be changed and it will be
different from the configured IP. Therefore, communication will not be possible. Therefore, the server
must be assigned a fixed IP address and cannot communicate using DHCP.

2) The port number can be assigned within the range of 2 bytes. However, note the use of predefined
ports. In addition, the port that is used dedicated by the Ethernet module cannot be set.

XGT Cnet client, RAPIEnet client, Modbus RTU, Modbus ASCII driver are supported in V6.0 or higher.

(2) How to use Modbus driver

The table below shows the commands and addresses of Modbus devices.

Code Function code name MO (FLHS Note
Data address
01 Read Coil Status OXXXX (bit-output) Read bit
02 Read Input Status IXXXX(bit-input) Read bit
03 Read Holding Registers AXXXX (word-output) | Read word
04 Read Input Registers 3XXXX (word-input) Read word
05 Force Single Coil OXXXX (bit-output) Write bit
06 Write output register 1 word (Preset Single Register) AXXXX (word-output) | Write word
15 Force Multiple Coils OXXXX (bit-output) Write bit
16 Preset Multiple Register AXXXX (word-output) | Write word
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6.3.3 P2P block

Select P2P block of the parameter in P2P menu, then P2P parameter setting screen appears.

€ 128312 x65000 - o x
DEAES © 2@ MO DH oo BEX SRV AMRES Re -

mEm OO Gl FEE FEG I A080 @R GUEEEEHIODD D NEAISEETE RS

i PROJECT EDIT FINDREPLACE VIEW ONUNE MONITOR DEBUG TOOLS WINDOW HELP

EHUYENSAASNASRAERRREYYEY rEEBRRE EEE EDDO0D @ 22 B 0wawa

NewProgiam |  System Variable %7 NewPLC- P2P 01

Indsn|  E-mail th Driver Setiing Header P3P function E”";"a‘g"‘a‘ Commandtyps|  Data Type

¥ J-FYETED
v J§ Network Configuration
v ) Undefined Network
gl NewPLC [BOST XGL-EFMHB(TAG)]

o of Destinat

Data sizs: Destination

variables 0 | station ramben Frams | Satting Variable setting conterits

Number 1
0 XGT Enet client LSISHET WRITE | _T200MS | 1.Single 2BYTE 1 Seting | READ1:PDDZ SAVE1:D200,5IZE
:TH High-speed Link 01 1

~ . p2po1
P2P Channel
i .5 P2P Block
© 138 User frame definition
L v Email
Address
..

Up to 64 separate blocks can be set. Select any block in XG5000 and set the action of the block as follows.

Setting

Setting

Setting

Setting

b [ Fiom A [ F R |

Setting

. Destinati T
Index E-mail Ch Driver Setting Header P2P function Ennﬁ:;nal Command typgf  Data Type vr:r?aljfas Data size stgﬂon Sg;ﬁ:”:::ﬁger Frame Setting
1] r 0 ®GT Enet client LSISGT WRITE _T200M5 1. Single 2BYTE 1 Setting
1 r 1 Modbus TCP client READ _T200MS 2. Continuous EIT 1 v 1] Setting
2 r Setting
3 r Setting
4 r Setting

— oo

The setting items for each and their meaning are as follows.
Classification Content

E-mail Used to set up email service.
Select the communicate port No. that will be used by the relevant block. The
communication port of each block is decided when the parameter is set, and it cannot
be changed during Run.
The maximum number of channels that can be set is as follows.
V6.0 or less: 16 - The number of dedicated communication connections
V6.0 or higher : 32
It indicates a communication driver specified in the P2P channel setting. When you
specify a channel, the driver will be loaded automatic according to the set channel,
and when any channel is deleted in the P2P channel setting, the set driver also will
be deleted. See Section 6.3.2 P2P Channel for details.
When setting XGT Enet client driver, you can select either LSIS-XGT or LSIS-
GLOFA.
This function carries out Read/Write Data from the destination station using the set
drivers. The detailed command functions are shown in the table below.
It defines the time for the P2P block to operate, and the constant period and memory
set trigger condition can be selected.
Select individual read / write and continuous read / write by determining the detailed
Command type operation of read / write. Individual read / write to write / write up to 4 memory areas,
and continuous read / write read / write to the size defined at the designated location.
It defines the data type to be processed by the block, and in case of XGT bit, byte,
2 bytes (word), 4 bytes (double word), 8 bytes (long word) data can be processed.
This item can be defined when Read Individually is selected. The number of areas
to be read individually is decided; up to 4 can be selected.
If you select continuous reading, it defines the size of data to read and its size
depends on the data type.
Frame Select the appropriate frame (group) setting for custom frame communication.
Designate the area of memory to send / receive. Specify the area to be sent and
the area to save the received data of the destination station.

Channel

Driver setting

Header

P2P function

Start condition

Data type

No. of variables

Data size

Setting
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Command

Please refer to the table below for the usage of commands used when users write programs.

Classification

Command

Usage

XGT/ Modbus
client

Read

This command is used to read / save arbitrary area of destination station
and it is used the same in XGT / Modbus client driver. Available memory
areas: P, M, K,F, T,C,U,Z,L,N,D, R, ZR,% Q,% |,% M, etc.

Write/Write
_NC

This command is used to send the area data of own station to destination
station and write data in the desired area of destination station. It is used
in the same way in XGT / Modbus client driver. It supports continuous
writing and individual writing and can write data in up to four separate
areas.

Available memory areas: P, M, K, F, T, C, U, Z, L, N, D, R, ZR,% Q,% |,%
M, etc.

User frame
definition

Send/Send_
NC

This command is used to send an arbitrary frame to the external device to
be connected by unspecified communication method, not XGT / Modbus
client protocol. Only one frame per the Frame Send function should be
selected and used, and the memory setting a fixed-sized/variable-sized
variable in the relevant frame should be specified in this function. You must
define a frame you wish to transmit before using this function.

Receive

This command is used to receive some frames among the frames sent from
the destination station. The same frame cannot be selected for each P2P
Frame Receive function block. Receive frame can determine only one
receive function block.
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‘ 6.4P2P service operation

P2P service operation describes how to read / write data between Ethernet modules as an example.

IP: 192.168.1.3
XGP-AC23 XGK-CPUSN | XGL-EFMFB | XGQ-RY2A | XGI-D22A | XGQ-TR2A
IP: 192.168.1.2
XGP-AC23 XGK-CPUE | XGQ-TR2A | XGL-EFMFB | XGI-D21A | XGQ-TR2A | XGH-DT4A

Write / Read data to Ethernet side of IP '192, 168.1.2' to XGT Enet / Modbus TCP client from Ethernet side with
IP address 192.168.1.3". In addition, write word data to Ethernet with IP address '192.168.1.3' to XGT Enet
client from Ethernet side with IP address '192.168.1.2".

IP: 192.168.1.3

e XGT Enet client

. Channel
- Write (4 Word): M0100, 0

M0101, M0110, MO111

. . Channel
Starting condition: 1
T200MS

e Modbus TCP client
- Read (16 bit): M00100
- Starting condition: T200MS

—

IP: 192.168.1.2
Channel e XGT Enet client
0 - Write (word): P0002
Channel - Starting condition:
1
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(1) P2P service setting(PLC1)

Program sequence: Connect to PLC system 1, 2 CPU and set in the following order. At this time, PLC1

sets the |IP address as “192.168.1.3".

Seq .
Settin }
uen 9 Setting method
process
ce
1) [Project]>Open [New Project] and enter the project name, CPU series, CPU
type, programming type, and program name.
Mew Project ? =
Project name: |PLC 1 || oK |
File directory: |c:WxGEDDDWPLc1 | Cancel
CPU Series HGHK ~ Product Name...
CPU type: XGK-CPUSN ~
Create Proaranming B 5
1 new Programrame:  [NewProgram
project w
Project description:
1) Select [Undefined Network]>[Add item]> [Communication module].
2) In the [Select Module] window, click “Add module”.
Select Module *
PLC type:
NewPLC ~
Communication Module:
MNurber BASE Slot Madule Metwork, in use
1 1) 0 i HGL-EFMT(B) i Undefined Metwork
Standard
2 network
adding
Add Module. .. Delete module Cancel
1) Set Type, Base and Slot in Communication module settings. After that, select
OK button in [Communication module selection] and module setting is completed.
Communication Module Settings =
Type: XGL-EFMT{E) ~
Base: oo e
Slot: oo ~
Cancel
Double-click the communication module in the [Project] window.
Project - o
~ B PLCT_P2P
~ EE Metwork Configuration
! e @ Undefined Metwork
~ 5‘?—,-, MewPLC [BOSO XGL-EFMT (B TAG)]
i ~ &L P2P O1
Undefine P2P Channel
3 d P2P Block
i User frarme definition
Network - E E-rnail i
H LB Address
Sett'ng o Message
“gs System Wariable
e NewPLCIXGK-CPUSN)-Offline
L E8 wariable/Comment
~ -[& Parameter
H LLTEN Rasic Parameter
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[continue]
Seq .
Settin .
uen 9 Setting method
process
ce
1) Set the media, IP address, etc. in the [Standard settings] window.

Enter own's IP address.

Select server mode among XGT server / Modbus server / Smart server. If you
use XGT server and Modbus server at the same time, select smart server. PLC1
selects XGT server as server operation of XGT Enet client.

Standard Settings - FEnet >
Basic Settings Host Table Settings Sets EIP Server
TCP/IP Settings
Station No.. m |
Media: [Pertt: |auTO ~
Port2: | AUTO
| 1P address: 192 . 168 . 1 . 3
U ndeflne Subnet Mask: 255 . 285 . 285
d Gateway: [ 1s2 . 1z . 1 . 1 |
4 Network DNS Server: [ o . o . o . 1 |
setting [1oHCP [ Relay [JoPc ua
Mo. of Dedicated (1-186)
Connections:
Receive Time Out Settings
Client: sec(2 - 255)
Server sec(2 - 255)
Diriver Setting
Server Mode: HGT server ~
Modbus Settings
RAPIEnet Settings: RAPIEnet w2 e
Cancel
1) Select [Ethernet module]>[Add item]> P2P communication].
Project > 0 ox MewProgram y' System Variable %
~ BB PLCI_P2P* The
v EF Network Configuration Wariable Address Type "“;”,he FLC Name/PLE Type
© ~ - Undefined Network MeLs
] &% NewPLC [BOSD XGL-EFMTIBITAGH 7 WAz WORD 7 MemPL LA -CPLS N
% System Variable Open BIT 32 MewPLCA<GK-CPUSN
-l NewPICXGK-CPUSN)-Offlin o 1 Mlewbl ok L BHEN
EJ Variable/Comment Add tem 4 Smart Extension
v [ Parameter Copy Ctri=C Network
¢ i{E Basic Parameter B rPaste Ctrl+V Communication Module
I8 VO Parsmeter ¥ Delete Delete P2P Communication
TH Local Ethernet Paramet
~ {81 Scan Program @ Properties... High-speed Link Communication
Lff] NewProgram , User Frame
Communication Module Setting and Diagnosis P —
P2pP 14 KO5000 . :
Add Slave
5 | paramete " bonotii
r Sett' ng 17 o200 Views C-:.nne-:h:m
2) Select 01 parameter window in P2P selection.
Select P2P =
a1 ot
Cancel
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[continue]
Seq .
Settin .
uen 9 Setting method
process
ce
1) Click P2P channel item of P2P01 parameter to set channel.
- Set channel 0 as XGT Enet client and, channel 1 as Modbus TCP client and
input the destination station's IP.
P2P | Channel Setting X
6 paramete '
rsettlng Chann|  Dperation mode P2P Diiver TCF/UDP Client/Server | Part Mumber| Partner [P address A
0 T Enet clent TCP Clent 2004 T92.166.1.2
1 Modbus TCP clent TCP Client B2 192 16612
2 (N
1) Set the setting items for each P2P block channel of P2P 01 parameter as
follows.
- Channel 0 writes 4 Word data to the server with XGT Enet client.
- Channel 1 writes 16 BIT data to the server with Modbus TCP client.
Index| Emal | Ch Diiver Setting Header PP furction | W | Conmardwpel DataTipe | Mo | patasize D?E‘m Destinalon | Frane Satting
0 r a ®GT Enet client LSISRKGT WRITE FO0032 1. Single 2BYTE 4 Setting
1 r 1 Modbus TCP client READ FO0032 2. Continuous BIT 1 2 a Setting
2) Channel 0 writes 4 words from M0100 to server D100.
3) Channel 1 reads 16 bit data from M0O0100 (Bit device).
Variable Setting > Variable Setting x>
P 2 P I:l Counterpart PLC Detail Settings Counterpart PLC Detail Settings
7 param ete gs#g::arpart cPU view by Product gg:_llg::erpart CPU view by Product
r Settlng 1(;3;nterpart CcPU ?Dunt&rpart CcPU
=H ype:
Read area: Local Address (NewPLC) Read area: Remote Address
Save area: Remote Address Save area: Local Address (NewPLC)
Read area Save area Data size | Address | Fead area | Save area |Datasize Address
1 0100 D10a 1 HOoooz1 1 | O=10000 E MO0O010 16 ioMO0042
2 MO0 [s31n] 1 NO002E ’ ’ )
3 o110 D102 1 HO0o31
4 MO111 D103 1 MNO00ZE
Cancel Cancel
1) Move the 4 word data to be written to D100 ~ D103 in channel 0 to M0100,
M0101, M0110, MO111.
2) Channel 1 reads 16 bits from the input contact status (0x10000) from the
server's input module (PLC2 slot 2) and stores it in the bit address of M00100.
In addition, it reads from Word address M0010 and moves to MOO11.
3) Move the value that 1 word data of input module (PLC2 slot 2) is written to
D00200 in PLC2 to D00250.
-Ts [ wov honFF wiion ||
|
8 Program 0 ‘
ming | HoY hFFFF o101 L
! HOY hOOFF WO110 L
! HoY hFFFF MOl 11 [_
_Oh
. } | HoY Wooio Maot 1 [_
[ hov poooenn poonesn | |
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6-13

[continue]
Sequen Settin .
q 9 Setting method
ce process
1) After selecting [Online]>[Connect] and [Online]>[Write], download the
following items.
Write to PLC rd =
[ ] Inhibit Program Upload
[]sets link enable with parameters
& newrLe
P PLC Configuration
= Comment Cancel
3 = raBn;:::erParamebEr Setting...
= yo paramemr Clear PLC...
Project e e =T
9 downloa | IR network Parameter
d IR peecaienet [asco, soto)
EIF tag
~[ZIEP EIP Server
=l High-speed Link
IEl High-speed Link 03
IEL High-speed Link 06
P2P{EIP)
1) Select [On-line]>[Reset/Clear]> [Reset individual module]
2) Select the relevant module in the reset window of individual module reset
and select OK.
KG5000 =
Basic parameter has changed. Reset Individual Modules to
! apply the changed basic parameter.
Individual module reset P
=-~EF PLC1_P2PO1
=-EER MewPLC
A1
FEnet [base0, slotd]
Communi
cation
10
module
reset
Cancel
Service . L . .
Select [Online] >[Communication Module setting]>[Enable Services].
11 enable ;
Then select [Online] >[Change Mode]->to run.
and run.
J LSELecTrIc
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(2) P2P service setting(PLC2)

Program sequence: Connect to PLC system 1, 2 CPU and set in the following order. At this time, PLC2

sets the |IP address as “192.168.1.2".

Seq .
Settin .
uen 9 Setting method
process
ce
1) [Project]>Open [New Project] and enter the project name, CPU series, CPU
type, programming type, and program name.
Mew Project ? =
Project name: [PLcipzpoz | ——
File directory: |c:W><G5000WPLc1P2PDz | Cancel
CPU Series KGK ~r Product Mame...
CPU type: XGK-CPUE bl
Create P e >
1 neW Program name: MNewProgram
project o
Project description:
1) Select [Undefined Network]>[Add item]-> [Communication module].
2) In the [Select Module] window, click “Add module”.
Select Module pd
PLC type:
MNewPLC a
Communication Module:
Mumber BASE Slot Module Metwork in use
Undefine
d
2
Network
Add Add Module... Delete module Cancel
1) Set Type, Base and Slot in Communication module settings. After that, select
OK button in [Communication module selection] and module setting is completed.
Communication Module Settings =
Type: XGL-EFMT(B) o
Base: oo ~
Slot: 131 v
Cancel
Double-click the communication module in the [Project] window.
Project * 0 x MewProgrz
~ EE PLCT1 P2PO2 *
~ B Metwork Configuration
!~ ) Undefined Network
Undefine L g MewPLC [BOST XGL-EFMT(BI(TAG)]
d % Systern Variable
3 \}..@ MNewPLCIXGK-CPUE)-Offline
Network Ej Variable/Comment
setting ~ [ Parameter
Basic Parameter
: T8 /0 Parameter
v Scan Program
MewProgram

6-14
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[continue]
Seq .
Settin .
uen 9 Setting method
process
ce
1) Set the media, IP address, etc. in the [Standard settings] window.
Enter own's IP address.
Select server mode among XGT server / Modbus server / Smart server. If you
use XGT server and Modbus server at the same time, select smart server. Select
Smart Server as the server operation of XGT Enet and Modbus TCP client of
PLC1.
2) Set the start address of the bit read area of the server side (PLC2) for Bit Read
in the Modbus TCP client of PLC1 to P00020.
Standard Settings - FEnet X
Basic Seftings Host Table Settings  Sets EIP Server
TCP/IP Settings
SwonNo: [0 ]
Media: Port1: |AUTO ~
Port2: |AUTO
Undefine IP address: [ 12 e . 1 . 2 |
4 d SubnetMask: | 255 . 255 . 285 . 0 |
Network Gateway: | 152 . .1 o1 |
setting DNS Server: [0 o o 1]
I DHcP [ Relay CJoPC UA
No. of Dedicated (1-16)
Connections:
Receive Time Out Settings
Client: [0 sect2-255 Modbus Settings ¥
Server: sec(2 - 255)
Bit read area Address: \%
Erver Setting Bit write area Address: P01000
[Server Mode Smart Server e
[[Modbus Settings | Word read area Address:
RAPIEnet Settings: | RAPIEnet v2 - Ward write area Address:
Cancel
QK Cancel
1) Select [Ethernet module]>[Add item]> P2P communication].
Project - o x NewProgram
~ EF PLC1P2PD2*
A ~ @ Metweork Configuration
i e D Undefined Metwork
i L NewPLC [BOS1 XGL-EFMT(B)(TAG)]
-8 System Variable Open
~ [ MewPLC(XGK-CPL
i EB Variable/Comin Add Item » Smart Extension
E ~ [ Parameter co Ctrl+C Netwaork
:: ﬁ,?;;:::ﬂs" Pa.:: Ctri=v Communication Module
| Scan Program | 7% Delete Delete P2P Communication
| NewProgral (2 properties... High-speed Link Communication
) User Frame
P2P a Communication Module Setting and Diagnosis 3 e Errn
! Add Slave
5 paramete I R
r setting
2) Select 01 parameter window in P2P selection.
Select P2P =
01 o
Cancel
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[continue]
Seq .
Settin .
uen 9 Setting method
process
ce
1) Click P2P channel item of P2P01 parameter to set channel.
- Set channel 0 as XGT Enet client and input the destination station's IP.
Channel Setting x
P2P
6 paramete Chann|  Operation mods P2P Driver TCP/UDP | Client/Server | Port Number| Partner IP address A
r setting 0 %G T client TCF Client 2004 19216813
1 (T
2 0aad
3 (i}
4 nnni
1) Set the setting items for each P2P block channel of P2P 01 parameter as
follows.
- Channel 0 writes 1 word for data to the server (PLC1) with XGT Enet client.
bes|  Emal | Ch | DiverSelirg Header | P2Pfunction E°”ﬁ‘a‘i§”a‘ Coamandipe] DalaTye | 1% | paase oot ot | o Seting Vatietle seting corterts
station
0 r 0 HGT Enet cient LEISHET WHITE Fo00s2 1. Single 28YTE 1 Setting E?gB?[ILDUUE,SAVElDZUU,S\Z
2) Write 1 word from input module (slot 2, address P0002) to address D200 of
server (PLC1).
Variable Setting X
[ Counterpart PLC Detail Settings
P 2 P g:rLilenstt:arpart crU View by Product
7 | paramete poenerpart G
r setting
Read area: Local Address (NewPLC)
Save area: Remote Address
‘ Read area | Save aiea |Dalasize| Address
I pao0 | 1] wooo
Cancel
1) Save data sent from M0100, M0101, M0110, M0O111 of PLC1 to D00100 ~
D00103 and move it to D00200 ~ D00203.
M
I [ wov Dooi0 000200 ||
[ oy ool 00020t ||
8 program !
ming [ oy I
[ oy 000103 000203 |
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[continue]
Sequen Settin .
q 9 Setting method
ce process
1) After selecting [Online]=>[Connect] and [Online]>[Write], download the
following items.
Write to PLC ? =
[ tnhibit Program Upload
[ sets link enable with parameters
NewPLC
[P PLC Configuration
H =] Comment Cancel
Project - Parameter
9 downloa : Basic Parameter S
d E LjO parameter Clear PLC...

@, Spedial module parameter
-[+I(=3] Program
: @‘ MNetwork Parameter
""" Basic Settings
[Reset]FEnet [basel, slotl]
EIP tag
[ EIP Server
- E High-speed Link
----- F2P(EIF)
H- P2P 01

Communi
cation
module
reset

10

1) Select [On-line]>[Reset/Clear]> [Reset individual module]
2) Select the relevant module in the reset window of individual module reset

and select OK.
KGS000

apply the changed basic parameter.

Individual module reset

= Settngs
FEnat [baseo, slot1]

Cancal

I Basic parameter has changed. Reset Individual Modules to

=

B3

Service
enable
and run.

11

Select [Online] >[Communication Module setting]>[Enable Services].

Then select [Online] >[Change Mode].

Enable Services

B 8

=-[1EL Communication service status
&1 [ High-speed Link

[E High-speed Link 1

-[_1[E] High-speed Link 2
1= High-speed Link 3

-[1[E] High-speed Link 4
[J[E] High-speed Link 5

—[[E] High-speed Link &
[E High-speed Link 7

[ JIE High-speed Link 3

-[J[E High-speed Link 9
[1[E High-speed Link 10

-[_1[E] High-speed Link 11
[JIE] High-speed Link 12

-] p2rEP)

P2P(EIF) 1

—[JE] P2PEIP) 2

[_|IE] P2r(EIF) 3

CE rerER) 4

118 p2P(EIP) 5

B rarER) 6

- [11E] p2r(EIF) 7

& rzrEF) 8

=1L Smart Extension

? >

13

6-17 J LSE.ecrric
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6.5 User frame definition ‘

6.5.1 Overview of a user frame definition

When the user needs to send a frame desired by the user or receives a frame among the frames on the network,
the frame to be sent or received should be defined. The user frame definition can be used only in the P2P service.
All frames consist of Head, Body and Tail, each of which can be omitted.

The user frame definition is expressed as the group name and the frame name, and the meaning of each item is

as follows.

Classificati
Usage
on

It is the group of frames that have the same Header and Tail.

Group . L . : .
Group registration is required for frame registration.
It consists of Head, Body, Tail.
Define the sending and receiving frames.

Frame A fixed-sized or a variable-sized variable can be added in Body.
The frame is composed of multiple segments and registered in the frame edit
window.

Device using protocol not supported by
XGT Ethernet module

Send frame Data send
Receive frame Il Data receive
HEAD BODY TAIL HEAD | BODY TAIL

6.5.2 User frame definition setting

(1) Adds Group
A group is a set of frames. Group registration is required for frame registration.

1) Adding a user frame definition group

Select User frame definition and click the right mouse button as shown. From the Add Group pop-
up menu, select [Add Item] = [Add a group].
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- [

~ H P2P 01

P2P Block
% User frame definition
Open From File

B Address |[Ef Export to File... 1

[ Message
-8 Systern Variable Add Item b Metwork
w @ NewPLC(XGK-CPUSN])-5T( o ChrleC Communication Module
'E:l Variable/Comment B Paste Chrl=V P2P Communication
v IE Parameter Delete Delete High-speed Link Communication

: Basic Parameter BT T
-G 1/0 Parameter 3 Properties... Add a Group

.. Local Ethernet Pararrrerer
v [2] Scan Program Add Slave
[ MewProgram
Views Connection

2) Select the name of user frame definition Group name and frame type

In the Edit Group window, enter the group name and select the frame type. Group name can be
entered arbitrarily.

Praoject » 0 x
~ EE PLCT_P2POT*

~ HF Metwork Configuration
~ @ Undefined Network

v ﬁiﬁ MewPLC [BOSD XGL-EFMTI(B)(TAG)]

-[E] High-speed Link 02
-[E High-speed Link 04
-[E] High-speed Link 05
-.[E] High-speed Link 07
~ & P2p 01

& P2P Channel

i-i=] P2P Block
W '@ Uszer frame definiticn

----- [ test] [Reception]

3) When the group name “SEND” and frame type are selected as sending, the results entered in the
project window are shown.

Project - O 3
«~ EB PLC1_P2PO1*
w % Metwork Configuration
w (B Undefined Network
v gt MewPLC [BOSO XGL-EFMT(B)(TAG)]
(- High-speed Link 01
El High-speed Link 02
El High-speed Link 04
El High-speed Link 05
- El High-speed Link 07
~ - P2P 01
P2P Channel
P2P Block
v@ Uszer frame definition

(2) Add frame

If you click the right mouse button on the added d group as below, the pop up menu appears. Click Add
frame and select the type of frame you wish to create. When HEAD, TAIL and BODY are selected, the
frame is added to the group.
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View P2P -
~ HE PLCT_P2POT*
v - NewPLC(XGK-CPUSN)-STOP
~ & P2P 01 [BOSD XGL-EFMT(B)(TAG)]
‘(& P2P Channel
[E] P2P Block

Edit Group

\:, _—g E-mail ¥
LB Address

Cut
Copy

Paste

> E P2P 02 [BOST FE
Delete Group

Ctrl+X
Ctrl=C
Ctrl+V
Delete

Add Frame
1) Adding HEAD of a user frame definition
Frame Edit oo
Type: |HEAD L L
MName: |HEAD
Cancel
2) Adding TAIL of a user frame definition
Frame Edit =
Type: |TAIL e
Mame: |TAIL
Cancel

3) Create and add a BODY name of a user frame definition.

Frame Edit

Type: |BODY e

et

Mame: |samp|e1|

Cancel
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(3) Type of segments

Frame is composed of a number of segments consisting of Head, Body, Tail, and registered in the frame
edit window below.

NewProgram x| MewPLC P2P - test] [Reception] |  NewPLC P2P - test2 [Tansmission] %~ NewPLC P2P 01 Frame - testt.HEAD = [N
~ JEF PLC1_P2P01~
v . NewPLC(XGK-CPUSN)-5TOP Up Down Add BCC Add Line Delete Line
v [E] P2P 01 [BOSO XGL-EFMT(B)(TAG)]
{-{& P2P Channel
P2P Block
~ @B User frame definition TN
i w3 test] [Reception]
H ’é’ HEAD
-E3 TAIL
-5 samplel
: {3 test2 [Transmission]
~ =1 E-mail
Address
.. Message
> [ P2P 02 [BOST FEnet]

Agsign

oty Conversion Swap Memory

Segment Frame Size Data

1) Frame configuration

C|a§S|f| Command Usage
cation
Numerical |Defines the part of the frame that is fixed as a constant and specifies the
constant |data value as Hex.
UG, Registers string constant among frames and specifies data as ASCII.
constant
Only available in the body area of the receiving frame. It is used when
Fix sized |[processing the data (size is Byte unit) of defined frame among received
variable |frames. If you check the memory designation, it can be saved in PLC
memory. At this time, saved data value can be swapped.
Type Only available in the body area.

(1) Send frame: When varying the frame length, check the memory
designation to configure the send frame with the data read from the PLC
memory.

Variable- ;
sized (2) Receive frame
! 1) It is used when processing variable size data among received frames.
variable . .
2) Registration can be done on only the last segment among the areas of
Body frame. Selecting memory designation saves the data of the
corresponding segment among the received frames in the memory area. The
data is also swappable.
Size The data size is displayed in bytes.
Data Input data to send and receive.

Assign memory  |Specify the memory area to save and read the data sent and received.

Send: Converts data read from the PLC memory into ASCII and configures a
frame to be transmitted.
Receive: Saves received data after converting it into ASCII.
Hex To When using 2 words of PLC memory MW100 to convert the frame to Hex to
ASCII, when h34353637 is stored in MW100, the corresponding segment of]
ASCII . p »
Conver the transmission frame becomes “4567".
sion And if you save a part received frames after converting it into Hex and the
value of the relevant area is “4567”, h34353637 will be saved to the PLC
memory
Send: Converts data read from the PLC memory into Hex and configures a
ASCII To .
Hex frame to be transmitted.
Receive: Saves received data after converting it into Hex.
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Swap

Swap data in 2,4,8 byte unit.

The result of swapping h1234567811223344 according to each

method is as follows.

-2 Bytes Swap: h3412785622114433
-4 Bytes Swap: h7856341244332211
-8 Bytes Swap: h4433221178563412

2) The specification of transmission and reception frame supported in the user frame definition
communication is as follows.

Group Frame Segment Contents
Numerical
HEAD constant Up to 10 bytes
String constant Up to 10 bytes
Numerical
AL constant Up to 10 bytes
Send String constant Up to 10 bytes
frame BCC Only one BCC can be applied.
Numerical
constant Up to 10 bytes
BODY String constant Up to 10 bytes
Varlab_le-s,lzed Up to 4 variables are available.
variable
Numerical
HEAD constant Up to 10 bytes
String constant Up to 10 bytes
Numerical
AL constant Up to 10 bytes
String constant Up to 10 bytes
R . BCC Only one BCC can be applied.
cceve Numerical
frame Up to 10 bytes
constant
String constant Up to 10 bytes
o . Up to 4 can be set.
BODY Fix sized variable Fixed size3, variable sizel available
Variable-sized Only one variable-sized variable can be set.
X A segment cannot be added at the back of the
variable ; . .
variable-sized variable.
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6.5.3 Operation of a user frame definition

Read current value and set temperature value of the temperature controller at intervals of 1 second, save the
current value at address M200, and save the temperature set value at address M210.

The frame structure of PC Link which is the communication protocol of Han Young temperature controller used
in this example is as follows.

» The frame of the temperature controller is configured with ASCII string and you can read and write the contents
of the defined D and | registers. There are two types of protocol: STD standard protocol and SUM protocol with
checksum added to the standard type. The protocol type selection is selected by the parameters of the
temperature controller. The standard protocol is “STD”, and it has the structure that begins with the start character
STX (0x02) and ends with the end character CR(0x0D) LF(0x0A).

The following table shows the frame structure of the standard protocol and Check Sum protocol.
For the command and data structure, refer to the PLC communication example of Hanyoung Nux Co., Ltd.
(http://hynux.com).

STX Station No. Command Data CR LF

0x02 1~99 0x0D Ox0A

STX Station No. Command Data Error code CR LF

0x02 1~99 Check 0x0D Ox0A
sum

(1) Writing an example frame

This example is the case of saving the current value and set value of the temperature controller on the M
device area of the PLC.

It is a frame that requests reading of data in consecutive area and response frame according to request
of reading data.

Frame | STX | Station | DRS | , Data D register start | CR | LF
No. number address

Size 1 2 3 1 4 4 1 1

(Byte)

* DRS: It is a command to read the consecutive values of D register, and the number of data to be read
on the frame and the start address of D register should be set.
* In the example, enter 2 for the number of data and 01 for the start address of the current value.

Frame STX Station DRS , OK , Data 1 , DataN | CR | LF
No.

Size 1 2 3 1 2 1 4 1 4 1 1

(Byte)

Send = STX + "01DRS,02,0001" + CR + LF
Receive = STX + "01DRS,0K,04D2,0929" + CR + LF
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(2) Standard settings

Sequen Settin .
q 9 Setting method
ce process
1) [Project]>Open [New Project] and enter the project name, CPU series,
CPU type, programming type, and program name.
MNew Project 7 =
Project name: |Srnart £ || OK I
File directory: |C:WXG5EIEIEIWSmart =E | Cancel
CPU Series XGK ~ | | Product Mame...
CPU type: XGK-CPUE -
Create Format LE Far = R
1 neW Program name: NewProgram
pl’O]eCt Program Language: LD
Project description:
1) Select [Undefined Network]2>[Add item]-> [Communication module].
2) In the [Select Module] window, click “Add module”.
Select Module >
PLC type:
MNewPLC ~
Communication Module:
Murmber BASE Slot kModule Metwork. in use
Standard
2 network
addlng Add Module. . . Delete module Cancel
1) Set Type, Base and Slot in Communication module settings. After that,
select OK button in [Communication module selection] and module setting is
completed.
al
Type: XGL-EFMT(B) ~
Base: oo ~
Slot: o0 ~
oK Cancel
Undefine | Double-click the communication module in the [Project] window.
d Project * 0 x
~ EE Smart S 7
Network v@ Metwork Configuration
setting |~ Undefined Network
: L 2% NewPLC [BOSO XGL-EFMT(B)(TAG)]
3 ----- % System Variable
v i) NewPLC(XGK-CPUE)-Offline
..... %j Variable/Comment
v [# Parameter
i Basic Parameter
& 1/0 Parameter
v (3] Scan Program
L.fE NewProgram
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Sequen | Settin .
q 9 Setting method
ce process
Set TCP / IP Settings, Receive time out Settings, and Driver settings on the
[Standard Settings] tab.
1) Set Station No.: 0 and IP address
Standard Settings - FEnet >
Basic Settings  Host Table Settings Sets EIP Server
TCP~IP Settings
Station Ne - (R
Media Port1 AUTO ~
Port2: |AUTO
H IF address [ 1e2 168 1 Al ]
U ndeﬂne Subnet Mask: [ =258 255 255 [ ]
3 d Gateway: [ e 168 1 1 |
N etWOI‘k DNS Server: [ ] .0 ] 1 ]
. [ oHCP [ Relay Oorc ua
setting No_of Dedicates a1e
Receive Time Out Settings
Client: sec(2 - 255}
Server: sec(2 - 255)
Diriver Setting
Server Mode HGT server -
Modbus Settings
RAPIEnet Settings: RAPIEnet v2 ~
Cancel
Select [Add item]>[P2P communication].
2) The user frame definition is displayed in P2P 01 of the project window.
Project vix NewProgram
v a3 Project v 0 X
»;@Nd'wufx(mﬁqma‘dnn v B Smat S8
V@:!:dgmmﬁ v ®F Network Configuration
é\ggs Nyt | v Undefined Network
4 . ;ﬂNeﬂ[ﬂEl-ﬂ’UE Addten - Smat Etension v ﬁ%l MewPLC [BOS0 XGL-EFMT(B)(TAG)]
Com muni --{_:J‘Jariahls'iomma% v E PZPM
cation Ve = " (& P2P Channel
- B ! " PP Black
0 Paamee X, Do Deite | P2P Commuriceion User frame definition
v-@ S Frogram ) High-speed Link Communiation ' -
B Popetis.. v =] E-mail
-3 NewProgam )
Commuricaion Module Seting and Dignoss Address
[ Message
| Add e % System Variable
6-25 1 LSE.ecrric
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(3) Writing send frame

Sequen
ce

Setting
process

Setting method

Create a
1 user
frame

1) Select User frame definition.

2) Click the right mouse button and select [Add item] =[Add a group].

4 Project * I x MNewProgram

I v.@ Smart 4 *
~ HF Network Configuration
~ D Undefined Network
~ 5% MewPLC [BOSD XGL-EFMT(B)(TAG)]
& P2p 01
: P2P Channel
P2P Block
@ User frame definition
w .= E-mail Open From File

Addre

Export to File...

»
% System Variable i

~ i) NewPLC(XGK-CPUE)-C
%J Variable/Comment 3,
o .[&

Communication Module

Copy Ctr1=C

Paste

P2P C

~ nmuni
Ctrl+V
Parameter

High-sp

Delete Delete

I

Basic Parameter
g 1/0 Parameter
Scan Program
L.[E7 MewProgram

User Frame

Add a Group

=]

Properties...

Add Slave

d Link Communication

2 Edit group

1) The group name indicates the name of a frame that will be created by the user.
2) Select send for the frame type since the send frame is created currently.
>

Group Edit

Frame type: |Transmission

Cancel

Add
frame

1) Select the frame name, right-click and select [Add Frame].

- Edit group: It is used for changing the frame name.
- Delete group: It is used for deleting a frame.

Project - o x

NewProg

~ @ Smat SE *
~ & MNetwork Configuration

v @ Undefined Metwork
v gt MewPLC [BOSO XGL-EFMT(B)(TAG)]

~ & P2P 01
j P2P Channel

& P2P Block
H8 User frame definition

Edit Group

5 Messi cut
&9 Systern Variable

« - NewPLCIXGK CPUB)-C '=)
29 VariablesComment | <
[ Parameter Add Frame

H Basic Pararmeter -

Copy
Paste

Delete Group

Ctrl=X
Ctrl+=C
Ctri+V
Delete
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Sequen Settin .
q 9 Setting method
ce process
1) Click Add Frame and select the frame type HEAD, TAIL, BODY to create.
2) The name of the frame edit window becomes active only if the type is BODY.
3) A number of BODY's can be created by using a different name.
Frame Edit = Frame Edit s Frame Edit X
register
4 HEAD, Type: HEAD e Type: |TAILL - Type: BODY -
TAIL,
BODY Name: |HEAD Mame: | TAIL Name: | test
Cancel Cancel Cance|
1) Double click the HEAD item in the project tree to create the segment
setting screen.
2) In addition to the segment, the type is a Numerical constant constant that
Add represents the Hex value in ASCII code, and the data is the Hex value of 2,
5 segment( | Which means STX.
H EAD) Up Down Add BCC Add Line Delete Line
Segment Frame Size [rata 2:?_;%?}] Canverzion Swap reman
i) Murmetical constant 1 0z I
1) In DRS.TAIL, type is Numerical constant constant represented by Hex
ASCII code and data is input Hex value D, A which means CR and LF.
Ad d Up Down Add BCC Add Line Delete Line
6 segment( "
TAl L) Segment Frame Size Data m:;‘g;y Corwersion Swap temory
oo Numerical constant 1 oD r
m Nurerical constant 1 e
1) Double click the test item to edit the segment as shown below.
2) Write a frame that requests read data value on two continuous areas with
No. 1 of D register in No. 1 station address as the starting address.
3) When writing a frame through the segment edit on editor screen, the size
Add of each segment is 10 or less.
7 segment(
BODY) Up Down Add BCC Add Line Delete Line
Segment Frame Size Data ﬁ;s_lngol:}l Conversion Swap Memorp
an String Constant 8:0DRS.02 r
ol String Constant 5. .0001 r
}) This is the result of writing the whole frame to request read data.
NewProgram > NewPLC P2P 01 Frame - send HEAD  x NewPLC P2P 01 Frame - send. TAIL % NewPLC P2P 01 Frame - send.test  » NewPLC P2P - send [T
Segment Field Frame Size Data ﬁ;s_r"g; Conwersion Swap Memon
8 Send 1 oo HEAD Numnerical 1 02 r *
frame 2 ] TAIL Rumerical 1 ) (i
3 o TalL Numerical 1 04 i
4 oo test String Constant; 8 0DRS.02 IO
5 o test Shiing Constant: & 0001 r
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(4) Writing receive frame

Sequen
ce

Setting
process

Setting method

Create a
user
frame

1) Select User frame definition.
2) Click the right mouse button and select [Add item] = [Add a group].

View P2P * 0 x MewProgram  x r MewPLC P2P - test1 [Re
~ % PLC1_P2PO1*

v -]l NewPLC(XGK-CPUSN]-Offline Up Down Add BCC Add Li
~ & P2P 01 [BOSO XGL-EFMT(BITAG)]

Segment Frame 9

~ JJ8 User frame definitinn
P @ test1 [Recey Open From File
& Exportto File...

Add ltem 4 Metwork

Communication Module

Copy Ctrl=C
Paste Ctriev P2P Communication
F] Address High-s

¥ Delete Delete —
é Message

B P2P 02 [BOS1 FEnet =] propertics...

Link Communication

User Frame

Add a Group
|

Edit group

1) The group name indicates the name of a frame that will be created by the user.
2) Select Reception for the frame type since the reception frame is created currently
Group Edit >

Group name: |receive|

Frame type: Reception e

Cancel

Add
frame

1) Select the frame name, right-click and select [Add Frame].

View P2P » 0 x MewP

w & PLCI_P2PO1*

v ) MewPLC(XGK-CPUSH)-Offline
~ T8 P2P 01 [BOSD XGL-EFMT(B)(TAG)]

----- P2P Channel
..... P2P Block
v--@ Uszer frame definition

L receive [Re-o-si-mT

v @ send [Trar EdBEIRUR
”é'? HEAD
-3 TAIL
ﬁ test
w =1 E-mail

. Address

Cut Ctri+X

Copy Cirl=C
Paste Ctrl+V

K[ i #<

Delete Group Delete

Add Frame

» -IE P2P 02 [BOS1 FEnty Nl
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Sequen Settin .
q 9 Setting method
ce process
1) Click Add Frame and select the frame type HEAD, TAIL, BODY to create.
2) The name of the frame edit window becomes active only if the type is BODY.
3) A number of BODY's can be created by using a different name.
Frame Edit X Frame Edit x Frame Edit =
register
4 HEAD, { Type: HEAD v Type: |TAIL 2 4 Type: BODY ~
TAIL,
BODY Mame: HEAD Name: TAIL Mame:
Cancel Concel | | Cancel
1) Double click the HEAD item in the project tree to create the segment
setting screen.
2) In addition to the segment, the type is a Numerical constant constant that
Add represents the Hex value in ASCII code, and the data is the Hex value of 2,
5 segment( | which means STX.
HEAD) Up Down Add BCC Add Line Delete Line
B Aszigh .
egment Frame Size Data memory Conversion Swap Memary
oo Numerical constant 1 02 r
1) In DRS.TAIL, type is Numerical constant constant represented by Hex
ASCII code and data is input Hex value D, A which means CR and LF.
Add f2 | 0@z | [eecaz] (B2220) B2 am6e)
6 segment(
TAIL) AImE e 37 HIo/E [H'EEE' e e HEz)
] A A 1 m:
IS R 1 [
1) Since the present value is saved in MB200 and the set value in MB210,
set the and save area area of the 1st and 2nd data.
2) Since the data size of 1,2 is 4 bytes, set the size as 4 as a fixed sized
variable when entering into the segment.
3) Check the memory assignment to select the data storage area.
Add HIoE =7 = | 41es =71 [=X=) FEFEEEY ™) g—— )
7 segment( B R — B [ZEaNE= ) H: (EREas - b (FEoNEE
BODY) ERT (a2 EF/E () EBB ) ERTT (o)
TIOIE]: [O1DRS.0K, (Hes) HOIE: |, (Hes)
M=l AE [T E AT
e wek
2 o
Erm - 5y [ HE | g1 [ #HE ] = [ #Hz |
This is the result of writing the whole frame of response that receives data
response by the temperature controller
NewProgram x|  MNewPLC P2P - send [Transmission] y' MewPLC PZP - receive [Reception] |  MewPLC-PZPO1 x|  NewPLC P2P 01 Frame - receiveHEAD
Rece|ve Segment Field Frame Size Data ﬁ:fgg;y Conversion Swap Memary
8 total 1 og HEAD Hurnerical 1 02 [
2 o0 TAIL Humerical 1 o] [&
frame 3 AL fiumerical iy r
4 o testl String Constant; 8 01DRS5.0K I
5 0 testl Fix sized 4 [ :NONE NONE
[ 02 test] Stiing Constant: 1 I
7 03 testl Fix sized 4 [ :NONE NONE
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(5) Create P2P send / receive block

Sequen Settin .
ge procesgs Setting method
1) Double click P2P block in P2P 01.
2) Enter the channel (user frame definition) selected in P2P channel.
3) In the P2P function, select Send as SEND and Receive as RECEIVE.
4) The starting condition will be enabled only when the P2P function is SEND.
5) Use F93 which indicates 1 second for the starting condition since data is
read once a second.
6) Click the setting of the receive frame to set the current temperature value
and the and save area area of the set value.
Create ' MewProgram x|  NewPLCP2P-send [ansmission] |  NewPLCP2P-receive Reception] 7 NewPLC-P2POT x|  NewPLCP2PO1Frame - receiveHEAD [  NewPLC P2PO1 Frame -receiveTAIL %[ NewPLC|
1 Send / Indes|  Emal | Ch Diiver Setting Header | PoPfunction | " | Conang el DataTupe | | paimsze D?:nm“ estnalen | Frame Selfing | Variable seting contents
re C e IV e a r 1 User frame defirition SEND _Ts e send test Setting
block 1 r 1 User frame definition RECEIVE Variable Setting % teceive test] Sefting gé"\ggingggg
2 r Setting
3 [nd Save area: Local Address (NewPLC) Sanng
4 r Save area Address Setting
5 r 1 MO200 NODOE2 Setting
B r 2 | MO210 NOODET Setting
T =
k] r Setling
10 r Setling
11 r Setting
= r Setting
) r Setting
o Sai
Write . . .
> aramete Write [Online]>[Write].
F 2) Select [Online]>[Communication Module setting]>[Enable Services].
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‘ 6.6 E-mail Service

E-mail service is a service to notify the remote administrator of the status by using the system when a problem
occurs in the system. If the status of the CPU has changed or an event occurred during operation, you can deliver
the status using the mail server.

6.6.1 Email setting

(1) Click the 'Email' item from the P2P window of XG5000 to activate the 'E-Mail setting screen.

If you check Use E-Mail, the following settings are possible.

WView P2ZP - O ' MNewProgram = | MewPLC P2P - send [Transmission] > | MNe
~ EF PLC1_P2P02 E-Mail Settings >
~ @ MewPLC(XGK-CPUE)-STOP
~ IE P2P 01 [BOSO XGL-EFMT(B)(TAG]] =] use E-Mail
- P2P Channel | User information
—[=] P2P Block 21
~ @ User frame definition User name:  [PLC |

= Address
. Message Message confirmation | 10

Mail address: |lsis@220.90.135.59 |

Server information

POP3 server address: | 220.20.135. 52
SMTP server address: |220.90.135.59

Account name: Isis

Password: eeee

intervals:

Ewent information

Message surveillance period: Sec.(10 ~)

Address Message
Elrur == sTOP 3 1
[OsTor == rRUMN
[ ErRROR
Cancel
Clagsm Item Usage
cation
using E-mail Selects whether or not to use email service. This item must be
9 checked before the email can be used.
Set the user name displayed when the other person receives the mail.
User name When set to PLC, the sender name appears as PLC when receiving
User mail.
informa The recipient e-mail address when you clicked Reply.
tion Mail address Refers to the sender's mail server consisting of the user name and mail
server, and the PLC can send data and the reply can Setting high speed
to be received by the PC.
POP3 server |Setthe IP address to the server address that receives mail from other
address devices. It can be set as a mail server that supports POP3.
SMTP server |The IP address must be set as the server address for the PLC to send
address data. Can be set to a server that supports SMTP.
Server . .
informa| Account name |Set the same account name as the email address in POP3.
el Password Set a password to access the POP3 account.
Message
confirmation [Set the time to check if a message arrived.
intervals
Mesgage This is the period to check whether the PLC mode has been changed
surveillance
. or not.
period
Event When the PLC mode has changed from RUN to STOP, the Ethernet
. RUN -> STOP . .
informa automatically sends an email.
tion STOP -> RUN When the PLC mode has c_hanged from STOP to RUN, the Ethernet
automatically sends an email.
ERROR When an error occurs during PLC run, the Ethernet automatically sends
an email. Sent when an error occurs in RUN, STOP, etc.
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The event information determines status information by monitoring the status of the CPU periodically. If
the PLC mode is STOP or an error has occurred, the communication parameters will not operate, so this
service is provided as an option in preparation for such a case.

6.6.2 Writing address

Double-clicking an address in the E-mail setup section of the P2P screen displays the screen for editing the
address book.
View P2P - O X
~ HF PLCI_P2PD2
v () NewPLC(XGK-CPUE)-S5TOP
~ & P2P 01 [BOSO XGL-EFMT(B)(TAG)]
P2P Channel

-5 P2P Block
T8 User frame definition
w =1 E-mail
Address
L % Message
In the screen below, register an address to send a mail.

Address Book >
Mo Name Address €2
=0
=1
=2
=3
=4
=5
=5
=7
=3
=9
= 10
= 11 W

Group Delete Close

(1) Address Edit

Select Edit to display the Edit Address screen, enter your name and e-mail address, and select OK.

Address Edit >

Mame m |

Address |gdhong @daum.net |

Cancel

Address Book =
Mo Mame Address e
E=lo hong gdhong@daum.net
1 il imaeil @korea.com

gsjang @nawver. com

LI IO B RN B B I |
o Owmbh

Edit Group Delete Close
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(2) Specified group
Select Group if you want to send the mail to a group instead of individual users at once.

Group Edit >
Group name groupl
Address Member
il jang
jana
Delete
(=4 Close
Address Book >

Mo MName Address &

E=lo hong adhong@daum.net

1 il jmaeil@korea.com

E=12 jang gsjang@naver.com

group1

4
5
=]
r
8
=]
10

"
-

£t Delet= Close

If you select a group, the personal address book registered so far is displayed on the left screen.
Select the address of each person who will be a member of the group and click OK to create the
group address book.

If you send to Group 1, the mail will be sent to 'jmaeil' and 'gsjang' at the same time.
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(3) Writing a message

If you select a message in the E-mail setup section of the P2P screen, the message edit screen appears.

View F2P

~ EB PLC1_P2P02

~ 1

~ -IE P2P 01 [BOSD XGL-EFMT(B)(TAG)]

MNewPLC{XGK-CPUE)-5TOP

P2P Channel

.[E] P2P Block

3 38 User frame definition
~ &7 E-mail

Address

... Message

- B X

1) Double click message the mail message you want to send.

E-mail Message Index

Titde

2
a

gq.hr.uru|

Delete Close

2) Double click the 0 on the above window to display the [E-mail Message] window.

E-mail Message *
Title |PLC e-mail data| |
Add Edit Delets Cancel
3) Click “Add” to open the [E- mail edit] window.
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Form: STRIMG -
Size: o
Data: |

[] change line

(=124 Cancel
Item Usage
STRING: It is used to send the message data of P2P ESend parameter to the
Form con'Fents set in the following data.
Mb:it is used to send the message data of P2P ESend parameter by the number
of bytes set in size.
Size Specifies the size of the message data. Up to 80 available range be set.
Data It is activated when STRING is specified in the form and inputs, data.
Change line Change line means that a command to change the line to the next line is included
when the received contents are displayed on the screen.

4) Click “Add” to open the [E- mail edit] window.

E-mail Edit b4

Form: |MB e

Size:

Data:

Change line

Cancel
E-mail Message Index il
Mo Title 2

a PLC e-mail data
1
2

3
4
5
&
7
8
9

10

Delete Close
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6.6.3 Create block

Parameter setting of P2P block is to send / receive the message of E-mail setting. Click the P2P block and set
the E-mail button to select the corresponding P2P command.

View P2P - 0
~w EE PLC1_P2P0O2

w (FD NewPLC(XGK-CPUE)-STOP

v P2P 01 [BOSOD XGL-EFMT(B)(TAG]]

P2P Channel
P2P Block
$ @ User frame definition
~ =7 E-mail

: £ Address

----- Message

Destinati

Index E-mail Ch Driver Setting Header P2F function Ennﬁ:gna\ Command type| Data Type v:r?éljfes Data size stg[?nn stgﬁos:n:::ﬁger Frame Setting Wariable setting contents

Line:3

0| ® satng | ez nerd
M ail data:000000
Line:2

1 2 ERECEIVE k00001 Setting M ail infarmation:k0010
t ail message:0100

Classification Contents

E-mail

Enable your email service.

P2P function

ESEND: Sends an email.
ERECEIVE: receives an email. Only one can be registered. .

Start condition

Enter the area to be used as the start condition.
Memory areas and flags are available.

(1) Click to enter the settings.

Variable Setting >

Read area: Local Address {MewPLC)

Fiead area Address
Msil Meseage o MOOOO1
b ail Address Mumber a mO0o0s
kA ail data Drogooo Foooi
cancel
Mail Message | Enter the index number from the Message Index among the Email Setting
Number of P2P. Decide the title and data of the mail.
Set the registration number set in the address book. Decide to whom you
wish to send mail.
Mail Address * If you want to send it to multiple people, you can set it using a group.
Send Number However, the mail addresses of the recipient group should have been
entered in advance before specifying the group. The number of groups
that can be specified is limited to 10 groups.
Indicates the start address of the data to be sent. The size of data to be
Mail data transmitted is the number of arrays (10 bytes) starting from the first array
corresponding to MB [10] within the email message setting.
Rece | Mail information | This is the area where mail information is saved.
ive Mail message | Saves a received mail message to the PLC memory.
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‘ 6.7Downloading and diagnosis of P2P parameter

6.7.1 Downloading a P2P parameter

When the P2P parameter setting is completed, you need to download the parameters to the PLC CPU and start
the P2P service. To download P2P parameters, select [Online] - [Write] in the XG5000 menu window and the
parameter download window will appear. In this window, basic setting, P2P parameter, high speed link parameter
registered by user can be selected.

Write to PLC ? pd

[]inhibit Program Upload
[] sets link enable with parameters

Configuration
Comment Cancel
@ Parameter
: Setting...
.E Basic Parameter SETong
-E 1/O parameter
‘ Clear PLC...
e .@ Spedial module parameter
~[ZI[8] Program

[ 8@ Metwork Parameter
-:.: Basic Settings
- [IEl [Resef]FEnet [base0, sloto]
=IE EIP tag
w2 EIP Server
I:IH High-speed Link
; H High-speed Link 01
I:IH High-speed Link 02
DH High-speed Link 03
i [ ]TE], High-speed Link 04
[1E High-speed Link 05
: 1 High-speed Link 05
1B High-speed Link 07
Iﬁ P2P(EIF)
~[Z1[8 P2P 01

Select only P2P parameters created during P2P 0 ~ 7 and select OK. If confirmed, the P2P parameter is
downloaded to the CPU module.
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6.7.2 P2P service operation

In order to download P2P parameters and start P2P service, P2P operation must be performed. To do this, select
[Online] & [Communication module setting and Diagnosis] = [Enable Services (high speed link, P2P)] from the
menu.

EBE

= E Communication service status -
= E High-speed Link
H High-speed Link 1
o H High-speed Link 2
- H High-speed Link 3
g E High-speed Link 4
g E High-speed Link 5
g :EI High-speed Link &
g H High-speed Link 7
- E High-speed Link 8
g H High-speed Link 9
g E High-speed Link 10
- H High-speed Link 11
E High-speed Link 12
- E P2P(EIF)
- [, p2P(EIP) 1
E rrEr) 2
,'!‘, P2R(EIF) 3
P2R(EIF) 4
P2P(EIF) 5
P2P(EIF) &
[ P2rER) 7
- []{8] P2P(EIF) &
=] H Smiart Extension =

oK Cancel

Select a P2P parameter you wish to start from the [Link enable (HS Link, P2P)] window. A P2P parameter which
is already checked has started, and if it is canceled, the relevant P2P service will stop. After downloading, check
the operation status of P2P service in [System Diagnosis] menu.
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6.7.3 P2P service diagnosis

P2P system diagnosis shows the service status and information of communication program after driver setting of
communication module. The user can check whether the P2P service is operating normally with the system
diagnosis Please refer to the Chapter 3.4 XG5000 program for details.

& PLC1_P2PO2 - XG5000
DSGEE & Ad MO @Wmio e BEEY 55 L% iAW e
BE OO G &FE&Ge @ Copoe@Eawnh@2 0000 0/ 0@ S ETELDs 2

Ex/F3 F4 F5 F6 F7 FB F9
PROJECT EDIT FIND/REPLACE VIEW ONLIN

TOR DEBUG TOOLS WINDOW HELP

FRAF A R M — L 4 45E AR ARE ME IFE T34 P L uRr wg EEEE EEE DDDD @2 £ 8 Bia oo

Lo
LS s s RE LN RERSRE Y Y YY
] ~Send ansmission] %] NewPLC P2P -recene [Reception] | NewPLC-F2P0T ]

NewProgram %] NewpiC

P01 Frame receweHEAD ] ewrll

PLC_P2P02
~ - NewPLC(XGK-CPUE)-STOP
~ - P2P 01 [BUSO XGL-EFMT(8)(TAG)] -
P2P Channel = LEF“HB KGQ-TRZx KGI-D21A XGQ-TR2x XGH-DT4A
P2P Block
> 38 User frame definition
~ £ E-mail
B8 Address
% Message

™
Systemn information Address Assignment (Variable) Comment
=@ Base 0 i XGB-M0GA Main Base(6 Slots)
[ Power: RGP-xxxx Power Module(AC100~240V or DC24Y Inputy
[fle ©PU: XGK-CPUE Economic CPU Module(|/0: Maximurm 1,536 Points)
[Hle Siot 0: XGL-EFMHE [PO0000 ~ POODOF] Fast Ethernet Communication Module. Hybrid Master
[ Slot 1: XGa-TR24/E [POOO10 ~ POODIF] Transistor Output, 16 Contacts (0,54, Sink Output/Source Qutput)
[z Slot 2: ®GI-D21A [PO0020 ~ POOOZF] DC 24V Input, 8 Contacts {Current Source/Sink Input)
[lls Slot 3: XGQ-TR24/B [PO0030 ~ POOOSF] Transistor Output, 16 Contacts (0,54, Sink Output/Source Qutput)
[ll+ Slot 4: XGH-DT44 [PO0040 ~ POODSF] DC 24Y Input, Transistor Output, 32 Contacts
[lls Slot 5 Empty slot [POOOE0 ~ POODEF]

(1) P2P service

Check the status of the user define service in detail. When P2P parameter is set and enabled, it indicates
whether the service is normal or not. Real-time monitoring is available by specifying read continuously
and refresh on menu.

Status by service >

Dedicated Service F2P Service HS Link Service Smart Extension

Standard Irformation Service information

casetio: [0 | pomesronsoncs o nservoes:
Slot Mo - II' Parameter task status: DOV MLOAD

Communication Diagnostics

Block number Channel number Connection Status Packets per second Service count  Emor count Block status
1] o IDLE o o 1] O K 0000}
1 o IDLE o o (] O KT DO00)

Details:

Read
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6.8XGR Redundancy Program Method

In case of P2P service, in order to read the data of the redundant system, P2P write should be done on the XGK
(1) side without using P2P write on the XGR side and use the flag of P2P service. Save normal service count of
P2P service connected to A-Side and B-Side and read STATUS of the block to check if it is 0 After that, it checks
that STATUS is 0 and normal service count is increased and read the data on either side.

(1) XGR and XGK (I) are redundant with different IP addresses on a single network

In such a case, since the P2P service must be composed of different blocks in one block, the ladder
program can be written as follows.

After checking whether P2P 1 has been serviced normally, set set_p2p1 ifitis

normal.
EQ
EN  EMD
_P2P1_STAT HE
g 4N EN  END}
_P2P1 _SNCE set_p2pl
fl 1 IK2 NTOO  {1H0 ouT {3 —
e
= e B END
o saved

coun
WTOD 4 IHouT t_pdpl

After checking whether P2P 2 has been serviced normally, set set_p2p2 ifitis

normal.
ED
EN EMO}
2P _ATAT
[131]] | EN EMD
_F2P1_SVCE sat_p2p2
0 4 IN2 NTOL - {IH0 OuT {5 —
i,
e | e B e
s saved_coun
WTOT 4 I OUT | e

LSE. ecrric | 6-40




Chapter 6 P2P service

If 1 is normal, 1 data is taken. If 1 server is abnormal, 2 data are taken.
| set_pZpl
fir—
set_pZpl ARY_MOVE
[ S
set_p2pl set_pZp2 ARY_MOYE
[ /1 [ EH ~ EMD | MOVE_WUM {MOWE  OUT |
_ _NUM
MOVE_WUM {MOVE  OUT | [
_ _HUM
M {IH [H_INDE TN
_ WO
IN_INDE  J1M_| OUT_INDK 00T
_ [IF4 [HD¥
OUT_ IO {00T_
_ IHD
| set_pZp2
Rr—

(2) XGR and XGK (I) are redundant with different IP addresses on other (separate) networks.

If you create a ladder in P2P service 1 connected to the master (standby) side, P2P service 2 connected
to the standby (master) side and 0 in P2P block 0, you can write as follows.

Check if P2P 1 has been serviced normally and set set_p2pl if it is normal.

El
EN t EHO
_PEP1_STAT HE
usoo 4 IN1TouT EHN ENO [
| _PZP1_SVCC set_p2pl
0 4 IH2 WTOD 4 IHTouT 53—
saved_coun
t_p2p 4 IH2
sawed_coun

_P2P1_SWCC
WTOO g t_pep

F Check if P2P 2 has been serviced normally and set set_p2p?2 if it is normal.

El
EN lJEND L
_PEP2_STAT HE
U=00 4 W1 OuT =] ENO
| _PeP2_SVCC set_pZpd
0 4 IH2 WTOD 4 IHTouT 53—
saved_coun MOYE
t_pZpz 4 INZ EN [=1]
sawed_coun

_P2pz2_SWCC
WTOO g t_pep
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Check if P2P 2 has been serviced normallv and set set p2p2 if it is normal.
set_pZpl
Rr—
set_p2pl ARV _NOVE
I EW ~ EMD |
set_pepl set_pipd ARY_MOYE
{1 [ | EH ™ EMD | MOVE_HUM {WOVE  0UT |
i _HUM
MOWE_NUM JMOVE OUT | M 1IN
i _HUM
YR IN_INOE 1M
i WX
IH_INDE 1N OUT_INDY 0UT_
i WX THD¥
OUT_INDY 00T
] [NDE
| set_pZps
Rr—

If XGR and XGK (I) are redundantly configured with the same IP address in different (separate) networks,
duplicated services can be implemented by writing the same ladder program (2) and the basic part is
different. .
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Chapter 7 Server service

Server service is explained by XGT server, Modbus server, EtherNet / IP server, OPC UA server function.

7.1 XGT server

7.1.1 Overview

(1) Overview of the protocol

XGT dedicated protocol is communication protocol between LS ELECTRIC Ethernet modules. Read / write is
available by using command and communication is available by using XGT dedicated protocol from PC and HMI.

XGT Dedicated communication can be used in the TCP and UDP communication method.

Communication
Protocol Port number
method
TCP/IP 2004
XGT Dedicated CP/ 00
UDP/IP 2005

(2) Frame structure

1) Structure of XGT dedicated frame

XGT dedicated protocol includes MAC, IP header, TCP header between LS ELECTRIC frame (including data)
required for Ethernet communication. The structure of the Ethernet communication frame is shown below.

Ethernet Request / Response Frame

v

A

MAC IP Header

TCP Header

LS IS Frame Format

A

TCP/IP Data Frame

v

2) Structure of XGT dedicated frame

The LSIS frame for data communication includes LS ELECTRIC's unique data (Company ID), command, data

type and data. The frame shape

is shown below.

LS IS Frame Format

Company Header

Commnad

Data Type

Data
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3) Header structure of XGT dedicated protocol

ltem Size (Byte) Contents
-“LSIS-XGT” + “NULL NULL(Reserved)”
(ASCII CODE : 4C 53 49 53 2D 58 47 54 00 00)
Company 10
ID 1 ~“LGIS-GLOFA’
(ASCIl CODE : 4C 47 49 53 2D 47 4C 4F 46 41)
* Client=>» server: Don’t care (0x00)
* Server = client:
Bit0O0~05: CPU type
(XGK/I/R-CPUH: 0x01, XGK/I-CPUS: 0x02, XGK-CPUA: 0x03,
XGK/I-CPUE: 0x04, XGK/I-CPUU: 0x05, XGK-CPUHN: 0x11,
XGK-CPUSN: 0x12, XGI-CPUUN: 0x15)
PLC Info 2 Bit06: O (Dual Master / single),
1 (Dual Slave)
Bit07: 0 (CPU normal operation),
1 (CPU Error operation)
Bit08~12: system status
(RUN :0x01, STOP: 0x02, ERROR :0x04, DEBUG :0x08)
Bit13~15: Reserved
It is determined that it is XGK / XGI / XGR series.
- XGK: 0xAOQ - XGB(MK): 0xB0O
CPU Info 1 - XGl: OxA4 - XGB(IEC): 0xB4
- XGR: 0xA8
Source of 1 * Client(HMI) = Server(PLC) : 0x33
Frame * Server(PLC) = Client(HMI) : Ox11
Invoke 1D 2 ID to distinguish order between frames
(Send this number to the response frame)
Length 2 Byte size instruction structure
Ethernet 1 BitO~ 3: Slot no. of Ethernet module
location Bit4~ 7: Base no. of Ethernet module
Re(s;(r:vg)d 2 1 0x00: Reserved area (Byte sum of Header)

position.

(1) Length means the sum of the size of (command frame) bytes from command to data number or data.
(2) Reserve 2 (BCC) is a 1 byte value from the sum of the frame contents from Company ID to Ethernet

(If the 4C+53+49+53 values are added together, it is 13B and only the lower byte, 3B, is displayed.)
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4) Frame structure of XGT dedicated protocol

- Command request frame(External communication device — Ethernet I/F module)

Reserved area

Header Command Data type (2 Byte) Structured data area
- ACK response frame (Ethernet module — external communication device, when data is received normally)
Head | Comman Data type Re::aer;ed Error status Structured data
er d (2 Byte) (2 Byte: h’'0000) area
- NAK response frame (Ethernet module — external communication device, when data is not received
normally)
Head | Comman Data type Re::aer;ed Error status Error code
er d P (2 Byte) (2 Byte value is not h’'0000) (2 Byte)

4 types of command are used in the XGT dedicated protocol and each command processes read/write and
request/response.

Available data type of each instruction is bit, byte, word, double word, long word or is individual and data type
is only byte if it is consecutive.

Command
Command Data type Contents
code
h’ 0000 BIT
h' 0001 BYTE
Request: Individual [h’ 0002 | WORD | Request to read data according to each data
h’0054 h" 0003 | DWORD
h’ 0004 | LWORD
Read Continuous | h* 0014 BYTE Request to read byte variable in blocks
h’ 0000 BIT
h’ 0001 BYTE
Reponse: Individual |h” 0002 | WORD Response to the request for Read Data
h’0055 h" 0003 | DWORD
h’ 0004 | LWORD
Continuous | h* 0014 BYTE Response to the request for block unit Read
h’ 0000 BIT
h’ 0001 BYTE
Request: Individual |h’ 0002 | WORD | Request to Write Data according to each data
h’0058 h" 0003 | DWORD
h’ 0004 | LWORD
Write Continuous | h* 0014 BYTE Request to write byte variable in blocks
h’ 0000 BIT
h’ 0001 BYTE
Reponse: Individual |h’ 0002 | WORD | Response to the request for Write Data
h’0059 h” 0003 | DWORD
h’ 0004 | LWORD
Continuous | h* 0014 BYTE Response to the request for block unit read
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- Expression of data type: Device Type of XGT PLC: Data types for variables suchas P, I, Q, M, L, F, K, C, D,

T, N, and R are displayed after the variable display character'%' (H25).

Data type Example
Bit %PX0,%LX0,%FX0
Byte %MBO, %PB0, %DB0
Word %PWO0,%LW0,%FW0,%DWO0
DWord %PD0,%LD0,%FD0,%DD0
LWord %PL0,%LL0,%FL0,%DL0

() In Timer/Counter, the Bit specification means the contact value and the Byte and Word value
specification means the current value.

(3) Only Byte and Word can be specified for the data register (D).

(4) In case of a byte type command, the address value will be doubled in comparison to specifying Word.
In other words, in case of D1234, %DW1234 is used when Word is specified, but in case the form of
Byte is specified, %DB2468 should be used.

(5) When accessing the bit area, it should be expressed in the order of data type unit of memory device. in
order to write the C th bit of M172, M should be calculated as bit type as below because it is word
device.

* 0HMX2764 = 172 x 16(Word) + 12(Bit)

(6) In the case of hexadecimal data before the number in the frame, it indicates that the data is in hexadecimal

type by 'h' or '0x', such as h'12345, h'34, 0x12, Ox89AB.

(7) When creating a frame, when expressing hexadecimal word data in the above frame, subtract h before the

number and change the position of two bytes.
ex) h’'0054 = h’'5400.
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7.1.2 XGT dedicated protocol commands

(1) Read variable individually

This is the function to specify the PLC device memory to read according to the memory data type. 16 independent
device memories can be read at a time.

1) Request frame

ltem Size (Byte) Contents
Command 2 0x0054: read request
Data type 2 Refer to the data type table(X, B, W, D, L)
Reserved 2 0x0000: Don’t Care

area
Number of 2 The number of variables to be read is up to 16.

blocks
Length of 2 The length of direct variable is up to 16 characters.
variable name
. Length of
Vggs}t;le variable Only direct variables are available
name

(Repeat as many as the number of variables/max. 16)
Length of 2 The length of direct variable is up to 16 characters.
variable name

Variable Length of
variable Only direct variables are available
name
name
Length
Name of Comman Data Reserve | Number of Variable
Header )
frame d type d area of block | variable name
name
Code(ex) h’'0054 h’0002 h’0000 h’0001 h’0006 %MW100

1 block (Up to 16 blocks can be set repeatedly)

- Blocks number: By specifying how many blocks composed of [variable names] and [length of variable] are
in the request frame, up to 16 blocks can be set. Therefore, the value of [Number of blocks] should be h’0001
~ h’0010.

- Length of variable name: It indicates the number of letters of a name that means a variable, and a maximum
of 16 characters is allowed. Therefore, the value of [length of variable name] should be h’'0001 ~ h’0010.

- Variable name: The variable address to be read is entered. It must be an ASCII value within 16 characters,
and other than numbers, upper/lower case, ‘%’ and’.’ are not allowed in this variable name.

2) Response frame(ACK response)

ltem Size (Byte) Contents
Command 2 0x0055: Read response
Data type 2 Refer to the data type table
Reserved 5 0x0000 : Don’t Care
area
Error status 2 Ifitis O, itis normal, if it is not 0, it is an error.
Error 5 In case of error, the lower byte is the error number
information
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Number of Number of variables to read when the error status is normal
blocks
Data size 2 Byte size of data
Data Data size Data to read
(Repeat as many as the number of variables/max. 16)
Data size 2 Byte size of data
Data Data size Data to read
Number
Name of Comma Data Reserv Error Data
Header of . Data
frame nd type ed area | status size |~ | ...
blocks
Code(ex) h’0055 h’0002 h’0000 h’0000 h’0001 h’0002 h'1234

1 block(Max. 16 blocks)

- Blocks Number: By specifying how many blocks composed of [variable length] and [data] are in the response
frame, up to 16 EA can be set. Therefore, the value of [Number of blocks] should be h’0001 ~ h’0010.

- Data size: It means the number of bytes of HEX type. This number is determined by the memory type (X, B,
W, D, L) contained in the variable name of the computer request frame.

3) Response frame(NAK response)

Name of | Heade | Comman Data type Reserve Error status Error code
frame r d P d area (Hex 2 Byte)
, , , h’FFFF or h’'O0FF ,
Code(ex) h'0055 h'0002 h’0000 (Non-zero value) h'0021

(1) The error code is a hexadecimal 2 byte and indicates the type of error.
For details, refer to the 'Error Code Table.
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(2) Variable continuous read

This is a function that directly designates the PLC device memory and continuously reads data as much as the
specified amount from the specified address.

1) Request frame

Item Size (Byte) Contents
Command 2 0x0054: read request
Data type 2 0x0014: continuous
Reserved 2 0x0000: Don't Care.
area
Number of 2 The number of variables to be read is up to 16.
blocks
Length of 2 The length of variable name is up to 16 characters.

variable name

Length of | Only direct variables can be used and indicate the first address of the

Variable variable block.
name
name
The number 2 Byte size of data, Max. 1400Byte
of data
Length The
Name of Comman Reserved | Number of Variable
Header Data type ; number
frame d area of blocks | variable name
of data
name
Code(ex) h'0054 h'0014 h'0000 h'0001 h'0006 %MB000 h'0006

- Data type: Data type can only be used as h'0014.

- Blocks Number: The number of blocks can only be used as h’0001.

- Length of variable name: It indicates the number of letters of a name that means a variable, and a maximum
of 16 characters is allowed. Therefore, the value of [length of variable name] should be h’0001 ~ h’'0010.

- Variable name: The variable address to be read is entered. It must be an ASCII value within 16 characters,
and other than numbers, upper/lower case, ‘%’ and’.’ are not allowed in this variable name.

2) Response frame(ACK response)

Item Size (Byte) Contents
Command 2 0x0055: READ response
Data type 2 0x0014: continuous
Reserved > 0x0000: Don’t Care
area
Error status 2 Ifitis O, itis normal, if it is not O, it is an error.
Error In case of error, the lower byte is the error number
information 5
No. of 0X0001: Normal operation
variables
Data size 2 Byte size of data
Data Data size | Data to read, max. 1400 Byte
The
Name of Comman Reserved Error Number
frame RS d REEIES area status of blocks i 2 BEIE
of data
Code(ex) h'0055 h'0014 h’0000 h'0000 h'0001 h’0006 gggﬁ? %6
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3) Response frame(NAK response)

Name of Reserved Error code
frame Header | Command Data type area Error status (Hex 2 Byte)
, , , h'FFFF or h'OOFF ,
Code(ex) h’0055 h'0014 h’0000 (Non-zero value) h'0021

(3) Write variable individually

This is the function to specify the PLC device memory to write according to the memory data type. Data can be
written to 16 independent device memories at once.

1) Request frame

ltem Size (Byte) Contents
Command 2 0x0058: Write request
Data type 2 Refer to the data type table
Reserved area 2 0x0000: Don’t Care
Number of blocks 2 The number of variables to be write is up to 16.
Length of variable 2 The length of direct variable is up to 16 characters.
name
Variable name Length of variable Only direct variables are available
name
(Repeat as many as the number of variables/max. 16)
Length of variable 2 The length of direct variable is up to 16 characters.
name
Variable name Length of variable Only direct variables are available
name
Data size 2 Byte size of data
Data Data size Data to write
(Repeat as many as the number of variables/max. 16)
Data size 2 Byte size of data
Data Data size Data to write
Name of | Heade | Com Data Rese | Ny Length o Variable Data
frame " mand | type rved | erof | variable name Size Data
area | blocks name .-
Code(ex) | .. | "% | noooz | M9 | woooz2 | wooos | 9emwioo h0002 | h1234
L L

1 block (Up to 16 blocks can be set repeatedly)
- Blocks Number: By designating the number of blocks composed of ‘[variable name length][variable
name][data size][data]’ in the request frame, up to 16 blocks can be set. Therefore, the value of [Number of
blocks] should be h’'0001 ~ h’'0010.
- Length of variable name: It indicates the number of letters of a name that means a variable, and a maximum
of 16 characters is allowed. Therefore, the value of [length of variable name] should be h’0001 ~ h’0010.
- Variable name: The variable address to be read is entered. It must be an ASCII value within 16 characters,
and other than numbers, upper/lower case, ‘%’ and’.’ are not allowed in this , variable name.
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(2) The device data type of each block should be same. If the data type of the first block is Word and
the data type of the second block is Double Word, an error occurred.
If the data type is Bool, the read data is displayed in HEX as one byte. In other words, if the bit value
is 0, h00 will be displayed, and if the bit value is 1, h’01 will be displayed.

2) Response frame(ACK response)

Name of Header Command Data type Reserved Error status Number of
frame area blocks
Code(ex) h’0059 h’0002 h’0000 h’0000 h’0001

- Blocks number: Displays the number of blocks to be written normally.

3) Response frame(NAK response)

Name of Header Comman Data type Reserved Error status Error code
frame d P area (Hex 2 Byte)
, , , h’FFFF or h’'O0FF ,
Code(ex) h’0059 h’0002 h’0000 (Non-zero value) h’0021

(4) Write variable continuously

This is the function to specify the PLC device memory to write the data. This is the function to write continuously as
much data as the specified quantity, starting from the specified address. However, only byte type variables can be
used.

1) Request frame

Item Size (Byte) Contents
Command 2 0x0058: Write request
Data type 2 0x0014: continuous
Reserved area 2 0x0000: Don’t Care.
Number of blocks 2 The number of variables to be write is 0x0001.
Length of variable 2 The length of variable name is up to 16 characters.
name
Variable name Length of Only direct variables can be used and indicate the first address
variable of the block(% MBO0,% PBO0)
name
Data size Data size Byte size of data
Data Data size The number of data to write is up to 1400byte.
Name of | Head | Comma Data Reserve | Number Length of Variabl Data
variable . Data
frame er nd type darea | of blocks name e name size
Code(ex) | .. | hooss | hoot4 | hoooo | hooot | ooos | MO0 | hooo2 | h1234

- Data type: Data type can only be used as h’'0014.

- Blocks Number: The number of blocks can only be used as h’0001.

- Length of variable name: It indicates the number of letters of a name that means a variable, and a maximum
of 16 characters is allowed. Therefore, the value of [length of variable name] should be h’'0001 ~ h’'0010.

- Variable name: The address of the variable to write must be an ASCII value within 16 characters, and other
than numbers, upper and lower case letters, ‘%’ and ’.” are not allowed in the variable name.

- Data size: It indicates the number of bytes of data (max. 1,400 bytes).
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2) Response frame(ACK response)

ltem Size (Byte) Contents
Command 2 0x0059: Write response
Data type 2 0x0014: continuous
Reserved area 2 0x0000: Don’t Care
Error status 2 Ifitis O, it is normal, if it is not O, it is an error.
Error information 5 In case of error, the lower byte is the error number
No. of variables 0X0001: Normal operation

3) Response frame(NAK response)

Frame Reserved Error code
name Header Command | Datatype area Error status (Hex 2 Byte)
, , , h’FFFF or h’'O0FF ,
Code(ex) h’'0059 h’0014 h’0000 (Non-zero value) h’0021

(5) Request to read information and status(PC/HMI -> PLC)
It is a service that can use PLC information and status through communication.

1) Computer requirements frame

Item Size (Byte) Content
Command 2 0x00BO0: Status Request
Data type 2 0x0000: Ignore
Reserved area 2 0x0000: Ignore

2) Response Frame(when the ACK response from PLC)

ltem Size (Byte) Content
Command 2 0x00B1: Status request
Data type 2 0x0000: Ignore
Reserved area 2 0x0000: Ignore
Error status 2 If it is O, it is normal, if it is not O, it is an error code.
Reserved area 2 0x0000: Ignore
Data size 2 0x0018
Data 24 Status Data
3) XGT Status Data Structure
Size Byte
ltem (Byte) Posyition Content
Slot info
Bit0O~ Bit03: Slot information remotely connected to another station
Bit04~ Bit07: Base information remotely connected to another station
Slot Info 4 0 B!t08~ B!tll: Slot in_formatiqn remotely connected to another statiqn
Bit12~ Bit1l5: Base information remotely connected to another station
Bit16~ Bit19: Slot information on which Ethernet module is mounted
Bit20~ Bit23: Base information on which Ethernet module is mounted
Bit24~Bit31: Reserved area
CPU TYPE 2 4 System type: Flag
PADT CNF 2 6 XG5000 Connection status: flag
SYS STATE 4 8 PLC mode and operation states: flag
CNF _ER 4 12 System error(Breakdown): Flag
CNF_WAR 4 16 System Warning: Flag
VER NUM 2 20 OS version No.: Flag
Reserved 2 22 Reserved area

* Refer to “4) Flag description” for detailed description of each item.
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4) Flag description
_CPU_TYPE

Bit 15 (0) : XGl

_VER_NUM
OXXXYY: xx.yy

, Bit 15(1) : XGK
Bit 15(0) : Single, Dual master0) , Bit 15(1) : Dual slave
(ex, Single: 0x8000~0xffff, XGK-CPUH :0xA001, XGK-CPUS: 0xA002)

_SYS_STATE
Displays the operation mode and operation status of the system. (DWORD, FOO~F01)
Variable Position | Device Function Description
| RUN BitO FO0000 |RUN CPU module operation status is RUN
| STOP Bitl FO0001 [STOP CPU module operation status is STOP
| ERROR Bit2 FO0002 ERROR CPU module operation status is ERROR
| DEBUG Bit3 FO0003 DEBUG CPU module operation status is DEBUG
i h I
| LOCAL_CON Bit4 | FO0004 |Local control (k)e'[;erat'on mode can be changed only by mode
| MODBUS_CON Bit5 FO0005 Modbus mode on Modbus slave in service
| REMOTE_CON Bit6 FO0006 |Remote mode on Remote mode run
- Bit7 F00007 - -
RUN EDIT ST Bits F00008 Editing dur!ng RUN Wa.ltmg for modified program when modifying
B - - (Downloading program) during run
. Editi hil ing(Int [ . . .
| RUN_EDIT_CHK Bit9 FO0009 "ing . while  running(interna Internal processing when modifying during run
processing)
| RUN_EDIT_DONE| Bitl0 | FOOOO0A [Edit done during RUN Modification completed successfully during run
Internal flag to indicate when
| RUN_EDIT_END Bitll | FOOOOB | modification is  completeModification completed successfully during run
during run
| CMOD_KEY Bitl2 | FOO0OOC [Operation mode change Change operation mode by key
| CMOD_LPADT Bitl3 | FOO0OOD [Operation mode change Change run mode by local PADT
| CMOD_RPADT Bitl4 | FOOOOE [Operation mode change Operation mode change by remote PADT
. . o ti d h b t
| CMOD_RLINK Bitl5 | FOOOOF |Operation mode change pera Io.n . moce  change y  remaie
communication module
| FORCE_IN Bit16 | FO0010 [Forced input Forced On / Off execution of input contact
| FORCE_OUT Bitl7 | FO0011 [Forced output Forced On / Off execution of output contact
Therei i I ifi
| SKIP_ON Bit18 | FO0012 |Executing I/ skips ereis an. input / output module specified to stop
fault checking and data refresh.
There i I I i i
' EMASK_ON Bitl9 | FO0013 |Executing fault mask ere is an | / O module designated to continue
operation even if a fault occurs
| MON_ON Bit20 | F00014 |Monitoring Rurming external monitor for program and
variable
. . St ft letion by STOP functi
_USTOP_ON Bit21 | FO0015 |Stop by Stop function O_p afer scan completion by unction
during RUN mode
ESTOP_ON Bit22 | FO0016 |Stop by ESTOP function Immediate stop by ESTOP function during RUN
mode operation
| CONPILE_MODE | Bit23 | F00017 |Compiling Compiling
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Variable Position | Device Function Description
_INIT_RUN Bit24 | FO0018 |Initializing Performing initialization task.
- Bit25 | FO0019 - -
- Bit26 | FOO01A - -
- Bit27 | FOO01B - -

_PB1 Bit28 | FOO01C |Program code 1 Program code 1 is being executed
_PB2 Bit29 | FOO01D |Program code 2 Program code 2 is being executed
_CB1 Bit30 | FOOO1lE |Compile code 1 Compilation code 1 is being executed
_CB2 Bit31 | FOOO1F |Compile code 2 Compilation code 2 is being executed
_CNF_ER
Collective display of error flags related to operation stop failure.
Variable Type | Device Function Description
If I ion i ibl If-
CPU_ER Bit | F00020 |CPU configuration error _normal operation is not possible due to se
diagnosis error of CPU module
. . If the configuration of the mounting module and 1 /
10_TYER Bit | FO0021 [Module type mismatch error g . -
O parameters of each slot are different
|0 DEER Bit | F00022 IModule detachment error Petects when t_he modulg configuration of each slot
- is changed during operation.
. Detect when the fuse of the module with the fuse of
| FUSE_ER Bit | FO0023 |Fuse cutoff error W . . wiew .
each slot is broken
An error occurs when the | / O module among the
_IO_RWER Bit | FO0024 |I/O module read/write error modules in each slot cannot be read / written
normally.
Special / communication|Normal connection is not possible due to
_IP_IFER Bit | FO0025 |module malfunction of special / communication module
Interface error among modules in each slot.
Sianificant error detection in Fault detection when a failure of external device is
_ANNUM_ER Bit | F00026 exgt]ernal device detected by user program and recorded in
ANC_ERR [n]
- Bit | F00027 - -
| BPRM_ER Bit | FO0028 Basic parameter error Check basic parameters to see if they are abnormal
| IOPRM_ER Bit | FO0029 |/O parameter error Check the | / O parameter to see if it is abnormal
. . Check special module parameter to see if they are
| SPPRM_ER Bit | FOOO2A [Special module parameter error P P y
abnormal
CPPRM ER git | Fooo2B Paramet_er _ error inCheck communication module parameter to see if
B - communication module they are abnormal
| PGM_ER Bit | FO0O02C [Program error Check user program to see if there is any problem
h i I [
| CODE_ER Bit | F0002D Program Code error Occurs when _an unmt.erpretabe command is
encountered while executing a user program
| SWDT_ER Bit | FOOO2E [System watchdog error Occurs when the system watchdog is exceeded
| BASE_ POWER_E Bit | FO002F Power error Occurs when there is an error in the base power
R supply
Occurs when the scan time of the program exceeds
| WDT_ER Bit | FO0030 {Scan watchdog the Scan Watchdog Time specified by the
parameter.
F00031
FOOO3F
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_CNF_WAR
Collectively displays warning flag related to continue operation(DWORD, FO04~F005)
Variable Type Device Function Description
| RTC_ER Bit F00040 |Abnormal RTC data In case of abnormal data of RTC

Cold restart is performed because normal (hot or warm restart)
program modification is impossible due to abnormal backup

| DBCK_ER Bit F00041 |Data back-up error data memory. A flag indicating this can be used for the
initialization program and will be reset automatically upon
completion of the initialization program.

| HBCK_ER Bit F00042 [Hot restart error Indicates that hot restart is not possible

It occurs when the program stops during operation for reasons
such as power cut off during program execution, and
continuous operation is not performed due to the preservation
data synchronized in scan unit when power is turned on again.
IAvailable in the initialization program and will be reset
automatically upon completion of the initialization program.

| ABSD_ER Bit F00043 |Stop abnormal operation

\When a user program runs, if the same task is requested

TASK_ER Bit F00044 |Task collision .
— - repeatedly, the task shows a conflict.

Detects and displays when the battery voltage required for
| BAT_ER Bit FO0045 |Battery error user program and data memory backup is less than the
standard.

. . . [When a warning message of an external device is detected by
Minor error detection in

ANNUM_ER Bit FO00046 . the user program and recorded in ANC_WB [n], fault detection
B - external device

is displayed.
| LOG_FULL Bit F00047 |Warning: Log memory full |Indicates that there is no log memory save area of PLC.
| HS_WAR1 Bit FO00048 [HS parameter 1 error
| HS_WAR2 Bit FO0049 [HS parameter 2 error
| HS WAR3 Bit FOOO4A [HS parameter 3 error
| HS WAR4 Bit FO004B [HS parameter 4 error
| HS_WARS Bit FO004C |HS parameter 5 error This flag is displayed when HS link operation is
| HS_WARG6 Bit FO004D HS parameter 6 error impossible by checking the error of each HS link
| HS WAR7 Bit FOOO4E [HS parameter 7 error parameter when HS link setting (Enable).
| HS WARS Bit FOO004F |HS parameter 8 error Reset when HS link is disabled
| HS_WAR9 Bit FO0050 [HS parameter 9 error
| HS WARI10 Bit FO0051 [HS parameter 10 error
| HS_WAR11 Bit FO0052 [HS parameter 11 error
| HS_WAR12 Bit FO0053 [HS parameter 12 error
| P2P_WARL1 Bit FO0054 |P2P parameter 1 error
| P2P_WAR2 Bit FO0055 |P2P parameter 2 error
| P2P_WAR3 Bit F00056 |P2P parameter 3 error This flag is displayed when P2P operation is
| P2P_ WAR4 Bit FO0057 |P2P parameter 4 error impossible by checking the error of each P2P parameter
| P2P_WAR5 Bit F00058 |P2P parameter 5 error when P2P setting is enabled. Reset when HS P2P is
| P2P_WARG6 Bit FO0059 [P2P parameter 6 error disabled
| P2P_WARY7 - FOOO5A |P2P parameter 7 error
| P2P_WARS - FOOO5B |P2P parameter 8 error
| Constant_ER - FO005C [Fixed period error If the scan time is longer than the fixed period, it will be 'ON'.
FO005D
] ) ~FO005F ] I
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7.1.3 Server operation

(1) System configuration

System where Ethernet module communicates with HMI as XGT server

XGP-AC23

XGI-CPUE

XGL-EFMFB

XGI-D22A

XGI-D22A

XGQ-TR2A

To communicate using server service, you must set server mode before downloading. (If not set, XGT server)
Dedicated connection number in basic parameter means the number of channels (HMI connection) connected by
XGT server. (However, up to 64 blocks per TCP server port is available in V6.0 and above. Therefore, the number
of dedicated communication channels can be changed by changing the number of server connections in the frame

editor.
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(2) Program procedures

Connect to PLC and set as below.

Setting

Sequence
process

Setting method

Create
1 new
project

1) [Project]>Open [New Project] and enter the project name, CPU series, CPU type,
programming type, and program name.

New Project ?

proectname: [Serve -

File directory: CHGE000WServer e

CPU Series XK | | Product Name...
CPU type: XGK-CPUS v

e LD Programming 52

Program name: NewProgram

LD

Project description:

Add
2 Undefined
network

1) Select [Undefined Network]>[Add item]> [Communication module].
2) In the [Select Module] window, click “Add module”.

Select Module

PLC type:
NewPLC v

Communication Module:
Nomber  BASE | Gt | Module

Netwark in use

Add Module... | | Delete module cancel

1) Set Type, Base and Slot in Communication module settings. Then select the OK button in the
[Communication module setting] window to complete the module setting.

Cemmunication Module Settings *

Type: XGL-EFMT(B) ~
Base: Qo w
Slot: 0o -

Corce

Undefined
Network
setting

Double-click the communication module in the |Pr0'|ect| window.

~ &F Server *
v && Network Configuration
v @ Undefined Network
[£6% NewPLC (8050 XGL-EFMT(®)TAG) )
® System Variable
v - NewPLC(XGK-CPUH)-Offline
22 Variable/Comment
v .[& Parameter
Basic Parameter
[ /0 Parameter
v Scan Program
NewProgram

7-15 I stELECTPiC
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Sequence

Setting
process

Setting method

Undefined
Network
setting

Set TCP / IP Settings, Receive time out Settings, and Driver settings on the [Standard Settings]
tab.

1) Set Station No.: 0 and IP address

Standard Settings - FEnet >

Basic Settings  Host Table Settings  Sets EIP Server

TCP/IP Settings

ER—

Station No
Media Pot1: |AUTO ~

Pot2: [AUTO
IP address: [ e2 168 1 |
Subnet Mask [ 258 255 255 0]
Gateway [ o2 168 1 1]
DNS Server [0 a 0 1]
[CloHce [ Relay Copc ua
No. of Dedicated a-1e

Connections:

Receive Time Out Settings

Cliert sec(2 - 255)
Server: sec(2 - 255)

Driver Setting
Server Mode: XGT server ~
Modbus Settings

RAPIEnet Settings: Disable bt

Program
download

In the [Online]>[Write] window ,Click ok.

Wirite to PLC

[ inhibit Program Upload
[ sets link enable with parameters

@, Special module parameter
Program

i [ ZE Network Parameter

Basic Settings
[Reset]FEnet [base0, slotd]
| ETP tag
- [vIf EIP Server
~[|[E] High-speed Link
-~ [“H prEF)

Cancel
-
d Basic Parameter —
: I te
[ [0 parameter Clear PLC...

LS'ELECTR"C |

7-16
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7.2 Modbus Server

It is used when another device or upper PC (HMI) operates as Modbus master.
7.2.1 Overview

The Modbus TCP/IP protocol is the function to read and write data using the function code. The Modbus TCP/IP frame
consists of MAC, Header, TCP Header and Modbus ADU for the Ethernet communication.

- ADU: Application data unit

- PDU: Protocol data unit
- MBAP: Modbus application protocol

(1) Frame structure

1) Modbus TCP/ IP server frame structure using Ethernet

Ethernet Request / Response Frame

A
\ 4

MAC IP Header TCP Header MODBUS TCP/IP ADU

A
v

MODBUS TCP/IP ADU

2) Modbus TCP/IP server frame structure

MODBUS TCP/IP ADU

A
A 4

MABP Header Function Code Data

v

A

PDU

MABP Header

Transaction Identifier Protocol Identifier Length Unit Identifier
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3) MBAP header structure

Classification Size Description Client Server
Classification of
Transaction identifier MODBUS o . Reply by copying in
. o 2 Byte Initialize on client P by copying
(Transaction Identifier) request/response response from server
process
- Copy from request
Protocol Identifier . . .
o 2 Byte | 0 = MODBUS protocol Initialize on client | frame in response
(Protocol Identifier)
from server
Frame size from unit Create from Create from server
Length 2 Byte | . o . .
identifier to data client (When responding)
. - Classification of units Copy from request
Unit identifier meatt un . o . Py . au
. . 1 Byte | connected to the serial Initialize on client | frame in response
(Unit Identifier) .
line from server
4) Available function codes
ClEssieEion EriImeem Function Modbus function Response size

code

Function Code 01 (h01)

Read output bit

Read Caoils

2000 Coils

Function Code 02 (h02)

Read input bit

Read Discrete Inputs

2000 Caoils

Function Code 03 (h03)

Read output word

Read Holding Registers

125 Registers

Function Code 04 (h04)

Read input word

Read Input Register

125 Registers

Function Code 16 (h10)

continuously

Write Multiple Registers

Function Code 05 (h05) Write output bit Write single Coil 1 Caoll
Function Code 06 (h06) Write output word Write single Registers 1 Register
Function Code 15 (hOF) Wntg output bit Write Multiple Coils 1968 Coils
continuously
Write  output word 123 Registers
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7.2.2 Server operation

(1) Program procedures

Connect to PLC and set as below.

Settin .
Sequence 9 Setting method
process
1) [Project]>Open [New Project] and enter the project name, CPU series, CPU type,
programming type, and program name.
New Project ? X
Prowctrame: [Server |-
Create e EEE
1 new ey
project B
Project description:
1) Select [Undefined Network]>[Add item]-> [Communication module].
2) In the [Select Module] window, click “Add module”.
Select Module X
PLC type:
Communication Module:
MNumber BASE Slot M odule Network in use
Add
2 Undeﬁned Add Module... Delete module _DK Cancel
network | 1) Set Type, Base and Slot in Communication module settings. After that, select OK button in
[Communication module selection] and module setting is completed.
Cemmunication Module Settings *
Type: XGL-EFMTI(E) ~
Base: Qo W
Slot: 0o -
Cance
Standard | Double-click the communication module in the [Project] window.
settings
v & Server *
v #& Network Configuration
v (@ Undefined Network
|2 NewPLC [BOSO XGL-EFMT(B)(TAG)] l
3  System Variable
v - NewPLC(XGK-CPUH)-Offline
3 Variable/Comment
v [ Parameter
Basic Parameter
8 1/0 Parameter
v Scan Program
NewProgram
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Settin .
Sequence 9 Setting method
Process
Set TCP / IP Settings, Receive time out Settings, and Driver settings on the [Standard Settings]
tab.
1) Set Station No.: 0 and IP address
2) Click Modbus setting and input each device
Standard Settings - FEnet >
Basic Settings  Host Table Settings  Sets EIP Server
TCP/IP Settings
Station Mo e ]
Media Port1 AUTO -
Port2: AUTO
IF address [ 1e2 168 1 2 |
Undefined Subrot Mesk: [ 2w e 0]
Gateway [ 1s2 188 1 1 |
4 N etWOI'k DNS Server: [ e 0 o 1]
setting OoHer  [Jhelay Dorc ua Modbus Settings X
o of Dedetes o
e om0 5 it read arca Addess
Client sec(2 - 255) o , PO1000
o w255 Bit write area Address:
Drver Setting Waord read area Address:
Server Mode Modbus Server ~ }
RAPIEnet Settings: Disable v
Cancel
In the [Online]->[Write] window ,Click ok.
Write to PLC ? x
[ tnhibit Program Upload
[[1sets link enable with parameters
- NewpLe
[v|ED PLC Configuration
-] comment Cancel
1% Parameter -
Basic Parameter il
[ 1/0 parameter
@ Special module parameter SERE
" Program
Program @ Metwork Parameter
5 Basic Settings
dOWﬂ|0ad [Reset]FEnet [base0, sloto]

EIP tag
V16D EIP Server
» E High-speed Link
- PPEP)

LSeE ectric | 7-20
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7.3 EtherNet/ IP server

7.3.1 Overview

EtherNet/IP communication methods are divided into explicit messaging connections and implicit (/O data) connections.

An explicit messaging connection is established to execute request-response transactions between two nodes, distinguished
by a client—server model. Unconnected Message Manager (UCMM) communication and Class 3 correspond to explicit
messaging connections. An implicit connection is established to periodically exchange I/O data, and multicast transmission
is possible with a producer-consumer model. Class 1 corresponds to implicit connection.

The producer is set to a periodic target, the consumer is set to a periodic connection, and the UCMM client is set to an acyclic
connection mode. The UCMM server and Class 3 server must download the EIP tag, and there are no other communication
parameter settings.

The periodic connection is similar to the high-speed link of the existing XGT communication service and is mainly used to
transmit and receive data periodically. Non-periodic connection is a communication method mainly used when a specific
event occurs.

EtherNet / IP communication function provided by Ethernet module (FEnet) is as follows.
(1) EtherNet / IP(EIP) target/server functions

It provides tag communication function of EIP periodic target function.
It provides tag communication function of EIP Non-periodic server function.

(2) EIP client function

1) EIP periodic connection
- provides EIP periodic connection functionality.
- EIP's periodic connection settings are integrated into the smart expansion service function.
2) EIP Non-periodic connection
- Provides EIP Non-periodic connection functionality.
- EIP's Non-periodic connection settings are integrated into the smart expansion service function.

(3) Smart extension service can connect up to 63 communication devices.

(1) OS ver V8.0 or higher of XGL-EFMxB support EtherNet / IP communication.
(2) In OS ver V8.1 of XGL-EFMxB, only one port can be received when setting multicast in the
periodic client. Note) Refer to V8.1 Multicast support port guide)
(3) In OS ver V8.3 higher of XGL-EFMxB, only all port can be received when setting multicast in
the periodic connection.
Note) V8.1 Multicast Support Port Guide
XGL-EFMTB XGL-EFMHB XGL-EFMFB
Port 2(lower port) Port 2(lower port) Port 1(Upper port)

KGL— XGL XGL-
EFHT(BY EFMFIBY

Pl
P2

7-21
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(4) Periodic communication (Implicit) method

Implicit Message provided by periodic communication means implicit (implicit) message and contains minimum
header information except the data on the frame. As a result, the frame itself is a message that does not know what
the data means. This means less header information, which simplifies the process of interpreting frames, enabling
faster data processing. In EtherNet/ IP, a connection is established between the originator and target as parameters
for data transfer. An originator is an object that receives and uses the data received after request a connection. The
target receives a connection request and Transmission Cycle data desired by the originator in the requested packet
interval (RPI) and the desired method (Unicast / Multicast). Therefore, the originator sets up the Consumed Tag and
the target sets up the Produced Tag.

Connect REQUEST

ORIGINATOR TARGET

(Consumed Tag) Connect RESPONSE (Produced Tag)

SCANNER ADAPTOR

An Originator also generates data to target. Depending on the type, the target can set the timeout with the data
cycle given by the originator and output to the target module with the data given by the originator.

(5) Non-periodic communication (Explicit) method

Explicit Message, which is provided by non-periodic communication, is an explicit meaning that a message contains
all the information that can be interpreted in the data frame. Therefore, again if it takes some time to analyze the
frame, if the desired message is sent without parameter setting process, the server interprets the frame and sends
the response. Mainly monitoring data is used as non-period data rather than control data.

7-22
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7.3.2 Operation Sequence

(1) EIP periodic target operation sequence

(2) EIP Non-periodic server operation sequence

7-23

| XGL-EFMxB setting and operation |
v

Basic parameter setting I

1 [ Use XG5000

Basic parameter setting using XG5000

v
Communication module
settings
2 | Module type [
® FEnet

3 | Base No.(0~7)
Slot No.(0~11)

N

Enter the network type and base / slot number where the
communication module is installed

5 | Communication module setting |r

\Y
EIP tag setting
6 | Variable(Tag) register
v
Sets EIP target

Standard settings
(Set TCP / IP Settings, Receive time out Settings, and

Set tags to use in local tags
- Omitted when using specific device values in local tags

7 | Basic setting > EIP target |

settings

\
Online (after connecting local)
15 | Write

| XGL-EFMxB setting and operation |
Y

Local tag area settings (Select tag or write device)
Set the number of data (Auto input when tag selection)

Basic parameter setting

1 | Use XG5000

Basic parameter setting using XG5000

Y
Communication module
settings
2 | Module type
® FEnet

3 | Base No.(0~7)
Slot No.(0~11)

N

Enter the network type and base / slot number where the
communication module is installed

5 | Standard settings

\Y
__ElPtag setting
6 | Variable(Tag) register
Y

Standard settings
(Set TCP / IP Settings, Receive time out Settings, and

Set tags to use in local tags
- Omitted when using specific device values in local tags

Online (after connecting local)

15 | Write
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7.3.3Parameter setting

The Ethernet module is a Smart extension service that provides EtherNet/IP connection functions. Describes how to set
parameters for EtherNet / IP connection.

(1) Basic settings

Smart Extension service operates according to the Basic Settings of Ethernet (FEnet). The following describes the
Basic Settings parameters for the Smart extension service.

Standard Settings - FEnet x

Basic Security Time Synchronization Sets EIP Target Advanced

TCP/IP Settings

saonro: (@]

Media Portl:  AUTQ
Port2: | AUTC

IP Address: 192 168 1 2
Subnet Mask 255 . 255 . 255 . 0
Gateway: 192 . 168
DNS Server: o - 1] c 0

DHCP Relay OPC UA
Mo. of Dedicated 3 (1-16)

Connections:

Receive Time Out Settings
Client 80 ®xls x10ms

Server: 15 ) x1s x10ms.

Driver Setting

Server Mode: XGT server

RAPIENEt Settings: Disable

1) Station No

Station number is used as station number of Ethernet module when using RAPIEnet protocol communication
with communication device. Station number is not used when setting EtherNet/IP.

2) RAPIEnet setting

The operation varies depending on the RAPIEnet setting in the driver setting item of the Standard Settings.

RAPIEnet setting Smart extension service operation

Disable Only the EtherNet / IP protocol can be used for the smart extension service.

RAPIEnet v1 Only RAPIEnet v1 protocol is available. (Smart extension service not available)

RAPIERet v2 Only the RAP.IEnet and EtherNet / IP protocol can be used for the Smart
extension service.

7-24
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7.3.4 Client setting

(1) Adding Smart Extension

7-25

1) Click the [Project] tab on the left project window and select by right clicking on the communication module
item on the tree.

Project « I x
w fF Server *
v @@ Network Configuration
i ) Undefined Network
; &% NewPLC [BOSO XGL-EFMT(B)
.5 system Variable
v ) NewPLC(XGK-CPUS)-STOP Add ftem L
19 Variable/Comment

Open

Smart Extension

v [ Parameter By copy Ctrl+C etwo
—IH Basic Parameter B Paste Chrl+V Communication Module
I /O Parameter ¥ Delete Delete P2P Communication
A Scan Program 1 Froperties High-speed Link Communication
{8 NewProgram
Communication Module Setting and Diagnosis k

Add Slave

1) When using the Smart Extension window to set up the Smart Extension Service, select” Next” in the Smart
Extension [Overview] window.

Setting for starting Smart extension service
For using Smart extension service,it is necessary to set the extension base and device memory setting
for input / output refresh.

[1] Overview
1 [2] Detailed setting
[3] PLC area settings.

m
!
Q

Next > Cancel

2) Smart extension service setting such as communication device adding and setting and PLC area setting can
be performed. However, |/ O parameter setting should be done separately during Communication device setting.
If you select "Next” in the smart extension overview window, the [Details] window appears. If you do not want to
add the Smart Extension service without using the Smart Extension window, simply select “Cancel” in the
[Overview] window of the Smart Extension window to register the Smart Extension service.
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No. of Communication Devices: \ 42 (1~63)
EB No Module Type } Module Name ‘ Station | IP Address Protocol
1 Modular XGL-DBDT 1:192.168.1.101 :RAPIEnet
2 Modular XGL-DBDT 2 :192.168.1.102 RAPIEnet
3 ‘Modular XGL-DBDT 3:192.168.1.103 RAPIEnet
4 ‘Modular XGL-DBDT 4 :192.168.1.104 RAPIEnet
< >
< Back Next > Cancel

3) After setting each item in [Details] or performing “Autoscan”, select the following. In order to proceed with “Auto
Scan’, it must be in [Online]>[Connect].

Iltem Contents
No. of | Set the number of Communication devices to be added to the Smart extension
Communication service.
Devices
Add connected Communication devices and specify connection information
Auto scan automatically.
- Only available online.
Specifies the EB number of the communication device to be added.
EB No. The EB number is the communication device channel number connected to the
Ethernet module (master) in the Smart extension service.
Specifies the module type of the Communication device to be added.
Module type

- For the module type, refer to the Communication Device User's Manual.

Module name

Specifies the module name of the Communication device to be added.
- For the module name, refer to the Communication device User's Manual.

Specifies the station number of the Communication device to be added.

Station No - The station number range is 0 ~ 220.
- Setting station number method, refer to the Communication device User's Manual.
Specifies the IP address of the communication device to be added. For the IP setting,
IP Address o : )
refer to the Communication device User's Manual.
Specifies the connecting protocol of the communication device to be added.
- The protocol information available between client and communication device
between the according to RAPIEnet setting is as follows.
RAPIEnet settings for Clients | Communication device
setting
Disable EtherNet/IP
Unavailable Smart
Protocol Extension
RAPIEnet v1 Unavailable Smart
Extension
EtherNet/IP
RAPIEnet v2
RAPIEnet
Apply Check the application box of the communication device that will store the connection

information.
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4) In [PLC area setting] window, memory setting for 'Input / Output Variable' and 'Enables EB/Slot Diagnostic
variable' is available. The address and size are automatically changed according to the communication device
added in the advanced detailed settings. (However, the memory area setting counts Smart extension service as
the highest priority. An area that overlaps with the memory area used by other services may occur.) When
setting are finished, select 'Finish'.

Input/Output
Area: D v Set the device memory for input / output refresh according
: to the slot information of the set EB.
Address: 4000 ] The memory address and size are calculated in words.
(At least 1536 words required)
Size: 1536 ‘

Enables EB/Slot Diagnostic Variables

Diagnostic
Sets device memory for diagnostic variables.
you select Provide EB / Slot diagnostic variable, you can
r monitor the status information of EB and slot of Smart
Address: 5536 ] Extasion.
_—_— The memory address and size are calculated in words.
Size: 100 ] (At least 54 words required)

Area: D v

< Back Finish Cancel

Iltem Contents

Area Set the memory area of the clients to map the input / output variables of the
communication device.

- Select between P/ M / D areas.

Input/Output Address | Set the memory start address of the clients to map the input / output variables of
Variables the communication device.

Size Set the memory area's size of the clients to map the input / output variables of
the communication device.

- 384 words per 1 unit of communication device required.

Enables EB/Slot
Diagnostic Enable /Disable the use of EB/Slot Diagnostic variables.
variables

Area Set the memory area of the client to map the diagnostic variables of the
communication device.

- Select between P/ M / D areas.

Address | Set the memory start address of the client to map the Diagnostic variables of the
Communication device.

Size Set the memory area's size of the client to map the Diagnostic variables of the
communication device.

- The basic diagnostic variable of Smart extension service requires 22 words.

- 8 words per 1 unit of communication device are required.

Diagnostic
variables
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(2) Communication device setting

1) If you double-click EtherNet / IP module among communication devices added under [Project]>[Smart
Expansion], you can check [Communication device setting] and [Communication device information] tree.

Project
v B Server*
v ﬁ Network Configuration
v . Undefined Network

- 3 x

~ -5 NewPLC [BOSO XGL-EFMT(B)(TAG)]

NewPLC [BOSO EBO4 - Generic EtherNet/IP Module] x I

=) Sets Communication Device
. Sets EIP Details Index
(= Communication device Inform, 0

Connect

Operation r

v @ Smart Extension

Ll New
D £Bo1 -

D egoz -

@ EBO3 -

XGL-DBDT
XGL-DBDF
XGL-DBDH

- eBos -

IS7 Ethernet IP

(P EBO4 - Generic EtherNet/IP Modul:]

(3 EBOG - XBL-EIPT
- % System Variable
~ -fiJ) NewPLC(XGK-CPUS)-STOP
129 Variable/Comment
vlﬂ Parameter
[El Basic Parameter
i [ 170 Parameter
v Scan Pregram
NewProgram

Project

View High-speed Link View P2P

1

2) In the [Communication device setting] tree, set the connection parameter by setting the block in the [EIP detailed

setting] window.

e ——

(=) Sets Communication Device

. Sets EIP Details Index| Operation mode | 1/0 type| Connection type Function Parameter Parameter contents Canditional flag T:;m[s;f]" Timeout Data Type Local tag Remate tag Data count
= Communication device Infermat 0
- Connect 1
- EIP non-periodic connection setting example
Indh : : . - Transmission :
e Operationmode  [1/0 type| Cannection type Function Parameter Parameter contents | Conditional flag peviodims] Timeout Data Type Localtag Remote tag Data count
0 Explicit Cliert i 0. TAG READ _Ti§ ‘wiORD TEST1/D00000 TEST2 1
1 I
- EIP periodic connection setting example
. . . Parameter - Transmission .
Operation mode 140 type Connection type Function Parameter contenls Conditional flag periadms| Timeout | Data Type Local tag Remate tag | Diata count
Irmplicit Client & B.Input Onl(T ag tupe] M ulticast Parameter 20 0 AP x4 © WwORD © TESTH/DOOOCZ © TESTY 1
LSEectric | 7-28




Chapter 7 server service
1 '

Item Contents

Set the operation mode of the EIP connection.

- Select either periodic connection or non-periodic connection.

Set |/ O type of EIP Period connection.

- A list of choices is displayed depending on what is defined in the target's EDS file.
Set the connection type with the EIP target.

- A list of choices is displayed depending on what is defined in the target 's EDS file.
Sets the functionality of the EIP non-periodic connection.

- Setting is not possible in EIP periodic connection.

Sets EIP connection parameters

Only enabled if the feature is ‘read’ or ‘write’ on non-periodic connection.
Parameter contents | The contents set in the parameter are displayed.

Sets the start condition of the EIP non-periodic connection.

- Setting is not possible in EIP periodic connection

Sets the send cycle of the EIP periodic connection. The minimum value is ‘20ms’.

Operation mode

I/O type

Connection type

Function

Parameter

Start condition

Send cycle . Lo - .
y - Setting is not possible in EIP non-periodic connection
Timeout Sets the Time-outs of the EIP periodic connection.
- Setting is not possible in EIP non-periodic connection
Sets data type.
Data type _typ_ . .
In EIP periodic connection, they are automatically represented by local tag values.
Set the local tag of the EIP connection.
Local tag . . . . o .
- Double-click to select tag or to directly write variable of specific device.
Set the tag of the destination station(EIP target/server)
Remote tag

- In addition to the tags, you can write direct variables of a specific device.
Set the data number of the EIP tag.

- One is a tag (device) written to a Local tag entry.

- The size of the tag (device) written in the local tag entry does not matter.
- The data size is the number of tags (devices) * data number in ‘local tag’.

The number of data

3) Selecting [Connect] in the [Sets Communication Devices] tree displays the following screen. If the
communication device is an EtherNet / IP dedicated module (if it does not have the Smart extension service
function), there is only a 'Connection' item in the Communication device information tree.

' NewPLC [BOS0 EB0O6(#192.168.1.106) - Generic EtherNet/IP Module: SlaveName06] x [ NewPr

—J- Sets Communication Device "
EB No.:
Basic Parameter 8l(1-63
Sets EIP Details Protocol EtherNet/IP »
—- Communication device Informat q .
Station Mo, ! & (0-
Connect 2| Ve
IP: [ 192 168 . 1 . 106 |
Module Generic EtherNet/IP Module
Image:
EDS Generic EtherNet/IP Module:Ver1.1
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Item Contents

EB No. Specify the EB number to be assigned to the communication device.

Specify the protocol type to be used for communication with the communication device.

Protocol type - Only EtherNet / IP can be selected because it is an EtherNet / IP dedicated module.

Specify Station number set to the Communication device.

Station No - Station number setting is impossible because it is an EtherNet / IP dedicated module.

Specify IP address number set to the communication device.
IP Refer to the Communication device user’'s manual for how to set the communication device's
IP address.

Specifies the module type of the communication device.
Module type - Module type is automatically assigned when adding a communication device and cannot be
modified.

Assigns the image of the communication device.
image - Use the desired photo file as the image of the communication device.
- This image is only used in the '‘Configure Communication Device Connection' function.

Assigns the EDS information of the communication device.
EDS information | - EDS information is automatically assigned when adding a communication device and
cannot be modified.
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7.3.5 Server setting

(1) In case of operating as periodic target

1) In the [Project] window, right-click the communication module added under the undefined network and select
Open.

Project v 3 x
v B Server*
~ & Network Configuration
+ w f Undefined Network
i i ﬁ MNewPLC [BOSD XGL-EFMT(B)(TAG ™
@ System Varizble
v () NewPLC(XGK-CPUS)-STOP Add ftem ’
&) Variable/Comment
v [@ Parameter
LJH Basic Parameter
*.E VO Parameter
~ (&) Scan Program
L NewProgram

Open

Copy Ctrli+C
Paste Ctr
Delete Delete

B Xm0

Properties...

Communication Module Setting and Diagnosis L

[AEILAl View High-speed Link  View P2P

2) Set each item in [Standard settings].

Standard Settings - FEnet X
Basic Security Time Synchronization |EEULRE] Advanced

TCP/IP Settings

Station o

Media Portl: | AUTO
Por2: | AUTO
1P Address 192 168 1 2
Subnet Mask: 255 255 255 0
Gateway: 192 168
DNS Server 0 0 0
CIDHCP [CIRelay CIOPC UA
No. of Dedicated |3 a-16

Connections:

Receive Time Out Settings

Client 0 @xis  Ox10ms
Server: 15 @xis Ox10ms
Driver Setting

Server Mode: XGT server

Modbus Settings

RAPIEnet Settings:  Disable

3) In the [Standard settings] window, select the parent Sets EIP Server tab.

Standard Settings - FEnet

Basic Security Time Synchronization] Sets EIP Target | Advanced

Index Lacaltag Data count
[]
1

4) In the [Sets EIP Server] window, double-click the area of the local tag. Use device values rather than tags. If
you want to use the device value, select the local tag area with the left mouse button once and enter the device
value you want to use. In this case, please skip ‘4). *
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Standard Settings - FEnet

Basic  Security

Time Synchrenization

Sets EIP Target  Advanced

Index

Local tag

Data count

]

1

5) In the [Select EtherNet / IP Tag] window, select the tag you want to use as the local tag for the EIP periodic
target, then select OK.

Select EtherMet/IP Tag X
T
Variable Type Device Comment
1 TEST WORD FAWD
1 3
File Path:

6) If the tag has been added to a local tag in the [Sets EIP target] window, select OK.

Standard Settings - FEnet

Basic Security Time Synchronization Sets EIP Target Advanced

x

Index

Local tag

Data count

0

TEST/ZAW0

1

(2) In case of operating as Non-periodic server

When the Ethernet module operates as Non-periodic server, there is no additional parameter setting other than tag

registration.
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7.3.6 Tag register

If an EIP connection uses a tag other than a device for a local tag, the tag must be registered first. The Tag register method
is as follows.

(1) Tag setting when using XGK CPU
1) Set tag for EIP communication. Select [Project]>[Setting EtherNet / IP (OPC UA) Variable].

L Server - XG5000
PROJECT | EDIT FIND/REPLACE VIEW ONLIN

[ Mew Project...
[ Open Project...
(@ Open From PLC...

Ctri=M |

Ctrl=0 E

Open KGLWIN File...
Open GMWIN File...

E save Project

Save As...

Ctri+5

Save as Earlier Version... F

Save as PLC Project...
Close Project

Save As Binary...
Write Binary to PLC...

Open from Memory
Write to Memory...
Edit SD Card »
Add ltem v
Import From File

Export to File...
Export Network Settings to File...
Save Variable Names to File...
Setting EtherMet/IP(OPC UA} Variable...
Export OPC UA Tag to XML File...

Remove All Comments ‘

Compare Projects...

I B

Print... Ctrl=P
Preview

Print Project...

Print Setup...

Recent Projects

Exit

2) In the [Setting EtherNet / IP (OPC UA) Variable] window, select New Variable.

Setting EtherNet/IP(OPC UA} Variable £3

Wariable: Type Device Comment Close

1| new variable

Edit Variable

Delete Variable

3) “Select 'New Variable', enter and select the variable, data type, device, etc. and select OK.
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Wariable Add ? x
e | o]
Address:
Description:
Iltem Contents

Variable Enter the name of the variable (tag) to use

Data type Select the data type of variable (tag) to use.

Device Enter the device address with the variable (tag).

Description Enter a description of the variable (tag). (Enter it if necessary)

4) After confirming that the variable added in the Setting EtherNet/IP (OPC UA) variable window appears normally,

select Close.

Setting EtherNet/IP(OPC UA) Variable x
‘ Variable Type Device Comment | Close |
1 ‘ TEST WORD : M0001
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(2) Tag setting when using XGI, XGR CPU

1) Right-click on [Global / Direct Variable] or [Local Variable] in the [Project] window and select Open.

Project

NewProgram[Prog

w JHE FEnet ™
~ &5 Network Configuration

Lo

¢ i) Undefined Network
5 System Variable

Li

w -fifl NewPLC(XGI-CPUUN)-Offline
-9 Global/Direct Variabl

1

~ -[#% Parameter Chen
HE Basic Parameter
T 1/0 Parameter

[ Local Ethernet Par:
Scan Program

> NewProgram
User Function/Functic

Add tem

Import From File
Export to File...

Cut

User Data Type
Library

Copy

Paste

XD e

Delete

Move Up
Move Down
Sort

Properties..

Add Library

Export Network Settings to File...

Refresh User Function/FB

Ctrl+X
Ctrl=C
Ctrl=V
Delete

L1z

[ZEIEd View High-speed Link  View P2P

2) Fill in the information of the variable (tag) to be used and

Lid

check “EIP / OPC UA”.

(For details of global / direct variable and local variable setting, please refer to XGI, XGR CPU manual.)

| Global Variable

E Direct Variable Comment l"]FIag Motion Shared Variable

Variable Kind Variable Type Address Initial Value Retain Uszed EIF'LC;F’C HMI | Motion Comment
1 VAR_GLOBAL i TEST WORD | O O Ol
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7.3.7 Setting Download

Downloading the EIP connection configuration will download it to the CPU module. The download method is as follows.

(1) On the[Online] tab, select Write

OMLIME | MONMOR DEBUG TOOLS WINDOW HE

% Disconnect

G Connection Settings...

gnature

Change Mode
Read...
Write...

Bygk b

Compare with PLC...

5et Flash Memaory...

(2) In the [Write] window, check the check boxes of [Smart Extension Service], [EIP Tag], and [EIP target], and select
OK. When downloading the Smart extension service, EIP tag, and EIP target, the module does not need to be reset

and the settings are immediately reflected.

(3) When the module is exchanged using the Module Changing Wizard, the EIP tag and EIP target parameter is not set
automatically. Redownload EIP tag and EIP target parameter by using [Online] = [Write] of XG5000.

Write to PLC
Inhibit Program Upload

[“iSets link enable with parameters:

[ JE LSPLC

¢ [JEH) PLC Configuration

L LG Parsmeter
i[Z|[[1] Basic Parameter

/0 parameter

H Special module parameter
L[ Local Ethernet Parameter

: Program

i w[JfF Autovariable retain value

- {Z|:H] Network Parameter

M Basic
L[ Reset]FEnet [based, slotq]

T Smart Extension Service

G EIP Target
High-speed Link
WIED repiER

? x

Cancel

Clear PLC...

(4) EIP Service enable

Start EtherNet/IP client operation when Smart Extension Service is enabled on [Online] >[Communication module
setting and Diagnosis] = [Service Enable] window. There is no separate service enable process for EIP target.

Download EIP settings and start working
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7.3.8 EtherNet/IP periodic communication operation example
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(1) Operation of EtherNet/IP module (scanner) and Ethernet module (adapter)

HEP-AC23

XGK-CPUE

HGL-EFMFB

XGL-EFMTE

XGI-D22A

XGO-TR2ZA

HGP-AC23

HGK-CPUSN

MGEL-EIPT

MGI-TR2ZA

¥GI-D21A

XGO-TR2ZA

NGH-DT4A

XGF-DCAH

Ethernet module
adapter operation

EIP Module
scanner operation

This is an example of connecting the Ethernet module to the EIP target. This is an example of a program that reads

the adapter's tag setting data from the scanner at periodic intervals.

Passes tag tttt (D0010) word data from the adapter as scanner tag jjjj (D00100) word data.
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1) Scanner setting(XGL-EIPT)

Setting .
Sequence Setting method
q process 9
1) [Project]|>Open [New Project] and enter the project name, CPU series, CPU type,
programming format, and program name.
New Project 7 x
Project
Project name: ‘E‘PT‘ |
File directory: D:A\PADT Project\PLO\EIPT
Create oc
1 neW CPU Series: XAGK Product Name...
prOjeCt CPU type: XGK-CPUSN
PLC Name: LSPLC
Program
i:ﬁﬂ?ﬂr:tr:ﬂmlﬂg LD Programming
Program name: MNewProgram
e e
1) Select [Undefined Network]>[Add item]> [Communication module].
2) In the [Select Module] window, click “Add module”.
Select Medule x
Add
2 Undefined T ||| e
network - — - -
1) Set Type, Base and Slot in Communication module settings. After that, select ok button in
[Communication module setting and Diagnosis] and module setting is completed.
Communication Module Setting an... X
Type: XGL-EIPT
Base: oo
Slot: oo
1) XGK CPU
- Click [Project]>[EtherNet / IP (OPC UA) Tag Settings].
- Select "New Variable' to add variables, Type, and device.
Setting EtherMet/IP(OPC UA) Variable x
‘Wariable Tupe Device Comment Clase
1 ““ WORD D000100 Mew Variable
Edit Variable
3 Tag ) Delete Variable
registration save
Import

2) XGI/R CPU

- Add variables in the [Global / Direct Variables] or [Local Variables] window of the project tree.
- Check the EIP / OPC UA item.

Variable Kind ariable Type Address Initial Value Retain Used EIPbiPC HMI Comment
1 VAR_GLOBAL jjj WORD %MW100 IC] IC] v r

* If you use continuous data, create an Array type variable.
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Sequence

Setting
process

Setting method

Standard
settings

Double-click the communication module in the [Project] window.
Project

@0 &
4 fREIPT +
e Metwark Configuratian
4 - [:ff] Undefined Metwork
B LSPLC [BOS0 XGL-EIFT(TAG)]
[EE] Motion Control Module
£ Systern Variable
4[] LSPLC{XGK-CPUSN)-Offline

| X A T N D 7. SRS

* B X

In the [Standard settings] window, set the IP address, subnet mask, gateway, DNS server,
waiting time, and tag usage. Check when using tag information in EIP module.

Standard Settings - EtherNet/IP x

Basic

1P Address: 192
Subnet Mask: .255 . 0
Gateway: 102
DNS Server: 0 o .0 .11

Reception 15
Waiting Time:

sec(2 - 255)

HUse Tagi

e

=l FHa

Service
settings

Click [Project]2>[Add item]>[P2P Communication]. Select among P2P parameter window No. 1
~8

Newrrogromiprooron < |
R &
« GHEIPT
4 fTs Network Configuration
[ Undefined Network
B LSPLC [BOSO XGL-EIPT(TAG)]
[E] Motion Contral Madule Open
£ System Variable
<[] LSPLC{XGK-CPUSN)-Offline
&), variable/Camment
+ [ Parameter
5] Basic Parameter
]1/0 Parameter
Local Ethemet Parameter
4 [&]Scan Program
L MewProgram

Add Item 3

Cop ctrl+C
Paste Ctrl+ ty
X Delete Delste Communication Module

P2P Communication

Link Communication
Communication Module Setting and Diagnosis 3

1) Double click EIP settings to display the [EIP settings 01] screen below. Then click [EDS
Information] on the right side of XG5000 screen to register EDS information of the external
device (XGL-EFMTB) to be connected to EIP.

2) If you click the external device to connect in [EDS Information], EDS by version is displayed.
Drag the version to the [EIP settings 01] screen to open the [EDS Channel Settings] window.

3) Set IP of channel (0 ~ 63) and external device (adapter).
NewProgram[Program] / LSPLC - EIP Settings 01 % -

:% '@
4 EIPT =
a Metwork Configuration
4-[:[f] Undefined Metwork

4 B LSPLC [BOS0 XGL-EIPT(TAG)]

¥ EDS channel x
S @rep o ]

=2 EIP Settings Channel 0

=] EIP Channel KGL-EFNTB Product Mame: XGL-EFMTE [Ver1.1)

5] EIP Block

[Em Mation Control Madule Channel No: |0

£ Systern Variable

R IP Address: 192 . 168 . 1 . 3
4-[:[[] LSPLC(XGK-CPUSN)-Offline
B, Varlable/Comment
<Ly Parameter o || f—

|[3| Basic Parameter

| /0 Pararmeter

Local Ethernet Parameter
4[] Scan Program

[, MewProgram
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Settin .
Sequence 9 Setting method
process
Double click EIP channel to open [Channel setting] window.
Channel 0's operation mode is set as period client as previously set in EIP configuration.
Channel Setting x
Channel Operation Mode Port Mumber Partner IP Address -
Tmplcit Connection LK
26,
36,
36,
36,
36,
36,
00,
8 00,
9 00,
1) Double click EIP block to set up block
2) Input 1 / O type, connection type and tag setting in channel 0.
(The information below depends on the server's EDS content.)
Service - 0. In/Out: read/write
5 settings - 1. Input Only: Read-only
- 2. Input Only(TAG): Tag Read-only
3)Set connection type
- Choose between Multicast and Point to Point.
4)Parameter
- Enter the read size. The data type is determined by the registered tag information.
5)Transmission period(ms), Timeout
- Set the Transmission period and timeout.
6) Tag time setting
- Local tag: Device (tag) of master to save data read from server.
Double click to select from [Select EIP Tag] window or set by directly inputting variable.
- Remote tag: The device (tag) of the server you want to read.
P NewsrogamiProgam] x| LSPLC - EIP Seftings 01 wseic-eror < [
nde | M) Operation Mode 1/0 type Connection type | Function|  Perameter | Parameter contents| Condiional flag T’;;fnmd‘[sj“f]" Tmeou | DaaTpe ?i;:t”ésg —
0 | 0 ImpicitConnection 2lnput Ony(TAG)  Pointto Point Parameter E;'?';“g‘éif:g 200 OLRPI«  WORD /000000 1
On [Online]>[Write] window, check Basic settings, EIP tag, P2P and Enable link and click OK.
Write to PLC ? X
[+] Sets link enable with parameters
PLC Configuration
_FY Comment
~[vILy Parameter
Program o [Stop]BasicParameter
@ [Stop]l/C parameter
dOWnload/ [Stop]Special module parameter
6 . - Local Ethernet Parameter
Set Ilnk -] [5toplProgram
enable Network Parameter

Basic

ax [Reset]EtherMet/IPTAG) [base, slot0]

EIP tag

High-speed Link

[ P2PEIP
8 p2p o1

1 Enable Link

Link enable settings can also be set in [Online]=>[Communication module setting and

diagnosis]—>[Enable Services].
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2) Adapter setting(XGL-EFMTB)

Setting .
Sequence process Setting method
1) [Project]|>Open [New Project] and enter the project name, CPU series, CPU type,
programming type, and program name.
New Project ? X
Project
Project name: |EFMTE‘ |
File directory: D:\PADT Project\PLO\EFMTE
Create
PLC
1 neW CPU Series: ¥GK Product Mame...
pI’OjeCt CPU type: XGK-CPUE
PLC Name: LSPLC
Program
Egjir:t':"m‘"g LD Programming
Program name: MewProgram
one 0
1) Select [Undefined Network]—>[Add item]-> [Communication module].
2) In the [Select Module] window, click “Add module”.
Select Module X
C;::;::““;:S':ndum Slot Module Network in use
Add
2 Undefined
network
Add Module Delete Module
1) Set Type, Base and Slot in Communication module settings. After that, select OK button in
[Communication module setting] and module setting is completed.
Cemmunication Module Setting an. x
Type:  XGL-EFMT{B)
Cancel
1) XGK CPU
- Click [Project]>[EtherNet / IP (OPC UA) Tag Settings].
- Select “Add Variable” to add variables, data types, and devices.
Setting EtherNet/IF(OPC UA) Variable &3
Wariable Type Device Comment Close
1 ttt WORD Dooo10o New Variable
Edit Variable
3 Tag Delete Variable
registration save
Import
2) XGI/R CPU
- Add variables in the [Global / Direct Variables] or [Local Variables] window of the project tree.
- Check the EIP / OPC UA item.
Variable Kind Variable Type Address Initial Value Retain Used E‘PLC;PC HMI | Motion Comment
1 VAR_GLOBAL it WORD %MW10 r r 3 0 iFE
* If you use continuous data, create an Array type variable.
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Sequence

Setting
process

Setting method

Standard

&

F

EFMTE =

5 Network Configuration

4-[:[J] Undefined Metwork
H LSPLC [B030 XGL-EFMTIBNT. .,
[ Motion Cantrol Madule
L3, Systern Variable
I LSPLC{XGK-CPUE)-Offline

Double-click the communication module in the |Proiect| window.

» e M

window, register the tag to be

Standard Setngs - FEnet

8asic Securty Time Synchronization

used in the sets EIP server.

Standard Setings - Fenet

Sets 9P Target  Advanced

x

Basic Secuity Time Synchionization  Sets B Taget Advanced

After setting IP address, subnet mask, gateway and DNS server in the [Standard settings]

- High-speed Link
D p2p(ER

settings B e
. [] 1
Sttion o i :
i por: im0 1 —
Gateuay 192 !
DHCP Ralay OPC UA
Client: oms
Server Mode AGT server | |
In [Online]->[Write] window, check Basic setting, EIP tag, P2P and EIP Target and click OK
Write to PLC ? x
[inhibrt rogram Upload:
Sets link enable with parameters
e ne
[ PLC Configuration
LB Comment
- 0k Parameter
- O] istopiBasic Parameter
[Stop]l/O parameter
Y[ (stopIspecial module parameter e Pl e
toplProgram
letwork Parameter
Basic
5 Program BestFenetloases, ot
EIP tag
download I BT

LS'ELECTR"C
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(2) Operation of Ethernet module (scanner) and EtherNet/IP module (adapter)

HEP-AC23

XGK-CPUE

HGL-EFMFB

XGL-EFMTE

XGI-D22A

XGO-TR2ZA

HGP-AC23

HGK-CPUSN

MGEL-EIPT

MGI-TR2ZA

¥GI-D21A

XGO-TR2ZA

NGH-DT4A

XGF-DCAH

Ethernet module
Smart extension operation

EIP Module
Implicit target operation

This is a program example that reads tag data of XGL-EIPT connected to periodic target by Smart extension service
of Ethernet module.

Delivers tag jjjj (D00100) word data from the adapter as scanner’s tag tttt (D00010) word data.
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1) Scanner setting(XGL-EFMTB)

Setting .
Sequence process Setting method
1) [Project]|>Open [New Project] and enter the project name, CPU series, CPU type,
programming type, and program name.
New Project ? X
Project
Project name: |EFMTE‘ |
File directory: D:\PADT Project\PLC\EFMTB I:l
Create p
1 neW CPU Series: ¥GK -
pI’OjeCt CPU type: XGK-CPUE -
PLC Name: LSPLC
Program
Egjir:t':"m‘"g LD Programming
Program name: NewProgram
one 0
1) Select [Undefined Network]>[Add item]> [Communication module].
2) In the [Select Module] window, click “Add module”.
Select Module X
C::;‘;:““;;S’:dea Slot Module Metwork in use
Add
2 Undefined
network
1) Set Type, Base and Slot in Communication module settings. After that, select OK button in
[Communication module setting] and module setting is completed.
Communicaticn Module Setting an x
Type: | XGL-EFMTI(B)
o [ cm |
1) XGK CPU
- Click [Project]>[EtherNet / IP (OPC UA) Tag Settings].
- Select “Add Variable” to add variables, data types, and devices.
Setting EtherNet/IP(OPC UA) Variable &3
Wariable Type Device Comment Close
1 ttt WORD Dooo10o
Edit Variable
3 Tag Delete Variable
registration
2) XGI/R CPU

- Add variables in the [Global / Direct Variables] or [Local Variables] window of the project tree.

- Check the EIP / OPC UA item.

Variable Kind Variable Type Address Initial Value Retain Used E\FLC;PC HMI | Motion Comment ‘
1 VAR_GLOBAL it WORD %MW10 r r 4 0

* |f you use continuous data, create an Array type variable.
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Sequence

Setting
process

Setting method

Double-click the communication module in the Pro'ect| window.

‘e M
4 THEFMTE »
4 Metwork Configuration
4 Undefined Metwork
B LSPLC [BOS0 XGL-EFMT(ENT..,
[ Motion Control Module
L3, System Variable
4-[[[] LSPLC{XGK-CPUE)-Offline

Standard

After setting IP address, subnet mask, gateway and DNS server in the [Standard settings]
window, register the tag to be used in the sets EIP server.

Standand Settngs - FEnet

Standard Seings - Fenet x

e e ——
settings —
E [ 1
Sttion b [E :
- I I—
DHCE Renlay OFC UA
Client: 60 s xoms
Server Mode: XGT server i |
e = | ==
In [Online]->[Write] window, check Basic setting, EIP tag, P2P and EIP Target and click OK
‘Write to PLC 7 X
[Jinhibt Brogram Upload;
Sets link enable with parameters
7 L
: PLC Configuration
- 20k Parameter
. ~EID] istopBasic Parameter
. [Stop] /O parameter
: [Stop]Special module parameter EET RS
top]Program
twork Parameter
- Ba
5 Program J i e
download
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Settin .
Sequence 9 Setting method
process
Click [Project]>[Add item]>[Smart Extension].
BB K
4 EFMTB *
a %Netwnrk Configuration
4-[:Jf Undefined Metwork
iLSPLC [BOS0 XGL-EFMTIBINT. ..
[EE| Motion Cantral Madule Open
£ Systern Yariahle
4[] LSPLC{XGK-CPUE)-RUN Add Item 4 Smart Extension
Bl Variable/Camment _ DNP
- dparameter Eg Copy Curl+C
BaSic Parameter Paste Ctrlsv Network
1 ;Opﬁggf:rﬁter > Delete Delete C:IT‘IT‘JI‘i:ET\:.\‘ '-:'::_l\s
[y MewProgram A properties... P2P Communication
High-speed Link Communication
Communication Module Setting and Diagnosis 4 User Frama
Smart - . .
expansion/ - - - - -
comr?mnication 1) Select “Autoscan” on the [Overview]->[Details] window to automatically register the
6 device connected network.
registration (PLC system should be connected in [Online]>[Connect] before Autoscan.)
(auto scan) 2) Set input / output variables and diagnostic variables as initial values in the [PLC Area
Setting] window.
Then proceed to Section 8.
EB o | oo Troe LM::.lrlr'ume Module Version .‘es'{o‘s;mm Guwnr\e“‘;::\;:\‘e;s Em?:i::‘ aﬂ i':” = -
|
1) Click [Smart Extension]>[Add Item]-> [Add Communication Device].
2) In the [Adds Communication Device] window, enter the contents of the [Basic
Parameter] and [Connect] tab.
NewProgram[Program] )-c_
B #
4 FEEFMTB =
4 Network Configuration
4-[:ff] Undefined Metwork
4§ LSPLC [BOSO XEL-EFMT(B)T. .
4[] Srnart Extension
,0 Mew Add Item » Adds Communication Device
[EE| Motion Control Madule - o
L3 System Varlable Changes Station No/IP
Fl —] p|
o [ LSPLC({XGK-CPUE)
Commur_ucanon ElL, Wariable/Cormment Ses Delete
7 device 4- Ly Parameter DI, i
registration [Tl Basic Pararmeter _ - J
(manual) 1) Click [Sets EIP Details] under XGL-EIPT of Smart Extension to register the pre-

registered Tagl as the local tag and the Tag3 as the remote tag.
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Setting

Sequence process Setting method

1) Double-click the registered EB to open a window and select [Sets EIP Details].
2) Set the operation mode, I/O type, connection type, parameters, transmission cycle,
8 Sets EIP Detail | fimeout, local tag, and remote tag.

Inde
"

Operation Mode 140 type Connection type | Function| Parameter| Parameter contents| Canditional flag [EE Timeout Data Type

i) Localtag | Remate tag| Data count

=

Implicit Connection 2. Read Only(TAG) © Paint to Paint Farameter a%? Eg g:::a

1=
=

0 0L RPI &4 WORD  ttt/DOO0T0 i 1

1) In [Online]->[Write] window ,Click ok.

2) Check Smart extension, check FEnet basic settings, smart extension service, EIP tag,
and EIP target, and then click OK.

Write to PLC ? X

[Jinhibit Frogram Upioad:

[] Sets link enable with parameters

[ PLc configuration

Parameter

[Stop]Basic Parameter Setting...

S} bt
Clear PLC..

[Stop]Special module parameter L

[Stop]Program
twork Parameter
Basic
L [Reset]FEnet [baseD, slot0]
Smart Extension Service
T EIP tag
VIER EIP Target
B High-speed Link
B p2rER)

9 Program
download

In the [Online] = [Communication module setting and diagnosis] = [Enable Link/Service ]
window, check smart extension FEnet (base0, slot 0) and click OK.

Enable Link/Senvices ? X

BB &

(1B High-speed Link 1 -

-[1B] High-speed Link 2

[IE] High-speed Link 3

1B High-speed Link 2

-1} High-speed Link 5

[1R] High-speea tink &

1B High-speed Link 7

(1B High-speed Link &

-[1B] High-speed Link 9

1B High-speed Link 10

10 Enable D High-speed Link 11
1 -] g}| High-speed Link 12

Services LB

-CIED p2pER 1

) pzriEim 2

-CIED papER) 3

D pzPiER 4

D PepEIR) 5

-LIED p2pER &

[ P2pER 7

[ PepiEIR &

& smart Extension

#-[/Z05 FEnet [based, slot0]
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2) Adapter setting(XGL-EIPT)

Setting .
Sequence Setting method
q process 9
1) [Project]|>Open [New Project] and enter the project name, CPU series, CPU type,
programming format, and program name.
New Project 7 x
Project
Project name: ‘E‘PT‘ |
File directory: D:A\PADT Project\PLO\EIPT
Create oc
1 neW CPU Series: XAGK Product Name...
prOjeCt CPU type: XGK-CPUSN
PLC Name: LSPLC
Program
i:ﬁﬂ?ﬂr:tr:ﬂmlﬂg LD Programming
Program name: MNewProgram
e L0
1) Select [Undefined Network]>[Add item]> [Communication module].
2) In the [Select Module] window, click “Add module”.
Select Medule x
C::;::““;:g’:“um Slot Modul Metwork in use
Add
2 Undeflned Add Module Delete Module
network 1) Set Type, Base and Slot in Communication module settings. After that, select ok button in
[Communication module setting and Diagnosis] and module setting is completed.
Communication Module Setting an... X
Type: XGL-EIPT
Base: oo
Slot: oo
1) XGK CPU
- Click [Project]>[EtherNet / IP (OPC UA) Tag Settings].
- Select "New Variable' to add variables, Type, and device.
Setting EtherMet/IP(OPC UA) Variable &
Wariable Type Device Comment Close
1 ilii WORD Dooo100 New Variable
Edit Variable
3 Tag Delete Variable
rengtrat|0n Save
Import

2) XGI/R CPU

- Add variables in the [Global / Direct Variables] or [Local Variables] window of the project tree.
- Check the EIP / OPC UA item.

Variable Kind Variable Type Address Initial Value Retain Used EIPLJE‘PC HMI Comment
1 VAR_GLOBAL  ijjj WORD %MW100 IC] IC] v r

* If you use continuous data, create an Array type variable.

7-48



Chapter 7 server service

Settin .
Sequence 9 Setting method
process
Double-click the communication module in the [Project] window.
Project + 0 x
B A
4 EIPT =
4 Metwork Configuration
4-[3[]] Undefined Metwark
i LSPLC [BOSO XGL-EIPTLTAGH]
[EE] Motion Control Module
£ Systern Variable
4 [ff] LSPLC{XGK-CPUSN)-0Offline
| B P D Y U ¥ Y
4 Standard : :
settings In the [Standard settings] window, set the IP address, subnet mask, gateway, DNS server,
waiting time, and tag usage. Check when using tag information in EIP module.
Standard Settings - EtherNet/IP x
Basic
IP Address: 192 . 168 . 1 2
Subnet Mask: 255 . 255 . 255 0
Gateway 192 . 168 . 1
DNS Server: 0 0 0
Reception 15 sec(2 - 255)
Waiting Time:
e
e
Click [Project]>[Add item]>[P2P Communication]. Select among P2P parameter window No.
1~8
Newrrogramirrogrom < [
i K
: ?&%PNTJM Configuration ]
4 [f] Undefined Metwork
iL‘SPLC [BOSO XGL-EIPTITAG)] —
[E] Motion Control Module Open
£, System Variable o
 GH]LSPLC(XGK-CPUSN)-Offline Add tem O EvEnksmzer
5, Variable/Comment con Chlac
+ [y Parameter .
Basic Parameter Paste Clrl+ k
x| 170 Parameter X Delete Delete Communication Module
) ;si:r‘ng"zz”g”ja’ame‘“’ — P2P Communication
(i NewProgram Communication Module Setting and Diagnosis 3 L i commanicson
1) Double-click the EIP channel to set the channel.
2) Set the operation mode of channel 0 to Implicit Target
. Channel Setting X
Service i
5 . Channel Operation Mode Port Number Partner |P Addiess -
SettlngS 2 Implicit Target, EEE:
0001
0001
0001
0001
0001
0001
g 0001
9 0001
0001
0001
0.0.01
0001
0001
0001
000
0001 -
(o [ anma |
1) Double-click the EIP block to set the block.
2) Register a local tag in channel 0.
Index Eh;nn (peration Mode | 170 ype| Cannection tyne | Function| Parameter| Parameter contents | Conditional fag Trpa;somc:[sriso]n Timeout| Data Type Lo t;gersnzttinl?:g T
1] 0 ¢ Implcit Target WORD /D000 1
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Settin .
Sequence procesgs Setting method
On [Online]>[Write] window, check Basic settings, EIP tag, P2P and Enable link and click OK.
Wirite to PLC 7 X
[+] Sets link enable with parameters
[l] PLC Configuration
Y Comment
r‘l. Parameter
Program [Stop]Basic Parameter
[Stop]l/O parameter
doWnIoad/ [Stop]5pecial module parameter
6 . Local Ethernet Parameter
Set Ilnk | [Stop]Program
enable Netwaork Parameter

E:g Basic
[Reset]EtherMet/IPTAG) [baseD, slotl]
I ElPtag
High-speed Link
[ P2riEIR)
[P p2r 1
[ Enable Link

Link enable settings can also be set in [Online]>[Communication module setting and

diagnosis]~>[Enable Services].
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7.3.9 Diagnosis

Ethernet module (FEnet) does not provide diagnostic function for EIP target/server (Periodic/Non-periodic) among EtherNet
! IP services, but only diagnostic function for EIP connection (Period/Non-period).

The EIP connection service is integrated into the Smart Extension Service and also includes diagnostics.

For the diagnosis function of smart extension service, refer to '4.4 Smart extension diagnosis function'.

Status by service

Dedicated Service P2P Service HS Link Service Smart Extension

Standard Information Service information

Base Mo.: 0 Service Status Enable
SetNo: [ 9 | SCAN MAX: SCAN MIN: SCAN CURR:

EBNo. | Protocol | Station NoJIP | Service | EBStatus | Service Count |EB Detach Count|
—l i EF e 92168111 Eventsevice g 2000088 i
12 (EP 1192.168.1.12 Event service I 131261495 ‘0
L= = — e
[ siots | Types | Status | ErrorCode | Serivce Count | Error Count | SlotFlag | |
[0 {Period service !CONNECT READY 0x0 131261495 ‘0

| Savethefle | CearScan  ClearFlag = Read | Refresh

7_5 1 | stELECTFHC
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7.3.10 System configuration
The Ethernet module provides both EtherNet / IP scanner/adapter functions.

Ethernet module(V8.0)
Scanner/Client

- —

Max. 64 stations
100Mbps/1Gbps

Adapter/Server | Adapter/Server Adapter/Server
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7.4 OPC UA function

OPC Unified Architecture (IEC 62541) is an interoperability standard for secure and reliable information exchange, making it
suitable for industrial applications. Based on client-server model, it is a communication protocol applicable from sensor level
to cloud and has the following features.

(1) Multi / cross platform support

Unlike OPC Classic, which was dependent on the Windows operating system, it is not limited to one operating system
or programming language, coordinate in it can be operated on various devices (Embedded Device).

(2) Strong security

It supports authentication and authorization through signing, encryption, and data integrity (consistency, accuracy,
and validity). Authentication uses X.509 certificates.

(3) Support a Service Oriented Architecture

XGT OPC UA server module can access flags, local and global variables set in PLC from OPC UA client. Based on OPC UA
Specification V1.03, binary protocol (UA Binary) is used, and binary can be downloaded from module of Ethernet module
V6.0 or higher and can be used with XGK, XGI, and XGR CPU.

HMI/ERP/MES

—
OPC UA Client

OPC UA Server

e

XGT OPC UA Server
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' 1

7.4.1 Overview

XGT OPC UA module has the following features

* Message encryption feature

* Authentication via Certificate

* User security functions

* Variable read / write function

* Variable Monitoring (Monitoreditem) Function through Subscription
* Alarm / Event function for variables

* History function for variables

The maximum performance specification of XGT OPC UA module is as follows.

» Connect with up to 10 OPC UA clients (Connect 10 Sessions with OPC UA Client).

* Up to 7000 variables can be set for OPC UA.

* Have up to 50 subscription channels, 10 per session.

* Register 1000 and up to 5000 variables (Monitoredltem) per subscription channel.

» Security Profiles support No Security, 128Rsal5 Sign, 128Rsal5 Sign & Encrypt, 256 Sign, 256 Sign & Encrypt,
256Sha256 Sign, 256Sha256 Sign & Encrypt.

* Alarm / Event can register up to 100 LimitLevel and OffNormal.

* History function can save up to 3,000 history of maximum 64 for variables.
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(1) OPC UA server available version

To use the OPC UA server, you must use the version below.
* XG5000: V4.25 or higher

* XGK CPU OS: V4.57 or higher

* XGK CPU(N) OS: V1.21 or higher

* XGI CPU OS: V4.08 or higher

* XGI CPU(N) OS: V1.31 or higher

* XGR CPU 0O/S: V2.73 or higher

* FEnet module H/W version: V2.0 only

(2) Ethernet module OS upgrade to use OPC UA server

7-55

To use the OPC UA server, you need to upgrade the OS of the Ethernet module. (Only V7.x version is supported)

1) Download OPC UA server OS from LS ELECTRIC website (http://www.Is-electric.com/).

2) After installing the Ethernet module on the system, supply power to the PLC

3) Connect to PLC with XG5000 and change the operation mode to STOP.

4) Select on [Online]-[Communication module setting and Diagnosis]-[OS Upload / Download].

ONUNE = MONMOR DEEUG TOOLS WINDOW HELP

& oisconnec BREE L Ne o
@ Connection Settings.... h @.—El, cTl T3 i1 s
ZIN 0V 0 (7 -0 M)
- |28 E 6w @ E
Change Mode L]
£ Read..
S wiite
ﬁ Compare with PLC..
Set Flash Memory...
EtherCAT Slave »
Communication Module Setting and Diagnosis » B Enables Senices
Reset/Clear Li
2 [ 05 Upload/Download.. I
System Diagnostics L £1P Tag Manager
G Forced UO....
Skip O...
Fault Mask System Diagnosis

—
Module Changing Wizard...

5) Check the base / slot number where the Ethernet module is installed, select the module and click the [BBMBoot]
button. The PLC will reset to operate in BBMBoot mode.


http://www.ls-electric.com/
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05 Download/Upload X
Select module
Base Mumber Slot number Link type
0 a FEnet
[i] 1 FEnet
< >
Select file type: |05 L
Selected file:
0% 0% 100%
BBMBoot Download Upload

XG5000

o Reset PLC, Continue?

Yes Mo

KG5000 X

BBEMBoot Mode on. Click on OK, reconnect and download
! the O35,

6) Select on [Online]>[Communication module setting and Diagnosis]—>[OS Upload / Download].
7) After selecting Ethernet module, select “OS” in file type selection and click [download] button. When the file
search window appears, select the OS file downloaded from the homepage.

05 Download/Uplead x
Select module
Base Number Slot number Link type
0 0 FEnet
[i] 1 FEnet
< >

Select file type: |OS

Selected file: XGL_EFMTB_T2_05_V7.0_180212_Encrypt.bin

0% 0% 100%
Downloading.
BEMBoot Download Upload Close
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7-57

8) Wait for the progress bar to reach 100% and click the [OK] button.

| Finished downloading.

o |

(1) Only Ethernet modules (V6.0 or higher) manufactured after January ‘18 can be upgraded to OS that supports
OPC UA server. If you change to the firmware version V7.x version, OPC UA is supported and other V6.x or V8.x
version does not support OPC UA function.

(2) If the H/W version is V3.0 or higher, firmware change to the OS for OPC UA is not supported. Please purchase
and use the OPC UA dedicated module (XGL-EOPCT).

¢ How to check the H/W version: Connect to the PLC, select the [Online] - [System Diagnostics] - [I/O
Information] menu, and then double-click the FEnet module in the “I/O Information” window or select the module
and click the [Details] button to check.

Module Info. - XGL-EFMT(B) ! <
Details Contents
Madule Marme ®GL-EFMTIB]

Communication made | 05 action
| Eirgr Status I armal
H. ¢ Yersion Wer 2.00
05 wer Wer. 9.00
05 Update Date 2024-05-02

Close




Chapter 7 server service

7.4.2 Parameter setting

OPC UA server parameter is divided into basic setting, secure channel setting, user authentication setting parameter, and
selecting variable to use in OPC UA. It is downloaded through XG5000.

(1) Standard settings

To set up OPC UA server, you have to select “OPC UA” option in standard settings of Ethernet communication

module.

Standard Settings - FEnet

Basic Settings  Host Table Settings  Sets EIP Server

TCP/IP Settings
saonto. [0 ]
Media: Port1: |AUTO ~

Port2: [AUTO
IP address: | 132 . 188 1 2 ]
Subnet Mask: | 255 . 255 255 . D |
Gateway: | 192 . 168 1 . 1 |
DNS Server: | o . 0o . 0o . 1 |
[C1oHCP [ 1Relay OPC LA

No. of Dedicated
Connections:

-1

Receive Time Out Settings

Clignt: sec(? - 255)

Server: sec(2 - 255)
Driver Setting
Server Mode: MET server ~

Modbus Settings

RAPIEnet Settings: | Disable A4

LS'ELECTR"C
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7.4.3 OPC UA settings

(1) Select on [Communication module setting and Diagnosis] = [OPC UA setting] menu to move to setting screen.

Projec < 2 x P Newpogun > [

w HE Server *
v #E Network Configuration
. w ) Undefined Network

Cpen

[ % System Variable
w -] NewPLC(XGK-CPUS)-STOP

Add Item L4

----- 4 Variable/Comment Ctrl+C
Parameter Ctrl=V
Basic P et
asic Farameter X Delete Delete
[ 1/0 Parameter
Scan Program B2 Properties...
“.[# NewProgram
Communication Module Setting and Diagnasis L4 G Enables Services
05 Upload/Download...
EIP Tag Manager
Config. Upload (Dnet, Pnet]
Reset Individual Module
E‘* Delete Parameter(Standard Settings,HS Link, P2F)...
AIlad View High-speed Link  View P2P
_:.';. System Diagnosis
Function/FB
Most Recently Used SIRE L SRE
(2) Basic settings
OPC UA settings x
Basic Settings ~ Secure Channel  User Authentication
@ﬂpphca{iun MName:
55000 XGK-LPUS . OPCUAServer/NewPLC
@ Paort Number:
@) Publishing Interval: ms
@ Samplng Interval: ms
Set UTC Time: |{UTC+09:00) Seoul w
O] Server URL address
1 opc.tcpd192.168.1.2:4840
2
Cancel

1) Application name: The name of the OPC UA server displayed when the OPC UA client connects to the server's
URL. “it is set by default as 'XG5000 Set PLC Type.OPCUAServer / Set PLC Name” and you can change it.

2) Port number: Enter the number to be used as the OPC UA server port. The default value is set to 4840, which
is the OPC UA server port default. It can be changed by the user except for port numbers (502, 2002, 2004,
2005, 2007, 2008, etc.) already defined among the decimal numbers from 1 to 65535.
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3) Publishing Interval: set the minimum frequency that the OPC UA server can send to OPC UA clients. The
default value is 200ms and can be changed by the user from 20ms to 1000ms.

4) Interval Set the sampling cycle between PLC CPU and OPC UA server communication module for the variable
registered as Monitoredltem. The default value is 200ms and can be changed by the user from 20ms to 1000ms.

However, the sampling cycle is affected by the scan time of the PLC CPU.

5) Server URL address: This is the address used by the OPC UA client to enter the OPC UA server address. “It
is displayed as 'opc.tcp: // communication module's IP address: OPC UA port number” and the user cannot
directly modify it. The IP address of the communication module and the port number of OPC UA can be changed

at the same time.

(3) Secure Channel

OPC UA settings

Basic Settings Secure Channel  User Authentication

®
@ Server Cerficate | [NINGNOTTANE Select Certificate...
Name:
@ Available security policy on the server:
Used Security Policy
1 Ird Mo security
2 Ird Basic128Rsa15 - Sign
3 I~ Basic128Rsa15 - Sign & Encrypt
4 I3 Basic256 - Sign
5 Ird Basic256 - Sign & Encrypt
6 r Basic2565ha256 - Sign
T r Basic2565ha256 - Sign & Encrypt
@ Accept client cerificate automatically
@ Twusted Client:
Certificate name Publisher Valid Date
F
Cancel

1) Server certificate name: displays part of the file name of the certificate to use as the server certificate.

2) Available security policies on the server: Displays the policies available for encryption with the XGT OPC UA
server module. When connecting to an OPC UA server from an OPC UA client, you can select one of the
selected security policies to connect.

3) Accept client certificate automatically: select this when you do not have a certificate for the client you want to
connect to or when you want to automatically authenticate all clients.
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4) Trusted client: register a certificate for trusted clients connecting to the OPC UA server. Unchecked the
“Automatically accept all client certificates” check box in 3) to enter the file.

5) Select Certificate: Enroll by issuing your own certificate or selecting a certificate stored on your PC.

Select Certificate *

Server Certificate List:

Certificate name Publisher Valid Date

Create Certificate... Add Delete Cancel

Create Certificate *

Certificate Type
(®) 5elf signed

Signed of CA CA Name:

Certificate Parameters

Certificate Name: |NewPLC_DPCUA_New |

Sign Verification: | ghaa5ensy o

Valid Start Date: |2'32'J-'32-2'II |

Valid End Date: |2030—U2—20 B~ |
Type of use: [npe |1a server -
Type Value
1 URI urn:XGE000 XGK-CPUS.O
PCUASenverMNewPLC
2 IP 19216812
3
Cancel
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(4) User Authentication

OPC UA settings

(@) [4] Allow Anonymous
@ [ Allow User and Password

Basic Settings  Securs Channel  User Authentication

User

Password

Delete

Cancel

1) Allow anonymous access: When connecting without specifying a user ID and password, this function accepts
the client's connection for the request.

2) Allow User and Password access: Check the user ID and password to determine if the client is connected.

7.4.4 Variable registration

The OPC UA server registers and uses server variables for use by OPC UA clients.

(1) XGK CPU

Add OPC UA server variables on [Project]-[Setting EtherNet / IP (OPC UA) Variable] menu.

Wariable

Type

Device

Carnment

| |1 TEST1

WORD

Mooo1

s

Close
New Variable
Edit Variable

Delete Variable

Save

Impart
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(2) XGI/R CPU

Add OPC UA server variables by selecting “EIP / OPC UA” check box in Global / Direct Variable window or Local
Variable window.

V| clobal Variable Imﬂiadvm{fomml }ﬂﬂag ]
Variable Kind Variable Type Address Initial Value  |Retain| Used | EIPIOPC LA| HMI Comment
1 VAR_GLOBAL TEST WORD %MW100 O & IO ¥ r

7.4.5 Setting Download

After setting up OPC UA server and selecting parameters, use [Online] >[Write] menu to download OPC UA server
parameters.

Write to PLC ? 4

[] inhibit Program Upload
[]sets link enable with parameters

-1 PLC Configuration
""" Comment Cancel

----- [ Parameter
Basic Parameter
E 1/0 parameter
@, Spedal module parameter
""" Program
[ Network Parameter
""" Basic Settings
[Reset]FEnet [base0, slotd]
OPC UA variable
[Reset]FEnet [base0, slotl]
EIP tag
21T EIP Server
""" E High-speed Link
----- P2P(EIP)

Setting...

Clear PLC...
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7.5 Server service user setting function

7.5.1 Overview

You can add each pre-defined server port number and consecutive number of ports.

7.5.2  Setting Method

If you enable “user defined port” in “Standard settings” — “Security Settings”, you can change the settings for the servers
below.

(1) XG5000 Port (TCP): Port number changeable (Default: TCP No. 2002)
(2) XGT Server Port (TCP): Port number and additional port can be set (Default: TCP No. 2004)
(3) XGT Server Port (UDP): Port number and additional port can be set (Default: UDP No. 2005)

(4) Expansion Serverl Port (TCP): Port number and additional port of expansion server 1 can be set (Default: TCP No.
5002)

(5) Expansion Server2 Port (TCP): Port number and additional 2 port can be set (Default: TCP No. 9600)

v| User custom port

Continuous Setting

Port Number Additional Port

XG5000 Port(TCPR)

XGT Server Port[TCP)
XGT Server Portf{UDP)
Extend Serverl Port[TCP)
Extend Server2 Port(TCP)

(1) When changing the port number for server functions except for the XG5000 connection port, communication
with the existing port number is also possible.

(2) The number of additional ports increases the port number by the number from the port number set by the user
and waits for a client connection. (Up to 15 cam be possible)

(3) If continuous setting is selected, the port numbers set by the user are arranged sequentially from the XG5000
port to the extension server 2 port number with the offset set by the user.
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7.6 DNP3 Server

7.6.1 Overview

(1) Protocol overview

DNP3 (distribute Network Protocol 3) is a protocol standard that defines communication rules between computers
and is used to collect various types of data and control devices.

(2) DNP3 basic specifications

DNP3-L3+ Support

DNP3 Server: Max 1ch.

Data Point: Max 5,000ea

Event Data Buffer: Max 100,000ea

Event data Retention Enable (Only with XGI-CPUZ3/5/7 CPU)

(3) DNP3 support version information

Communication module:XGL-EFMxB V8.80 or higher
CPU: XGI-CPUx V4.30 or higher, XGI-CPUUN V2.00 or higher, XGI-CPUZx V1.50 or higher
PADT: XG5000 V4.76 or higher

7.6.2 Server operation

(1) Program sequence

Connect to the PLC and set in the order below.

sequence | Setup process How to set up

1) Open [Project] = [New Project] and enter the project name, CPU series, CPU type,
programming format, and program name.

New Project ? X
Project
Project name: DMP3 Server
Cancel
File directory: D:\PADT Project\PLO\DMNPS Server
PLC
CPU Series: *Gl - Product Name...
1 Cre_ate a new CPU type: ¥GI-CPULIN
project
PLC Mame: LSPLC
Program
Eﬁsﬂr:t:”mi"g ¥Gl Programming
Program name: MewProgram
Program LD
Language:
Project description:
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sequence

Setup process

How to set up

1) Right-click [Undefined Network] and select [Add Item] - [Communication Module].

2) In the [Select Module] window, click “Add Module”.

‘e
4 s DNP3 Server +
4 Metwork Configuration
Undefined Metwark
[ Motion Contral Mo
£ Systern Variable
4 LH] LSPLC{XGI-CPL
%) Global/Direct V| Paste
4 ﬁ Parametar o ADoiete
|[1| Basic Param
[Em| 170 Paramet efrech Size
Lacal Ethern _
4-[73] Scan Program
I | p MewPrograr = .
User Functiondf oo oo

N

Ly

Add Item L4

rerrogarirrorer >

Network
Communicaticn Mecdule
P2P Communication

ed Link Communication

=a llaar Nata Tuna I—I
Select Module *
PLC Type:
LSPLC
Communication Module:
Mumbei  BASE Slat Modulz Metwark in use
Add
2 communication
module
| Add Module || Delete Module |
3) Set the type, base, and slot in [Communication Module Setting] and click the OK button.
Communication Module Setting an... X
Type: XGL-EFMTI(E) =
Base: 00 =
Slot: 00 =
| OK | | Cancel |
1) Double-click the communication module in the [Project] window.
Project * 3 x
e &
4 o= DMP3 Server =
Network P Metwark Configuration
s standard 4 Undefined Metwork
settings

B LSPLC [BOSO0 XGL-EFMT(BI(T...

Mation Control Module
L3 Systern Variable
4-[[[] LSPLC{XGI-CPUUN}-Offline
Y Global/Direct Yariables

LS'ELECTR’IC

I
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sequence | Setup process How to set up

2) In the [Basic Settings] window, set [TCP/IP settings], [Receive Timeout settings], and
[Driver settings].

Standard Settings - FEnet x

Basic Settings  Security Setting  Time Synchrenization  Sets EIP Server  Advanced

TCP/IP Settings

setonro: B ]

Media: Port1: | AUTO
Port2: | AUTO
IP Address: 192 168 1 2
Subnet Mask: 255 255 255 0
Gateway: 192 168
DNS Server. o c o c o
[JDHCP [ Relay [JOPC UA
Mo. of Dedicated 3 (1-16)

Connections:
Receive Time Out Settings
Client: 60 ®x1s O x10ms

Server: 15 @xls  Oxloms

Driver Setting

Server Mode: XGT server

RAPIEnet Settings: Disable

1) Right-click the communication module and select [Add Item] > [DNP].

R M Lo
+ (3 DNP3 Server «
4 %Nelwmk Configuration L7
4-[:ff] Undefined Metwark

B LEPLC [BOS0 XGL-EFMT(EXT,

[EE] Motion Contral Module Open

£y System Varlable
4 [ LSPLC{XGI-CPUZ }-Offline Add Item v Smart Extension
DNP

2% Global/Direct Variables
4- Ly Parameter - -
\[3| Basic Parameter Paste Ctrl+V

Eg Copy Ctrl+C

[IEE] 1/ Parameter X Delete Delete Co c
Add DNP3 Local Ethernet Parameter
4 . P2P Communication
service 4 | EtherCAT Parameter )‘ Properties...
B b acter High-speed Link Communication
asmve Communication Module Setting and Diagnosis 4
4 £ Motion Data £7
Encoder pararneter S—
|0:| &xis Parametar Lg Add Slave
il Awis Group Parameter
Pl MC Parameter L9 Views Connection
BRI Memnen -
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sequence

Setup process

How to set up

1) Double-click DNP.

2) Set [Communication Setting] and [DataPoints] of DNP3.

DNP Setting ta
Commanication Setting  DataFoint
Set DNP communication propertes.
=38 1 search e
« DNP3 Main -
ONP3 Enable Enable
Ever Data Buttr Size(Court) 000
When Evant Data bulte is ull Aheeh
Dianusis Variable Address 5MB0
. Channel
Netwark Type TCP-P
TLS Enatle Disable
Port Number 200m
P Frame Size(byte) 252 byte
T Frame Size(byte) % byle
Fx Frame Timeoutms) 15000 ms.
Canfimm Made NEVER
Max Refries 3
Canfim Timeou(me) 2000 me
Offline Poll Perlod(ms) 10000 ms
First Char Waitms) Oms
i Fragmant Size(byte) 2048 byte
Tx Fragment Sizelbyle) 2048 byte
- Session
Local Address 1
Master Address. 0
Link Status Period{ms} 2500 ms
Validate Source Adress Disable
DN P3 Enable Sell Address Disable
Mult Frag Resp Alowed Enable
Muli Frag Corf Enabl
5 parameter Fe e e i
. Clock Valid Period(ms) 160000 ms
Settl ngs Application [nni:r?‘ﬁmenlﬂ[ms) !HJES .
£
In the [Online] - [Write] window, Click OK.
When downloading the project, select the DNP checkbox.
Write to PLC ? x
Inhibit Program Upload
Sets link enable with parameters
[ perameter -
|Stop]Web DE parameters
[Stop]Basic Parameter
[Stop]l/O parameter
7 Setting...
[Stop]Special module parameter
[Stop]Local Ethernet Parameter Clear PLC...
EtherCAT Parameter
Motion Data
Encoder parameter
6 Program @ Axis Parameter
fﬂ Axis Group Parameter
download

fl NC Parameter
m; MNC Program
CAM Data

715 CAM Profile
[Stop]Program

IiE [Stop]Auto variable retain value
MNetwaork Parameter

Basic Settings

[Reset]FEnet [basel, slot0]
EIP tag

T3 EIP Server
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7.6.3 DNP3 Parameter Setting

(1) DNP3 communication setting details

7-69

Parameter Value Scope Default Value Description
DNP3 Enable Enable/Disable Enable Define DNP3 Service Enable/Disable
Event Data Buffer | 100..100000 30000 Max count of event data can be stored
Size(Count)
When Event Data | Refresh/Stop Refresh What to do when the number of event data stored is
buffer is full exceeded
Refresh: Delete the oldest data and save new event
data
Stop: Ignore new data
Diagnosis Variable | M Area Only %MBO Memory address where diagnostic variables will be
Address stored
Diagnosis Variable | 16 16
Size
Network Type TCP-IP TCP-IP DNP3 communication method
UDP-IP TCP-IP: Provides DNP3 service through TCP/IP
TCP-UDP protocol.
UDP-IP: Provides DNP3 service through UDP/IP
protocol
TCP-UDP: DNP3 service operates through TCP/IP
protocol while simultaneously receiving and
processing UDP/IP broadcasting messages.
TLS Enable Enable/Disable Disable
Port Number 0..65535 20000 Port Num. for DNP3 Server
Rx Frame | 24..292 292 Maximum received message frame size in the data
Size(byte) link layer
TX Frame | 24..292 292 Maximum transmit message frame size in the data
Size(Byte) link layer
Rx Frame | 0..4294967295 15000 Waiting time until frame reception is completed after
Timeout(ms) frame synchronization
Confirm mode Never Never Specifies when a link layer confirmation can be
Sometimes requested
Always
Max Retries 0..255 3 Indicates the retry count of link layer confirmation
time-outs
Confirm 0..4294967295 2000 Waiting time when requesting Confirm from link
Timeout(ms) layer
Offline Poll | 0..4294967295 10000 Specifies the duration to re-establish communication
Period(ms) for an offline session
First Char wait 0..65535 0 Indicates the minimum time between reception and
transmission
Rx Fragment size 24..2048 2048 Indicates the maximum message frame length in the
data link layer
Tx Fragment size 24..2048 2048 Indicates the maximum message frame length in the

data link layer
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Parameter Value Scope Default Value Description

Local Address 1..65520 1 Indicates the source address for this session

Master Address 1..65520 0 Indicates the destination address for this session

Link Status 0..4294967295 2500 Indicates the period to send link status requests if no

Period(ms) DNP3 frames are received on this session

Validate Source Enable Disable Specifies if the source address is validated in

address Disable received frames

Enable Self Enable Disable Responds with its own address so that the master

Address Disable can automatically discover the slave address

Multi Frag Resp Enable Enable specifies if the application is allowed to send multi-

Allowed Disable fragment responses

Multi Frag Confirm Enable Enable specifies if the application layer confirmations are

Disable requested for no final fragments of a multifragment
response

Respond Need Enable Disable specifies if this device sets the need time 1IN bit in

Time Disable response to this session at startup and after the
clock valid period has elapsed

Clock Valid 0..4294967295 1800000 specifies the period for which the clock remains valid

Period(ms) after receiving time synchronization

Application Confirm | 0..4294967295 10000 specifies the period for which the slave DNP3 device

Timeout(ms) waits for the application layer
confirmation from the master

Select Timeout(ms) | 0..4294967295 5000 specifies the maximum amount of time that a
selection remains valid before the
corresponding operation is received

Allow Multi CROB Enable Enable determines if the objects of the Multiple Control

Request Disable Relay Output block are allowed in a single request

Max Control 0..10 10 determines if the maximum number of controls are

Request allowed in a single request

Unsolicited Allowed | Check/Uncheck | Check determines if the unsolicited responses are
allowed

Send Unsolicited Enable Disable determines if the unsolicited null responses are

When Online Disable transmitted when the session comes online

Unsolicited Class x | 0..255 5 If unsolicited responses are enabled,

Max Events UnsolClassXMaxEvents specifies the maximum
number of events in the corresponding class to be
allowed before an unsolicited response is
generated.

Unsolicited Class x | 0..4294967295 5000 specifies the maximum amount of time after an

Max Delay event in the corresponding class is received before
an unsolicited response is generated

Unsolicited Retry 0..4294967295 5000 specifies the time to delay after an unsolicited

Delay confirmation time-out before retrying the unsolicited
response

Unsolicited Max 0..65535 3 specifies the maximum number of unsolicited retries

Retries before changing to the offline retry period

Unsolicited Offline 0..4294967295 30000 specifies the time to delay after an unsolicited time-

Retry Delay

out before retrying the unsolicited response after
UnsolMaxRetries are attempted
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(2) DNP3 data point setting details

Data Points can be added, deleted and modified.at Datapoint tab.

DNP Setting
Communication Setting DataPoint ~Event History

Set DNP Data Point.

Class

Event Variation A 7 2 3

DataType | Index | StaficVaristion PLC Memory

Freeze

Description Enable

Fieeze
Interval

Analog
Deadband

r:

‘ Low Limit ‘ High Limit ‘

Add Data Point: Double-click an empty space on the data point setup screen and enter the setup data in the pop-up

window that is created.

Data Paint Setting x
Basic Setting
Data Type: Binary Input -
Class: 0 1 2 d |
Static Variation: With flags -
Event Variation: With absolute time -
PLC Memary: %MX20000 D
Description: Binary Input Mo.1
Advanced Setting
Freeze Interval: ] |
Analog Deadband: |0 |
Low Limit: 0 |
High Limit: 0 |
| QK | | Cancel |
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Parameter Descritpion Remark

Data Type Data Type of DataPoint Binary Input / Binary Output /

Counter / Analog Input / Analog Output

Class Defines the event class of points Unsolicited is not allowerd with class 0 only
Static Variation Indicates the static variation for data point See Data Point Variation detailed table
Event Variation Indicates the event variation for data point See Data Point Variation detailed table
PLC memory Indicates address of the register in CPU

Description User comment for the data point

Freeze Enable Enable Freeze event generation Binary Counter, Analog Input only

Freeze Interval Freeze event generation cycle of data points Binary Counter, Analog Input only

Analog Deadband Change value of data points that do not | Analog Input only
generate events based on the last generated

event data

Low Limit If it is less than the set value, deadband is | Analog Input only
ignored and an event is generated.

High Limit If it is greater than the set value, the deadband | Analog Input only

is ignored and an event is generated.

The data types in Static Variation, Event Variation and PLC memory should be match.

Delete Data Point : Select Data Point and press ‘DELETE’ Key

Set DMP Data Point.

. o o Class
Data Type Index | Static Yariation | Ewvent Variation 0 | 1 | 2 3
12 Binaylnput 0 Wihfags LIS ee "o T Clex | F
E‘El Copy Cirl+C
X Delete Delete
Export
Import

Edit Data Point : Double Click DataPoint which want to edit.
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7-73

Data Point Variation Detailed Table by Group

Object Description

Group Variation

1 1 Binary Input—Packed format

1 2 Binary Input—With flags

2 1 Binary Input Event—Without time

2 2 Binary Input Event—With absolute time

2 3 Binary Input Event—With relative time

10 1 Binary Output—Packed format

10 2 Binary Output—Output status with flags

11 1 Binary Output Event—Status without time

11 2 Binary Output Event—Status with time

12 1 Binary Command—Control relay output block (CROB)
12 2 Binary Command—Pattern control block (PCB)

12 3 Binary Command—Pattern mask

13 1 Binary Output Command Event—Command status without time
13 2 Binary Output Command Event—Command status with time
20 1 Counter—32-bit with flag

20 2 Counter—16-bit with flag

20 5 Counter—32-bit without flag

20 6 Counter—16-bit without flag

22 1 Counter Event—32-bit with flag

22 2 Counter Event—16-bit with flag

22 5 Counter Event—32-bit with flag and time

22 6 Counter Event—16-bit with flag and time

30 1 Analog Input—32-bit with flag

30 2 Analog Input—16-bit with flag

30 3 Analog Input—32-bit without flag

30 4 Analog Input—16-bit without flag

30 5 Analog Input—Single-prec flt-pt with flag

30 6 Analog Input—Double-prec flt-pt with flag

32 1 Analog Input Event—32-bit without time

32 2 Analog Input Event—16-bit without time

32 3 Analog Input Event—32-bit with time

32 4 Analog Input Event—16-bit with time

32 5 Analog Input Event—Single-prec flt-pt without time
32 6 Analog Input Event—Double-prec flt-pt without time
32 7 Analog Input Event—Single-prec flt-pt with time

32 8 Analog Input Event—Double-prec flt-pt with time
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Object Description

Group Variation

40 1 Analog Output Status—32-bit with flag

40 2 Analog Output Status—16-bit with flag

40 3 Analog Output Status—Single-prec flt-pt with flag

40 4 Analog Output Status—Double-prec flt-pt with flag

41 1 Analog Output—32-bit

41 2 Analog Output—16-bit

41 3 Analog Output—Single-prec flt-pt

41 4 Analog Output—Double-prec flt-pt

42 1 Analog Output Event—32-bit without time

42 2 Analog Output Event—16-bit without time

42 3 Analog Output Event—32-bit with time

42 4 Analog Output Event—16-bit with time

42 5 Analog Output Event—Single-prec flt-pt without time

42 6 Analog Output Event—Double-prec flt-pt without time

42 7 Analog Output Event—Single-prec flt-pt with time

42 8 Analog Output Event—Double-prec flt-pt with time

43 1 Analog Output Command Event—32-bit without time

43 2 Analog Output Command Event—16-bit without time

43 3 Analog Output Command Event—32-bit with time

43 4 Analog Output Command Event—16-bit with time

43 5 Analog Output Command Event—Single-prec flt-pt without time
43 6 Analog Output Command Event—Double-prec flt-pt without time
43 7 Analog Output Command Event—Single-prec flt-pt with time
43 8 Analog Output Command Event—Double-prec flt-pt with time
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7.6.4 Diagnosis Global Variable

The diagnosis Data is supported as global variables.

(1) DNP3 diagnostic variable area

The DNP3 diagnostic variable area can be set in DNP3 parameters.
The length is fixed to 16 words.

DMP Setting
Communication Setting DataPoint  Event History

Set DNP communication properties.

o=:| A

o= | Z =earch

4+ DNP3 Main
DMP3 Enable Enable
Event Data Buffer Size{Count) 30000

full

Diagnosis Yariable Address Z%MBD
Diagnosis Yariable Size 16

(2) Registration of diagnostic variables

Theses variables area can be set in the DNP setting windows and are registered when you close it.

XG5000 ot

Register a variable based on the diagnostic variable-related
! property value of the communication setting?

=5 =
Register Special Module Variables X
=L A Apply Wariable Kind Yariable Type Address IL‘
Di Base00, Slot00: XGL-EFMT(B) (Fast Ethernet |
1 ¥ VAR_GLOBAL :_DOODD_SC_INFO WORD %LW3760
2 [¥ VAR_GLOBAL :_ODDO_LINKUP_INF: BOOL %LX60088
3 ¥ VAR_GLOBAL :_DDDO_ADDR_LNM :WORD %LW3761
4 [¥ VAR_GLOBAL :_ODDO_STAND_ALO: BOOL %LX60144
] [¥ VAR_GLOBAL :_ODDO_LINE_TOPO : BOOL %LX60148
E [¥ VAR GLOBAL . _0DDOD_RING_TOPO:BOOL %LX60149
7 [¥ VAR GLOBAL . _0000_CH_NFR ARRAY[D..31]; %LX60928
2 [¥ VAR GLOBAL . _0000_DNP_SVC_E: BOOL %MX0
] [¥ VAR _GLOBAL . _0000_DNP_EVENT. BOOL %MX2
10 [¥ VAR _GLOBAL . _0000_DNP_COMM: BOOL %MX14
11 [¥ VAR _GLOBAL | _00DDO_DNP_NEW_:BOOL %MX15
12 [¥ VAR _GLOBAL |_0D00O_DNP_SND_ :WORD F%MW2
13 [¥ VAR _GLOBAL |_0D00O_DNP_SND_ :WORD %MW3
14 [¥ VAR _GLOBAL |_00D00_DNP_DISC_:WORD %MW
15 [¥ {VAR_GLOBAL |_0DDDO_DNP_DISC_:WORD %MWS5
18 [¥ {VAR_GLOBAL |_DDDO_DNP_RX_E {WORD %MWE
17 [¥ VAR_GLOBAL |_DDDO_DNP_RX_E {WORD Z%MW7
4 » 4 »
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(3) Diagnostic variable list

Variable Name Type Description
DNP_SVC_ENABLE BOOL DNP: SERVICE ENABLE STATE
DNP_EVENT_BUFFER_STATE BOOL DNP: EVENT BUFFER(SEND BUFFER) STATE
DNP_COMM_STATE BOOL DNP: CLIENT CONNECTION STATE
DNP_NEW_EVENT_DATA BOOL DNP: THERE IS NEW EVENT DATA TO BACKUP

DNP: EVENT DATA BUFFER(SEND BUFFER)
DNP_SND_BUF_CNT_L WORD
—SND_BUF_CNT_ © COUNT(L)
DNP: EVENT DATA BUFFER(SEND BUFFER)
DNP_SND_BUF_CNT_H WORD
- -~ - COUNT(H)
DNP_DISC_CNT_L WORD DNP: Communication Disconnection Count(L)
DNP_DISC_CNT_H WORD DNP: Communication Disconnection Count(H)
DNP_RX_ERR_CNT_L WORD DNP: Receive Frame Error Count(L)
DNP_RX_ERR_CNT_H WORD DNP: Receive Frame Error Count(H)

7.6.5 DNP3 Event Data log

The Event history can be checked in Event History tab of DNP Setting at the XG5000.

DNP Setting
Communication Sefting  DataPoint  Event History

Standard Information Log Range Save File

Base No [e] Previous Log First Log Read All
Delete Log
Slot No 0 Next Log Recent Log

No Time: Event Type Data Type Data Point Index | Value

[ 2023-11-21 09:24:55.221 Analeg Input Cha. Analog Input o]
2023-11-21 09:24557.121 Analeg Input Cha..  Analog Input o 2

Frame Data Details:
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Chapter 8 Additional functions

8.1 Remote communication

This function is XG5000 and remote control function such as program writing, user program download, program debugging
and monitor in network system where PLC is connected by Ethernet. Especially, when the devices connected to the network
are far apart, it is a convenient function to easily access each device from one place without moving the place. XG5000
remote communication service function can be connected by creating the following logical path.

PC

.

XG5000 PLC(1) PLC(2) PLC(N)
RS232/USB| IP:192,168,91,190  IP:192,168,91,191 IP: 192,168,91,199

e .
B

!

emote 1 stage connection
Local_ 9 v L Network 1
connection
Remote 2stage connection
& Network 1
___I’
Sill
PLC(A) PLC(B) PLC(C)
IP: 192,168,91,200 IP: 192,168,91,201 IP: 192,168,91,202

In XG5000, USB cable is connected to PLC (1) and PLC (1), PLC (2) and PLC (N) are connected to each other via Ethernet.
To access the contents of PLC (1) in the above figure, make the local connection from the online menu of XG5000 and
access the contents of PLC (1). After the connection is terminated, disconnect the PLC (1) disconnection menu to connect
with PLC (N). after that, select PLC (N) (Ethernet module slot of PLC (1): 1) in the remote connection of the online menu to
establish a connection, and the connection is established by USB and Ethernet. This status supports all the functions that
can be done in PLC (1), such as creating, downloading, debugging, and monitoring programs, just as a USB cable is
connected to PLC (N). In addition, if the Ethernet module is installed on the PC where the XG5000 is operating and connected
to the same network as the PLC, remote 1 connection is possible with the PLC via Ethernet without going through the local
connection via RS-232C.
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8.2 XG5000 setting and connection

All PLCs connected to XGT network can be connected by XG5000 communication service. The remote connection of the
XG5000 consists of the 1-stage connection and the 2-stage connection, The following describes how to connect remote stage
1 and stage 2.

PC

L

XG5000 PLC(1) PLC(2) PLC(N)
RS232/USB|  IP: 192,168,91,190 IP: 192,168,91,191 IP: 192,168,91,199

emote 1 stage connection
f |
~

™ -
N

Local
connection

Network 1

Remote 2stage connection

[ Network 1

PLC(A) PLC(B) PLC(C)
IP: 192,168,91,200 IP: 192,168,91,201 IP: 192,168,91,202

The figure above shows an example of connecting the 1st PLC (2) and 2nd PLC (B) in a system consisting of two networks.

8.2.1 Remote 1-stage connection (when using USB)

XG5000 must be offline for remote 1 connection. From this menu, select [Online]-> [Connection Settings].

PROJECT EDIT FIND/REPLACE VIEW | OMLINE | MONITOR DEBUG TOOLS WINDOW  HELF

SR A A APE A — | —p s ALF o Connect

B F3 F4 3F1 sF2 F5 Fo oF8 59 F9 & .
— @& Connsction Settings... ™
wodEs D£E37 2 Safety Lock I

v@ Network Configuration
| v ) Undefined Network
. -g% MewPLC [BOST XGL-EFMH  Change Mode Mr
% Systemn Variable 2 pead.. vf'

Safety Signature

(1) Connection setting

1) Method: Select a local connection method. In the figure below, we are using a USB connection to local.
2) Step: In connection step, it decides whether to connect with PLC to local, remote 1 or remote 2. Select remote
stage 1.

LSE ecrric | 8-2
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Connection Settings - NewPLC III 7 4 ] Connection Settings - MewPLC

Details - ? X
Setting Options

USE  Remoate 1

X

(®) Manual i) Metwork Browsing
IUSE Driver
Connection Settings Mame: | LS15 X5 Seres |
| Reinstall USB Driver |
Depth: |Remote 1 s Prewview
General

Timeout Interval: 5 || sec
Retrial Times: 1 =| times

Read f Write data size in PLC run mode

Maormal Maximum

* Send maximum data size in stop mode.

Connect Cancel Scan IP oK Cancel
Details El ? x

USBE Remote 1

Metwork type: I FEnet e

(_JCPU Remote (® Module Remote

Local communication module

-

Basze number:

-

| 0
Slot number: 1 =

Cret channel: Channel

Remote 1 communication module

-

Station number: 0 -

IP address: I 192.168.91.190 |

Scan IP Cancel

(2) Settings (Details) _USB
1) USB driver: Setto LSIS XGT Series.
(3) Settings (Details) _Remode 1

1) Network type: Select Rnet, Fdnet, Cnet, FEnet, FDEnet, etc. according to the network type to which step 1
connection is made. Step 1 connection is selected by Ethernet (FEnet).
Also selects an Ethernet connection between the CPU built-in Ethernet / Ethernet module.

2) base, slot number: Designate number of base and slot where local Ethernet module(USB connected PLC)
for remote connection is installed.
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3) IP address: Specify the IP address of the Ethernet module mounted in the PLC of the destination station
(PLC (2)) to be connected with network 1 in network 1. Connect to the Ethernet module with the IP address

192.168.91.191.

The stage 1 connection is completed is the same logical connection state as the local connection. Therefore,
all functions of the online menu can be used. (except when the CPU type of the PLC and the currently open

project is not correct)

Cautions for remote connection

Create a program that matches the CPU type of the other party to connect remotely and connect. If the CPU type is
not correct, only limited functions are available and the upload, download and monitoring function functions of the

program are not supported.

8.2.2 Remote 2-stage connection (when using USB)

(1) XG5000 must be offline for remote 2 connection. In this state, select [Online]-> [Connection settings] from main menu.

(2) Connection setting

1) Method: Select a local connection method. In the figure below, we are using a USB connection to local.

2) Step: In connection step, it decides whether to connect with PLC to local, remote 1 or remote 2. Select remote

stage 2.

Setting Options

Connection Settings

Connection Settings - MewPLC m ?

@ Manual D Metwork Brawsing

Depth:  |Remote 2 ~ Preview

General

Timeout Interval: 3 = SEC
Retrial Times: 1 = times

Read / Write data size in PLC run mode
MNormal Maximum

* Send maximum data size in stop mode.

Connect Cancel

Details X
USB  Remote 1 Remote 2
USE Driver
Mame: | L5IS XG5 5eres |
: Reinstall USB Driver ]
Sean [P oK Cancel
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]
Details El ? % Details II' 7 %

Use Remote 1 Remote 2 USE  Remote 1 Remote 2
Network type: Fenet  ~ Network type: ~ [EEnet 1~
() CPU Remote (®) Module Remote () CPU Remate (® Module Remote

Local communication module Remote 1 communication module

0 = Base number: 0 =
Slot number: 1 = Slot number: 0 =

Base number:

Cnet channel: Channel Cret channel: Channel

Remote 1 communication module Remete 2 communication madule

Station number: 0 = Station number: 0 =

IP address: 152.168. 91 191 ]| IP address: [[192.168. 91 201
Scan IP Cancel Scan P Cancel

(3) Details_Remote 1(Remote 1 setting is same as “8.2.1 Remote 1 connection”.)

(4) Details_Remote 2

1) Network type: Select Rnet, Fdnet, Cnet, FEnet, FDEnet, etc. according to the network type to which step 2

connection is made. The network types of the 1st and 2nd connection are not related.

It is connected by 1-
stage Ethernet to FEnet.

2) Base, slot number: Write the base and slot number of the Ethernet module mounted on the remote 2 connected
PLC.(Remote 1 stage)

3) Station number setting : Write the station number of the remote 2 connected module.
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8.2.3 CPU access directly from PC connected to Ethernet

If the PC running XG5000 is connected to PLC by network, you can connect to CPU with remote 1 by Ethernet without
connecting to PLC CPU by USB or RS-232C

PLC(1) PLC(2) PLC(N)
IP: 192,168,91,191 IP: 192,168,91,199

emote 1 stage copnec on
~

XG5000
RS232/USB IP: 192,168,91,190
=0

[ Network 1

Remote 2 stage connection

= il Network 1

PLC(A) PLC(B) PLC(C)
Rnet 1 station Rnet 2 station Rnet 3 station

(5) Remote 1-stage connection(when using Ethernet)

The above figure shows the case where PC and PLC are connected by Ethernet. In this case, XG5000 can connect
to all PLCs on network without using USB or RS-232C. In this case, local connection is omitted and all PLCs are
connected to remote stage 1 and CPU. Iin Connect and if connect remote 1 directly via Ethernet, select connection

setting and set as below dialog box.

Connection Settings - MewPLC III ? = Details 2 W

Setting Options

Ethemet
(®) Manual () Metwaork Browsing
Set IP address
S @®ip 192 . 168 . 91 . 190]
Depth: | Remote 1 - Preview (© Host name:

[] User custom port

General
= sec Port Setting: 2002

[ s
Retrial Times: 1 =| times

Read / Write data size in PLC run mode

Timeout Interval:

Waming: Change the port number only in
case of port forwarding using the router.

Mormal Maximum

= 5end maximum data size in stop mode.

S Canc Sean IP Cancel
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8-7

1) Connection method:

Select how the connection will be made. Select Ethernet because it connects to Ethernet without using RS-
232C.

2) Connection stage:

Decide whether to establish the connection to the PLC in either remote 1-stage or remote 2-stage. Select
remote stage 1.

3) IP address:

In the above the figure, the connection to the PLC (1), the Ethernet module with IP address 192.168.91.190,
is taken as an example.

All subsequent steps are the same as when using RS-232C. Select OK in this state and select Connection
from the online menu. The connection with the built-in Ethernet is the same as that of the Ethernet module.

(6) Remote 2-stage connection(when using Ethernet )

If the PC running XG5000 is connected to PLC via network, the setting example of remote 1 connection to Ethernet
and PLC (A) Rnet station 1 to remote 2 are as follows.

Connection Settings - MewPLC III 7 > Details ? X

Setting Options

Ethemet
@ Manual D Metwork Browsing
Set |IP address
Connection Settings @ IP address: | 192 . 168 . 91 _ 191 |
Host name:
Depth: |Remote 1 ~ Preview On
General [] User custom port

Timeout Interval: 5 = sec Port Setting: | 2002
N

Retrial Times: = times

Waming: Change the port number anly in
Read f Write data size in PLC run mode case of port forwarding using the router.
Mormal Maxirmum

* Send maximum data size in stop mode.

Connect Cancel Scan P Cancel
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Connection Settings - MewPLC 7 ot .
9 [3] Details [a] * x

Setting Options
Ethemet HRemote 2

@ Manual (::I Metwork Browsing

Metwork type: | Rnet e

ATTTEE LT RIS CPU Remote (@) Module Remote
Type: Ethernet i Remote 1 communication module
Depth: IRemote 2 VI Preview Base number: IL -

=

Slot number:

General

- Cnet channel: Channel
Timeout Interval: 5 - || sec
N

Remote 2 communication module

Station number: 1] -
Read [ Write data size in PLC run mode

Mormal Maximum IP address: | : : : |

Retrial Times: = times

* Send maximum data size in stop mode,

Conngct Cancel Scan IP Cancel

1) Method: Select a local connection method. Remote connection via Ethernet.

2) Step: Remote 1 stage is set same as "Remote 1 stage connection”. Set remote 2 to set Rnet station 1.

3) Station address: In order to connect to PLC (A), set base and slot number of remote 1 Ethernet and input station
number of Rnet 1 station in remote 2 communication module.

(1) Cautions when working with remote stage 1/2

1)If the currently open project on XG5000 and CPU type connected in 1st and 2nd stage do not match, the
following menu items cannot be used.

a) Write the program and each parameter

b) Read the program and each parameter

¢) Monitor

d) Flash memory

e) Set link permission

f) /0 information

g) Forced I/O information

h) I/0 SKIP

2) When programming XG5000 by connecting remote 1 and 2, open the project of the station to be connected
and execute remote connection.

3) Remote connection is only supported up to 2 levels No further remote connection is possible.

(2) Remote connection via XGR redundancy

The same service is supported even when remotely connecting to a dual system. However, in case of
connecting by master or standby, the connection path must be connected to the master CPU to transmit and
receive data.
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8.3 System configuration using switch module

Communication with host system, existing PLC system and other controllers can be done by using Ethernet communication
module. XGT PLC can be configured with high speed and reliability by using Ethernet module.

8.3.1 Ethernet, RAPIEnet mixed system configuration (supported by Ethernet V8.0 or higher, switch V2.0 or
higher)

(7) RAPIEnet communication using standalone MRS

Ethernet module(V6.0)
Ethernet module(V6.0)

i
TN el

Switch module(MRS)

T
,,,Iul-ll |

Switch module(MRS)

“

RAPIEnet
RAPIEnet Smart I/O

RAPIEnet Smart 1/0

Smart I/0 ‘g F;?ﬂ?:f?g

2-ring system configuration (Ring 1ring 1 line system configuration

to Ring) (Ring to Line)

Ethernet module(V6.0)

Switch module(MRS)

RAPIEnet
RAPIEnet ._ Smart I/O

Smart I/O ‘!
by
Qs

2- line system configuration
(Line to Line)
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(8) RAPIENnet and Ethernet communication using MRS

Ethernet module(V6.0)

Ethernet: ——

’ . II RAPIEnet:
T TEmE] |

Switch module(MRS)

Expansion

RAPIEnet Smart I/O

Smart I/O

Ethernet module(V6.0)

RAPIEnet ,Ethernet system
configuration

Ethernet module(V6.0)

Switch module(MRS)

Expansion
Smart /0

Ethernet: ——

Expansion
Smart I/O

Ethernet module(V6.0)

——If=
=

Ethernet ring-line system

configuration

Use either Ethernet or PAPIEnet among the four switch modules.

(1) Smart extension service can be used in various system configurations. However, if 1Gbps and 100Mbps
media are mixed in the system, it operates at 100Mbps. In the case of optical media, and optical media should

be installed in accordance with the transceiver.
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8.4 Communication module object data send and receive function

This function is to send/receive object data of communication module. In order to use it, please refer to the supported version
information below and apply it to the system.

(1) Supported S/W version information

No. | XGL-EFMxB Version | Object ID Description
1 V8.50 1 SNTP
2 Vv8.50 2 Smart Extension
3 V8.50 3 P2P
4 Vv8.60 4 Diagnosis
No. CPU Type CPU Version
1 XGI-CPUUN V1.80
2 XGK-CPUHN V1.80
3 XGK-CPUSN V1.80
4 XGK-CPUUN V1.80
(2) Command: CP_MSG
XGL-EFMxB | XG5000 T
No . . CP_MSG Function Description
" | Version Version

Commun.ica'Fion module. obj.ect read | Access to Local object(SNTP, Smart
1 Vv8.50 V4.61 communication module object write extension, P2P)

Communication module object write ,read

Read remote communication module object | Communication ~ module  object

V8.60 V4.70 . L . i
2 Write remote communication module object | access of smart extension slave

For detailed instruction usage, refer to “XGK / XGB instruction user manual” or “XGI/XGR/XEC/XMC instruction user manual”.
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8.4.1 SNTP object
The structure of the SNTP object (Object ID :1) is as follows.

SNTP Object |(ObjectID: 1)

3 1]

Offset SNTP Command

0x0000
(WRITE)

0x0100

SNTP Event operation

{(WRITE)

0x0150 SNTP Event operation
(READ)

LSE ecrric | 8-12
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0x0200

0x0300

Periodic SNTP diagnostic

Information (Read)

- Since there are a maximum
of 4 servers that can be
registered, the response
structure is also 4

Event SNTP diagnostic
information (Read)
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(1) SNTP command using CP_MSG

Offset
O0x0000

3

0

I I,

- Write control command to SNTP command offset (0x0000)
- Message structure: Command : SNTP control command

No. Command Description
1 0x0010 SNTP diagnostic count clear command
2 0x0020 SNTP Event diagnostic count clear command

- CP_MSG SNTP Command WRITE Request Message Structure

- Ladder program writing example
: SNTP diagnostic count clear command

e ooy rooomiz wsw ||
| ooy rooooooor mosoe |
| v nooosooor mosog |
| v roooooooo mosos |
| v rooooooos mosos |
| ooy rooooooro | wosio |

o EEEED 24 5000 S

LS—'ELECT!"‘!C |
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: SNTP Event diagnostic count clear command

HDI%D;:” OOy hOO0001 12 MOS00
| Ok h00000001 M50z
| OOy hOa0s0001 MO504
| OOy hO000a00a MOS0
| OOy hoonoono4 MO503
| DKy h00a000z0 MO510
| HDIDD;J] | CPM3G hoao? MO500 24 5000 M1a0a M1500 Mz000

Ir— 1 1 T T— T— T

(2) SNTP Event operating for using CP_MSG

SNTP  Event operation
(Write)

Offset
O0x0100

- Write control command to SNTP event operation command offset (0x0100)

- Message structure

: NTP Server IP Address: IP address of NTP Server for SNTP event operation
: NTP Server Port No: Port address of NTP Server for SNTP event operation

==> If the NTP server port is not changed, the port address is 123.
: Time Zone: Time Zone setting for SNTP operation

SNTP Event operation

==> Convert the time zone value for each country that the user wants to set into minutes and input

ex1) Korea time zone is +9 hours, so 9*60 = 540.
ex1) US time zone is -5 hours, so (-5)*60 = -300
==> See table below
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No. Time zone (UTC * time) convert to minutes
1 (UTC-12:00) International Date Line West -12:00 * 60 = -720
2 (UTC-11:00) Samoa -11:00 * 60 = -660
3 (UTC-10:00) Hawaii -10:00 * 60 = -600
4 (UTC-09:00) Alaska -09:00 * 60 = -540
5 (UTC-08:00) Baja California -08:00 * 60 = -480
6 (UTC-08:00) Pacific Time (US & Canada) -08:00 * 60 = -480
7 (UTC-07:00) Arizona -07:00 * 60 = -420
8 (UTC-07:00) Chihuahua, La Paz, Mazatlan -07:00 * 60 = -420
9 (UTC-07:00) Mountain Time (US & Canada) -07:00 * 60 = -420
10 (UTC-06:00) Central America -06:00 * 60 = -360
11 (UTC-06:00) Central Time (US & Canada) -06:00 * 60 = -360
12 (UTC-06:00) Guadalajara, Mexico City, Monterrey -06:00 * 60 = -360
13 (UTC-06:00) Saskatchewan -06:00 * 60 = -360
14 (UTC-05:00) Bogota, Lima, Quito -05:00 * 60 = -300
15 (UTC-05:00) Eastern Time (US & Canada) -05:00 * 60 = -300
16 (UTC-05:00) Indiana (East) -05:00 * 60 = -300
17 (UTC-04:30) Caracas -04:30 * 60 = -270
18 (UTC-04:00) Asuncion -04:00 * 60 = -240
19 (UTC-04:00) Atlantic Time (Canada) -04:00 * 60 = -240
20 (UTC-04:00) Cuiaba -04:00 * 60 = -240
21 (UTC-04:00) Georgetown, La Paz, Manaus, San Juan -04:00 * 60 = -240
22 (UTC-04:00) Santiago -04:00 * 60 = -240
23 (UTC-03:30) Newfoundland -03:30 * 60 = -210
24 (UTC-03:00) Brasilia -03:00 * 60 = -180
25 (UTC-03:00) Buenos Aires -03:00 * 60 = -180
26 (UTC-03:00) Cayenne, Fortaleza -03:00 * 60 =-180
27 (UTC-03:00) Greenland -03:00 * 60 =-180
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28 (UTC-03:00) Montevideo -03:00 * 60 = -180
29 (UTC-02:00) Coordinated Universal Time-02 -02:00 * 60 =-120
30 (UTC-02:00) Mid-Atlantic -02:00 * 60 = -120
31 (UTC-01:00) Azores -01:00 * 60 = -60
32 (UTC-01:00) Cape Verde Is. -01:00 * 60 = -60
33 (UTC) Casablanca 12.00AM *60=0
34 (UTC) Coordinated Universal Time 12.00 AM *60=0
35 (UTC) Dublin, Edinburgh, Lisbon, London 12.00 AM *60=0
36 (UTC) Monrovia, Reykjavik 12.00 AM *60=0
37 (UTC+01:00) Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 01:00 * 60 =60

38 (UTC+01:00) Belgrade, Bratislava, Budapest, Ljubljana, Prague 1:00 AM * 60 = 60
39 (UTC+01:00) Brussels, Copenhagen, Madrid, Paris 1:00 AM * 60 = 60
40 (UTC+01:00) Sarajevo, Skopje, Warsaw, Zagreb 1:00 AM * 60 = 60
41 (UTC+01:00) West Central Africa 1:00 AM * 60 = 60
42 (UTC+02:00) Amman 2:00 AM * 60 =120
43 (UTC+02:00) Athens, Bucharest, Istanbul 2:00 AM *60 =120
44 (UTC+02:00) Beirut 2:00 AM * 60 =120
45 (UTC+02:00) Cairo 2:00 AM * 60 =120
46 (UTC+02:00) Damascus 2:00 AM * 60 = 120
a7 (UTC+02:00) Harare, Pretoria 2:00 AM * 60 = 120
48 (UTC+02:00) Helsinki, Kyiv, Riga, Sofia, Tallinn, Vilnius 2:00 AM * 60 = 120
49 (UTC+02:00) Jerusalem 2:00 AM * 60 = 120
50 (UTC+02:00) Minsk 2:00 AM * 60 =120
51 (UTC+02:00) Windhoek 2:00 AM * 60 =120
52 (UTC+03:00) Baghdad 3:00 AM * 60 = 180
53 (UTC+03:00) Kuwait, Riyadh 3:00 AM * 60 = 180
54 (UTC+03:00) Moscow, St. Petersburg, Volgograd 3:00 AM * 60 = 180
55 (UTC+03:00) Nairobi 3:00 AM * 60 = 180
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56 (UTC+03:30) Tehran 3:30 AM * 60 = 210
57 (UTC+04:00) Abu Dhabi, Muscat 4:00 AM * 60 = 240
58 (UTC+04:00) Baku 4:00 AM * 60 = 240
59 (UTC+04:00) Port Louis 4:00 AM * 60 = 240
60 (UTC+04:00) Thilisi 4:00 AM * 60 = 240
61 (UTC+04:00) Yerevan 4:00 AM * 60 = 240
62 (UTC+04:30) Kabul 4:30 AM * 60 = 270
63 (UTC+05:00) Ekaterinburg 5:00 AM * 60 = 300
64 (UTC+05:00) Islamabad, Karachi 5:00 AM * 60 = 300
65 (UTC+05:00) Tashkent 5:00 AM * 60 = 300
66 (UTC+05:30) Chennai, Kolkata, Mumbai, New Delhi 5:30 AM * 60 = 330
67 (UTC+05:30) Sri Jayawardenepura 5:30 AM * 60 = 330
68 (UTC+05:45) Kathmandu 5:45 AM * 60 = 345
69 (UTC+06:00) Astana 6:00 AM * 60 = 360
70 (UTC+06:00) Dhaka 6:00 AM * 60 = 360
71 (UTC+06:00) Novosibirsk 6:00 AM * 60 = 360
72 (UTC+06:30) Yangon (Rangoon) 6:30 AM * 60 = 390
73 (UTC+07:00) Bangkok, Hanoi, Jakarta 7:00 AM * 60 = 420
74 (UTC+07:00) Krasnhoyarsk 7:00 AM * 60 = 420
75 (UTC+08:00) Beijing, Chongging, Hong Kong, Urumgqi 8:00 AM * 60 = 480
76 (UTC+08:00) Irkutsk 8:00 AM * 60 = 480
77 (UTC+08:00) Kuala Lumpur, Singapore 8:00 AM * 60 = 480
78 (UTC+08:00) Perth 8:00 AM * 60 = 480
79 (UTC+08:00) Taipei 8:00 AM * 60 = 480
80 (UTC+08:00) Ulaanbaatar 8:00 AM * 60 = 480
81 (UTC+09:00) Osaka, Sapporo, Tokyo 9:00 AM * 60 = 540
82 (UTC+09:00) Seoul 9:00 AM * 60 = 540
83 (UTC+09:00) Yakutsk 9:00 AM * 60 = 540
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84 (UTC+09:30) Adelaide 9:30 AM * 60 = 570
85 (UTC+09:30) Darwin 9:30 AM * 60 = 570
86 (UTC+10:00) Brisbane 10:00 AM * 60 = 600
87 (UTC+10:00) Canberra, Melbourne, Sydney 10:00 AM * 60 = 600
88 (UTC+10:00) Guam, Port Moresby 10:00 AM * 60 = 600
89 (UTC+10:00) Hobart 10:00 AM * 60 = 600
90 (UTC+10:00) Vladivostok 10:00 AM * 60 = 600
91 (UTC+11:00) Magadan, Solomon Is., New Caledonia 11:00 AM * 60 = 660
92 (UTC+12:00) Auckland, Wellington 12:00 PM * 60 = 720
93 (UTC+12:00) Coordinated Universal Time+12 12:00 PM *60 = 720
94 (UTC+12:00) Fiji 12:00 PM * 60 = 720
95 (UTC+12:00) Petropavlovsk-Kamchatsky - Old 12:00 PM *60 = 720
96 (UTC+13:00) Nuku ’alofa 1:00 PM * 60 = 780
97 (UTC+01:00) British Summer Time 1:00 AM * 60 = 60
98 (UTC+01:00) Irish Summer Time 1:00 AM * 60 = 60
99 (UTC+01:00) Western Europe Summer Time 1:00 AM * 60 = 60
100 (UTC+02:00 ) Central Europe Summer Time 02:00* 60 =120
101 (UTC+03:00 ) Eastern Europe Summer Time 3:00 AM * 60 = 180
102 (UTC+04:00 ) Moscow Summer Time 04:00 * 60 = 240
103 (UTC-03:00) Atlantic Daylight Time -03:00 * 60 =-180
104 (UTC-04:00 ) Eastern Daylight Time -04:00 * 60 = -240
105 (UTC-05:00) Central Daylight Time -05:00 * 60 = -300
106 (UTC-06:00 ) Mountain Daylight Time -06:00 * 60 = -360
107 (UTC-07:00) Pacific Daylight Time -07:00 * 60 = -420
108 (UTC-08:00) Alaska Daylight Time -08:00 * 60 = -480
109 (UTC+10:00 ) Australian Eastern Daylight Time 10:00 AM * 60 = 600
110 (UTC+10:30) Australian Central Daylight Time 10:30 AM * 60 = 630
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Daylight Saving Time: Daylight Saving Time setting for SNTP operation
Daylight Saving Time Disable: 0
Daylight Saving Time Enable: 1

Timeout Value: Timeout setting value until retrieval of time information from NTP server

Enter a value in ms units (10ms 65535ms)

- CP_MSG SNTP Event operating WRITE Request Message Structure

- Ladder program writing example

MDI”F.DIDD | DMy hoooooti2  MOsoD |
| MMy 00000001 WOs02 |
| DMy hoDOSDOD! MOS04 |
| DMv  hODDODTOD  MOSOS |
| DMy hODODDOTO MOSOB |
| DMy hedDiABCO MOSID |
| DMy 123 msiz |
| oMy 540 Mosie |
| Do 3000 Mste |

MDIDDIDD EE hooo? MO500 36 5000 M1000 M1500 Heaoo |

LS—'ELECT!"‘!C
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(3) Read SNTP Event operating status for using CP_MSG

SNTP  Event operation
(Read)

Offset
Ox0150

SNTP Event operation

-Read SNTP event operation command offset (0x0150)

- Time information received from the NTP server through the most recent SNTP event operation
: Month/Year: month /two digit after year (ex) 2021 --> 0x21)

: Hour/Date

: Sec/Min

: Year/Day:two digit before year (ex) 2021 --> 0x20) / day of week (1 to 7 indicate Monday and Sunday)
ex) Month/Year (Example: 2021 --> 0x21)

Month/Year: 0x06 / 0x21

Hour/Data: 0x14 / 0x22

Sec/Min: 0x38 / 0x10

Year/Day: 0x20 / 0x02

- CP_MSG SNTP Event operating READ response Message Structure
3 1]
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- Ladder program writing example

””I%DFS ooy hoooooiil weson ||
| Oy hooooooon WosD2 ||
| DMy hooos0o01 WOsD4 ||
| DMV hODDODISD WOSDG ||
| v hoooooioo wosoe ||

””IE'DFE IEE haoo? MOS0 20 5000 M1000 M1500 Heooo ||
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(4) Read SNTP diagnostics information for using CP_MSG

Periodic SNTP diagnostics
information (Read)

Offset
0x0200

1st Periodic SNTP
diagnostics information

2nd Periodic SNTP
diagnostics information

3rd Periodic SNTP
diagnostics information

4th Periodic SNTP
diagnostics information

- Read Diagnostic information offset (0x0200) for periodic SNTP operation

- Message structure

: Connection Info: Connection status with NTP server

==> 0: No Setting

==> 1: Parameter Download

==> 2. NTP server Connect

==>3: NTP NTP server disconnection)

: NTP Server IP Address: NTP Server IP address downloaded as parameter
: NTP Server Port No: NTP Server port address download as parameter

: time update Count: Count normally updated time information from NTP server
: lost connection Count: Count disconnected from the NTP server

8-23 | LSE ecrric
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- CP_MSG reriodic SNTP Diagnostics READ response Message Structure
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- Ladder program writing example

HEI%D.E” [ omov !
[ L
| onov hooooooo! MOS0z ||
| owov hODOSOODT MOS04 ||
| v hoooooeoo wosos ||
| v hoooooioo wosos |
i IEEEEE 20 S0 WO WSl weo ||

(5) Read event SNTP diagnostics information for using CP_MSG

Event SNTP diagnostics
information (Read)

Offset

Event SNTP diagnostics
0x0300

information

- Read Diagnostic information offset (0x0300) for periodic SNTP operation

- Message structure

: Service Status: Status of the most recently performed SNTP event action

==> 0: normal

==> For values other than 0, refer to 'List of Error Codes for SNTP Objects' below.

: NTP Server IP Address: IP address of NTP Server for recently and if SNTP event operation

: NTP Server Port No: NTP port number for the most recently performed SNTP event operation
: Month/Year, Hour/Data, Sec/Min, Year/Day: Time information received from the NTP server through the most
recent SNTP event operation

==> For detailed description, refer to the above SNTP event operation READ

: Time Update Count: Count of successful update of time information with SNTP event action

: Time Update Fail Count: Count of failed SNTP event operation
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- CP_MSG event SNTP Diagnostics READ response Message Structure

wa
o

- Ladder program writing example

MOonoz

T T T T 7T T

o NOY  hOODOD1TT MOSOD
MOV hOODODODT OS2

MOV hOODSOODT MOs0d

MOV hOODODA00 MOS0

MOV hOODODIOD MOS0

e ECEEED 20 SO0 WO Ws00 Weood
LS—’ELECTR.’C |
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(6) refer to 'List of Error Codes for SNTP Objects' below.

No. Error code Description

1 0x0150 TIMEZONE setting error when writing SNTP event operation command

2 0x0151 NTP SERVER register error when writing SNTP event operation command

3 0x0152 DAYLIGHT SAVING TIME setting error when Write SNTP event operation command

4 0x0153 TIMEOUT VALUE setting error when writing SNTP event operation command

5 0x0154 COMMAND setting error when writing SNTP event operation command

6 0x0155 Error receiving time information from NTP SERVER when writing SNTP event operation
command (If time information is not received during the set timeout period)

7 0x0156 When the SNTP event operation command is WRITE, the event SNTP cannot be
operated because periodic SNTP is operating through the parameter.
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8.4.2 Smart Extension object

The structure of the Smart Extension object (Object ID :2) is as follows.
Smart extension object (Object
ID: 2)
Offset 3 I}

Ox 0000 Smart extension

command/diagnostics

(1) Smart extension service Enable/Disable command using CP_MSG

- Write control command to smart extension service control object offset (0x0000).

- Enable: 0x0000000E

- Disable: 0x0000000D

- An error ( UNIV_ERR_INVALID_PRM ) response to an input value outside the set range of each field of the
command.

- In the state of being enabled, it cannot be re-enabled.

- In the state of being disabled, it cannot be re-disabled.

Note) For safe operation of smart extension service, the Inhibit time for service Enable/Disable command is 200ms.
Executing Smart Extension Service Enable/Disable CP_MSG within 200ms returns an error.

(2) Smart extension service Enable/Disable Status read using CP_MSG

- Read smart extension service control object offset (0x0000).
- Status information: 0xO000000E (Smart extension service Enable status)
- Status information: 0x0000000D (Smart extension service Disable status)

(3) Example of smart extension status read message

Smart Extension

3 Read Response 0
Smart Extension

3 Read Request 0
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8.4.3 P2P object

The structure of the P2P object (Object ID :3) is as follows.

P2P object (Object ID: 3)

Offset
0x0000
Ox0004
(0008
O 000C
Ox0010

P2P channel command

2P channel diagnostics

0x0038
Ox003C

010040 | Staus(@4nn) | stas(cHso

(1) P2P client channel commands using CP_MSG (Write Only)

- Write control command to P2P object offset (0x0000).

- Channel No: TCP channel index number set as client of P2P channel parameter (0 ~ 31)

- Command: Refer to the following table for supported command items.

(An error ( UNIV_ERR_INVALID_PRM ) response to an input value outside the set range of each field of the

command.)
Code (hex) Name Description
Start connection to the server of the P2P channel set as
a TCP client (only channels with a channel status of
0x0001 CONNECT_REQ . (only . . .
Disconnected are available; otherwise, an error is
returned)

After sending TCP RESET to P2P channel set as TCP
client, internal forced connection is released.
0x0002 RESET_RE D o
-REQ (Only possible if the channel is in CONNECTED state,
otherwise an error is returned.)

(2) Status read command of P2P client channel using CP_MSG (Read Only)

- Reads the value of P2P channel diagnosis area (offset: 0x0004 ~ 0x0040) by “reading” operation. The minimum
read unit is 4 bytes.

- Refer to the following table for current status information of channels.
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Code (hex) Name Description
0x0000 DISCONNECTED Connection release (IDLE)
0x0001 CONNECTED Connection complete
0x0002 WAIT_CONNECTING The server is waiting for a connection from the client.
0x0003 CONNECTING Connecting
0x0004 DISCONNECTING Disconnecting

(3) P2P object error code

Code (hex) Name Description
0x0130 UNIV_P2P_ERR_BAD_CHANNEL | P2P channel parameters do not meet the conditions.
0x0131 UNIV_P2P_ERR_IDLE_CHANNEL | P2P channelis in IDLE state.
0x0132 UNIV_P2P_ERR_BUSY_CHANNEL | P2P channel is in BUSY state.

(4) Example of P2P object read request/response message structure

- P2P Read Request message

[P2P Read Request]

- P2P Read Response message structure

Ls—'EL ECTRIC
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[P2P Read Response]

(9]

"Ill ==

8.4.4 Diagnosis object

The structure of the Diagnosis object (Object ID :4) is as follows.

Diagnostics object (Object ID: 4)
Offset

Ox0000

0x0100
Ox0200
0x0400
Ox0500
0x0800
Ox1000
0x1800

Ox2000

0x3000

0x3004

w
o
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(1) Module Information read using CP MSG
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8-33

Member name

Value

Parameter Exist

0X00: No Basic parameter
0X00: normal operation in Basic parameter

Link Type 0x01 : FEnet
0x01: copper x 2port(XGL-EFMTB)
Link Sub Type 0x02 : Fiber Optic x 2port(XGL-EFMFB)
0x04 : Copper 1port + Fiber Optic 1port(XGL-EFMHB)
Station No. Station Number
IP Address IP Address
Os Date QS Date
MAC Address MAC Address
0 : Link Down
Port 1 Link
ort 1 Link Status 1 Link Up
. 0 : Link Down
Port 2 Link Status 1: Link Up
HW Version Hardware Version
HW Status Hardware Status
OS Version OS Version
Reserved -
b’0 : P2P Service Enabled
b’1 : HS Service Enabled
RUN Mode b’'2 : Remote Loader is in service
b’3 : Server is working
Note : See Server mode in basic parameter fo detail
Reserved -

Media Status Portl

Media Status Port2

0 : Auto (Link down)
1:10M Half
2 : Reserved
3 : 100Mbps Half
4 : 100Mbps Full
5 :100Mbps FX Half
6 : 100Mbps FX Full
7 : 1000Mbps Full
8 : 1000Mbps X Full
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- Ladder program writing example(XGK)

MIo00a

P | v oot wosoo |
| omov ho0OO0001 - Mos02 ||
| onov HODDS0004 MOBO4 ||
| owov HODDOOOOD MOB06 ||
| owov hO0OOO03C MOS08 ||

MDD

| CPMSE hooo! MOS00 20 5000 M1000 MI500 Hzoon ||
0 1 Z 3 4 h b 7 ] 9

M1000 | 0121 ¢ 0000 0001 ¢ 0000 ¢ 0004 ¢ 0005 0000 0000 : Q03C ¢ 0ooo

Mi010 | 01071 ¢ 0001 ¢ ABCO: 0201 ¢ 0217 2022 : EOOO ¢ 0591 : 9769 : 101

MI1020 | 0200 0000 623C: 0000 ¢ 0005 : 0404 ¢ 0000 ¢ Q000 : 0000 @ oooo

(2) Read Feature List of FEnet module
- It responds with a list of features supported by FEnet. The meaning of the Feature List is assigned to each bit,
and if the bit is 1, it is supported, if it is O, it is not supported.

Feature name Bit Position Feature description
BPSC LARGE RAM SUPPORT b’0 Supports large-capacity backplane common RAM
RAPIENET PLUS SUPPORT b1 Mountable on RAPIEnet+ slave
LD MULTI CONNECT SUPPORT b’2 Loader service multi-connection support
DIAG MULTI ACC SUPPORT b’3 Diagnostic service multi-message support
MSG TUNNELING SUPPORT b’4 n-Backplane Message Tunneling Support
LARGE SERVER MSG SUPPORT b’5 Large server message support
Reserved b’'6 ~ b’31 -
Reserved b’32 Support for smart extension high-speed output mode
PASS THRU SUPPORT b’33 Message Pass through support
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- Ladder program writing example(XGK)

Ir— T T T T— T

HOOo00
| | DMOY hOooonT 11 MO500
_I DMOY hOooonao1 MO502
_I DMoY hO00S0004 MO504
J D0y hRO00001 00 MOG0G
J OMoY hO0O0003E M0G0
ME;DDIE” | CPMSGR hO0m HOS00 20 RO00 M1000 H1500 Moo
Hexadecimal
0 1 2 3 4 L 6 ? g 9
MIDOO | 0121 ¢ 0000¢ 0001 ¢ 0000 ¢ 0004 ¢ 0a05: 0100 0000 ¢ 003C © 0000
MI010 | OO03F ¢ 0000¢ 0001 ¢ 0000: 0000 0000 ¢ 0000 0000 0000 ¢ 0000
Binary number
0 1 2 3 4 5 6 7 8
MIO0D | o 0001 010 bont | 0oo0 ooy 0000 tood | 0009 bhuo o0 00Ot ¢ too0, 0000 0hug 0900 | 0000 0000 Do 0100 | 0ubd 00ay oooo 011 | D000 tug1 0000 ohuo | nogh 000u tuon 0000 | buog 0oog o1l 1100,
M1010 | 0000 0000 0011 1117 DOOD 0000 0000 0000 : 0000 0000 0000 0001 0000 0000 0000 D000 @ 0000 0000 0000 0000 - 0000 0000 DODO 0000 @ 0000 0000 0000 0000 @ 0000 D000 0000 0000 : 0000 D000 0000 0000

9

0000 1000 0000 0000

(3) Frame capture control

- To start frame capture, write 0XO0O00000E to Frame Capture Control offset (0x3000) using the CP MSG Write

function.

- To start frame capture, write 0x0000000D to Frame Capture Control offset (0x3000) using the CP MSG Write

function.

- To erase captured frame data, write 0x0000000C to Frame Capture Control offset (0x3000) using CP MSG

Write function.
- If no frame capture filter is set, all frames are recorded.

- Up to 2280 frames can be saved, and when the frame recording space is full, new frames are recorded after

deleting the old frame recording. (Over write)
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- Ladder program writing example(XGK)

I 1 1 T— T— T— T—

* Enable
_MD'DDIDD | OOy hooooot 12 MO&00
_I OOy hoooooom MO=02
J DwaY h0o050004 MOS04
J OMov hO0003000 MOG05
_I O hO0oa0a04 MOG05
_I OOy hOooooooe MOS10
MDIDDIm | CPM3G hoom MO500 24 5000 1000 W1500 M2000
1] 1 2 3 4 L b 7 8 9
M1000 | 0122 ¢ 0000: 0000 ¢ 0000 : 0000 : 0000: 0000 : 0000 : 0000 @ oooo

Module Log

Event History Communication Log Error Frame Log

Standard Information Select View
Base No.: o () View by HEX
Slot No.: 1 O Wiew by ASCI
MNo Date Time Description
13 2022-11-16  08:37406... 00 B0 91 02 05
4 2022-11-16  083741.6... 00 B0 91 02 05
15 2022-11-16  0837426... 00 B0 9 02 05
16 2022-11-16  0837436... 00 B0 9 02 05
17 2022-11-16¢  0837:586.. COED91 0205
18 2022-11-16  08:37:596.. 00 ED 91 0205
19 2022-11-16  08:38:006.. 00 EO0 0205
20 2022-11-16  08:38:01.6... 00 B0 9 02 05
21 2022-11-16  08:38:02.5.. FF FFFF FF FF FF
22 2022-11-16  08:38:026... 00 E0D 9 02 05
23 2022-11-16  08:38:03.6... 00 ED 9 02 05
4 2022-11-16  08:38:04.6... 00 B0 9 02 05
25 2022-11-16  08:38:006.. COEDS1 0205
26 2022-11-16  08:38:06.6... 00 ED 91 0205
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I— T T T T— T— T—

« Disable
ME;DDIDD | OMow hO0ooa112 MOG00
_I OO hO0aooom MOG02
_I OOy hO0o&0004 MO=04
_I OO hO0ooE000 MO506
J O hO0000004 MOG03
_I OMov hO0000000 MOS10
_MEI|DDEI1 CPM3G hoom MO500 24 5000 1000 W1500 M2000
1] 1 2 3 4 L b ? B 9
M1000 | 0122 ¢ 0000 0000 ¢ 0000 0000 ¢ 0000 0000 0000 0000 @ oooo

Module Log

Event History Communication Log Error Frame Log

Standard Informaticn Select View

Base MNo.: 0 i@ View by HEX

Slot No: 1 7 View by ASCII
Mo Date Time Description
59 2022-11-16 08:41:436.. 00 EQ 9102 05
a0 2022-11-16 0841446, OOEDO1 0205
61 2022-11-16  08:41:456.. 00 E0 9102 05
62 2022-11-16  08:41:466... 00 EQ 9102 05
63 2022-11-16 0841475, FFFFFFFFFFFI

4 2022-11-16  08:41:476... 00 EQ 9102 05
65 2022-11-16  08:41:486.. 00 EQ 9102 05
66 2022-11-16  08:41:496.. OO0 EC 91 02 05
67 2022-11-16  08:41:506.. 00 EQ 9102 05
68 2022-11-16  0841:516.. OQOEDS10205
69 2022-11-16  0841:525... FFFFFFFFFFFI
70 2022-11-16  08:41:526.. 00 EQ 9102 05
71 2022-11-16  08:41:53.6... 00 EC 91 02 05
72 2022-11-16  08:41:546.. 00 EQ 9102 05
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Ir— T T T T— T— T

Event History Communication Log  Error Frame Log

Standard Information Select View
Base No.: o =) View by HEX
Slot No: 1 View by ASCII
No Date Time Description
KG3000 x

| No log to read.

18
ro

(4) Frame Capture Filter Settings

*  Clear
M [mov rooooiz wosm
oo noooon WS
ooy oo wosm
[ mov nooosmn Wosts
[mov noooone wosis
[mov noooonc wosio
! [owsi  roool woso 2 SO0 MO0 Wis0) koo
0 1 2 3 4 5 b6 7 g 9
MIDOO | 0122 : 0000 : 0000 : 0000 : 0000 @ 0000 @ 0000 @ 0000 @ oood @ oooo

- Frame capture filters can be set from 1 to 4. All frames are recorded if no frame capture filter is set. If you want
to record by selecting a frame, set the frame filter.
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- For each filter, refer to the description in the table below.

Member name

Value

combination

Use 0x0001 for the first frame capture filter item

OR(0x0002): It decides whether to receive or not by OR condition with the result of the previous frame capture
filter item

AND(0x0003): It decides whether to receive or not by OR condition with the result of the previous frame capture
filter item

Logic

Set the conditions of the set capture filter.
- EQUAL (0x0000): Record the frame when the field area of the inspected frame is the same.
- NOT EQUAL (0x0001): Record the frame when the field area of the inspected frame is not the same.

field

Specifies the field in the frame to condition on.

0X0000: As a user-specified area, the offset, length, and filter data of the frame to be compared must be specified.
0X0001: As a DST_MAC filter, it compares the destination MAC address range in the frame to be compared.
Enter the destination MAC address 6Byte in the filter data area.

0X0002: As a SRC_MAC filter, it compares the source MAC address range in the frame to be compared.

Enter the compared source MAC address 6Byte in the filter data area.

0X0003: As an Ether Type filter, it compares the Ethernet Type field in the frame to compare.

Enter Ether Type 2Byte to be compared in the filter data area.

0X0004: It is used to record the entire frame that is TCP.

There is no need to set offset, length and filter data.

0X0005: It is used to record the entire frame that is UDP.

There is no need to set offset, length and filter data.

0X0006: As an SRC_IP filter, if it is an IP protocol frame, the source IP field is compared.

Enter the compared source IP address 4Byte in the filter data area.

0X0007: As an DSP_IP filter, if it is an IP protocol frame, the source IP field is compared.

Enter the destination IP address 4Byte in the filter data area.

0X0008: As an SRC_IP filter, if it is an IP protocol frame, the send Port field is compared.

Enter port number 2Byte in the filter data area.

0X0009: As an DST_PORT filter, if it is an IP protocol frame, the destination Port field is compared. Enter port
number 2Byte in the filter data area.
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Only used when the Custom Area Frame filter is selected.

ffset )
Offse Enter the offset area where the data to be compared is located. (Input range: 0 to 127)
Lenath Only used when the Custom Area Frame filter is selected.
g Enter the length of data to compare. Up to 8 bytes
Reserved -
The value to be input differs depending on the Field setting. (Refer to Field Description.)
Ex) When entering the IP "192.168.1.10" value, enter 0XOAO1A8CO
Ex) When entering the IP "2.3.4.5" value, enter 0x05040302
Filter data Ex) When entering the Ether Type 0x0800 value, enter 0x00000800

Ex) When entering Port 2000 (0x07D), input 0x07D0
Ex) When entering Ethernet MAC address 00:E0:91:05:67:98, input 0x0591E000, 0x00009867
Ex) If user-defined filter is used, same as Ethernet MAC address.
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8.4.5 Ethernet option object

The structure of the Ethernet option object (Object ID :8) is as follows.

Ethernet option object (Object ID :8)

Offset 3 0

(1) ARP Permanent option Enable command using CP_MSG

- ARP Permanent Enable: 0x00000004

- If the ARP Permanent option is enabled, the MAC address stored in the cache will be continuously used without
re-updating if there is a relative MAC address in the ARP cache.

If the ARP permanent option is not enabled, the ARP cache will be updated every 400 seconds.
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Chapter 9 Toubleshooting

An explanation of how to check the causes of a failure or an error that may occur during system operation and measures.
The following procedure can be used to check the status of the Ethernet module. Please follow the troubleshooting

procedures to determine the abnormal module status.

(1) Error checking method by LED on the front of module
Check whether there is a problem with the Ethernet module by lighting the LED on the front of the Ethernet module.

(2) Error checking method by XG5000 connection(Only Ethernet module)

1) Error / Warning check during PLC operation
2) Error / Warning check during communication module operation.

- Error / Warning check during communication module operation(P2P/dedicated service)
- Error / Warning check during communication module operation(Smart Extension Service)

- Diagnostic variables during communication module operation(Smart Extension Service)

3) View Communication Module Log

(3) XGT dedicated communication error code(Only Ethernet module)
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9.1 LED Error Check

To check the fault or status of the module, check the status of the communication module according to the lighting status of

the LED.
9.11

Abnormal operation indication of XGL-EFMT / EFMF

LEDs on the front of the Ethernet module provide easy operation.

XG_—EFMT.
RUN- [
HS----[J---PC--[J------ | /F- [
POP- [ veeeeee e ™ O
PADT- [ J-- ERR-[J--------RX- [
10/100- .
LED Name Error contents Solution
1) Mounting error of Ethernet communication module
RUN LED off after PLC - Check if the DC 5V power supply of the power supply module is abnormal..
power on - Check if the communication module is installed in the base normally.
2) Use XG5000 to check if communication module is recognized properly.
LED on or off 1) Check if the CPU works normally
I/F during normal 2) Check if the communication module is installed in the base normally.
communication 3) Check that the information is correctly recognized by the xG5000.
1) Check if standard settings parameters of FEnet module are normally configured
Turned off durin by using XG5000.
P2P P2P service 9 2) Check if the function block / command is normal.
3) Check if the communication connection is normal.
4) Check if P2P link enable (allowed) of XG5000 menu is set.
. 1) Check if standard settings parameters of FEnet module are normally configured
Turmed off during bi/ using XG5000. P Y eoms
HS Qgcizgeed link 2) Check if HS link setting is normal.
3) Check if high speed link link enable (allowed) of XG5000 menu is set.
PADT -rreur::)?g ggciggng 1) Check if the IP address for remote connection is correct.
; 2) Check if remote connection is released with XG5000.
service
1) Check if the IP address for dedicated connection is correct.
PC Turned off during 2) Check if host table setting of standard settings is enabled and if it is enabled,
dedicated service | check if IP of MMI (PC) is registered in dedicated connection table.
3) Check if connection request is made in MMI (PC) device.
Turned on  after 1) Check if standard settings parameters of FEnet module are normally configured
ERR OWer on by using XG5000.
P 2) Check if there is any interface error with the CPU.
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9.1.2

Abnormal operation indication of XGL-EFMTB / EFMF

Checked by the LED on the front of the Ethernet module.

XGL-EFMTB
RUN

HS Bl SVR B rACT
P2P W RELAY B S |NK Wm
PADT B CHK -ZI:ACT

between relay ports

ERR HEN FAULT I Y N
LED Name Error contents Solution
1) Mounting error of Ethernet communication module
LED off after PLC - Check if the DC 5V power supply of the power supply module is abnormal..
power on - Check if the communication module is installed in the base normally.
RUN 2) Use XG5000 to check if communication module is recognized properly.
Flicker after PLC 1) Normal operation is impossible due to error after power on
power on - The power was turned ON, but a module error occurred. (V6.0 or higher)
Turned off during 1) Che;(l; |foségndard settings parameters of FEnet module are normally configured by
high speed link using XG5000. -
service 2) Check if HS link setting is normal.
HS 3) Check if high speed link link enable (allowed) of XG5000 menu is set.
Flicker during high : . . .
speed link service 1)Check if parameter is normal due to HS link parameter error. (V6.0 or higher)
1) Check if standard settings parameters of FEnet module are normally configured by
Turned off durin using XG5000.
: 9 2) Check if the function block / command is normal.
P2P service . s e
P2pP 3) Check if the communication connection is normal.
4) Check if P2P link enable (allowed) of XG5000 menu is set.
ng\ljiiredurmg p2P 1) Check whether the parameter is normal with P2P parameter error.. (V6.0 or higher)
PADT :-eur;r:)etg ggciggng 1) Check if the IP address for remote connection is correct.
service 2) Check if remote connection is released with XG5000.
ERR Turned on  after This is the LED which is turned on in the event of a critical error of the module.If the
power on phenomenon repeats after turning on the power again, request A/ S.
1) Check if the IP address for dedicated connection is correct.
SVR Turned off during 2) Check if host table setting of standard settings is enabled and if it is enabled, check
dedicated service if IP of HMI (PC) is registered in dedicated connection table.
3) Check if connection request is made in HMI (PC) device.
If the Relay option of the standard settings parameter is checked, if the speed of each
Ethernet port of Port 1 and Port 2 is the same, it is ON when the frame can be relayed
Communication Even if the Relay option is checked, it blinks (V6.0 or higher) if the media speed is
RELAY speed mismatch different between the two ports.

OFF if the Relay option is not checked.
* Since 10Mbps does not support relay function, Relay LED is turned off when Relay
option is checked at 10Mbps.




Chapter 9 Troubleshooting

LED Name

Error contents

Solution

CHK

Turned on after
power on

1) Check if the IP redundancy setting is on the same network. (V5.0 or higher)

2) Check if the media of the standard settings parameter and the product have the
same media type.

3) Check the RAPIEnet slave parameters for errors. (V6.0 or higher)

4) Check the RAPIEnet slave parameters for errors. (V6.0 or higher)

5) A packet receiving overload has occurred. Check communication line and
communication data

Flicker during
communication

1) Check if RAPIEnet network connection status is changed from Ring to Line.(V6.0
or higher)

2) Check if the module which has disabled EB or module swap (hot swap) option
has been detached while the smart extension service is in operation. (V8.0 or
higher)

FAULT

Flicker during
communication

1) Check the communication cable and Ethernet connection.

2) Check the network status and the communication module history.

3) Check the error status of the EB with the 'EB or module exchange (hot swap) in
operation’ option enabled during the smart expansion service EB. The error status
of EB can be checked conveniently using diagnostic variables. For details on the
operation of diagnostic variables according to the ‘EB or module exchange (hot
swap) option during operation’, refer to ‘4.3.3 Diagnosis variable operation
according to the EB or module exchange (hot swap) option during operation’.

ON

1) Check if the station number of RAPIEnet self station no. And other RAPIEnet
device is overlapped.(V6.0 or higher)

2) Check if the IP redundancy setting is on the same network. (V6.0 or higher)

3) Check the error status of the EB with the 'EB or module exchange (hot swap) in
operation' option Disable during the smart expansion service EB. The error status
of EB can be checked conveniently using diagnostic variables. For details on the
operation of diagnostic variables according to the ‘EB or module exchange (hot
swap) option during operation’, refer to ‘4.3.3 Diagnosis variable operation
according to the EB or module exchange (hot swap) option during operation’.

ACT

Turned off during
communication

Turns off when there is no frame send or receive.

LNK

Turned off during
communication

Check the communication cable connection status (host station / destination side).
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9.1.3 Abnormal operation display of XGL-EH5T

Check the normal operation through the LED on the front of the switch module.

XGL-EH5T
PWR HH

[ACT -2|:ACT [
INK HI S INK .
ACT HE rACT -S[ACT [
INK HEE S NK S N -

The switch module only needs to be powered from the base and no parameter setting is required.
If all LEDs except the power LED of the switch module blink once after the power is applied, the switch module is normal.

LED contents

Error contents

Solution

LED off after PLC

1) Mounting error of Switch module

PWR owWer on - Check if the DC 5V power supply of the power supply module is abnormal..
P - Check if the communication module is installed in the base normally.
1) Check if the cable is properly connected to the port.
ACT LED Off LED is not On when not connected
2) Make sure the data is sent and received normally
LNK LED Off 1) Check if the cable is properly connected to the port.

LED is not On when not connected
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9.1.4 Abnormal operation display of XOL-ES4T/ES4H

Check the normal operation through the LED on the front of the switch module.

XOL-ES4H

1G(T) mm 1G(F)mm RUN HH
RING1 m RING2EE ERR mm
RELAY]1 M RELAY?EEE FAULT mmm

The switch module only needs to be powered from the base and no parameter setting is required.

LED contents Error contents Solution
RUN LED off after PLC 1) Mounting error of Switch module
power on - Check if the DC 24V power supply of the power supply module is abnormal..
1) Check if the cable is properly connected to the port.
ERR LED Off LED is not On when not connected
2) Make sure the data is sent and received normally
FAULT LED Off 1) Reconfirm the station number due to collision with MRS station number of
the same network.
1) Channel 1 and 2 are connected by 100M.
16 LED Off 2) Channel 3 and 4 are connected by 100M.
. 1) Channel 1 and 2 are connected in a line topology.
RING LED offfflicker 2) Channel 3 and 4 are connected in a line topology.
1) This is the case when channels 1 and 2 do not operate as a relay.
RELAY LED Off 2) This is the case when channels 3 and 4 do not operate as a relay.
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9.2 Error checking method by XG5000 connection

9.2.1 Error/ Warning check during PLC operation

By XG5000 program, you can monitor the communication module abnormally. After connecting to CPU port, check through
[Online]-—>[Diagnostics ] [PLC History] and [PLC Error / Warning] of XG5000.

Error/Warning - LSPLC ? X

Errar/Warning Error Log

Category Code |State  Contents
31 Error  Module detach error

Dretails/Corrective Action

Check if the medule is installed correctly and reset the PLC, and then try again.
[Base 0, Slot 3]

v] Always Notify Error/Warning Save file

If the module has hardware error or CPU interface error, the LED of the communication module itself is abnormal. Also
programs also provide a quick way to see status information. The above figure is error / warning information that can be
checked through [PLC History] of [Online] menu of XG5000.
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(1) Error / Warning check during XGK CPU module operation

Operation
Code Cause of error Action (Restart Mode After Action) gtatus LED status Diagnostics point
If the same error repeats when power is turned Blink in full LED
2 Data Bus Error . . Error Power on
on again, A/S is requested. order
If the same error repeats when power is turned Blink in full LED
3 Data RAM Error . . Error Power on
on again, A/S is requested. order
If the same error repeats when power is turned
4 | Clock IC (RTC) Error ) ) Error ERR: ON Power on
on again, A/S is requested.
If the same error repeats when power is turned
6 Program memory error . . Error ERR : ON Power on
on again, A/S is requested.
If the same error repeats when power is turned
10 |USBIC error . . Error ERR : ON Power on
on again, A/S is requested.
If the same error repeats when power is turned
11 |backup RAM Error i ) Error ERR : ON Power on
on again, A/S is requested.
If the same error repeats when power is turned
12 | backup Flash Error . ) Error ERR: ON Power on
on again, A/S is requested.
) i If the same error repeats when power is turned Power on
13 |Base information error . . STOP ERR : ON
on again, A/S is requested. RUN mode change
Backup flash memory|Restart after modifyin rogram of backu RUN mode change
22 P Y fing  prog . Error ERR: ON g
program error Flash after reset
Start after reloading the program
Replace the battery if there is something wrong
i with the battery RUN mode change
23 | Program execution error ) . STOP ERR : ON
After reloading the program and checking the after reset
storage status, if there is an error, replace the
CPU module.
Start after reloading I/O parameter
Battery change if battery has a problem.
i RUN mode change
24 |1/O parameter error Check the preservation status after I/O|STOP ERR: ON after reset
parameter reloading and if error occurs, change
the CPU module.
Start after reloading basic parameters
Replace the battery if there is something wrong
i with the battery RUN mode change
25 | Basic parameter error ) . . |STOP ERR: ON
After reloading basic parameters and checking after reset
the storage status, if there is an error, replace
the CPU module.
Exceed execution range | Restart after downloading program RUN mode change
26 ) ) STOP ERR: ON
error If it occurs repeatedly, request service center. after reset
i Start after reloading program. RUN mode change
27 | Compile error ) i STOP ERR: ON
If it occurs repeatedly, request service center. after reset
i After checking the wrong position of slot by
Module set in parameter i
] XG5000, modify the module or parameter and | STOP ERR : ON
30 |and the installed module RUN mode change
then restart. (RUN) (P.S.: ON)

does not match.

Reference flag: module type mismatch error flag
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Module falling during

After checking the position of falling/adding slot
by XG5000, modify the installation status of

Reference flag: Fuse break error flag

) . ) STOP ERR: ON
31 |operation or additional| module and then restart (according to Scan end
(RUN) (P.S.: ON)
setup parameter).
Reference flag: Module detach error flag
| After checking the position of slot where the fuse
Fuse cutoff of fuse built-
. . cutoff occurs by XG5000, change the fuse and | STOP ERR : ON
32 |in module during i Scan end
) then restart (according to parameter). (RUN) (P.S.: ON)
operation

9-9
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Run
Code Cause of error Action (Restart Mode After Action) S LED status Diagnostics point
After checking the position of slot where
the access error occurs by XG5000,
Data of I/O module does )
.| change the module and restart (according| STOP [ERR : ON
33 | not access normally during Scan end
) to the parameter). (RUN) [(P.S.:ON)
operation. )
Reference flag: | / O module read / write
error flag
Check the location of the slot where
Normal access of access error occurred with XG5000,
34 special/llink module data replace the module and restart STOP | ERR: ON Scan end
during operation not (according to the parameter). (RUN) [ (P.S.:ON)
available. Reference flag: Special /
Communication Module Interface Error
Abnormal system shutdown due to noise
or hardware failure
Abnormal stop of CPU or . RUN: ON
39 i 1) If it occurs repeatedly when power STOP Always
malfunction ) . ERR: ON
reinput, request service center
2) Noise measures
Scan time of program After checking the scan watchdog time
during operation exceeds | designated by parameter, modify the RUN: ON i
40 ) STOP In operation
the scan watchdog time parameter or the program and then ERR : ON
designated by parameter. | restart.
Operation error occurs i
. . Remove calculation error-> Redownload RUN: ON .
41 | while running the user STOP In operation
Program and Restart ERR : ON
program.
The stack exceeds the
. RUN: ON )
42 normal range while Restart STOP In operation
) ERR : ON
running the program
i Reset after confirming the base setting RUN mode change after
43 Base double setting error . STOP | ERR: ON
switch reset
i i Start after modifying / re-downloading STOP | RUN: ON
44 Timer index user error . . Scan end
the timer index program (RUN) | ERR:ON
) . Repair and restart the wrong device by
Detecting critical error of ) )
. referring to the fault detection flag of the | STOP | ERR: ON
50 external device by user ) . Scan end
) ) external device (according to the (RUN) | (P.S.:ON)
program during operation
parameter).
The number of tasks If it occurs repeatedly after restarting,
. . . . STOP | ERR: ON .
55 | waiting to run exceeds check the installation environment In operation
. . ) . (RUN) | (P.S.: ON)
the specified range if error continues, request service center
) Remove the error factor that triggered
E_STOP function . RUN: ON .
60 - the E_STOP function in the program STOP In operation
executed . ERR : ON
and turn the power on again
When STOP: Correct the program by
. checking the operation error details with | STOP | ERR: ON .
61 Operation error In operation
XG5000.. (RUN) | (P.S.:ON)

When RUN: Refer to error step of F area
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If the battery is OK, turn the power back
Data memory backup not
500 . on. STOP | ERR:ON Reset
possible . .
Switch to STOP mode in remote mode
If there is no problem with the battery,
501 | Clock data abnormal resetting the time with a device such as - CHK: ON Always
XG5000.
Battery change in the state of power
502 | Low battery voltage input - BAT: ON Always
input.
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(2) Error / Warning check during XGI CPU module operation

Operation
Code Cause of error Action (Restart Mode After Action) gtatus LED status Diagnostics point
If the same error repeats when power is turned Blink in full LED
2 Data Bus Error . . Error Power on
on again, A/S is requested. order
If the same error repeats when power is turned Blink in full LED
3 Data RAM Error . . Error Power on
on again, A/S is requested. order
If the same error repeats when power is turned
4 |[Clock IC (RTC) Error ) ) Error ERR: ON Power on
on again, A/S is requested.
If the same error repeats when power is turned
6 Program memory error . . Error ERR : ON Power on
on again, A/S is requested.
If the same error repeats when power is turned
10 |USB IC error ] ) Error ERR : ON Power on
on again, A/S is requested.
If the same error repeats when power is turned
11 |backup RAM Error ) ) Error ERR : ON Power on
on again, A/S is requested.
If the same error repeats when power is turned
12 | backup Flash Error ) ) Error ERR: ON Power on
on again, A/S is requested.
i ) If the same error repeats when power is turned Power on
13 |Base information error ] ) STOP ERR : ON
on again, A/S is requested. RUN mode change
Backup flash memory|Restart after modifyin rogram of backu RUN mode change
22 P y fying prog P Error ERR: ON g
program error Flash after reset
Start after reloading the program
Replace the battery if there is something wrong
i with the battery RUN mode change
23 |Program execution error ) ) STOP ERR : ON
After reloading the program and checking the after reset
storage status, if there is an error, replace the
CPU module.
Start after reloading I/0O parameter
Battery change if battery has a problem.
i RUN mode change
24 [1/O parameter error Check the preservation status after 1/O|STOP ERR : ON after reset
parameter reloading and if error occurs, change
the CPU module.
Start after reloading basic parameters
Replace the battery if there is something wrong
i with the battery RUN mode change
25 |Basic parameter error . ) . |STOP ERR: ON
After reloading basic parameters and checking after reset
the storage status, if there is an error, replace
the CPU module.
) After checking the wrong position of slot by
Module set in parameter i
) XG5000, modify the module or parameter and | STOP ERR: ON
30 |and the installed module RUN mode change
then restart. (RUN) (P.S.: ON)
does not match. )
Reference flag: module type mismatch error flag
After checking the position of falling/adding slot
Module falling during [by XG5000, modify the installation status of
. o . STOP ERR : ON
31 |operation or additional| module and then restart (according to Scan end
(RUN) (P.S.: ON)

setup

parameter).
Reference flag: Module detach error flag
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After checking the position of slot where the fuse
) | cutoff occurs by XG5000, change the fuse and | STOP ERR: ON
32 |in module during . Scan end
. then restart (according to parameter). (RUN) (P.S.: ON)
operation

Reference flag: Fuse break error flag

Fuse cutoff of fuse built-
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Run
Code Cause of error Action (Restart Mode After Action) S LED status Diagnostics point
After checking the position of slot where
the access error occurs by XG5000,
Data of /0 module does )
.| change the module and restart (according| STOP [ERR : ON
33 |not access normally during Scan end
) to the parameter). (RUN) [(P.S.:ON)
operation. )
Reference flag: | / O module read / write
error flag
Check the location of the slot where
Normal access of access error occurred with XG5000,
34 special/llink module data replace the module and restart STOP | ERR: ON Scan end
during operation not (according to the parameter). (RUN) | (P.S.: ON)
available. Reference flag: Special /
Communication Module Interface Error
Abnormal system shutdown due to noise
or hardware failure
Abnormal stop of CPU or ) RUN: ON
39 i 1) If it occurs repeatedly when power STOP Always
malfunction . i ERR : ON
reinput, request service center
2) Noise measures
Scan time of program Check the the scan watchdog time time
during operation exceeds | specified by the parameter and Restart RUN: ON .
40 ) e STOP In operation
the scan watchdog time after modifying the parameter or ERR: ON
designated by parameter. | program.
Operation error occurs i
. . Remove calculation error-> Redownload | STOP | RUN: ON .
41 | while running the user In operation
Program and Restart (RUN) | ERR: ON
program.
The stack exceeds the
. RUN: ON .
42 normal range while Restart STOP In operation
) ERR : ON
running the program
) ) Start after modifying / re-downloading STOP | RUN: ON
44 Timer index user error ) ) Scan end
the timer index program (RUN) | ERR: ON
i i Repair and restart the wrong device by
Detecting critical error of ) )
) referring to the fault detection flag of the | STOP | ERR: ON
50 external device by user . ) Scan end
) ) external device (according to the (RUN) | (P.S.: ON)
program during operation
parameter).
) Remove the error factor that triggered
E_STOP function L RUN: ON .
60 the E_STOP function in the program STOP In operation
executed . ERR: ON
and turn the power on again
If the battery is OK, turn the power back
Data memory backup not
500 ) on. STOP | ERR: ON Reset
possible ) .
Switch to STOP mode in remote mode
If there is no problem with the battery,
501 | Clock data abnormal resetting the time with a device such as - CHK: ON Always
XG5000.
Battery change in the state of power
502 | Low battery voltage - BAT: ON Always

input.
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1) 1) Check the error No. 2 ~ 13 in the “Error code during CPU operation” at the AS center.
2) Error number 22 or less can be confirmed using the error history of XG5000.
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(3) Error / Warning check during XGR CPU module operation

Run

Code Cause of error Action (Restart Mode After Action) S LED status Diagnostics point
13 | Base information error A/ S request if repeated on power up STOP S013 Power on
RUN mode change
Start after reloading the program(Cold)
Replace the battery if there is something wrong
23 Program execution | with the battery(Cold) STOP £023 RfUN mode change
error After reloading | / O parameters and checking the after reset
storage status, if there is an error, replace the CPU
module(Cold)
Check the | / O parameters and the installed RUN mode change
24 [1/O parameter error | module to set and download the same | / O |STOP | E024 after reset
parameters as the mounted module
. i i RUN mode change
25 |Basic parameter error Start after reloading the. basic parameter(Cold) sSTOP £025 g
(Enable to download in STOP mode) after reset
Start after reloading the redundancy parameter
28 Redundancy Ing u Yy P STOP E028 Power on, .
parameter error (Do not check when downloading during run) program loading
Start after reloading the special parameter =)
29 | Special parameter error g P p _ STOP | EO029 oweron, -
(Do not check when downloading during run) program loading
Module set in Check the location of \{vrgng slot with XG5000 and Somer on
0 parameter and the restart after modifying _ _the module or sTOP £030 o
installed module does parameter.(Cold when modifying a progrm’n) (RUN) Program loading
not match Reference flag: Module type mismatch error Change RUN mode
flag(_IO_TYER, _IO_TYER_N, _IO_TYERRIn])
Restart the module after checking the position of
. . detach / additional slot with XG5000 and modifying
Module falling during ) .
. . the mounting status of the module.(accordingtothe | STOP
31 [operation or additional EO031 |Scanend
setup parameter) (RUN)
Reference flag: Module detach error flag
(_10_DEER,_IO_DEER_N,_|0_DEERR[n])
After checking the position of slot where the fuse
Fuse cutoff of fuse |cutoff occurs by XG5000, change the fuse and then
o . i STOP
32 |built-in module during | Restart (according to parameter). (RUN) E032 |Scanend
operation Reference flag: FUSE break error flag
(_FUSE_ER,_FUSE_ER_N, FUSE_ERR[n])
Power on, end of scan
Detach STOP, / , ,
36 etach efror on Extended cable detach error E036 |during program
extended base RUN .
operation
Ab L stop of CPU Power on,scan
39 normaisiop o A/ S request if repeated on power up - E039 |completion,
or malfunction )
In operation
Scan time of program | Check the the scan watchdog time time specified by
40 |during operation the parameter and after restart after modifying the| STOP | E040 |In operation

exceeds the scan

parameter or program.(Cold)
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watchdog time
designated by
parameter.

Operation error occurs

Remove calculation error-> Redownload

41 |while running the user STOP EO041 |In operation
program and restart
program.
. : Run LED . : .
Code Cause of error Action (Restart Mode After Action) Diagnostics point
status | status
Base double settin . : .
43 error g Check Expansion driver ID duplicates sToP | E043 | Poweron
Check power module installation when both | STOP,
45 | Base power error POW el on w E045 Power on
power modules are off RUN
A module that cannot be mounted on the base sTOP Power on, program
48 | Module position error is mounted. Please refer to the error history for "| E048 loading, change RUN
details. RUN mode
Critical error detection in external device
Detecting critical error of
ng e (_ ANNUN_ER,_ANC_ERRIn]) <TOP
50 external device by user _ _ '| Eoso | scan completion
program during Repair and restart the wrong device by RUN p
operation referring to the fault detection flag(according to
the parameter).
CPU module installation If the CPU module is mounted in an
101 . unmountable slot, move it to the correct [ STOP | S101 | Poweron
position error .. .
position to install
102 CPl_J module ID duplicate | Set the CPU module ID setting differently from stop | s102 | Poweron
setting error the counterpart CPU module
Configure the extension cable in a ring
topology, and restart the system after STOP
103 | Base abnormal error configuring the missing base normally. "| E103 | Inoperation
Please refer to Standby CPU error history RUN
for its detached base information.
Reconfigures Redundant system
i . * Check the Expansion driver module
System  configuration i Power on
104 Y 9 station number STOP | E104 ]
error _ . Scan completion
* Check O / S version between expansion
driver module and expansion manager
. . When enterin
Redundant system | When entering redundant operation or redundant o eratioi
300 | synchronous operation | between CPUs during operation Occurswhen | STOP | E300 P
or between CPUs
error the program and data are out of sync . .
during operation
When we Restart after by redundant operation
Standby CPU run error | *Set the standby CPU operation mode to .
When operating in
301 | occurs because of | STOP. STOP | E301
standby CPU
Master CPU error. *Release the master CPU error and restart
*Set the standby CPU operation mode to
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RUN.
When the standby CPU restarts in standalone
operation

Stop the master CPU (STOP or power off)

*Restart the standby or reset the operation mode to
STOP /RUN using the standby switch of the standby
CPU.

If there is no problem with the battery, resettin Power on,scan
501 | Clock data abnormal e 18 110 probiem i W, eSEENG | RuN | EsOL | O
the time with a device such as XG5000. completion
. Power on,scan
502 Low battery voltage Battery change with power on RUN E502 _
completion
] Check Expansion base power ]
bxx Expansion base error RUN Ebxx | operation

Check Expansion base cable
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9.2.2  Error / Warning check during communication module operation

By XG5000 program, you can monitor the communication module abnormally. Connect to CPU port and click [Online] >
[Communication module setting and diagnosis] = [System diagnosis] of XG5000. Thereafter, you can right-click the Ethernet
module in the PLC system and check it through the Block Status tab of [Status by Service] - [P2P Service]. Please refer to
E-mail error code when using E-mail service.

status by service x

Dedicated Service P2P Service HSLink Service  Smart Extension

Standard Information Service Information
Base Mo 0 Parameter existence: Exist Block in services: Z
Slat No.: 7 Parameter task status: DOWMNLOAD

Communication Diagnostics

Block number | Channel number | Connection Status | Packets per second | Service count | Error count Block status
0 0 CONNECT 1 48 12 OK(0x0000)
1 0 COMMNECT 1 47 12 P2P-Connection Request Error(0x
4 >
Dietails:

Stop reading | | efresh ‘
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(1) Error / Warning check during communication module operation(P2P/dedicated service)

Error code

Error contents

Solution

0x0000

Normal operation

0x0001

P2P-Communication
Error

1) Modbus registration failed in Modbus communication. If the problem persists,
please contact our Customer Centre.

2) The number of channels in the message in the server service (dedicated
communication) exceeded 1 Check the P2P block setting. (Up to 64 channels
are supported in V6.0 or higher.)

3) Email address error in Email service. Please check your email address

0x0002

P2P-Communication
Error

1) Modbus transmission size error occurred in Modbus communication. Check
the block setting.

2) Data type request error in P2P service. Check the block setting.

3) The message to send with the Email address book is not set in the Email
service. Check the address and message settings.

0x0003

P2P-Communication
Error

1) Device area request error. Check the block setting.

2) The server service (dedicated communication) is establishing a connection
with the server.

3) The number of blocks of XGT Cnet client (Cnet dedicated communication)
request message has been exceeded. Check the block setting.

4) Email service cannot connect to the email server. Check the IP address, ID,
password of the email server and check the network status.

0x0004

P2P-Communication
Error

1) The device area requested by the server service (dedicated communication)
has been exceeded. Check the block setting.

2) An error message was received from the server in Modbus communication.
Check the block setting (address, data size, etc.).

3) Check the variable length of the XGT Cnet client (Cnet dedicated
communication) request message.

0x0005

P2P - Time out error

1) The server service did not receive a response from the server (slave) station
within the response wait time. Check the communication settings.

When the server service received the response message from the server in
time, the server received an error message from the server because it exceeded
the maximum size (1400 bytes) of the single block. Check the block setting.
Email send failed in the email service. Check the network connection.

0x0006

P2P-Disconnection
notification

1) The server service has disconnection with the server (slave station). Check
the communication settings and connection status.

When the server service received the response message from the server in
time, the server received an error message from the server because it exceeded
the maximum size (1400 bytes) of the single block. Check the block setting.

0x0007

Server service - Data
type error

1) The Cnet client requested a data type that is not supported by the server
CPU. Check the block setting.

2) It was downloaded without using “E-mail” in Email setup window. Select "Use
E-mail" to use.

0x0008

Dedicated Server -
Address type error

There is an error in the address format set in XGT Cnet client (Cnet dedicated
communication). Check the block setting.

0x0010

P2P-XGT server
communication or
download error

1) Downloading P2P parameter of XGT dedicated communication.
2) There is an error in the data type of the FEnet dedicated communication
request message. Check the block setting.
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Error code Error contents Solution
1) Data type of Enet dedicated communication request message and direct
P2P - communication variable of detail setting do not match Check the block setting.
0x0011 There is an error in the message data requested from XGT Cnet client (Cnet
error . o
dedicated communication). Check the data.
3) Check the data type of the XGT dedicated communication P2P block.
1) There is an error in the address format of the FEnet dedicated communication
OX0012 P2P - communication | request message. Check the block setting.
error 2) An error occurred during data transmission of the FEnet dedicated
communication. Check the server and network connection.
0x0013 P2P-Request error P2P block request information of XGT dedicated communication is wrong. If the
problem persists, please contact our Customer Center.
P2P-Event transmit There is a problem with the Ethernet transmission of the XGT dedicated
0x0015 SR i
error communication. If the problem persists, please contact our Customer Center.
P2P-Event receive There is a problem with the internal sending logic of the XGT dedicated
0x0016 SR ;
error communication. If the problem persists, please contact our Customer Center.
O0X0017 P2P-Connection XGT dedicated communication cannot establish connection with server. Check
request error the communication settings and network connection.
P2P-internal transmit The internal transmission frame number of FEnet dedicated communication has
0x0018 frame storage S : )
been exceeded. Check the communication settings and network connection.
exceeded
Periodic L The periodic communication service has already been registered by another
0x0020 communication block client. Please check the block settings
registration error ' gs.
Periodic i . . .
o The periodic communication block is out of the configurable range. Please
0x0021 communication block !
! check the block settings.
range setting error
Periodic The registered periodic communication block is already in operation. Please
0x0022 communication “start” . '
check the block settings.
command error
Periodic
communication There are no registered periodic communication blocks. Please check the block
OX0023 “ 9 1
STOP” command settings.
error
Periodic
communication There are no registered periodic communication blocks. Please check the block
0x0024 « » ;
DELETE” command | settings.
error
0x0030 CoS registration error CoS(Change of status) communication service has already been registered by
another client. Please check the block settings.
CoScomnmnmmmn The CoS (Change of status) communication block is out of the configurable
0x0031 block range setting Pl heck the block .
arror. range. Please check the block settings.
CoS communication | The registered CoS communication block is already in operation. Please check
OX0032 “ ” 1
start” command error | the block settings.
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Error code Error contents Solution
CoS communication . —
0x0033 “STOP” command The.re are no registered CoS communication blocks. Please check the block
settings.
error
CoS communication . -
0x0034 “DELETE” command The.re are no registered CoS communication blocks. Please check the block
settings.
error
P2P-Exceeded The maximum number of connections that can be connected to XGT dedicated
0x0051 maximum number of | communication has been exceeded. Check the number of connections. If the
connection problem persists, please contact our Customer Center.
0X0062 P2P-Channel error There is an error in the channel set in XGT dedicated communication. Check
the channel settings.
P2P-Rece|ved XGT The CompanyID is set incorrectly in the request Message header for FEnet
0x0075 dedicated error . o ;
dedicated communication. Check the settings.
reply message
PZR-Recelved XGT The size of the request Message header for FEnet dedicated communication is
0x0076 dedicated error reply | . .
incorrect. Check the settings.
message
PZR-Recelved XGT Checksum in the request Message header of FEnet dedicated communication is
0x0077 dedicated error reply set incorrectly. Check the settings
message Y- gs-
P2P_-Rece|ved XGT The command Message header of FEnet dedicated communication is set
0x0078 dedicated error reply | . .
incorrectly. Check the settings.
message
Ded|_cated Seryer ) there is a problem in monitor execution registration request of XGT Cnet client
0x0090 Monitor execution : L )
error (Cnet dedicated communication). Check the settings.
OXOOEO P2P-Buffer Error There was a problem when aIIocatlr)g an internal buffer for FEnet dedicated
communication. If the problem persists, please contact our Customer Centre.
Dedicated Server - The monitor registration number to be executed by XGT Cnet client (Cnet
0x0190 Monitor execution dedicated communication) has exceeded the maximum value Check the
register number error | settings.
Dedicated Server - The monitor registration number to be executed by XGT Cnet client (Cnet
0x0290 Monitor registration dedicated communication) has exceeded the maximum value Check the
error settings.
0x1132 Dedicated Server - The XGT Chnet client (Cnet dedicated communication) attempted to access a
Device type error device area that is not supported by the server CPU. Check the settings.
0x1232 Dedicated Server - The maximum data size (120Byte) that can be requested in XGT Cnet client
Data size error (Cnet dedicated communication) is exceeded. Check the settings.
Dedicated Server - XGT Cnet client (Cnet dedicated communication) has exceeded the designated
0x1234 ; .
Extra frame error data size of the server. Check the settings.
0x1332 Dedicated Server - There is an error in data type of single read / write in XGT Cnet client (Cnet
Data type mismatch dedicated communication). Check the settings.
Dedicated Server - XGT Cnet client (Cnet dedicated communication) received hexa conversion
0x1432 . )
HEX conversion error | error message from server. Check the settings.
OX5D52 P2P-Email parameter | It was downloaded without using “E-mail” in Email setup window. Select "Use E-

download error

mail" to use.
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Error code Error contents Solution
Dedicated Sewer ) The device area requested by XGT Cnet client (Cnet dedicated communication)
0x7132 Excess of variable :
has been exceeded. Check the settings.
requested area error
. The communication module sent a message to the CPU, but there was no
0x8123 Server timeout error . ; o
response. Please try increasing the communication cycle.
The communication module sent a message to the CPU, but the QUEUE was
0x8124 Drop request message full and the message was dropped. Please try increasing the communication
cycle.
0xB001 P2P - Data type error Check the block data type in XGT Cnet client (Cnet dedicated communication).
P2P driver type is not set in XGT Cnet client (Cnet dedicated communication)
0xB002 P2P - Driver type error Check if the basic parameter is set to P2P and driver type of P2P channel
setting.
P2P - Command type An unsupported P2P instruction was attempted in the XGT Cnet client (Cnet
0xB003 : L )
error dedicated communication). Check the block setting.
P2P - Block number The block number settable in XGT Cnet client (Cnet dedicated communication)
0xB004
error has been exceeded. Check the P2P parameter.
There is an error in the User frame definition parameter in XGT Cnet client
OxBOOS P2P - Segment error (Cnet dedicated communication). Check the parameter.
OXBO06 P2P - Block size error Check th_e bl_ock size setting in XGT Cnet client (Cnet dedicated
communication).
i . In XGT Chnet client (Cnet dedicated communication), unsupported function code
OxBOOY P2P - Function type error is used. Check the block setting.
0xB008 P2P - Block station The maximum station number was exceeded in XGT Cnet client (Cnet
number setting error dedicated communication). Check the block setting.
P2P - Received incorrect It is not a response to the frame requested from XGT Cnet client (Cnet
0xB025 response frame for the ; I .
dedicated communication). Check the server settings.
reguest.
P2P - Received delayed | Delayed response frame was received from XGT Cnet client (Cnet dedicated
0xB026 " . L
response communication). Check the Reception waiting time
OXEOOL P2P-Process error There is a pr_oblem with the client m_ternal logic in FEnet dedicated
communication. If the problem persists, please contact our Customer Centre.
OXEQ04 P2P - Driver type error P2P driver type is not setin FEnet dedicated communication. Check driver type
of P2P channel setting.
P2P - Command type P2P command not supported in FEnet dedicated communication was
O0xE005 .
error requested. Check the block setting.
OxE006 P2P - Data type error Incorrect data type in FEnet dedicated communication. Check data type
OXEQ07 P2P-Request buffer full FEnet dedicated communication is unable to process the requested data. Check
the server and network connection.
P2P-User defined server | In user frame definition communication, the server cannot send data before
0xE020 ; ; ) . ! ) )
transmit error making a connection. First, establish a connection on the other client.
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Error code Error contents Solution
. FEnet has a connection with a server in dedicated / user frame definition
OxE022 P2P-Connecting communication.
OXE024 P2P-XGT dedicated An error occurred during data send in FEnet dedicated communication. Check
protocol transmit error | the network connection.
OXEO25 P2P-Modbus protocol An error occurred during Modbus data send during Modbus communication.
transmit error Check the network status.
OXE026 P2P-User frame An error occurred during data transmission in user frame definition
definition send error communication. Check the server and network connection.
P2P - Transmission An error occurred during data send in FEnet dedicated communication. Check
OxE027 )
error the network connection.
OXEO60 P2P-User defined The data size set in user frame definition communication exceeded the
protocol size error maximum size (1024byte). Adjust the data size
OXE170 P2P-Email parameter It was downloaded without using “E-mail” in Email setup window. Select "Use E-
download error mail" to use.
OXE171 P2P-Email parameter It was downloaded without using “E-mail” in Email setup window. Select "Use E-
setting error mail" to use.
OXE172 Erzz'eESr::"eagg&?;Zgzt There are no messages to send with the Email address book. Check the
error 9 address and message setting on XG5000 and try again.
OxE173 P2F_>-Em_a|I receiver An error occurred while registering the email receiver. Check the settings.
registration error
P2P-Email sender . o , :
OxE174 . . An error occurred while registering the email sender. Check the settings.
registration error
OXE175 P2P-Email initialization | An error occurred initializing the Email driver. If the problem persists, please
error contact our Customer Centre.
OXE176 P2P-Email address Wrong type of Email address requested. Please check your email
error address(Group or individual).
OXE177 P2P-Email message An invalid email message type was requested. Check the type of email
type error message.
P2P-Email server Can not connect to the Email server. Check the IP address, ID, password of the
OxE178 . .
connection error email server and check the network status.
OXE179 P2P-Email sending Email send failed in the email service. Check the communication connection
error status.
P2P- Data sending FEnet dedicated communication is unable to process the requested data. Check
OxFFD7 L -
buffer Full the communication connection status.
P2P- internal interlock | There is a problem with the client internal logic in FEnet dedicated
OxFFEB S .
error communication. If the problem persists, please request A/ S.
1) In user frame definition communication, the server cannot send data before
OXEEFE P2P-Error making a connection. First, establish a connection on the other client.
2) The data size set in user frame definition communication exceeded the
maximum size (1024byte). Check the data size

Notel) FEnet dedicated communication collectively refers to XGT server and XGT Enet client
Note2) XGT dedicated communication is collectively called FEnet dedicated communication and Cnet dedicated
communication.
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(2) Error / Warning check during communication module operation(Smart Extension Service)

By XG5000 program, you can monitor the communication module abnormally. Connect to CPU port and click [Online]
- [Communication module setting and diagnosis] = [System diagnosis] of XG5000. Thereafter, you can right-click
the Ethernet module in the PLC system and check it through the Block Status tab of [Status by Service] > [Smart

Extension)].

Status by service

Dedicated Service P2P Service HS Link Service  Smart Extension

Standard Information

Service Information

Base Mo 0 Service Status: Enable
Slot No.: SCAN MAX: 29 ms SCAN MIN: 0.2 ms SCAN CURR: 0.7 ms
EB No. Protocol Station No.JIP Service EB Status Service Count Error Count | EB Detach Coun ~
=} 1 RAPIEnet 1 V0 service WORKING 148 0 0
+lf 2 RAFIENet 2 V0 service WORKING 148 0 0
lf 3 RAPIEnet 3 /0 service WORKING 148 0 0
It 4 RAPIENet 4 10 service WORKING 148 0 0
|_ i | siot No. Type Slot Flag
i 0 i GEL-D24C
I} 5 | RAPEnet 5 T I0 service "WORKING 7148 0 0
-t 6 | RAPEnet i { VO service | WORKING 148 0 0
|_ i | siotNo. Type | Slot Flag
| 0 | GEL-TRAC(1}
+E 7 | RAPEnet 7 {0 service T WORKING 7148 0 0 &
< >
Details:
Save File Clear Scan Clear Flag Read Refresh
Close
Describes each item on the screen above
ltem Contents
Base Number Displays the base number on which the Ethernet module is mounted.

Slot No.

Displays the slot number on which the Ethernet module is mounted.

Service status

Displays the enabled status of the Smart extension service.
- Types of service status and descriptions are as follows.

Service status type

Description

Enable

Smart extension service is working.

Disable The operation of the Smart extension service has stopped.
SCAN MAX Smart extension service displays the maximum scan cycle of the network.
SCAN MIN Smart extension service displays the minimum scan cycle of the network.
SCAN CURR Smart extension service displays the current scan cycle of the network.
EB No. Displays the EB number of the communication device.
Protocol Displays the protocol type used for connection with the communication device.

Station No/IP

Displays the station number / IP of the communication device.
- Displays the station number when the protocol type is RAPIEnet.
- Displays the IP address when the protocol type is EtherNet / IP.

Service

Displays currently active services.
- I/O service: Service provided by communication device with Smart Extension function
- Event service: EtherNet / IP Client Service
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ltem

Contents

EB status

Displays the current EB status.

Service status

Description

IDLE The communication device (slave) to be controlled is not
recognized in the network.

DETECTING Looking for communication device (slave).

STATE CFM The communication device has been checked.

PRM_DONE Parameter download has been completed to the

communication device.

|IO_PRM_MISS_MATCH

The 1/ O list of the reserved parameters and the | / O list
installed in the communication device are different.

WORKING It is a state that normally performs Smart extension
service.
DETACH The Communication device is detached during the control.

Service count

Displays the service operation counts currently.

Error count

Displays the count of errors that have occurred currently.

EB detachment count

Displays the EB detachment counts that have occurred currently.

EB flag Flag is displayed according to the type of error occurred when an error occurs in EB.
Slot No. (slot) Displays the slot number (EB).
Type(slot) Displays the module type installed in the slot (EB).
- For EtherNet / IP EIP ) clients, displays the service type.
Status(slot) Displays the service status of the slot (EB).

Block Status(slot)

Display the status of that service block.
- This feature is only available for EIP clients.

Error code (Slot)

The error code of the service is displayed.
- This feature is only available for EIP clients.

Service count(slot)

The service count of the service is displayed.
- This feature is only available for EIP clients.

Error count(Slot)

The error count of the service is displayed.
- This feature is only available for EIP clients.

Slot flag (slot)

Flag is displayed according to the type of error occurred when an error occurs in slot.

File save Saves the current status of Smart extension service as a file.
Clear scan Initializes the scan information.

Initializes the SCAN MAX and SCAN MIN values.
Clear flag Initialize the EB flag and slot flag (slot).

- Error flag history is initialized.

Continuous reading

Smart extension service status is updated continuously.
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(3) Diagnostic variables during communication module operation(Smart Extension Service)

Smart extension service can check error-related diagnostic variable (EB flag) in diagnosis variable and Status by
Service. See the table below for the corrective actions for the errors identified in the diagnostic variables (EB flags).
If the same error occurs after the measures below, request A/ S.

Smart Extension
! Master Setting Format: Hexadecimal - |\c'ariableSetting|| synchronize |

Communication Device Settings
Allocate Input/Output Varizbles
Allocate Diagnostic Variables
Connection View

EIP Cycle/Details

EB Mo. | Station MoAP Variable Kind Variable name Type Device Monitor value Comment
EBO0 oI 0M192168.1.2  System diag L]

_0001_STATUS_CHG_CNT UINT D01500 AOE =S L1|E$45£"QE}'|’"'5§ 5
_D001_SCAN_MAX UINT D01501 2 0§ 276 Z7] (100us)

0001 SCAN MiN UiNT B01502 A0 E S8 Ha A7 7] (100us)
0001 _SCAN_CUR UINT D01503 = R A7 Z7] (100us)
_0001_SYSTEM_ER BIT D01504.0 A0S Z4 A H EB 02

0007 SYSTEM WAR BIT D01504.1

"0001_EB_DEER BIT D01504.2 ADE 54 8% S EB S

D001 EB_BASE INFO_ER BIT D015043 A Hj O]~ HE 6

0001 0 TYER BIT D01504.4 AH{E R G B b

0001 10_DEER BIT DO15045 iogEoE

0001 FUSE ER BT D01504.6
0001 _REF_TIME_OUT BIT D01504.7 AO[E F4 S A Bl of2
_0001_EB_CRC_ER BIT D01504.8 A0S Z4 EBCRC 03 2o =
0001 TAG_ER BIT D01504.9
0001 _EB_CFG_ER BIT D01504.A
"0001_EB_DETACH WAR BIT D01504 8
18 _0001_I0_DETACH_WAR BIT D01504.C 20E S 235 08 2
19 | "0001_FUSE_WAR BIT D01504D AOE EE SHEFUSE H
20 | 0001 STATUS CHE CNT CLR T BIT D01505.8 AGE SE HE S SEj HA 2l
21 | 0001 REF_TIME_OUT_CLR T BIT D01505.C AD[E Fi S L] BHol oj 2 &
22 | _0001_EB_CRC_ER_CLR BIT D01505.0 ADE £4 EB CRCOID 220 =
123 | 00071 SCAN_CLR BIT DO1505.E
124 | "0001_FLAG. CLR BIT DO1505F
25 | 0001 _EB_FR_W0 WORD T8l Do1506 S ER G2 EB00 ~ B85
(12 | "0001_EB_ER_WA1 WORD 18] Doi507 ~OrE £5 ER 02 EB16 ~ EB31
59 | _0001_EB_ER_W2 WORD 18] Do1508 'ER 0j2{ EB32 - EB4T
] » |76 | 0001 EB ER W3 WORD ¥ Do1509 A0PE £% EB 02 EB48 ~ EBA3
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Diagnostic Variable name Corrective Measure
variables

Check the network connection.
1) System check including smart extension network cable

_BBSS_SYSTEM_E | 2) Check the power status of devices in the network

R
* Allocate diagnostic variables depend on the setting of the EB or m

odule swap(hot swap) option during operation. For more information,
refer to '4.4.3 Diagnosis Variable Action by EB or Module Change (H
ot Swap) Option'.

Check the network connection.
1) System check including smart extension network cable

_BBSS_SYSTEM_W | 2) Check the power status of devices in the network

AR

Allocate diagnostic variables depend on the setting of the EB or mod
ule swap(hot swap) option during operation. For more information, re
fer to '4.4.3 Diagnosis Variable Action by EB or Module Change (Hot
Swap) Option'.
Check the network connection.
1) System check including smart extension network cable

System di . .

: 2) Check the power status of devices in the network
agnosis _BBSS_EB_DEER ) P

Allocate diagnostic variables depend on the setting of the EB or mod
ule swap(hot swap) option during operation. For more information, re
fer to '4.4.3 Diagnosis Variable Action by EB or Module Change (Hot
Swap) Option'.

_BBSS _EB _BASE_| | Check the EB diagnostic variable and reapply the power to the EB w
NFO_ER here BBSS EBXX_ BASE_INFO_ER occurred.

Check the EB diagnostic variable to see if the | / O parameter settin
_BBSS_IO_TYER g value of the communication device where _BBSS EBXX_IO_TYER
occurred matches the type of | / O module installed.

Check | / O module status of the communication device for which _B
BSS_EBXX_|I0_DEER occurred by checking the EB diagnostic variabl
e.

1) Check if 1 / O module is missing from communication device

_BBSS_IO_DEER 2) Check if I / O module failure of communication device

* Allocate diagnostic variables depend on the setting of the EB or m
odule swap(hot swap) option during operation. For more information,
refer to '4.4.3 Diagnosis Variable Action by EB or Module Change (H
ot Swap) Option'.
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9-29

Diagnostic Variable name Corrective Measure
variables
BBSS FUSE ER Replace | / O module Where 'Fhe FUSE error occurred among the | /
- - - O modules of the communication device.
Check the EB diagnostic variable to check the communication device
_BBSS_REF_TIME_ | for which _BBSS_EBXX_REF_TIME_OUT has occurred.
ouT
See Actions in EB Diagnostic Variables for action.
Check the network connection.
ﬁBBSS—EB—CRC—E 1) System check including smart extension network cable
2) Check the connection between the network cable and the module
BBSS TAG ER Downloa(_j EtherNet /1P tag (EIP tag) to XGL-EFMxB module for sma
- - - rt extension service operation.
Check the status of EB set in the smart expansion service.
ﬁBBSS—EB—CFG—E 1) Check the EB network detachment
System di 2) Check the Status of the EB error
agnosis

_BBSS_EB_DETAC
H_WAR

During operation, check the network connection for EB that have EB
or module swap (hot swap) settings enabled.

1) System check including smart extension network cable
2) Check the power status of devices in the network

* This diagnostic variable reflects only the status of EB or EB with m
odule exchange (hot swap) setting enabled during operation.

_BBSS_IO_DETACH
_WAR

Check the 1/O module status of the communication device where _BB
SS EBXX 10 _DEER occurred by checking the EB diagnostic variables
of EB that have EB or module exchange (hot swap) setting enabled
during operation.

1) Check if 1 / O module is missing from communication device
2) Check if 1 / O module failure of communication device

* This diagnostic variable reflects only the status of EB or EB with m
odule exchange (hot swap) setting enabled during operation.
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Diagnostic Variable name Corrective Measure
variables
During operation, replace the 1/0 module that has a FUSE error amo
ng the I/O modules of the EB or EB with module exchange (hot swa
BBSS FUSE WAR p) setting enabled.
* This diagnostic variable reflects only the status of EB or EB with m
odule exchange (hot swap) setting enabled during operation.
System di Check the diagnostic variable or EB flag of EB corresponding to the
agnosis WORD value where the error occurred.

_BBSS_EB_ER

Allocate diagnostic variables depend on the setting of the EB or mod
ule swap (hot swap) option during operation. For more information, r
efer to '4.4.3 Diagnosis Variable Action by EB or Module Change (Ho
t Swap) Option'.

_BBSS_EB_WAR

Check the diagnostic variable or EB flag of EB corresponding to the
ARRAY value where the warning occurred.
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Diagnostic
variables

Variable name

Corrective Measure

EB EB
diag
Diagn | nosti
osis cs

_BBSS_EBXX_CFG_ER

- At service initialization (including power up)
1) System check including smart extension network cable

2) Check the power state of the corresponding communication
device

- ‘Write’ during service operation

1) See action for I0_TYER (concurrent with I0_TYER)

_BBSS_EBXX_DEER

Check the network connection.
1) System check including smart extension network cable

2) Check the power status of devices in the network

_BBSS_EBXX_REF_TIME

—ouT

- Check the network connection of the relevant communication
device

1) System check including smart extension network cable
2) Check the power status of devices in the network

- Check the network load of the relevant communication devic
e.

1) Check if the network load meets the specifications of the p
roduct. Refer to '2.2.3 Load Specification' for load specification
and checking method.

* REF_TIME_OUT may occur when the smart extension servic
e does not operate normally due to other errors.

* When REF_TIME_OUT occurs, _BBSS_EB_WAR occurs, an
d the error counter of the corresponding EB is increased in t
he Smart extension tab of the service status.

* |If REF_TIME_OUT occurs consistently, EB detach (_ BBSS
EB_DEER, BBSS_EBXX_DEER) occur.

_BBSS_EBXX_P1_CRC_

ER

Check the network connection of PORT 1 of the correspondin
g communication device.

1) System check including smart extension network cable

2) Check the connection between the network cable and the
module
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Diagnostic Variable name Corrective Measure
variables
Check the network connection of PORT 2 of the correspondin
g communication device.
EEBSS—EBXX—PZ—CRC— 1) System check including smart extension network cable
2) Check the connection between the network cable and the
module
_BBSS_EBXX_BASE_INF | Reapply power to the communication device.
O_ER
EB
diag . o
nosti | _BBSS_EBXX_IO_TYER Che_ck that the |1 / O parameter settings of the communication
cs device and the mounted | / O module match.
Check | / O module status of the corresponding communicatio
n device.
_BBSS_EBXX_I0_DEER | 1) Check if 1 / O module is missing from communication devi
EB ce
Diagn 2) Check if I / O module failure of communication device
osis
_BBSS_EBXX_FUSE_ER | Replace | / O module where the FUSE error occurred.
_BBSS_EBXX_SYY_IO_T | Check that | / O parameter settings of the communication dev
YER ice and the mounted | / O module match.
Check |1 / O module status of the communication device.
_BBSS_EBXX_SYY_IO_D | 1) Check if 1 / O module is missing from communication devi
EER ce
Slot ) _ o _
2) Check if I / O module failure of communication device
_BBSS_EBXX_SYY_FUS | Replace | / O module.
E_ER
_BBSS_EBXX_SYY_SVC | Check EtherNet / IP communication settings.
_ER
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9.2.3 View Communication Module Log

Communication module history view function of XG5000 program can check whether error occurred and measures. Select
[Online] »>[Communication module setting] = [System Diagnosis] from XG5000. Right-click on the XGL-EFMxB module you
want to diagnose and select [View communication module log]. If you select the error occurrence history in the [Event History]
tab and the [Communication History] tab, you can check the details of the error and the corrective action in "Details and
Actions" below.

Module Log

Event History Communication Log  Error Frame Log

Standard Information Log Range

Base No lIl | Previous Log H First Log || Read All ‘
.

Slot No. | Next Log H Recent Log |
No Time Description -
55 03:29:486.. Smart Extension-Receive EtherNet/IP auto scan result (VendorlD: 258, DeviceType: 7, ProductType: 4.
56 03:29:48.6.. Smart Extension-Receive EtherMet/IP auto scan result (VendorlD: 259, DeviceType: roductType: 4.
57 03:29:486.. Smart Extension-Receive EtherNet/IP auto scan result (VendorlD: 258, DeviceType: 7, ProductType: 4.
58 03:29:48.6.. Smart Extension-Receive EtherMet/IP auto scan result (VendorlD: 259, DeviceType: 10, ProductType: .
59 03:29:486.. Smart Extension-Receive EtherNet/IP auto scan result (VendorlD: 258, DeviceType: 7, ProductType: 4.
60 03:29:48.6.. Smart Extension-Receive EtherMet/IP auto scan result (VendorlD: 259, DeviceType: 10, ProductType: .
61 03:29:486.. Smart Extension-Receive EtherNet/IP auto scan result (VendorlD: 258, DeviceType: 7, ProductType: 4.
62 03:29:48.6.. Smart Extension-Receive Etherhet/IP auto scan result (VendorlD: 258, DeviceType: 7, ProductType: 4.
63 03:29:48.6.. Smart Extension-Receive EtherMet/IP auto scan result (VendorlD: 259, DeviceType: 7, ProductType: 4.

=Y 03:31:29.8. Smart Extension-Response Waiting Timeout (OBJECT ID: 20, EB No.: 11, LINK ID: 0x140B0108)

65 03:31:34.8.. Server - Timeout error (Server: Smart extension)

66 03:31 Smart Extension-Response Waiting Timeout (OBJECT ID: 20, EB No. 14, LINK ID: 0x140E0184)

67 03:31 Server - Timeout error (Server: Smart extension)

68 03:31 Server - Timeout error (Server: Smart extension) -

Frame Data Details:

If you press [Frame Capture (C)] in the [Frame History] tab, you can start/stop frame capture, and if you read the history, you
can see the communication frame at the start-stop point. If you press [Save File (S)], it is saved as a txt file and can be
imported from “wireshark”.

Module Log

Event History Communication Log ~ Error Frame Log

Standard Information Select View Log Range
Base No 0 ® View by HEX [ Previousiog || Fistiog || Readal |
= Delete Log
Slot No. (O View by ASCII | Next Log H Recent Log ‘
Capture Frames

1 00 09 88 FE 4C 00 00 00 00 OC 00 81 00 00 OC 00 OC 00 85 A2
100 0D 28 FE 42 00 00 00 00 OF 00 81 00 00 0C 00 OC 00 85 AZ 0.
1 00 OA 88 FE 48 00 00 00 00 0B 00 81 00 00 0C 00 OC 00 85 A2 0
1 00 0C 88 FE 48 00 00 00 00 09 00 81 00 00 0C 00 OC 00 85 A2 0

144 202241
145 2022-11-17 03:32:59.8.. 00 0B 29 70 00 00 00 0B 29
146 2022-1 03:32:59.8.. 00 0B 29 70 00 00 00 0B 29
147 2022-11- 03:32:59.8.. 00 0B 29 70 00 00 00 0B 29

03:32:59.8.. 00 0B 29 70 00 00 00 0B 29

148 20221 03:32:59.8.. 00 0B 29 70 00 00 00 OB 29 71 BB BB 88 FE 4C 00 00 00 00 02 00 81 00 00 0C 00 OC 00 85 AZ 0.,
148 2022-11- 03:32:59.8.. 00 0B 29 70 00 00 00 0B 29 71 00 0B 88 FE 4C 00 00 00 00 OA 00 81 00 00 OC 00 OC 00 85 A2

150 202241 03:32:59.8.. 000B29700000000B2971 000888 FEG40000000005002100000C C00C 0035 A20..
151 2022-11- 03:32:59.8_. 00 0B 29 70 00 00 00 OB 29 71 00 04 88 FE 4C 00 00 00 00 04 00 81 00 00 0C 00 0OCO0B5 A2 0

152 2022-1 03:32:508_. 00 0B 29 70 00 00 00 OB 29 71 00 03 88 FE 48 00 00 00 00 03 00 81 00 00 OC 00 0C 00 85 A2 0.

153 2022-11-17 03:32:59.8.. 00 0B 29 70 00 00 00 OB 29 71 00 AA 88 FE 48 00 00 00 00 06 00 81 00 00 OC 00 0C 00 85 A2 ..

154 2022-1 03:32:59.8.. 00 0B 29 70 00 00 00 OB 29 71 00 07 88 FE 48 00 00 00 00 07 00 81 00 00 0C 00 0C 00 85 A2 0

155 2022-11-17 03:32:59.8.. 000B29700000000B 2971000228 FEG4 0000000002 00281 00 000C 00 0C 0085 AZ 0.
156  2022-1 03:32:59.8.. 00 0B 29 70 00 00 00 0B 29 71 00 01 88 FE 48 00 00 00 00 01 00 81 00 00 0OC 00 0C 00 85 A2 0

157 2022-11-17 03:32:59.8.. 000B29700000000B2971 0007 88FE7201 000000070081 00000C000C00B5000.. »

Frame Data Details:
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9.3 XGT dedicated communication error code

9.3.1

This is an error code that responds when an error occurs for a request for XGT dedicated communication beginning with

STATUS value that can be checked in communication frame

“LSIS-XGT” or “LGIS-GLOFA”".
The error code can be checked in the error code area of the NAK message.

Format Reserved Error code
Name Header | Command Data type area Error Status (Hex 2 Byte)
, , , h’FFFFor h’'O0FF ,
Code(ex) h’'0055 h’0002 h’0000 (Non-zero value) h’0004
0000 00 e0 91 02 00 21 00 0 91 O3 12 93 0B 00 45 00 ..... L e E.
0010 00 46 00 03 00 00 80 06 b8 96 cO a8 00 5a cO a8 B Z..
0020 00 6e 07 d4 bb 52 01 91 8e eF dc 6c 5c e3 50 18 B o PP = T L
0030 3Je B0 3c a3 00 00 i BE Sl BT A i S la i e .
WONYON01 01 A0 11 00 00 0a 00 04 1c 55 00 14 00 00 00
0050 f 00 04 00

Error number _
Decimal HEX Description
1 0x0001 The number of blocks exceeded 16 in single read / write requests.
2 0x0002 Received a data type other than X, B, W, D, L.
3 0x0003 If you request a device thatis not in service. (XGK: P, M, L, K, R..., XGl: I, Q, M....)
4 0x0004 It is the case that exceeded the supported area for each device.
5 0x0005 Read / write up to 1400 bytes at a time, if you request beyond this range.(Single block size)
6 0x0006 Read / write up to 1400 bytes at a time, if you request beyond this range.(Total size per block)
117 0x0075 The head of the frame header in the dedicated service is invalid (‘LSIS-GLOFA")
118 0x0076 The length of the frame header in the dedicated service is invalid
119 0x0077 The Checksum of the frame header in the dedicated service is invalid
120 0x0078 Incorrect command in dedicated service.

(1) When checking the value on the frame, the upper and lower bytes of the hexadecimal word data are swapped and
displayed. (Difference according to Endian)
Ex) h’'0054 =5400
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9.4 Troubleshooting by error

Trouble shooting method is to check the error history in XG5000 and LED status of Ethernet module and then take measures.

9.4.1 Troubleshooting

(1) Turn off the Run LED on the Ethernet module: hardware error

H/W error

the power supply
normal?

the installation
specifications?

Yes

the Etherne
module installed
correctly?

Check the power /

voltage

Complement the ‘
installation environment

No

Install the Ethernet
module correctly.

Yes

Restart the power

PO you get the same
error?

It is hardware error of
Ethernet module.
Contact A/ S center
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(2) I / F LEDs on the Ethernet Module do not flash: Interface error

C H/W error )

No
the power supply - Check the power /
normal? voltage
Does the installation No Eomply with the gensral

environment meet the
allation spec ificationa”

> standards for the | -

surrounding
environment.

Install Ethernet module

correctly on the base ———P»t
module.

Ethemet module installed
correctly on base module?

It is hardware error of
Ethernet or CPU module
. Contact A/ S center
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Chapter 10 EMC Standard

10.1 The requirements for compliance with EMC standards

The EMC Directive specifies the products must 'be so constructed that they do not cause excessive electromagnetic
interference (emissions) 'and 'are not unduly affected by electromagnetic interference (immunity)'. The applicable products
are requested to meet these requirements. This section summarizes the precautions on conformance to the EMC Directive
of the machinery assembled using XGT PLC series. The details of these precautions are based on the requirements and the
applicable standards control. However, LSIS will not guarantee that the overall machinery manufactured according to these
details conforms to the below-described directives. The method of conformance to the EMC directive and the judgment on
whether or not the machinery conforms to the EMC Directive must be determined finally by the manufacturer of the machinery

10.1.1 EMC Standard

The standards applicable to the EMC Directive are listed below.

Specifications Test item Test details Standard value
EN55011 Electromagnetic emissions from the 30~230 Mz QP: 50 dBV/m =1
Radiated noise *2 | product are measured 230~1000 Miz QP: 57 dBV/m
~ kHz 79 dB
EN50081-2 ENSS011 _ . 150 5.00 QP:79
Conducted EM Electromagnetic emissions from the Mean: 66 dB8
noise product to the power line is measured. 500~230 Mz QP : 73 dB
Mean: 60 dB
EN61000-4-2 Immunity test in which static electricity is 15 kV Aerial discharge
Electrostatic applied to the case of the equipment 8 KV Contact disch
immunity pp quip ontact discharge
EN61000-4-4 . . . L Power line: 2 kV
. Immunity test in which burst noise is . )
Fast transient burst lied to th i d sianal I Digital /O: 1 kV
noise applied to the power line and signal lines Analod 1/0. sianal lines: 1 kv
EN61131-2 g0, sig :
EN61000-4-3 Immunity test in which field is irradiated to | 10Vm,26~1000 M
Radiated field AM the product 80%AM modulation@ 1 kHz
modulation P oANM modulation
[E)I;Ir?]toe?joc-)i;:%llzatory Immunity test in which a damped oscillatory | Power line: 1 kV
wave immunity wave is superimposed on the power line Digital I/O (24V or higher): 1 kV
* 1. QP: Quasi-peak value, Mean: Average value

* 2:The PLC is an open type device (device installed to another device) and must be installed in a conductive control panel.
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10.1.2 Panel

The PLC is an open type device (device installed to another device) and must be installed in a control panel.
This is because an accident such as electric shock does not occur when a person comes into contact with the product (XGT
PLC), and the noise generated in the PLC has the effect of attenuating the control panel.

In the case of XGT PLC, it is necessary to install on a metal control panel in order to suppress electromagnetic waves (EMI)
emitted from the product.
The specifications for the control panel are as follows.

(1) Control Panel
The PLC control panel must have the following features

1) Use SPCC (Cold Rolled Mild Steel) for the control panel

2) The steel plate should be thicker than 1.6mm.

3) Use isolating transformers to protect the power supply from external surge voltage.

4) The control panel must have a structure which the radio waves does not leak out. For example, make the door
as a box-structure so that the panel body and the door are overlapped each other. This structure reduces the
surge voltage generate by PLC.

Panel

Door

=

5) To ensure good electrical contact with the control panel or base plate, mask painting and weld so that good
surface contact can be made between the panel and plate.

Seal

(2) Power and Earth Wiring

Earthing and power supply wires for the PLC system must be connected as described below.
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1) Earth the control panel with a thick wire so that a low impedance connection to ground can be ensured even

at high frequencies.

2) The function of LG (Line Ground) and FG (Frame Ground) terminals is to pass the noise generated in the
PLC system to the ground, so an impedance that is as low as possible must be ensured.
3) The earthing wire itself can generate the noise, so wire as short and thick to prevent from acting as an antenna.

10.1.3 Cable

(1) Extension cable processing

High-speed electrical signals flow through the extension cables of the XGT series. Therefore, high frequency noise
waves are radiated from this extension cable. To ensure CE conformity, attach ferrite cores as shown below to the

extension cable.

Ferrite core

Type Vendor Note
CU1330D E tech
ZCAT3035-1330 TDK

(3) How to fix the cable in the panel

When fixing the extension cable of the XGT series to the metal control panel, keep the extension cable at least 1 cm so
that the extension cable does not directly contact the metal plate. The metal plate of the control panel has a shielding
effect that blocks noise from radio waves, but it can also be a good antenna if a cable that is a source of noise is
connected nearby. The transmission cable for high speed signals, not limited to the extension cable, needs to be kept
as far as possible from the metal plate of the control panel
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10.2 Requirement to conform the Low-voltage Directive

The low-voltage directive requires each device that operates with the power supply ranging from 50V to 1000VAC and 75V
to 1500VDC to satisfy the safety requirements. Cautions and installation and wiring of the series PLC XGT series to conform
to the low-voltage directive are described in this section. However, LSIS will not guarantee that the overall machinery
manufactured according to the details conforms to the below-described directives. The method of conformance to the EMC
directive and compliance to the EMC Directive must be determined by the manufacturer of the machinery.

10.2.1 Standards applicable to XGT series

The XGT PLC complies with EN6100-1 (safety of equipment used in measurement and control laboratories. XGT series
PLCs have been developed in accordance with the above standards for modules operating at rated voltage of AC50V /
DC75V or higher.

10.2.2 Selection of XGT Series PLC

(1) Power supply module

There are dangerous voltages (higher than 42.4V peak) inside the power supply modules of the Rated input voltage
AC110/ 220Vtes. Therefore, the CE mark-compliant models feature enhanced insulation strong primary and secondary
windings.

(2) /0 Module

There are dangerous voltages (voltages higher than 42.4V peak) inside the I/O modules of the AC110/220V rated 1/O
voltages. Therefore, the CE mark-compliant models are enhanced in insulation internally between the primary and
secondary.

The I/O modules of DC24V Rated input are out of the low-voltage directive application range.

(3) CPU module ,base
Since the above modules use DC5V and 3.3V circuits internally, they are not subject to the low voltage command.
(4) Special, Communication module

Special and communication modules are DC24V or less in rated voltage, therefore they are out of the low-voltage
directive application range.
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Appendix

A.1 XGT CPU memory device list

For the latest CPU type devices, refer to the CPU manual. Also, for CPU models released after the writing of this
manual, please refer to the relevant CPU manual.

A.1.1 XGK CPU devices

Memory area of the CPU used for local data send / receive.

Local Device Type Range Size (Word) Read/Write
P PO - P2047 2048 R/W
M MO - M2047 2048 R/W
K KO - K2047 2048 R/W
F FO - F1023 1024 R
F F1024 - F2047 1024 R/W
T TO - T2047 2048 R/W
C CO0 - C2047 2048 R/W
u U00.00 - U7F.31 4096 R/W
z Z0- 27127 128 R/W
L LO-L11263 11264 R/W
N NO - N21503 21504 R/W
D(CPUH) DO - D32767 32768 R/W
D(CPUS) DO - D19999 20000 R/W
R RO - R32767 32768 R/W
ZR ZRO0 -ZR65535 65536 R/W
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A.1.2 XGIl CPU devices

Device Type Size Range Note
Symbolic variable 12K b )
area(A) > yte %AWO0~%AW262143 Up to 256K byte retainable
Input variable(l) 16K byte %IW0.0.0 ~ %IW127.15.3 -
Output
variable(Q) 16K byte %QW0.0.0 ~ %QW127.15.3 -
M 256K byte %MWO0~%MW131071 Up to 128K byte retainable
Direct R 64K byte * 2
memory w 128K byte %WWO~%WW65535 -
F 4K byte %FWO0~%FW2047 System flag
| K 16K byte %KWO0~%KW8399 PID flag
Fla
variabie | L 22K byte  |osl W0~9%LW11263 High speed link flag
N 42K byte %NWO~%NW25087 P2P flag
U 8K byte %UW?7.15.31 Analog refresh flag
A.1.3 XGR CPU devices
Local Device Type Size Range Note
Input variable(l) 16KB %IW0.0.0 ~ %IW127.15.3 |-
Output variable(Q) 16KB %QWO0.0.0 ~ %QW127.15.3 |-
Automatic ]
Variable(A) 512KB %AWO0~%AW262143  |Up to 256K retainable
M 256KB %MWO0~%MW131071  |Up to 128K retainable
Direct
variable | R 64KB * 2 block %RWO0~%RW32767  |64KB per block
Memory W 128KB %WWO~%WW65535 Same area as R
F 4KB %FWO0~%FW2047 System flag
K 18KB %K WO0~%KW8399 PID RUN area(PID 256 loop)
Flag L 22KB %L WO0~%LW11263 High speed link flag, P2P flag
variable
N 42KB %NWO0~%NW25087 P2P Parameter(XG5000 setting)
Analog data refresh area
0,
U 32KB pUW31.15.31 (31 base, 16 slot, 32 channel)
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A.2 Describes of terms

Before using this product, explain the general terms of Ethernet module. Please refer to the Ethernet technical
book for details.

eAuto-MDIX(Automatic Medium Dependent Interface Crossover) The type of Ethernet cable is divided into
Crossover Cable (TX-RX, RX-TX) and Straight Cable (TX-TX, RX-RX), where the TX / RX is interchanged based on
TX /RX. Communication of each network device is possible through connection of TX (node A) -RX (node B) / RX
(node A) -TX (node B), so it is impossible to communicate with Straight Cable. However, if there is a function that
can electrically exchange TX and RX in the connected node, it is possible to communicate with each other using
a straight cable, which is called Auto-MDIX.

* Auto-NegotiationEthernet is the process by which Ethernet devices exchange information about performance,
such as operation speed and duplex mode.

1) Find out why connection was denied

2) Determine the performance of your network equipment

3) Change connection speed

* ARP (Address Resolution Protocol)
Protocol to search for MAC address by means of correspondent IP address on the Ethernet LAN

* Bridge

A device used to connect two networks so to be operated as one network. Bridge is used not only to connect two
different types of networks but also to divide one big network into two small networks in order to increase the
performance

* Client
A user of the network service, or a computer or program (mainly the one requesting services) using other
computer's resource.

e CSMA/CD (Carrier Sense Multiple Access with Collision Detection)

Each client checks if there is any sign prior to transmission of data to the network (Carrier Sense) and then sends
its data when the network is empty. At this time, all the clients have the equal right to send (Multiple Access). If
two or more clients send data, collision may occur. The client who detects the collision tries to send again in a
specific time.

* DHCP ( Dynamic Host Configuration Protocol)

Communication protocol IP standard for automatically allocating and managing setting information necessary for
executing TCP / IP communication. Provides uniform management of IP addresses in telecommunication
networks in TCP / IP environments.
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* DNS (Domain Name System)
A method used to convert alphabetic Domain Name on the Internet to its identical Internet number (namely, IP
address).

* Dot Address
Shows IP address of ‘“100.100.100.100°, where each figure is displayed in decimal with 1 byte occupied
respectively for 4 bytes in total.

* Duplex
It means duplex communication that can send / receive in both directions. Separate the send and receive paths
so that they can operate without being affected by each other.

* EDS File
Abbreviation for Electronic Data Sheets, a file containing information about the device and its communication
settings.

e E-mail address

The address of the user with login account for the specific machine connected via the Internet. Usually user's ID
@ domain name (machine name) is assigned. In other words, it will be like hjjee@microsoft.com, where @ is
called as 'at’ displayed with shift+2 pressed on the keyboard. The letters at the back of @ are for the domain
name of specific company (school, institute,..) connected with the Internet, and the letters in front of @ are for the
user ID registered in the machine. The last letters of the domain name are for the highest level. USA generally
uses the following abbreviation as specified below, and Korea uses .kr to stand for Korea. com : usually for
companies) / .edu : usually for educational organizations such as universities. / .ac(academy) is mostly used in
Korea / .gov : for governmental organizations. For example, nasa.gov is for NASA (government) / .mil : military
related sites. For example, af.mil is for USA air force (military)/ .org : private organizations / .au : Australia/ .uk :
the United Kingdom / .ca: Canada/ .kr : Korea/ .jp : Japan / .fr : France / .tw : Taiwan, etc.

* Ethernet

A representative LAN connection system (IEEE 802.3) developed by Xerox, Intel and DEC of America which can
send about 10Mbps and use the packet of 1.5kB. Since Ethernet can allow various types of computers to be
connected as one via the network, it has been called a pronoun of LAN as a universal standard with various
products available, not limited to some specific companies

* Explicit Messaging

In addition to the explicit message and data, this message contains all the information that can be interpreted in
the frame.

(XGT EtherNet / IP module provides non-cycle client communication)

* FDDI (Fiber Distributed Data Interface)
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Based on optical cable, provides 100Mbps, Shared Media Network as Dual Ring method, Token Passing is done
in two-way. Max 200Km distance for entire network, Max 2Km between Nodes, Max 500 nodes. Generally, this
used as Backbone Network.

* FTP (File Transfer Protocol)
An application program used to transfer files between computers among application programs providing TCP/IP
protocol. If an account is allowed to the computer to log in, fast log in the computer is available wherever the
computer is so to copy files.

* Gateway
Software/Hardware used to translate for two different protocols to work together, which is equivalent to the
gateway necessary to exchange information with the different system.

* Header
It indicates parts of packets, including its own station and the destination station's addresses, and a part for
checking for an error.

e HTML
Hypertext Markup Language, standard language of WWW. In other words, it is a language system to prepare
Hypertext documents. The document made of HTML can be viewed through the web browser

e HTTP
Hypertext Transfer Protocol, standard protocol of WWW. It is a protocol supporting the hypermedia system.

* ICMP (Internet Control Message Protocol)
An extended protocol of IP address used to create error messages and test packets to control the Internet.

* Implicit Messaging
Implicit messages and messages with minimal header information other than data.
(XGT EtherNet / IP module provides cycle client / cycle server communication)

* |[EEE 802.3

IEEE 802.3 specifies standards for CSMA/CD based Ethernet Exactly it is a LAN based on CSMA/CD (Carrier
Sense Multiple Access with Collision Detection) Ethernet designed by IEEE 802.3 group, which is classified into
detailed projects as specified below.

1) IEEE P802.3 - 10G Base T study Group

2) |EEE P802.3ah - Ethernet in the First Mile Task Force
IEEE P802.3ak - 10G Base-CX4 Task Force. Both IEEE 802.3 and Ethernet are broadband networks
using the CSMA / CD scheme and have a common feature that is implemented in the network
interface card hardware.
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¢ [P (Internet Protocol)
Protocol at the network layer for the Internet

* |IP Address

Address of respective computers on the Internet made of figures binary of 32 bits (4 bytes) to distinguish the
applicable machine on the Internet. Classified into 2 sections, network distinguishing address and host
distinguishing address. The network address and the host address is respectively divided into class A, B and C
based on the bits allotted. IP address since it shall be unique all over the world, shall be decided not optionally
but as assigned by NIC (Network Information Center) of the applicable district when joining the Internet. In Korea,
KRNIC (Korea Network Information Center) is in charge of this work. Ex.) 165.244.149.190

* SO (International Organization for Standardization)
A subsidiary organization of UN establishing and managing the international standards.

* LAN (Local Area Network)

Called also as local area communication network or district information communication network, which allows
lots of computers to exchange data with each other as connected though communication cable within a limited
area such as in an office or a building.

* MAC (Medium Access Control)
A method used to decide which device should use the network during given time on the broadcast network.

* Node
Each computer connected with the network is called Node.

* Packet

Package of data which is the basic unit used to send through the network. Usually the package is made of
several tens or hundreds of bytes with the header attached in front to which its destination and other necessary
information are added.

* PORT number
Used to classify the applications on TCP/UDP.
Ex.) 21/tcp : Telet

* PPP (Point-to-Point Protocol)

Phone communication protocol which allows packet transmission in connecting with the Internet. In other words,
normal phone cable and modem can be used for the computer to connect through TCP/IP with this most general
Internet protocol.

Similar to SLIP, however with modern communication protocol factors such as error detection and data
compression, it demonstrates more excellent performance than SLIP.
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* Protocol

Contains regulations related with mutual information transmission method between computers connected with
each other through the network. The protocol may specify detailed interface between machines in Low level (for
example, which bit/byte should go out through the line) or high level of message exchange regulations as files
are transferred through the Internet.

* Reset
This is function used when you want to initialize the communication module to clear the error.
Select [Online] [Reset/clear] [PLC reset] in the XG5000 If you execute this function, PLC will restart

* RPI
Abbreviation for Requested Packet Interval, which means to send packet.
(XGT EtherNet / IP module is provided in transmission cycle)

* Router

A device used to transfer the data packet between the networks. It sends the data packet to its final destination,
waits if the network is congested, or decides which LAN is good to connect to at the LAN junction. Namely, it is a
special computer/software used to control the two or more networks connected.

* Server
The side which passively responds to the client's request and shares its resources.

* Tag
Name tag, in other word named variable.

* TCP (Transmission Control Protocol)
A transport layer protocol for the Internet

- Data Tx/Rx through connection

- Multiplexing

- Transmission reliable

- Emergent data transmission supported

* TCP/IP (Transmission Control Protocol/Internet Protocol)

Transmission protocol used for communication among different kinds of computers, which makes the
communication available between general PC and medium host, IBM PC and MAC, and medium or large-sized
different types of computer. It is also used as a general term for information transmission protocol between
computer networks including FTP, Telnet, SMTP, etc. TCP divides data into packets to send through IP and the
packets sent will be united back together through TCP.

* Telnet
It means remote login via Internet. To login to remote host via TELNET, account of that host is necessary. But for
some hosts providing public service, you can connect without account.
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* Token Ring

As short-distance network using Token to connect to network having physical ring structure, one of the Node
connection methods at network. If node sending data gets Token, then node gets right to send message packet.
Realistically structured examples are IEEE 802.5, ProNet-1080 and FDDI. Terms called Token is used as IEEE
802.5

* UDP (User Datagram Protocol)
A transport layer protocol for the Internet

- High speed communication because of communication without connection
- Multiplexing
- Lower reliability than TCP in transmission (Tough data doesn’t arrive, it doesn’t send data again).

e Watchdog Timer A transport layer protocol for the Internet
It is a function to set the predetermined execution time of the program and to generate an alarm when the
processing is not completed within the specified time, indicating that there is an error in the PLC operation.

» FDDI (Fiber Distributed Data Interface)

Based on optical cable, provides 100Mbps, Shared Media Network as Dual Ring method, Token Passing is done
in two-way. Max 200Km distance for entire network, Max 2Km between Nodes, Max 500 nodes. Generally, this
used as Backbone Network.

* Ethernet Transceiver
A device designed to connect a computer or electronic device to a network that enables transmit or receive of
messages.

* Media Converter
In most cases, it is a device that acts as a transceiver. It is a device that converts the electrical signal used in the
UTP network to the light wavelength used in the optical fiber cable.
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A.3 List of flags

A.3.1 XGK CPU flags

A.3.1.1 Special Relay (F) List

Device 1 Device 2 Type Variable Function Description
FO000 - DWORD |_SYS STATE Mode and state Indicates PLC mode and operation status

- FO0000 BIT _RUN RUN RUN status.
- FO0001 BIT |_STOP STOP STOP status.
- FO00002 BIT _ERROR ERROR ERROR status.
- FO0003 BIT |_DEBUG DEBUG DEBUG status.
- F00004 BIT |_LOCAL_CON Local control Local control mode.
- FO0005 BIT |_MODBUS_CON Modbus mode Modbus control mode.
- FO0006 BIT | _REMOTE_CON Remote mode Remote control mode.
- F00008 BIT | RUN_EDIT_ST Edit during RUN gf’m"oadi”g the editing program during
- FO0009 BIT |_RUN_EDIT_CHK Edit during RUN Internal edit processing during RUN.
- FOOO0A BIT _RUN_EDIT_DONE | Online editing done Edit done during RUN.
- FO000B BIT _RUN_EDIT_END Edit done during RUN | Edit done during RUN.
- FO000C BIT | CMOD _KEY Operation mode Ig; operation mode has been changed by
- FO000D BIT |_CMOD_LPADT Operation mode Operation mode changed by local PADT.
- FOOOOE BIT |_CMOD_RPADT Operation mode Operation mode changed by remote PADT
- FOOOOF BIT |_CMOD_RLINK Operation mode Sg’rﬁﬁﬂﬁ?caﬂgnnor";l% duﬁ:a”ged by remote
- F00010 BIT |_FORCE_IN Forced input Forced input state.
- F00011 BIT |_FORCE_OUT Forced output Forced output state.
- F00012 BIT _SKIP_ON 1/0 SKIP Executing |1/ O SKIP
- FO0013 BIT _EMASK_ON Error mask Executing Error mask
- F00014 BIT _MON_ON Monitor Executing monitor
- F00015 BIT |_USTOP_ON STOP Stopped by STOP function.
- FO0016 BIT _ESTOP_ON ESTOP Stopped by ESTOP function.
- F00017 BIT |_CONPILE_MODE |Compiling Compiling is in progress.
- F00018 BIT |_INIT_RUN Initializing Initialization task is running.
- F0001C BIT |_PB1 Program code 1 Program code 1is selected.
- F0001D BIT |_PB2 Program code 2 Program code 2 is selected.
- FOOO1E BIT | _CB1 Compile code 1 Compilation code 1 is selected.
- FOOO1F BIT | _CB2 Compile code 2 Compilation code 2 is selected.
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Device 1 Device 2 Type Variable Function Description
F0002 i DWORD | CNE ER System error Indicates the critical error state of the
- - system.
- F00020 BIT _CPU_ER CPU error There is an error in the CPU configuration.
- F00021 BIT _IO_TYER Module type error | The module type does not match.
- F00022 BIT _IO_DEER Module The module has been detached
detachment error
- F00023 BIT _FUSE_ER Blown fuse error The fuse has blown.
- F00024 BIT _IO_RWER Module 1/O error A problem occurred in the module I/O.
) F00025 BIT P IFER Module interface | There was a problem _Wlth the special /
- = error communication module interface.
i F00026 BIT ANNUM ER External device A fgult has been detected in the external
- - fault device.
- F00028 BIT _BPRM_ER Basic Parameter It is abnormal to the basic parameter.
- F00029 BIT _IOPRM_ER 10 parameter There is a I/O configuration parameter error.
Special module . .

- FO002A BIT _SPPRM_ER parameter The special module parameter is abnormal.
i FO002B BIT CPPRM ER Communication The communication module parameter is
- - module parameter |abnormal.

- F0002C BIT _PGM_ER Program error There is an error in the program.
- F0002D BIT _CODE_ER Code error There is an error in the program code.
- FO002E BIT _SWDT_ER System watchdog |System watchdog worked.
- FOO002F BIT _BASE_POWER_ER |Power error The base power supply is abnormal.
- FO0030 BIT _WDT_ER Scan watchdog The scan watchdog worked.
F0004 ) DWORD | CNF WAR System warning Reports the minor error status of the
system.
- F00040 BIT _RTC_ER RTC error There is abnormality in the module.
- F00041 BIT _DBCK_ER Backup error There was a problem with the data backup.
- F00042 BIT _HBCK_ER Restart error Hot restart is unavailable.
- F00043 BIT _ABSD_ER Abnorr_nal Stop by abnormal operation.
operation stop
- F00044 BIT _TASK_ER Task collision Itis collided to the task.
- F00045 BIT _BAT_ER Battery error Battery condition is abnormal.
) F00046 BIT ANNUM WAR External device |A minor error in external device has been
- - fault detected
- F00047 BIT _LOG_FULL Memory full Log memory is full.
- F00048 BIT _HS_WAR1 High speed link 1 High speed link - parameter 1 or more
- F00049 BIT _HS_WAR2 High speed link 2 High speed link— parameter 2 or more
- FOO04A BIT _HS_WAR3 High speed link 3 High speed link— parameter 3 or more
- F0004B BIT _HS_WARA4 High speed link 4 | High speed link— parameter 4 or more
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Device 1 Device 2 Type Variable Function Description

- Fooo4C BIT _HS _WARS5 High speed link 5 High speed link— parameter 5 or more
- F0004D BIT _HS_WARG6 High speed link 6 High speed link— parameter 6 or more
- FOO04E BIT _HS_WAR7 High speed link 7 High speed link— parameter 7 or more
- FO004F BIT _HS_WARS8 High speed link 8 High speed link— parameter 8 or more
- F00050 BIT _HS_WAR9 High speed link 9 High speed link— parameter 9 or more
- FO0051 BIT _HS_WAR10 High speed link 10 | High speed link - parameter 10 or more
- F00052 BIT _HS_WAR11 High speed link 11  |High speed link - parameter 11 or more
- FO0053 BIT _HS_WAR12 High speed link 12  |High speed link - parameter 12 or more
- FO0054 BIT _P2P_WAR1 P2P parameter 1 P2P - parameter 1 error
- FO0055 BIT _P2P_WAR2 P2P parameter 2 P2P- parameter 2 error
- FO0056 BIT _P2P_WARS3 P2P parameter 3 P2P- parameter 3 error
- FO0057 BIT _P2P_WARA4 P2P parameter 4 P2P- parameter 4 error
- F00058 BIT _P2P_WAR5 P2P parameter 5 P2P- parameter 5 error
- FO0059 BIT _P2P_WARG6 P2P parameter 6 P2P- parameter 6 error
- FOOO5A BIT _P2P_WART7Y P2P parameter 7 P2P- parameter 7 error
- FO005B BIT _P2P_WARS P2P parameter 8 P2P- parameter 8 error
- FO005C BIT _CONSTANT_ER Fixed period error Fixed period error

F0009 - WORD | _USER_F User contact point | Timer that can be used by the user
- FO0090 BIT _T20MS 20ms Clock of 20ms cycle.
- F00091 BIT _T100MS 100ms Clock of 100ms cycle.
- F00092 BIT _T200MS 200ms Clock of 200ms cycle.
- FO0093 BIT _T1S 1s Clock of 1s cycle.
- F00094 BIT _T2S 2s Clock of 2s cycle.
- FO0095 BIT _T10S 10s Clock of 10s cycle.
- FO00096 BIT _T20S 20s Clock of 20s cycle.
- F00097 BIT _T60S 60s Clock of 60s cycle.
- F00099 BIT _ON Always On This bit is always On.
- FOO09A BIT _OFF Always Off This bit is always Off.
- F0009B BIT _10ON 1scan On Only the first scan is On.
- FO009C BIT _10FF 1scan Off Only the first scan is Off.
- FO009D BIT _STOG Reversal Reverses every scan

F0010 - WORD |_USER_CLK User CLOCK User-settable CLOCK.
- F00100 BIT | _USR_CLKO ngneat specified | oo ified scan On/Off Clock 0
- F00101 BIT | USR CLK1 Repeat  specified | specified scan On/Off Clock 1
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Device 1 Device 2 Type Variable Function Description

- F00102 BIT | USR_CLK2 ngrfat specified| g0 ified scan On/OFf Clock 2

; F00103 BIT | USR CLK3 Repeat  specified | specified scan On/Off Clock 3

- F00104 BIT | USR_CLK4 ngrfat specified | 5o iified scan On/OFf Clock 4

- F00105 BIT | USR_CLK5 ngrfat specified| g0 ified scan On/OFf Clock 5

; F00106 BIT | USR CLK6 Repeat specified | o o ified scan On/Off Clock 6

- F00107 BIT | USR_CLK7 Sce;fat specified | oo ified scan On/Off Clock 7
FOO11 - WORD |_LOGIC_RESULT Logic result Indicates the logical result

- F00110 BIT _LER Operation error ON for 1 scan on operation error

- F00111 BIT _ZERO Zero flag ON when the operation result is 0

- F00112 BIT _CARRY Carry flag ON when carry occurs during operation

- F00113 BIT _ALL_OFF All output OFF ON when all outputs are OFF

- F00115 BIT | LER LATCH Operation error latch ggcnlj'rr;“e On when operation error
F0012 - WORD | _CMP_RESULT Comparison result Indicates the comparison result.

- F00120 BIT LT LT flag If “less than” to On

- F00121 BIT _LTE LTE flag If “less than or equal” to On

- F00122 BIT _EQU EQU flag If “equal” to On

- F00123 BIT _GT GT flag If “larger than” to On

- F00124 BIT _GTE GTE flag If “If “larger than or equal” to On

- F00125 BIT _NEQ NEQ flag If it is “not equal” to On
F0013 ) WORD | AC E CNT Instantaneous Indicates the number of instantaneous

- - - interruption interruption occurrences.

F0014 - WORD |_FALS_NUM FALS No. Displays the number of FALS.
FO0015 - WORD | _PUTGET_ERRO PUT/GET error 0 Main base PUT / GET error
FO0016 - WORD | _PUTGET_ERR1 PUT/GET error 1 Extension base 1-stage PUT/GET error
FO017 - WORD | _PUTGET_ERRZ2 PUT/GET error 2 Extension base 2-stage PUT/GET error
F0018 - WORD |_PUTGET_ERR3 PUT/GET error 3 Extension base 3-stage PUT/GET error
F0019 - WORD | PUTGET _ERR4 PUT/GET error 4 Extension base 4-stage PUT/GET error
F0020 - WORD | PUTGET _ERR5 PUT/GET error 5 Extension base 5-stage PUT/GET error
F0021 - WORD | PUTGET _ERRG6 PUT/GET error 6 Extension base 6-stage PUT/GET error
F0022 - WORD | PUTGET _ERR7 PUT/GET error 7 Extension base 7-stage PUT/GET error
F0023 - WORD |_PUTGET_NDRO PUT/GET complete O | Main Base PUT / GET Complete
F0024 . WORD |_PUTGET_NDRL  |PUT/GET complete 1 | PUT/GET done in the extended base
F0025 - WORD | PUTGET_NDR2  |PUT/GET complete 2 g;’gET done in the extended base
F0026 - WORD |_PUTGET_NDR3  |PUT/GET complete 3 IF;S;/%ET done in the extended base
F0027 . WORD |_PUTGET_NDR4  |PUT/GET complete 4 | PUT/GET done in the extended base
F0028 - WORD | _PUTGET_NDR5  |PUT/GET complete 5 | UT/GET done in the extended base

level 5
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Device 1 Device 2 Type Variable Function Description
F0029 . WORD |_PUTGET_NDR6 PUT/GET complete 6 :Z?/Z(%ET done in the extended base
F0030 . WORD |_PUTGET_NDR? PUT/GET complete 7 || o1/GC1 done In the extended base
F0044 i WORD | CPU_TYPE CPU type l;g:ecates information related to the CPU
F0045 - WORD |_CPU_VER CPU Version Indicates CPU version.
F0046 - DWORD |_OS_VER OS Version Indicates OS version.
F0048 - DWORD |_OS_DATE OS date Indicates the OS distribution date.
FO0050 - WORD |_SCAN_MAX Maximum scan time |Indicates maximum scan time.
FO051 - WORD |_SCAN_MIN Minimum scan time |Indicates minimum scan time.
F0052 - WORD |_SCAN_CUR Current scan time Indicates current scan time.
F0053 - WORD |_MON_YEAR Month / Year Indicates month and year data of PLC.
F0054 - WORD |_TIME_DAY Time / Day Indicates time and day data of PLC
F0055 . WORD |_SEC_MIN Second / Minute nalcates second and minute data of
Hundred years /|Indicates hundred years and weekday
F0056 ) WORD | _HUND_WK Weekday data of PLC.
FO057 - WORD |_FPU_INFO feF;llJm caleulation | i 1avs floating-point results.
- F00570 BIT _FPU_LFLAG_| Incorrect error latch |Latch on Inaccurate Error
: F00571 BIT |_FPU_LFLAG_U Underflow latch Latches the —error when underflow
occurs.
- F00572 BIT _FPU_LFLAG_O Overflow latch Latches the error when overflow occurs.
: F00573 BIT |_FPU_LFLAG_Z Zero divide larch | -alenes the error when zerodivide
- FO0574 BIT | FPU_LFLAG_V I'gz’c"ﬂ'd Operation |} aich when invalid operation.
- FOO57A BIT _FPU_FLAG_I Inaccurate error Indicates an inaccuracy error occurred.
- FO057B BIT FPU_FLAG_U Underflow Display the error when underflow
- = - occurs.
- FO057C BIT _FPU_FLAG_O Overflow Display the error when overflow occurs.
- FO057D BIT _FPU _FLAG z Zero divide Displays at zero division
- FOO57E BIT _FPU_FLAG_V Invalid operation Display when invalid operation.
- FOO57F BIT _FPU_FLAG_E Lna%jtta of irregular Reports when input of irregular value.
FO058 - DWORD |_ERR_STEP Error step Saves error step.
F0060 - DWORD |_REF_COUNT Refresh Increase when module Refresh.
FO062 - DWORD |_REF_OK_CNT Refresh OK 'n”cfrrrf]zfe when module Refresh is
FO064 - DWORD |_REF_NG_CNT Refresh NG Increase ~when module refresh s
- - = abnormal
Increase when module refresh s
F0066 - DWORD |_REF_LIM_CNT Refresh LIMIT abnormal
(TIME OUT)
FO068 - DWORD | REF_ERR_CNT Refresh ERROR Increase ~when module refresh is
- - - abnormal
F0070 ) DWORD | MOD_RD_ERR_CNT Module READ | It increases when the module 1 word is
ERROR read abnormally.
FO072 ) DWORD | _MOD_WR_ERR_CNT Module WRITE | It increases when the module 1 word is
ERROR write abnormally.
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Device 1 Device 2 Type Variable Function Description

F0074 - DWORD | _CA_CNT Block service Increase in module's block data service

F0076 - DWORD | _CA_LIM_CNT Block service LIMIT Increase in block data abnormal service

F0078 - DWORD | _CA_ERR_CNT E:;;é;erwce Increase in block data abnormal service

F0080 - DWORD | BUF_FULL_CNT |Buffer Full Increase when CPU internal buffer is full.

F0082 - DWORD | _PUT_CNT PUT count It increases when performing PUT.

F0084 - DWORD |_GET_CNT GET count It increases when performing GET.

F0086 - DWORD |_KEY Current key Indicates the current state of the local key.

F0088 - DWORD |_KEY_PREV Previous key Indicates the previous state of the local key.

F0090 - WORD |_IO_TYER_N Mismatch slot Module type mismatch slot number display

Display the slot number where the module

F0091 - WORD |_IO_DEER_N Detached slot has been detached

F0092 i WORD FUSE ER N Fuse disconnection | Indicates the slot number where the fuse
- - = slot blows

F0093 ) WORD | I0_ RWER N RW error slot Module read / write error slot number

display

F0094 - WORD |_IP_IFER_N IF error slot Module interface error slot number display

F0096 - WORD |_IO_TYERO Module type O error Main base module type error.

F0097 - WORD |_IO_TYER1 Module type 1 error Extension base 1-stage module type error

F0098 - WORD |_IO_TYER2 Module type 2 error Extension base 2-stage module type error

F0099 - WORD |_IO_TYER3 Module type 3 error Extension base 3-stage module type error

F0100 - WORD |_IO_TYER4 Module type 4 error Extension base 4-stage module type error

FO0101 - WORD |_IO_TYERS Module type 5 error Extension base 5-stage module type error

F0102 - WORD |_IO_TYERG6 Module type 6 error Extension base 6-stage module type error

F0103 - WORD |_IO_TYER?Y Module type 7 error Extension base 7-stage module type error

F0104 - WORD |_IO_DEERO g/lr(r)grme detachment Main base module Detach error.

F0105 ) WORD IO DEER1 Module detachment 1|Extension base 1-stage module detach
- - error error.

F0106 ) WORD IO DEER2 Module detachment 2|Extension base 2-stage module detach
- = error error.

F0107 ) WORD IO DEER3 Module detachment Extension base 3-stage module detach
- = error error.

F0108 ) WORD IO DEER4 Module detachment 4 |Extension base 4-stage module detach
- - error error.

F0109 ) WORD IO DEERS Module detachment 5|Extension base b5-stage module detach
- = error error.

F0110 ) WORD IO DEER6 Module detachment Extension base 6-stage module detach
- = error error.

F0111 ) WORD IO DEER7 Module detachment 7 |Extension base 7-stage module detach
- - error error.

F0112 - WORD | _FUSE_ERO Z:ﬁﬁ disconnection Main base fuse disconnection error

F0113 ) WORD FUSE ER1 Fuse disconnection Extension base 1-stage fuse disconnection
= - error error

F0114 i WORD FUSE ER2 Fuse disconnection Extension base 2-stage fuse disconnection
- - error error

F0115 i WORD | FUSE_ER3 Fuse disconnection Extension base 3-stage fuse disconnection

error

error
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Device 1 Device 2 Type Variable Function Description
F0116 i WORD FUSE ER4 Fuse disconnection Extensmn . base 4-stage fuse
- - 4 error disconnection error
F0117 _ WORD FUSE ER5 Fuse disconnection E_xtensmn _ base 5-stage fuse
- - 5 error disconnection error
F0118 i WORD FUSE ER6 Fuse disconnection Extensmn . base 6-stage fuse
- — 6 error disconnection error
F0119 i WORD FUSE ER7 Fuse disconnection Extensmn . base 7-stage fuse
- - 7 error disconnection error
F0120 - WORD |_IO_RWERO Module RW 0O error Main base module read / write error
FO121 - WORD | IO RWER1 Module RW 1 error | EXPansion base 1-stage module read /
write error
F0122 - WORD | IO RWER2 Module RW 2 error | EXPansion base 2 stage module read /
write error.
F0123 - WORD |_I0_RWER3 Module RW 3 error | EXPansion base 3 stage module read /
- - write error.
FO124 - WORD | _I0_RWER4 Module RW 4 error | EXPansion base 4 stage module read /
write error.
F0125 - WORD | _IO_RWERS5 Module RW 5 error | EXPansion base 5 stage module read /
write error.
F0126 - WORD |_IO_RWER6 Module RW 6 error | EXPansion base 6 stage module read /
- - write error.
FO127 - WORD | 10 RWER7 Module RW 7 error | EXPansion base 7 stage module read /
write error.
F0128 - WORD |_IO_IFER_O Module IF O error Main base module interface error.
F0129 - WORD | IO IFER_1 Module IF 1error | EXtension ~ base  1-stage  module
- = — interface error.
F0130 - WORD | _I0_IFER 2 Module IF 2 error | EXtension ~ base  2-stage  module
- - — interface error.
F0131 - WORD | _I0_IFER_3 Module IF 3error | EXtension ~ base  3-stage  module
- = — interface error.
F0132 - WORD | I0_IFER 4 Module IF 4 error Extension base  4-stage  module
interface error.
F0133 - WORD | _I0_IFER 5 Module IF 5error | EXtension ~ base  5-stage  module
- - - interface error.
F0134 - WORD | _I0_IFER_6 Module IF 6 error | EXtension ~ base  6-stage  module
- - — interface error.
F0135 - WORD | 10 IFER 7 Module IF 7 error Extension base  7-stage module
interface error.
F0136 - WORD |_RTC_DATE RTC date Displays the current date .
F0137 - WORD |_RTC_WEEK RTC weekday Displays the current day of week
F0138 - DWORD |_RTC_TOD RTC time Current time in RTC (ms unit)
F0140 ) DWORD | AC FAIL CNT Save the number of | Saves the number of times the power
- = - power off. cutoff.
F0142 ) DWORD ERR HIS CNT Save the number of | Saves the number of times an error
- - - error count. occurred.
F0144 ) DWORD MOD HIS CNT Save the number of | Saves the number of times the mode
- - = mode change. change.
F0146 ) DWORD | SYS HIS CNT History occurrence|Saves the number of system history
- == count occurrences.
F0148 - DWORD | _LOG_ROTATE Log rotate Saves log locate information.
F0150 - WORD |_BASE_INFOO Slot information 0 Main base slot information
FO151 - WORD | _BASE_INFO1 Slot information 1 Extension base 1-slot information
F0152 - WORD | _BASE_INFO2 Slot information 2 Extension base 2-slot information
F0153 - WORD | _BASE_INFO3 Slot information 3 Extension base 3-slot information
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Device 1 Device 2 Type Variable Function Description
FO154 - WORD |_BASE_INFO4 Slot information 4 Extension base 4-slot information
FO155 - WORD |_BASE_INFO5 Slot information 5 Extension base 5-slot information
F0156 - WORD |_BASE_INFO6 Slot information 6 Extension base 6-slot information
FO157 - WORD |_BASE_INFO7 Slot information 7 Extension base 7-slot information
FO158 - WORD | RBANK_NUM Block number in use 5;%3" number which is currently being
F0159 - WORD |_RBLOCK_STATE Flash state Flash block state
F0160 - DWORD | _RBLOCK_RD_FLAG |Flash read ON when reading data of flash N block
F0162 - DWORD | _RBLOCK_WR_FLAG |Write on flash On when writing flash N block data
FO164 - DWORD | RBLOCK_ER_FLAG |Flash error ?grv‘”}rcfr occurred during flash N block
F1024 - WORD |_USER_WRITE_F ':;iar:ltable contact Contact point available in program.
- F10240 BIT _RTC_WR RTC RW Writing and reading data in RTC
- F10241 BIT _SCAN_WR Scan WR Initializing the value of scan.
) F10242 BIT CHK ANC ERR External critical error | Request of fatal error detection from
- - - request external device
) F10243 BIT CHK ANC WAR External light error|Request of minor error detection from
- - - request external device
F1025 - WORD | USER _STAUS F User contact point User contact point
) F10250 BIT INIT DONE Initialization Indicates completion of initialization
- = completed task
F1026 ) WORD ANC ERR _External_crltlcal error | Displays fa}tal error information of
- - information external devices
F1027 ) WORD ANC WAR Exter_nal light error|Displays minor error information of
- - warning external devices
F1034 - WORD |_MON_YEAR_DT Month / Year Clock information data (month / year)
F1035 - WORD |_TIME_DAY_DT Time / Day Clock information data (hour/day)
F1036 - WORD |_SEC_MIN_DT Second / Minute Clock information data (second/minute)
F1037 i WORD HUND WK DT Hundred years /|Clock information data (hundred
— - = Weekday year/week)
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A.3.2 XGI CPU flags
A.3.2.1 Mode and state

Flag Name TYPE Memory Content Description

 SYS_STATE | DWORD %FDO  |PLC mode and states Displays the operation mode and operation
status of the system.

_RUN BOOL %FX0 RUN

_STOP BOOL %FX1 STOP
Indicates operation state of PLC module.

_ERROR BOOL %FX2 ERROR

_DEBUG BOOL %FX3 DEBUG
It displays the status that can change the

0,

_LOCAL_CON BOOL VoFX4 Local control operation mode only by mode key or GMWIN.

I_I\IIBI?OS E_EMASK_ DWORD %FD477 Base fault mask information Displays base fault mask information.

REMOTE_CON BOOL %FX6 Remote mode on Remote control mode.

RUN EDIT ST BOOL %EX8 Dow_nloadlng the program during edit during
- = - running.
RRUN—EDIT—CH BOOL %FX9 Internal processing during edit during running..
RUN EDIT 5O Edit during running

NE - BOOL %FX10 Edit during running completed.

_RUN_EDIT_NG BOOL %FX11 Abnormal completion during edit during running.

_CMOD_KEY BOOL %FX12 Operation mode change by key

_CMOD_LPADT BOOL %FX13 Operation mode change by local PADT

Operation mode change )

_CMOD_RPADT BOOL %FX14 Operation mode change by remote PADT

| CMOD_RLINK BOOL %EX15 Operatlon _ mode change by remote
communication module

FORCE_IN BOOL %EX16 Forced input Indicates that forced On/Off for input contact is in
progress.

FORCE_OUT BOOL %EXLT Forced output _Indlcates that forced On/Off for output contact is
in progress.

_SKIP_ON BOOL %FX18 I/O SKIP Executing I/ O SKIP

_EMASK_ON BOOL %FX19 Error mask Executing Error mask

_MON_ON BOOL %FX20 Executing monitor Executing monitor

USTOP_ON BOOL %FX21  |Stopped by STOP function. Stop after scan completion by STOP function
during RUN mode.

ESTOP_ON BOOL %FX22  |Stopped by ESTOP function. Immediate stop by ESTOP function during RUN
mode operation

INIT_RUN BOOL %FX24  |Performing initialization task. Indicates during executing initial program which
is programmed by user.

_PB1 BOOL %FX28 Program code 1 Program code 1 is selected.

_PB2 BOOL %FX29 Program code 2 Program code 2 is selected.

_BASE_INFO ARRAY %FW150 Base information Display the base information.

_RTC_WR BOOL %FX16384  |Data write and read in RTC. Data write and read in RTC.

_SCAN_WR BOOL %FX16385 Initializing the value of scan. Initializing the value of scan.

_RCHK_ANC_ER BOOL %EX16386 Extemnal critical error request (Fjeee\?ig:st of fatal error detection from external

_RCHK_ANC_WA BOOL %EX16387 Extemal light error request Sglqiggst of minor error detection from external
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Flag Name TYPE Memory Content Description
E%ASE—SKl P_IN DWORD %FDA478 Base Skip information Display the base skip information.
If this flag is set by user’s initial program, it is
_INIT_DONE BOOL %FX16400 Initialization task completion. started to execution of scan program after initial
program completion.
_KEY DWORD %FD43 Current key Indicates the current state of the local key.
FUSE_ER PMT|  BOOL %HEX15232 Setting continue running when a fuse error|Setting continue running when a fuse error
occurs. occurs.
CP_ER PMT BOOL YEX15235 Setting  continue  running when|Setting continue running when communication
communication module error occurs. module error occurs.
| 10_ER_PMT BOOL %EX15233 Setting continue running when IO module|Setting continue running when IO module error
€ITor OCCurs. OCCurs.
SP_ER PMT BOOL YEX15234 Setting continue running when special|Display setting continue running when special
module error occurs. module error occurs.
_INIT_RUN BOOL %FX24 Executing the initial task Display executing the initial task.
A3.2.2 System error
Flag Name TYPE Memory Content Description
_CNF_ER DWORD %FD1 System errors(critical error) Handles error flags about non-operation fault
error as below.
Representative flag displayed when 1/O
configuration parameter for each slot is not
_IO_TYER BOOL %FX33 Module type mismatch error matched with practical module configuration or a
specific module is applied in the wrong location.
(Referto 10 TYER N, 10 TYERIn])
Representative flag displayed when the module
_1O0_DEER BOOL %FX34 Module detachment error configuration for each slot is changed while
running.(Referto IO DEER_N, 10_DEER[N])
Representative flag displayed when the fuse of
FUSE_ER BOOL %FX35 Fuse cutoff error module is cut off.(Refer to _FUSE ER N,
_FUSE_ER[n)
When I/O configuration parameter for each slot is
not matched with practical module configuration
I0_TYER N WORD %FW90  |Slot number of mismatched module type |2 2 SPecific module is applied in the wrong
position, displayed as the lowest slot number
after detecting these mismatch error in slot
locations.
When slot module configuration is changed while
|0 DEER N WORD %FWO1  |Module detached slot no. PLC running, displayed as the lowest slot
number after detecting these detachment error in
slot locations.
When a fuse equipped module is cut off,
 FUSE ER N WORD %FW92 Slot number of fuse cut off displayed as the lowest slot number after,
detecting this error in slot locations.
. ! . Representative flag displayed when critical fault|
_ANNUM_ER BOOL %FX38 gg\t,llfgj fault detection error in- extemnal error detected by user program is recorded in
ANC_ERRJn].
_BPRM_ER BOOL %FX40 Basic Parameter Itis abnormal to the basic parameter.
_IOPRM_ER BOOL %FX41 IO parameter Itis abnormal to the 10 configuration parameter.
_SPPRM_ER BOOL %FX42 Special module parameter error It is abnormal to the special module parameter.
_CPPRM_ER BOOL %FX43 Communication module parameter error galr;na;z(r)rma] to the communication module
PGM ER BOOL YEXA4 Program error Indicates that there is problem with user-made
— — program checksum.
_FUSE_ERR WORD %FW112 Fuse cutoff error Display fuse cutoff error.
CODE_ER BOOL EX45 Program Code error Indicates that while user program is running, the

program code can't be interpreted.
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Flag Name TYPE Memory Content Description

Displayed when the saved program gets

_SWDT_ER BOOL %FX46 CPU abnormal ends. damages by an abnormal end of CPU or|
program cannot work.

—EQSE—POWER BOOL %FX47 Power error The base power supply is abnormal.

WDT_ER BOOL %EXAS Scan watchdog efror Indicates that thg program scan time exceeds the
scan watchdog time specified by a parameter.

_10_DEERR WORD FW104 Module detachment error Display module detachment error.

_10_TYERR WORD %FW96 Module type mismatch error Display module type mismatch error.

A.3.2.3 System Warning

Flag Name TYPE Memory Content Description

CNF_WAR DWORD %ED2 System waming Representative flag displayed the system
warning state.

_RTC_ER BOOL %FX64 RTC error Indicates that RTC data is abnormal

_P2P_WAR BOOL %FX84 P2P parameter error - representative flag %Dal\zplay P2P parameter eror - representative

_EIP_TAG_WAR BOOL %FX95 EtherNet/IP TAG  information error Display EtherNet/IP TAG information error.

HS WAR BOOL EXT2 ngh-speed. Link parameter error -|Display ngh-speed Link parameter error -

representative flag representative flag
HS WAR W WORD %FW58 !—hgh-sp_eed Link parameter error - whole Dlspla)_/ ngh-_speed Link parameter error -
information whole information

_AB SD ER BOOL %FX67 Abnormal operation stop Stop by abnormal operation.

TASK ER BOOL %FX68 Task collision Itis collided to the task.

_BAT_ER BOOL %FX69 Battery error Battery condition is abnormal.

_ANNUM_WAR | BOOL %FX70  |Exteral device fault Indicates that the minor fault in the external
device is detected.

_P2P_WAR_W WORD %FW59 P2P parameter error - whole information  |Display P2P parameter error - whole information

BASE INFO ER | BOOL %FX49  |Base information error It is occurred to abnormality in the main base
information.

HS_WARn BOOL %FX928  |High speed link— Parameter 'r: Ef]_?'{”lozr)maj o the high speed link parameter

_P2P_WARnN BOOL %FX944 P2P - parameter It is abnormal to the P2P parameter n. (n: 1~8)

_CONSTANT_ER BOOL %FX92 Fixed period error Fixed period error
Critical fault of external device is detected by

ANC_ERR WORD 9%FW1026  |Critical fault information of extemal device |YS€" Program. and that error is saved at this
zone as numbers which can identify 16 error|
types.
Minor fault in external device is detected by user

ANC_WAR WORD %FW1027 Minor error information in external device |Prodram: _and the bit pos_,ltlon of_the occurred
error is displayed as an integer in occurrence
order.

N?:I(‘)OT—EMASKJ WORD %FW958 Slot Fault Mask information Display slot fault mask information.

(_)SLOT_SKI P_INF WORD %FW966 Slot Skip information Display slot Skip information.
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A.3.2.4 User flag

Flag Name TYPE Memory Content Description
Clock signal used in user program reverses
T20MS BOOL %FX144 20ms cycle clock
- ° ek On/Off per a half cycle Reversal of signal is
_T100MS BOOL %FX145  |100ms cycle clock processed after the scan is completed, so the
clock signal may be delayed or distorted
_T200MS BOOL %FX146 200ms cycle clock according to the program execution time. Please
use more enough long clock signal than PLC
_T1S BOOL %FX147 1s cycle clock scan time. The clock signal begins from the Off
state at the beginning of the initialization program
_T2S BOOL 9%FX148 2s CyCle clock and scan program.
_T10S BOOL %FX149 10s cycle clock Example od_T100ms clock
1208 BOOL %FX150  |20s cycle clock : S0ms: 50ms :
_T60S BOOL %FX151 60s cycle clock J \—‘ L
ON BOOL O%EX153 Ordinary time On S:;gﬁn On state flag, used when writing user
OFF BOOL YEX154 Ordinary ime Off Always Off state flag, used when writing user
program.
10N BOOL %FX155 1'st scan On Only 1’st scan On after operation start
_10FF BOOL %FX156 1’st scan Off Only 1’st scan Off after operation start
On/Off toggle flag per every scan when user
0,
_STOG BOOL VOFX157 Scan toggle program is working. (On state for first scan)
A.3.2.5 Operation result flag
Flag Name TYPE Memory Content Description
Operation error flag on the basis of operation
_ERR BOOL %FX176 Operation error flag function (FN) or function block (FB), is renewed
every time operation works.
Operation error latch flag on the basis of
program block (PB), the error indication which
_LER BOOL %FX181 Operation error latch flag occurs while program block running keeps until
the program ends. It is available to delete by a
program.
_ARY_IDX_ERR BOOL %FX28864 Error flag of array index range over Error flag displayed when exceeding the seting
array numbers.
_ARY_IDX_LER BOOL %FX28896 [Latch error flag of array index range over Latgh error flag displayed when exceeding the
setting array numbers.
_ALL OFF BOOL %FX179 All output Off On when all outputs are Off

A.3.2.6 System operation status information

Flag Name TYPE Memory Content Description

_CPU_TYPE WORD %FW44  |Indicates CPU Type Information. Displays the operation mode and operafion
status information

_CPU_VER WORD %FW45 CPU version. Display CPU version number.
_OS _VER DWORD %FD23 OS version. Display System OS version number.
_OS_VER_PATCH | DWORD %FD89 OS patch version Displays OS version to two decimal places.
_OS_DATE DWORD %FD24 OS date Display OS date.
_ SCAN_MAX WORD %EWS0 Maximum scan fime Indicates max. scan time during operation.

Unit:0.1ms
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Flag Name TYPE Memory Content Description
SCAN_MIN WORD %FW51  |Minimum scan time Indicates min. scan tme during operation.
— — Unit:0.1ms
SCAN CUR WORD %EW52 Current scan time Ind_|c.ates current scan time during operation.
— - Unit:0.1ms
_RTC_TIME[Q] BYTE %FB106 RTC TIME[Year] Indicates PLC Clock data(Year).
_RTC_TIME[1] BYTE %FB107 RTC TIME[Month] Indicates PLC Clock data(Month).
_RTC_TIME[2] BYTE %FB108 RTC TIME[Date] Indicates PLC Clock data(Date).
_RTC_TIME[3] BYTE %FB109 RTC TIME[Time] Indicates PLC Clock data(Hour).
_RTC_TIME[4] BYTE %FB110 RTC TIME[Minute] Indicates PLC Clock data(Minute).
_RTC_TIME[5] BYTE %FB111 RTC TIME[Second] Indicates PLC Clock data(Second).
_RTC_TIME[6] BYTE %FB112 RTC TIME[Day] Indicates PLC Clock data(Day).
_RTC_TIME[7] BYTE %FB113 RTC TIME[Hundred year] Indicates PLC Clock data(Hundred year).
_RTC_DATE WORD %FW136 Current date of RTC Indicated on the basis of 1.Jan.1984.
Indicates a day of the week.(0:Mon, 1:Tue,
0,
_RTC_WEEK WORD 06FW137 Current a day of the week of RTC 2-Wed, 3:Thu, 4-F, 5:Sat, 6:5un)
o . Indicates a data for the time of the day on the
0,
_RTC_TOD DWORD %FD69 Current time in RTC (ms unit) basis of 00:00:00 (unit : ms).
 RBANK_NUM WORD %EW158 Block number which is currently being|Display block number which is currently being
used used
AC F CNT UINT %FW13 Calculation of momently shut-down count Report of momently shut-down count during
RUN mode operation.
_FALS _NUM WORD %FW14 FALS number Displays the number of FALS.
SOE_LOG_CNT WORD %FW1786 SOE event occurrence count Increase SOE event count.
ESO E_LOG_ROTAT WORD %FW1787 SOE event rotate information Increases when 3000 events are exceeded
SOE_READ_LOG_ o Increase SOE event count read by using
CNT WORD %FW1784 SOE events count read by the user SOE_RD function block.
SOE_READ_LOG_ WORD FW1785 SOE event rotate information read by the|Increase when SOE event count read by using
ROTATE user SOE_RD function block reaches 3000.
EHS—ENABLE—STAT ARRAY %FX15840 HS enable/disable current status Display HS enable/disable current status.
HS_REQ ARRAY |  9%FX16480 |HS enable/disable request Changes the state of high speed link
enable/disable
_HS _REQ_NUM ARRAY %FX16496  |Setting enable/disable for high speed link |Display setting enable/disable for high speed link
T_EZP—ENABLE—STA ARRAY %FX15872 P2P enable/disable current status Display P2P enable/disable current status.
_P2P_REQ ARRAY %FX16512  |P2P enable/disable request Changes the state of P2P enable/disable.
_P2P_REQ_NUM ARRAY %FX16528  [Setting P2P enable/disable Display setting P2P enable/disable.
_CYCLE_TASK_SCA o . Indicates max, min and current scan time of]
N TIME ARRAY OFW190 Scan time of fixed cycle task fixed cycle task.
NC\\/(V%LE—TASK—SCA BOOL %FX16392 Initialize scan value of fixed cycle task Initialize scan value of fixed cycle task.
E%%(,:\ﬁ_EETR—CLOSE— ARRAY %FW996 CLOSE count of each sockets Disconnection count with client per socket.
_RTC_TIME_USER(0 BYTE %FB2068 Time to set (year) Change RTC information data(Year).
]—RTC—TIME—USER[l BYTE %FB2069 Time to set (month) Change RTC information data(Month).
_RTC_TIME_USER(2 BYTE %FB2070 Time to set (Date) Change RTC information data(Date).

A-21



Appendix

Flag Name TYPE Memory Content Description
_RTC_TIME_USER(3 BYTE %FB2071 Time to set (hour) Change RTC information data(Hour).
_RTC_TIME_USER(4 BYTE %FB2072 Time to set (minute) Change RTC information data(minute).
]—RTC—TIME—USER[S BYTE %FB2073 Time to set (second) Change RTC information data(second).
_RTC_TIME_USER(6 BYTE %FB2074 Time to set(day) Change RTC information data(day).
]—RTC—TIME—USERW BYTE %FB2075 Time to set (age) Change RTC information data(Year).
%D,\I/IE—OPERAT'NG— DWORD |%FDA498 PLC Operation Time PLC Operation Time(Sec) / Normal Type CPU
Trth—OPERAT'NG— DWORD |%FD501 PLC Operation Time PLC Operation Time(Sec) /N Type CPU
NSTOCKETl—ERR—C DWORD |%FD504 Error frame counter 1 Local Ethernet Socket 1 error counter
N?_OCKETZ—ERR—C DWORD |%FD505 Error frame counter 2 Local Ethernet Socket 2 error counter
N?_OCKETS—ERR—C DWORD |%FD506 Error frame counter 3 Local Ethernet Socket 3 error counter
_SOCKET4_ERR_C DWORD |%FD507 Error frame counter 4 Local Ethernet Socket 4 error counter

NT
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A.3.3 Communication relay (L) list

(1) Special register for data link

High speed link No. 1 ~12

No. keyword Type Content Description
Indicates that all stations operate normally as per the parameter
set from the high speed link. It becomes On in the following
conditions.
All stations of 1. When all stations set for the parameter are in RUN mode and
high speed link | thereis no error
L0O00000 _HS1_RLINK Bit parameter No. 1 | 2. When all data blocks set for the parameter communicate
operate normally
normally. 3. When the parameter set for each station set for the parameter
communicates normally
When Run_link becomes On, it will be maintained until it is
stopped using link disable.
This flag becomes On when the communication status between
the station set for the parameter and the data block while
_HSmMRLINK flag is On.
Indicates 1. When the station set in the parameter is not in RUN mode
abnormal state 2. If a station set for the parameter has an error
L000001 _HS1 LTRBL Bit after 3. If the communication status of the data block set for the
HS1RLINK ON parameter is unstable
Link trouble becomes On when a condition falling under 1,2 and 3
above occurs, and it becomes Off when the condition returns to
normal.
HS Link 1 Turns on when “Input Data Set in an Emergency: Receive Area
Receive Data Data in Receive Timeout” is set to Latch among the high-speed
L 000002 _HS1_INPUT CLR Bit AmaAumﬁmﬁc link parameters.
Clear Setting in
Receive
Timeout
_ :)nvd;;:;:ess;;[lues of Indicates the overall status of communication information for
L000020 ~ | _HS1_STATE[kK] Bit No. k block in each data block of the set parameter.
LOOO009F (k=000~127) array | . h speed link
gn sp HS1STATE[k]=HS1MOD[k]&_HS1TRX[k]&(~_HSmMERR[K])
parameter No. 1
Run operation
L000100 ~ | _HS1 _MODIK] Bit Lnlgglf gtfalng.nfn Indicates the operation mode of the station set for k data block of
LO0017F (k=000~127) array high speed link the parameter.
parameter No. 1
Display of
normal
L000180 ~ | _HS1_TRX[K] Bit @?tnﬁn&gn:fﬁ}'oocnk Indicates whether the communication status of k data block in the
LO0025F (k=000~127) array | ciovion i.n high parameter is carried out smoothly, as it is set, or not.
speed link
parameter No. 1
Operation error
L000260 ~ | _HS1 ERRI[K] Bit E}ESE gtfa':li(c))'n}?n Indicates whether an error occurred in the communication status
LOO0O33F (k=000~127) array high speed link of k data block in the parameter or not.
parameter No. 1
Display of No. k
::8883‘112 ~ | -HS1_SETBLOCK[K] ErI:ay E:gﬁkszeegldnﬁr:ﬂ Indicates the k data block setting status in the parameter.
parameter No. 1
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I_—||gh Sppeed Address in L area Note
link number
2 L0O00500~L00099F
3 L001000~L00149F
Compared with HS link 1, the flag address of other HS link station no. Is as
5 L002000~L00249F ) ) _ )
6 L002500~L 00299F aS:alculamon formula: Address in L area = LO00000 + 500 x (high speed link number—
7 L0O03000~L00349F
8 L003500~L00399F . o
If you want to use HS link flag for program and monitoring, you can use the flag
9 L004000~L00449F . .
map registered in XG5000.
10 L004500~L00499F
11 LO05000~L00549F

k is the block number and the information of 128 blocks from 000 to 127 is shown as a total of 8 words, including
1 word for every 16 blocks. For example, in case of mode information (_ HS1IMOD), the information of block 0O to
block 15 is shown in L00010, and the information of block 16~31, 32~47, 48~63, 64~79, 80~95, 96~111 and
112~127 is shown in L00011, LO0012, LO0O013, LO0014, LO0O015, LO0016 and LO0017 respectively. Therefore, the
mode information of block number 55 is shown in LO00137.
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P2P parameter: 1 ~8, P2P : 0 ~63

No. keyword Type Content Description
L006250 P2P1 NDROO Bit P2P parameter Nq. 1 completed P2P.parameter No. 1 completed No. 0 block
- - No. 00 block service normally service normally
. P2P parameter No. 1 completed P2P parameter No. 1 completed No. 0 block
1006251 _P2P1_ERRO0 Bit No. 00 block service abnormally service abnormally
Error code in the case where P2P Error code is displayed when P2P parameter 1
L00626 | _P2P1_STATUSOO | WORD | parameter No. 1 completed No. 00 0 block service abnormal completion.
block service abnormally
Number of No. 00 block service . .
L00627 | _P2P1 SVCCNTO0 val’g?c;e normal execution by P2P E)'(Z‘éﬁﬁtsgr%“arﬂbf Og,z'\'Ff’ : grt:%(;l:esrer\rl\gcf
parameter No. 1 y oy P T
Number of No. 00 block service . .
Double - Displays the number of No. 0 block service
L00629 | _P2P1_ERRCNTOO word abnormal execution by P2P executed normally by P2P parameter No. 1.
parameter No. 1
. P2P parameter No. 1 completed P2P parameter No. 1 completed No. 1 block
1006310 —P2P1_NDRO1 Bit No. 01 block service normally service normally
. P2P parameter No. 1 completed P2P parameter No. 1 completed No. 1 block
1006311 _P2P1_ERROL Bit No. 01 block service abnormally service abnormally
Error code in the case where P2P -
Error code is displayed when P2P parameter 1,
L00632 | P2P1_STATUSOl | WORD parameter No. 1 completed No. 01 1 block service abnormal completion.
block service abnormally
Number of No. 01 block service . .
L00633 | _P2P1_SVCCNTOL Double normal execution by P2P Displays the number of No. 1 block service
word executed normally by P2P parameter No. 1.
parameter No. 1
Number of No. 01 block service . .
L00635 | _P2P1 ERRCNTOL | POUPle | ahnormal execution by P2P Displays the number of No. 1 block service
word executed normally by P2P parameter No. 1.
parameter No. 1
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' 1

(2) Link devices (N) list

P2P Number: 1 ~8, P2P: 0 ~63

No. keyword Type Content Description
P2P parameter No. 1 No. blg(?ll/?)? ;hzepd;:rt;rrlnaéltz? :l:)atllon address on No 00
N0000O ~P1BOOSN WORD 2&3'(?:';3;56“528‘“0“ If the destination station address is used in XG5000,
it can be modified during Run using P2PSN
command.
N00001 ~ P1BOORD1 Device ggzlziLa;nwiftroNr%aﬁ No. Saves device 1 on No. 00 block area to read of P2P
NO0004 - structure . parameter No. 1.
device 1
P2P parameter No. 1 No. .
: Saves size 1 on No. 00 block area to read of P2P
N00005 _P1BOORS1 WORD (20 block area to read size parameter No. 1.
N00006 ~ P1BOORD?2 Device gg':)lgiLa;‘:f{oNr%aﬁ No. Saves device 2 on No. 00 block area to read of P2P
NO0009 - structure . parameter No. 1.
device 2
P2P parameter No. 1 No. .
) Saves size 2 on No. 00 block area to read of P2P
NO0010 _P1BOORS2 WORD 20 block areato read size parameter No. 1.
NO0011 ~ Device P2P parameter No. 1 No. Saves device 3 on No. 00 block area to read of P2P
P1BOORD3 00 block area to read
NO0014 - structure ; parameter No. 1.
device 3
P2P parameter No. 1 No. .
) Saves size 3 on No. 00 block area to read of P2P
N00015 _P1BO0ORS3 WORD gO block area to read size parameter No. 1.
N00016 ~ P1BOORD4 Device ESZI%iLagg;e:oNroe'at No. Saves device 4 on No. 00 block area to read of P2P
N00019 - structure . parameter No. 1.
device 4
P2P parameter No. 1 No. .
) Saves size 4 on No. 00 block area to read of P2P
N00020 _P1BO0ORS4 WORD 20 block area to read size parameter No. 1.
. P2P parameter No. 1 No. .
N00021 ~ Device - Saves device 1 on No. 00 block save area of P2P
N00024 _P1BOOWD1 structure 20 block save area device parameter No. 1.
P2P parameter No. 1 No. Saves size 1 on No. 00 block save area of P2P
N00025 _P1B0OWS1 WORD 00 block save area size 1 parameter No. 1.
. P2P parameter No. 1 No. .
N00026 ~ Device : Saves device 2 on No. 00 block save area of P2P
N00029 _P1B0O0OWD2 structure (2)0 block save area device parameter No. 1.
P2P parameter No. 1 No. Saves size 2 on No. 00 block save area of P2P
N00030 _P1B0OWS2 WORD 00 block save area size 2 parameter No. 1.
. P2P parameter No. 1 No. .
NO00031 ~ Device - Saves device 3 on No. 00 block save area of P2P
N00034 _P1B0OOWD3 structure go block save area device parameter No. 1.
P2P parameter No. 1 No. Saves size 3 on No. 00 block save area of P2P
N00035 _P1BOOWS3 WORD 00 block save area size 3 parameter No. 1.
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No. keyword Type Content Description
NO00036 ~ P1BOOWD4 Device P2P parameter No. 1 No. 00 | Saves device 4 on No. 00 block save area of P2P
N00039 — structure | block save area device 4 parameter No. 1.
P2P parameter No. 1 No. 00 | Saves size 4 on No. 00 block save area of P2P
N00040 _P1B0OWSA4 WORD block save area size 4 parameter No. 1.
Saves the destination station address on No 01
P2P parameter No. 1 No. 01 | block of P2P parameter No. 1.
N00041 _P1BO1SN WORD block destination station If the destination station address is used in XG5000,
address it can be modified during Run using P2PSN
command.
NO00042 ~ P1BO1RD1 Device P2P parameter No. 1 No. 01 | Saves device 1 on No. 01 block area to read of P2P
N00045 - structure | block areato read device 1 | parameter No. 1.
P2P parameter No. 1 No. 01 | Saves size 1 on No. 01 block area to read of P2P
NO00046 _P1BO1RS1 WORD block areato read size 1 parameter No. 1.
N00047 ~ P1BO1RD?2 Device P2P parameter No. 1 No. 01 | Saves device 1 on No. 01 block area to read of P2P
N00050 - structure | block areato read device 2 | parameter No. 1.
P2P parameter No. 1 No. 01 | Saves size 2 on No. 01 block area to read of P2P
N00051 _P1BO1RS2 WORD block areato read size 2 parameter No. 1.
N00052 ~ P1BO1RD3 Device P2P parameter No. 1 No. 01 | Saves device 3 on No. 01 block area to read of P2P
N00055 - structure | block areato read device 3 | parameter No. 1.
P2P parameter No. 1 No. 01 | Saves size 3 on No. 01 block area to read of P2P
N00056 _P1BOIRS3 WORD block area to read size 3 parameter No. 1.
NO0057 ~ P1BO1RD4 Device P2P parameter No. 1 No. 01 | Saves device 4 on No. 01 block area to read of P2P
N00060 - structure | block areato read device 4 | parameter No. 1.
P2P parameter No. 1 No. 01 | Saves size 4 on No. 01 block area to read of P2P
N00061 _P1B01IRS4 WORD block areato read size 4 parameter No. 1.
NO00062 ~ P1BO1WD1 Device P2P parameter No. 1 No. 01 | Saves device 1 on No. 01 block save area of P2P
N00065 - structure | block save area device 1 parameter No. 1.
P2P parameter No. 1 No. 01 | Saves size 1 on No. 01 block save area of P2P
NO0066 _P1B01WS1 WORD block save area size 1 parameter No. 1.
NO0067 ~ P1BO1WD2 Device P2P parameter No. 1 No. 01 | Saves device 2 on No. 01 block save area of P2P
N00070 - structure | block save area device 2 parameter No. 1.
P2P parameter No. 1 No. 01 | Saves size 2 on No. 01 block save area of P2P
N00071 _P1B01WS2 WORD block save area size 2 parameter No. 1.
NO00072 ~ P1BO1WD3 Device P2P parameter No. 1 No. 01 | Saves device 3 on No. 01 block save area of P2P
N00075 - structure | block save area device 3 parameter No. 1.
P2P parameter No. 1 No. 01 | Saves size 3 on No. 01 block save area of P2P
N00076 _P1BOIWS3 WORD block save area size 3 parameter No. 1.
NO0077 ~ P1BO1WDA4 Device P2P parameter No. 1 No. 01 | Saves device 4 on No. 01 block save area of P2P
N00080 - structure | block save area device 4 parameter No. 1.
P2P parameter No. 1 No. 01 | Saves size 4 on No. 01 block save area of P2P
NO0081 _P1B01WS4 WORD block save area size 4 parameter No. 1.

(1) N area is automatically set when P2P parameter is set using XG5000 and can be modified during run
using P2P dedicated command.

(2) N area is classified according to P2P parameter setting number and block index number, so the area
not used for P2P service can be used as internal device.
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(3) FEnet Connection information List

Variable Type Description
_0000_ADDR_LNM WORD FEnet : LNM information(above Ver 6.0)
_0000_CH_NFR ARRAY FEnet : New Frame Ready(Ver 8.6 or higher), (XGI CPU)
:ggggiggggimig - BIT FEnet : New Frame Ready(Ver 8.6 or higher), (XGK CPU)
_0000_LINE_TOPOLOGY BIT FEnet : Line topology state(above Ver 6.0)
_0000_LINKUP_INFO BIT FEnet : Link up/down information
_0000_RING_TOPOLOGY BIT FEnet : Ring topology state(above Ver 6.0)
_0000_SC_INFO WORD FEnet : Server connection state
_0000_STAND_ALONE BIT FEnet : Stand alone state(above Ver 6.0)

It can add variables as FEnet module. For example, if there are FEnet modules in 1 and 3 slot, “_0001_~" and

“ 0003_~" are added as variable.
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A.4 ASCII Code Table

American National Standard Code for Information Interchange

ASCII Code ASCII Code ASCII Code ASCII Code
HEX Decimal Value HEX Decimal Value HEX Decimal Value HEX Decimal Value
00 000 NULL 40 064 @ 80 128 € co 192 A
01 001 SOH 41 065 81 129 . C1 193 A
02 002 STX 42 066 B 82 130 , Cc2 194 A
03 003 ETX 43 067 Cc 83 131 f C3 195 A
04 004 EQT 44 068 D 84 132 ” C4 196 A
05 005 ENQ 45 069 E 85 133 C5 197 A
06 006 ACK 46 070 F 86 134 T C6 198 A
07 007 BEL 47 071 G 87 135 c7 199 C
08 008 BS 48 072 H 88 136 " Cs8 200 E
09 009 HT 49 073 I 89 137 %o C9 201 E
0A 010 LF 4A 074 J 8A 138 S CA 202 E
0B 011 VT 4B 075 K 8B 139 < CB 203 E
oc 012 FF 4C 076 L 8C 140 CE CC 204 I
0D 013 CR 4D o077 M 8D 141 . CD 205 i
OE 014 SO 4E 078 N 8E 142 z CE 206 T
OF 015 SI 4F 079 O 8F 143 . CF 207 i
10 016 DLE 50 080 P 90 144 . DO 208 b
11 017 DC1 51 081 Q 91 145 ‘ D1 209 N
12 018 DC2 52 082 R 92 146 ’ D2 210 o
13 019 DC3 53 083 S 93 147 “ D3 211 o
14 020 DC4 54 084 T 94 148 7 D4 212 0
15 021 NAK 55 085 U 95 149 . D5 213 0
16 022 SYN 56 086 Vv 96 150 - D6 214 o
17 023 ETB 57 087 w 97 151 — D7 215 x
18 024 CAN 58 088 X 98 152 - D8 216 %]
19 025 EM 59 089 Y 99 153 ™ D9 217 U
1A 026 SuB 5A 090 z 9A 154 $ DA 218 U
1B 027 ESC 5B 091 [ 9B 155 ) DB 219 0
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ASCII Code ASCII Code ASCII Code ASCII Code
Value Value Value Value
HEX Decimal HEX [ Decimal HEX Decimal HEX Decimal
1C 028 FS 5C 092 \ 9C 156 e DC 220 U
1D 029 GS 5D 093 ] 9D 157 . DD 221 '
1E 030 RS 5E 094 A 9E 158 z DE 222 p
1F 031 us 5F 095 _ 9F 159 Y DF 223 3
20 032 (space) 60 096 AO 160 EO 224 a
21 033 ! 61 097 a Al 161 i El 225 a
22 034 " 62 098 b A2 162 ¢ E2 226 a
23 035 # 63 099 c A3 163 £ E3 227 a
24 036 $ 64 100 d A4 164 o E4 228 a
25 037 % 65 101 e A5 165 ¥ E5 229 a
26 038 & 66 102 f A6 166 | E9 230 &
27 039 ' 67 103 g A7 167 § EA 231 c
28 040 ( 68 104 h A8 168 EB 232 e
29 041 ) 69 105 i A9 169 © EC 233 é
2A 042 * 6A 106 i AA 170 a ED 234 é
2B 043 + 6B 107 k AB 171 « EE 235 é
2C 044 6C 108 I AC 172 - EF 236 i
2D 045 - 6D 109 m AD 173 FO 237 i
2E 046 6E 110 n AE 174 ® F1 238 7
2F 047 / 6F 111 o] AF 175 - F2 239 i
30 048 0 70 112 p BO 176 ° F3 240 o}
31 049 1 71 113 q B1 177 * F4 241 fi
32 050 2 72 114 r B2 178 2 F5 242 0
33 051 3 73 115 S B3 179 3 F6 243 o]
34 052 4 74 116 t B4 180 F7 244 o}
35 053 5 75 117 u B5 181 Il F8 245 o]
36 054 6 76 118 v B6 182 1 F9 246 o]
37 055 7 77 119 w B7 183 FA 247 +
38 056 8 78 120 X B8 184 , FB 248 o
39 057 9 79 121 y B9 185 L FC 249 u
3A 058 TA 122 z BA 186 0 FD 250 1]
3B 059 ; 7B 123 { BB 187 » FE 251 a
3C 060 < 7C 124 | BC 188 Ya FF 252 u
3D 061 = 7D 125 } BD 189 Ya EF 253 y
3E 062 > 7E 126 ~ BE 190 é EF 254 b
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3F 063 ? 7F 127 0 BF 191 A EF 255 y
A.5 Ethernet technology compare table
Technology Speed (Mbps) Media Max. distance
Token Ring 4.16 uTP 100m
10BASE-T 10 uTpP 100m
10BASE-F(Multi mode) 10 Optical cable Max. 2km
Ethernet 10BASE-F(Single mode) 10 Optical cable Max. 2.5km
10BASE-5 10 Coaxial cable 500m
10BASE-2 10 Coaxial cable 185m
100BASE-T4 100 UTP 100m
Fast 100BASE-TX 100 UTP 100m
Ethernet | 100BASE-FX(Multi mode) 100 Optical cable 42152((;'u"’|‘:fDDu“p"l"'§;)
100BASE-FX(Single mode) 100 Optical cable 20km
1000BASE-T 1000 UTP 100m
Gigabit 100BASE-FX(Single mode) 1000 Optical cable 3km
Ethernet 100BASE-FX(Multi mode) 1000 Optical cable 500m
100BASE-T 1000 Coaxial cable 25m
100VG-AnyLAN 100 UTP -
ATM 155-622 UTP,Optical cable -
FDDI(Single mode) 100 Optical cable 40-60km
FDDI(Multi mode) 100 Optical cable 2km
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A.6 Dimension

(1) XGL-EFMTB/EFMFB, XGL-EH5T

o

90+0,1

Unit : mm
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(2) XOL-ES4H

Unit : mm
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(3) XOL-ES4T
Unit : mm
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Warranty and environmental policy

Warranty

1. Warranty Period

The product you purchased is guaranteed for 36 months from the date of manufacture.

2. Scope of Warranty

(1) The initial diagnosis of faults is basically conducted by your company. However, upon your request, our company or our service hetwork
can undertake this task for a fee. If the cause of the fault lies with our company, this service will be provided free of charge.
(2) This warranty only applies if the product is used under normal conditions according to the specifications and precautions described in the
handling instructions, user manuals, catalogs, and caution labels.
(3) Even within the free warranty period, the following cases will be subject to paid repairs:
1) Replacement of consumable and life-limited parts (e.g., relays, fuses, electrolytic capacitors, fans, LCDs, batteries, etc.)
2) Failures or damages caused by improper storage, handling, negligence, or accidents by the customer
3) Failures resulting from the customer's hardware or software design
4) Failures due to modifications without our consent
(Repairs will be refused, even for a fee, if recognized as modified or repaired outside our company)
5) Failures that could have been avoided if the customer's equipment, in which our product is incorporated, had safety devices required by
legal regulations or common industry standards
6) Failures that could have been prevented if maintenance and replacement of consumable parts were performed normally according to
the handling instructions or user manuals
7) Failures and damages to the product caused by using connected equipment or inappropriate consumables
8) Failures caused by external factors such as fire, abnormal voltage, force majeure, and natural disasters such as earthquakes, lightning,
salt damage, wind, and flood damage
9) Failures due to reasons that could not be predicted with the scientific and technical standards at the time of our shipment
10) Other failures, damages, or defects recognized as the responsibility of your company

Environmental Policy

LS ELECTRIC Co., Ltd supports and observes the environmental policy as below.

Environmental Management About disposal of the Product.
LS ELECTRIC considers the environmental LS ELECTRIC’ PLC unit is designed to protect
preservation as the preferential management the environment. For the disposal, separate
subject and every staff of LS ELECTRIC use =——aluminum, iron and synthetic resin (cover) from
the reasonable endeavors for the pleasurably the product as they are reusable.

environmental preservation of the earth.
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Tel: 90-212-806-1225 E-Mail: turkey@ls-electric.com * LS ELECTRIC America Western Office (Irvine, USA)

Tel: 1-949-333-3140 E-Mail: america@Is-electric.com

Disclaimer of Liability

LS ELECTRIC has reviewed the information in this publication to ensure consistency with the hardware and software described.
However, LS ELECTRIC cannot guarantee full consistency, nor be responsible for any damages or compensation, since variance
cannot be precluded entirely. Please check again the version of this publication before you use the product.

© LS ELECTRIC Co., Ltd 2015 All Right Reserved. 2024.11
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